should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through help links. All such sample code is provided “as is” and “as available”, for use only with an authorized NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's particular usage pattern requires a higher limit or threshold, then the Customer should procure a subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally available. To use such features, Customer acknowledges and agrees that such beta features are subject to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will use the beta feature carefully and will not use it in any way which might result in any loss, corruption or unauthorized access of or to its or any third party's property or information. Customer must promptly report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability of such beta features and may substantially modify or cease providing such beta features without entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the performance of the Service resulting from the use of beta features. Oracle's standard service levels, warranties and related commitments regarding the Service shall not apply to beta features and they may not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the date that Oracle at its sole option makes a beta feature generally available to its customers and partners as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document. Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click here to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
Table of Contents

CSV Imports Overview ............................................................................................................ 1
Importing CSV Files with the Import Assistant ................................................................. 3
  Step 1 Scan & Upload File ................................................................................................. 3
    Select an Import Type .................................................................................................. 4
    Select a Record Type for Import .................................................................................. 5
    Choose Import Character Encoding .......................................................................... 5
    Choose CSV Column Delimiter .................................................................................. 6
    Select a File for Import ............................................................................................... 7
  Step 2 Import Options .................................................................................................... 8
    Choose Data Handling for Import .............................................................................. 8
    Required Permissions for CSV Imports ...................................................................... 9
    Set Advanced CSV Import Options .......................................................................... 10
    Use Multiple Threads and Multiple Queues to Run CSV Import Jobs .................. 15
  Step 3 File Mapping ..................................................................................................... 17
  Step 4 Field Mapping .................................................................................................... 17
    CSV Field Mapping Tasks ......................................................................................... 19
    General CSV Field Mapping Tips ............................................................................ 20
    Required Fields on Records ..................................................................................... 21
    Select Reference Types .............................................................................................. 21
    Assign Default Values during Field Mapping ......................................................... 24
    Assign Null Values during Field Mapping ............................................................... 25
  Step 5 Save Mapping & Start Import ............................................................................ 25
    Checking CSV Import Status ..................................................................................... 26
    Canceling a CSV Import .............................................................................................. 28
    CSV Import Error Reporting ...................................................................................... 29
    Deleting Incorrect CSV Data ...................................................................................... 30
Working with Saved CSV Imports .................................................................................. 31
  Editing a Saved Import .................................................................................................. 32
  Sharing Imports ............................................................................................................ 33
  Translating Import Map Name and Description ......................................................... 34
  Including Import Maps and CSV Files in SuiteBundler ........................................... 35
Setting CSV Import Preferences ..................................................................................... 37
Guidelines for CSV Import Files .................................................................................... 39
Supported Record Types for CSV Import ........................................................................ 39
Accounting Import Type .................................................................................................... 42
  Budget Exchange Rates Import .................................................................................... 43
  Chart of Accounts Import ............................................................................................. 43
  Consolidated Exchange Rates Import .......................................................................... 45
  Currency Exchange Rates Import ............................................................................... 45
  Expense Categories Import ......................................................................................... 46
  Fair Value Price CSV Import ....................................................................................... 48
  Global Account Mapping Import .................................................................................. 49
  Item Account Mapping Import ..................................................................................... 50
Activities Import Type ...................................................................................................... 51
  Events Import .............................................................................................................. 51
  Phone Calls Import ....................................................................................................... 58
  Resource Allocations Import ......................................................................................... 60
  Tasks Import ................................................................................................................ 62
Classification Import Type ................................................................................................. 64
  Class Import ................................................................................................................ 65
  Custom Segment Value Import .................................................................................... 65
  Department Import ....................................................................................................... 67
  Location Import ............................................................................................................ 68
<table>
<thead>
<tr>
<th>Import Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merchandise Hierarchy Node Import</td>
<td>69</td>
</tr>
<tr>
<td>Communications Import Type</td>
<td>70</td>
</tr>
<tr>
<td>Messages Import</td>
<td>71</td>
</tr>
<tr>
<td>Notes Import</td>
<td>71</td>
</tr>
<tr>
<td>Custom Records Import</td>
<td>72</td>
</tr>
<tr>
<td>Customization Import Type</td>
<td>73</td>
</tr>
<tr>
<td>Custom List Import</td>
<td>73</td>
</tr>
<tr>
<td>Employees Import Type</td>
<td>81</td>
</tr>
<tr>
<td>Expense Report Import</td>
<td>81</td>
</tr>
<tr>
<td>Job Import</td>
<td>82</td>
</tr>
<tr>
<td>Time-Off Change CSV Import</td>
<td>88</td>
</tr>
<tr>
<td>Track Time Import</td>
<td>89</td>
</tr>
<tr>
<td>Items Import</td>
<td>90</td>
</tr>
<tr>
<td>Item Record Types that Can Be Imported</td>
<td>91</td>
</tr>
<tr>
<td>Item Sublists Available for Import</td>
<td>92</td>
</tr>
<tr>
<td>Notes about Items Imports</td>
<td>93</td>
</tr>
<tr>
<td>Selecting General Ledger Accounts for Item Imports</td>
<td>96</td>
</tr>
<tr>
<td>Importing Demand Planning Data for Items</td>
<td>98</td>
</tr>
<tr>
<td>Importing Related Items Groups</td>
<td>101</td>
</tr>
<tr>
<td>Importing Matrix Options for Items</td>
<td>102</td>
</tr>
<tr>
<td>Importing Pricing Data for Items</td>
<td>106</td>
</tr>
<tr>
<td>Replacing the Bill of Materials Sublist with the CSV File</td>
<td>112</td>
</tr>
<tr>
<td>Payment Instruments Import Type</td>
<td>112</td>
</tr>
<tr>
<td>Relationships Import Type</td>
<td>113</td>
</tr>
<tr>
<td>Billing Account Import</td>
<td>114</td>
</tr>
<tr>
<td>Contacts Only Import</td>
<td>114</td>
</tr>
<tr>
<td>Customer-Subsidiary Relationship Import</td>
<td>117</td>
</tr>
<tr>
<td>Customers Only Import</td>
<td>118</td>
</tr>
<tr>
<td>Projects (Jobs) Import</td>
<td>122</td>
</tr>
<tr>
<td>Leads Only Import</td>
<td>124</td>
</tr>
<tr>
<td>Partners Import</td>
<td>127</td>
</tr>
<tr>
<td>Prospects Only Import</td>
<td>129</td>
</tr>
<tr>
<td>Vendor-Subsidiary Relationship Import</td>
<td>132</td>
</tr>
<tr>
<td>Vendors Import</td>
<td>133</td>
</tr>
<tr>
<td>Importing Entities and Contacts Together</td>
<td>135</td>
</tr>
<tr>
<td>Understanding Leads, Prospects, and Customers</td>
<td>139</td>
</tr>
<tr>
<td>Rules Setup Import Type</td>
<td>139</td>
</tr>
<tr>
<td>Foreign Currency Variance Posting Rule Import</td>
<td>139</td>
</tr>
<tr>
<td>Subscription Billing Import Type</td>
<td>142</td>
</tr>
<tr>
<td>Price Book Import</td>
<td>144</td>
</tr>
<tr>
<td>Price Plan Import</td>
<td>145</td>
</tr>
<tr>
<td>Subscription Import</td>
<td>147</td>
</tr>
<tr>
<td>Subscription Change Order Import</td>
<td>148</td>
</tr>
<tr>
<td>Subscription Line Import</td>
<td>149</td>
</tr>
<tr>
<td>Subscription Plan Import</td>
<td>150</td>
</tr>
<tr>
<td>Usage Import</td>
<td>151</td>
</tr>
<tr>
<td>Supply Chain Import Type</td>
<td>152</td>
</tr>
<tr>
<td>Bill of Materials Import</td>
<td>152</td>
</tr>
<tr>
<td>Bill of Materials Revision Import</td>
<td>153</td>
</tr>
<tr>
<td>Bin Import</td>
<td>154</td>
</tr>
<tr>
<td>Item Location Configuration Import</td>
<td>154</td>
</tr>
<tr>
<td>Item Revision Import</td>
<td>155</td>
</tr>
<tr>
<td>Manufacturing Cost Template Import</td>
<td>155</td>
</tr>
<tr>
<td>Manufacturing Routing Import</td>
<td>161</td>
</tr>
</tbody>
</table>
CSV Imports Overview

CSV import is the most commonly used method for transferring small to medium-sized data sets from other applications into NetSuite. The CSV import process saves time and prevents errors, by submitting data in a CSV (comma-separated value) file. This data can add or update many records at one time, avoiding the need for manual data entry.

**Note:** NetSuite recommends that you scrub your data before importing it.

NetSuite provides an Import Assistant that you can use to step through the process for most CSV imports. If you have the Import CSV File permission, the Import Assistant is available at Setup > Import/Export > Import CSV Files. The types of data that you can import with the Assistant depend upon your assigned role and permissions, and on your account's enabled features.

In the Assistant, you select the type of records to be imported, specify the CSV file containing data to be uploaded, indicate whether CSV data adds new records or updates existing records, and map CSV file fields to NetSuite fields.

You can save an import job to be run later. After you have saved an import, you can reuse its mapping for later import jobs and share it with other users. When you run an import, a status page is available for you to view its progress.

Review the following for information about importing CSV data into NetSuite:

- For instructions for working with the Import Assistant, see Importing CSV Files with the Import Assistant.
- For help preparing files for CSV import and a list of data record types that can be imported, see Guidelines for CSV Import Files.

For details about alternate approaches to import tasks, see the following:

- After you have saved an import map, you can execute a SuiteScript API to programmatically import CSV file data using that mapping. For details, see the help topic `nlapiSubmitCSVImport(nlobjCSVImport)`.
- See Additional Import and Export Options for information about other imports that do not use the CSV Import Assistant, including Peachtree data.

- NetSuite SOAP web services provide a solution for large or ongoing data migration projects, and for migrating data for record types not currently supported for CSV import. For information, see the SuiteTalk SOAP Web Services Platform Guide.

Note the following:

- Simplified versions of the Import Assistant are available to import budget data, single journal entry data, single inventory worksheet data, Microsoft Project tasks data, and website redirects data into NetSuite.
  - The budget import assistant is at Transactions > Financial > Set Up Budgets > Import, if you have the Set Up Budgets permission. For more information, see the Budget Import help topic.
  - The single journal entry import assistant is available at Transactions > Financial > Make Journal Entries > Import. If you use NetSuite OneWorld, the single intercompany journal entry import assistant is available at Transactions > Financial > Make Intercompany Journal Entries > Import. You need the Make Journal Entry permission. For more information, see the Single Journal Entry Import help topic.
  - The single inventory worksheet import assistant is available at Transactions > Inventory > Adjust Inventory Worksheet > Import. You need the Adjust Inventory Worksheet permission. For more information, see the Single Inventory Worksheet Import.
  - The project tasks import assistant is at Activities > Scheduling > Project Tasks > Import, if the Project Management feature is enabled. For more information, see the Project Tasks Import help topic.
  - The website redirects import assistant is at Setup > SuiteCommerce Advanced > Redirects > Import, when the Web Site and Host HTML Files features are enabled. You need the Set Up Web Site permission. For more information, see the help topic Importing Web Site Redirects.

- The following CSV imports are template-based and are not available in the Import Assistant: Bulk Fulfilling Orders Using a CSV Import, Importing a Vendor Price List, Importing Employee Commission Data, and Importing Single-Use Coupon Codes.

- A SuiteScript API is available to automate CSV imports through scripting instead of using the Import Assistant. See the help topic nlapiSubmitCSVImport(nlobjCSVImport). Note that scripted imports are not supported for data normally imported through simple (2-step) assistants.
Importing CSV Files with the Import Assistant

You can use the Import Assistant for most imports of CSV data to NetSuite. The Import Assistant is available at Setup > Import/Export > Import CSV Records, if you have the Import CSV File permission.

Before an import, review the information available in Guidelines for CSV Import Files for help formatting your CSV files correctly.

The Import Assistant includes five steps:

- **Step 1 Scan & Upload File**
  - Select an Import Type
  - Select a Record Type for Import
  - Choose Import Character Encoding
  - Choose CSV Column Delimiter
  - Select a File for Import

- **Step 2 Import Options**
  - Choose Data Handling for Import
  - Set Advanced CSV Import Options

- **Step 3 File Mapping** (required only for multi-file imports)

- **Step 4 Field Mapping**

- **Step 5 Save Mapping & Start Import**

The Assistant provides verification of each step and does not let you proceed to the next page if it encounters errors. After you complete these steps, you can run an import job immediately or save the import and run it later.

**Warning:** CSV Import of Published Saved Searches is not supported.

**Step 1 Scan & Upload File**

Complete the following tasks for step 1 of the Import Assistant:

- Select an Import Type
- Select a Record Type for Import
- Choose Import Character Encoding
- Choose CSV Column Delimiter
- Select a File for Import

Click Next.

If your CSV file contains incorrect characters or other errors, an error message displays the type and number of errors.

You then can download a ZIP file containing the CSV files with an additional column in each file indicating the errors. After you fix the errors, you can launch the Import Assistant again and upload the files.
- If no errors are detected, the Assistant Proceeds to **Step 2 Import Options**.

### Select an Import Type

On the Scan & Upload CSV File page of the Import Assistant, select the category of record to import from the Import Type dropdown list. Record types available for import are divided into categories, listed alphabetically:

**Select an Import Type**

On the Scan & Upload CSV File page, choose the category of record to import from the Import Type dropdown list. Record types are divided into categories, listed alphabetically:

<table>
<thead>
<tr>
<th>Category</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships</td>
<td>Select...</td>
</tr>
<tr>
<td>Custom Records</td>
<td>Select...</td>
</tr>
<tr>
<td>Employees</td>
<td>Select...</td>
</tr>
<tr>
<td>Items</td>
<td>Select...</td>
</tr>
<tr>
<td>Relationships</td>
<td>Select...</td>
</tr>
<tr>
<td>Supply Chain</td>
<td>Select...</td>
</tr>
<tr>
<td>Support</td>
<td>Select...</td>
</tr>
<tr>
<td>Transactions</td>
<td>Select...</td>
</tr>
</tbody>
</table>

**CSV File(s)**

- **ONE FILE TO UPLOAD**
- **MULTIPLE FILES TO UPLOAD**
The following import types are available. Click on a link below to see the record types available for each import type, to help you determine which import type to select:

- Accounting Import Type
- Activities Import Type
- Classification Import Type
- Communications Import Type
- Custom Records Import
- Customization Import Type
- Employees Import
- Items Import
- Relationships Import Type
- Rules Setup Import Type
- Subscription Billing Import Type
- Supply Chain Import Type
- Support Import Type
- Transactions Import Type
- Website Import Type

For a list of all record types sorted by import type, see Supported Record Types for CSV Import.

Select a Record Type for Import

After you select an import type, record types in that category display in the Record Type dropdown list. Choose a record type from the dropdown list.

NetSuite recommends that you read the CSV file guidelines specific to your selected record type, and prepare your CSV files before you do an import. For more details, see Supported Record Types for CSV Import.

Choose Import Character Encoding

On the Scan & Upload File page of the Import Assistant, choose the type of character encoding for your CSV import. The type of character encoding you choose depends on the type of file you wish to import.
Encoding schemes generally act the same way for common characters, such as 'a', 'A', and '0'. For special characters that programs may generate automatically as you type, such as typographic quotation marks, and for characters with diacriticals, encoding schemes differ, for example 0x8E vs. 0xE9 for 'e' + acute accent.

NetSuite supports the following types of character encoding:

- **(Unicode) UTF-8 encoding** — UTF-8 character encoding is the most widely used format for international users importing a CSV file created in a language other than U.S. English. If you intend to use the format, you should ensure your file contains valid UTF-8 characters. You may have to use a third party editor to convert your file to UTF-8 prior to the import into NetSuite. Some editors will append the BOM (Byte Order Marker) to the beginning of the file indicating that it is UTF-8 encoded. UTF-8 encoded CSV files are imported regardless of whether the BOM is present. Note that on Windows platforms, you can use Notepad to convert your CSV file into UTF-8 format. Open your CSV file in Notepad, click File > Save As and select UTF-8 from the Encoding dropdown before clicking Save on the Save As dialog box.

- **Western (Windows 1252) encoding** — Typically, NetSuite users create CSV files for import in Microsoft Excel, which uses Windows 1252 character coding. Western (Windows 1252) is the default for the U.S. edition.

- **Western (ISO-8859-1) encoding** — ISO-8859-1 encodes what is commonly referred to as “Latin alphabet no. 1,” consisting of 191 characters from the Latin script. The character-encoding is used throughout the Americas, Western Europe, Oceania, and much of Africa. It is also commonly used in most standard romanizations of East Asian languages.

- **Chinese Simplified (GB18030)** — GB18030 is the registered Internet name for the official character set of the People's Republic of China (PRC), superseding GB2312. The character set is formally called “Chinese National Standard GB 18030-2005: Information technology -- Chinese coded character set.” GB abbreviates Guójiā Biāozhun, which means national standard in Chinese. (Description cited from Wikipedia.) Chinese Simplified (GB18030) is the default when the Chinese language preference has been selected.

- **Chinese Simplified (GBK) encoding extension** — Used in mainland China and Singapore.

- **Traditional Chinese (Big5) encoding** — Typically used in Taiwan, Hong Kong, and Macau.

- **Japanese (Shift-JIS) encoding** — Shift-JIS character encoding is the most widely used format for Japanese users intending to import a CSV file. Japanese (Shift-JIS) is the default for the Japanese edition and when the Japanese language preference has been selected.

- **(Western) MacRoman** — CSV files created in Excel running on Macs use MacRoman character encoding.


- **Korean (EUC-KR) encoding** — One of the more widely-used legacy character encodings (extended UNIX code).

**Note:** If invalid characters prevent a file from being processed for import, you receive an error and are able to fix it. For more information, see CSV Import Error Reporting.

### Choose CSV Column Delimiter

On the Scan & Upload File page of the Import Assistant, select the delimiter used to separate the columns in the CSV file you are importing. You can choose among the following:

- Comma (,) (the default separator)
- Semicolon (;)
- Pipe (|)
The separator you specify here overrides any account-level column separator preferences set on the CSV Import Preferences page and your subsidiary's Preferences subtab.

Select a File for Import

On the Scan & Upload CSV File page of the Import Assistant, indicate the file or files to be the source of imported CSV data.

For some record types, you can choose an option button to indicate whether one file or multiple files will be uploaded. There is a limit of 25,000 records per uploaded file.

Select one or more CSV files to import by clicking the Select... buttons and browsing to the CSV files you want to import.

- If you have chosen One file to upload, the Assistant provides one Select... button.
- If you have chosen Multiple files to upload, the Assistant provides a Select... button for the primary file, and multiple, optional Select... buttons with descriptions of the types of files that can be linked to the primary file.

It is important that the data for the main fields in the imported records is included in the primary file, not in the linked files.

Linked files may contain sublist data that is stored separately, such as multiple addresses for each customer. For more information, see Sublist Data Import.

Click the Select buttons corresponding to the types of data you want to upload, and browse to the correct files. After you have added a file, its name appears. You can click the Remove button to select an alternate file.

The following screenshot shows file selection for a multi-file import:
Step 1 Scan & Upload File

Note the following:

- The list of optional linked files shows sublists that may be available for import. The list does not reflect
  the disabling of related features, so it may include sublists not currently available for import.
- If you select multiple files, the Import Assistant’s File Mapping page requires you to define the column
  in each file used to link data among files.

⚠️ **Important:** If you are using a previously saved import map, your choice of one file or multiple
files should be consistent with the original choice for the import map. If you choose one file for a
map that previously used multiple files, or vice versa, some CSV file data may not be imported.

Step 2 Import Options

Complete the following tasks for step 2 of the Import Assistant:

- Choose Data Handling for Import
- Set Advanced CSV Import Options
- Click Next to go to Step 3 File Mapping or Step 4 Field Mapping.

Choose Data Handling for Import

On the Import Options page of the Import Assistant, choose a Data Handling option to indicate how the
imported data will affect NetSuite data:

- **Add** — Select if all imported records are new to NetSuite.
- **Update** — Select if all imported records already exist in NetSuite, and the import is intended to modify
  these records.
- **Add or Update** — Select if imported records are a mixture of new and existing records.

⚠️ **Note:** See Required Permissions for CSV Imports to get an understanding of the permission level
a user must have for a record type to add or update records of that type via CSV import.

Be aware of the following issues for CSV data updates of NetSuite data:
Your selection of a reference type in the Import Assistant’s Field Mapping step determines how CSV file records are mapped to existing NetSuite records. Possible reference types are external ID, internal ID, or name. Issues with reference types may cause update errors; name references are more susceptible to errors because of matching failures. For more information, see Select Reference Types.

By default, NetSuite fields will not be cleared of data when the CSV file contains corresponding fields that do not contain data. You can change the default behavior by enabling the Overwrite Missing Fields advanced option. For information, see Overwrite Missing Fields.

Imports always populate dependent field values automatically when related field values are set, in the same manner that dependent field values are populated in the user interface. For updates, be sure to include all necessary values in CSV files, to avoid inadvertent changes of existing field values to defaults.

Updates of sublist data depend on the setting for the Overwrite Sublists option, and on whether sublists are keyed. Overwrite Sublists can be set as an advanced option for an import job, or as a general preference for all imports at Setup > Import/Export > CSV Import Preferences.

If the Overwrite Sublists option is enabled, CSV file sublist rows completely replace existing sublist data. If the Overwrite Sublists option is disabled, for keyed sublists, CSV file sublist rows selectively update existing sublist data, and for other sublists, CSV file sublist rows are appended to existing sublist data.

For more information about the option, see Overwrite Sublists. To review which sublists are keyed, see Supported Sublist Imports and Keyed Sublists for CSV Import.

Complete deletion of sublist data currently is not supported. Existing sublist data can only be overwritten with new CSV file sublist data, not with an absence of CSV file sublist data.

Required Permissions for CSV Imports

To be able to import CSV data, the Import CSV File permission must be assigned to the role. An administrator may assign the permission to a role.

To assign the Import CSV File permission to a role:

1. Go to Setup > Users/Roles > User Management > Manage Roles.
2. Locate the role you want to modify. Click the corresponding Edit or Customize link.
3. On the Permissions subtab, click Setup.
4. In the Permissions dropdown list, select Import CSV File.
5. In the Level dropdown list, select the appropriate permission level.
6. Click Add.
7. Click Save.

To learn how to view the permissions assigned to a role, see the help topic Reviewing Permissions Assigned to Roles.

Supported import data handling for a record type maps to the user’s permission level for that record type. The permissions model is consistent with permissions requirements for creating and updating records in the NetSuite user interface.

The following table lists the record type permission level a user must have for the different import data handling options to be enabled in the Import Assistant for that record type:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Permission Level</th>
<th>Types of CSV Imports Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VIEW</td>
<td>None</td>
</tr>
</tbody>
</table>

CSV Imports
### Set Advanced CSV Import Options

On the Import Options page of the Import Assistant, you can expand the Advanced Options menu to set preferences for the current import job. The following advanced options are available:

- Log System Notes For Custom Fields
- Overwrite Missing Fields
- Validate Mandatory Custom Fields
- Overwrite Sublists
- Ignore Read Only Fields
- Prevent Duplicate Records
- Custom Multi-Select Value Delimiter
- CSV Decimal Delimiter
- Custom Form
- Server Scripting and Workflow Execution
- Use Multi-Threading
- Queue Number

Some of these options also are available on the CSV Import Preferences page, where administrators and other users with the Set Up CSV Preferences permission can set preferences for all imports. For more information, see Setting CSV Import Preferences.

Advanced Options settings for an individual import job override the general preferences set on the CSV Import Preferences page.

**Important:** As of Version 2010 Release 1, the Use Conditional Defaults option is no longer available. Now, imports always populate dependent field values automatically when related field values are set, in the same manner that dependent field values are populated in the user interface. For updates, be sure to include all necessary values in CSV files, to avoid inadvertently changing existing field values to defaults.

### Log System Notes For Custom Fields

Enable to create system notes during the import of data from custom fields. The option is disabled by default. Disabling system notes for custom fields improves performance and is recommended for imports that add data.
Step 2 Import Options

The option is available in a check box on the Step 2 Import Options page of the Import Assistant, when you expand the Advanced Options section.

**Important:** System-generated notes are used in NetSuite to track changes to a record, including what action was taken, when the record was modified, and the user who is responsible for the change. These notes are important for maintaining a complete audit trail. If you turn off system-generated notes for custom fields, specific changes related to custom fields within the imported record are **not** recorded in NetSuite, although all changes for standard fields are logged as usual. If a custom field contains sensitive information that is critical for audit purposes, you should **not** disable system-generated notes.

**Overwrite Missing Fields**

Enable the option during data updates, to clear NetSuite fields mapped to CSV file fields that do not contain data. The option is disabled by default.

**Note:** Using this option has no impact on any field that is not included in the mapping.

An alternative to enabling the Overwrite Missing Fields option is to set null values for fields without CSV data. For information, see Assign Null Values during Field Mapping.

Be aware of the difference between the Overwrite Missing Fields option and the Overwrite Sublists option. The Overwrite Sublists option replaces sublist data as a whole, rather than checking for individual fields mapped to CSV file fields with no data.

**Validate Mandatory Custom Fields**

Enable the option to require mandatory custom field data to be present for records to be created. Disable the option to create records even though mandatory custom field data is not present. The option is enabled by default.

**Overwrite Sublists**

Your setting for the Overwrite Sublists option affects imports of sublist data when one of the following data handling option buttons is selected: Update, Add or Update. By default the option is disabled.

- **Overwrite Sublists = True** — If you enable the Overwrite Sublists option, the Import Assistant completely replaces all existing sublist values and replaces them with the CSV file sublist data. Be cautious in enabling the option, as all existing sublist values are removed.

- **Overwrite Sublists = False** — If you do not enable the Overwrite Sublists option, the effect varies according to whether the sublist import supports selective updates based on key field values.
  - For keyed sublists, if the Overwrite Sublists option is disabled, the Import Assistant:
    - Selectively updates existing sublist data with key field values that match CSV file sublist rows.
    - Adds CSV file sublist rows with key field values that do not match any values in existing rows as new sublist rows. (These rows represent new sublist key values, such as a new location or a new vendor.)
  - For non-keyed sublists, if the Overwrite Sublists option is disabled, the Import Assistant appends all CSV file sublist data as new rows.
For a list of sublists that are keyed, see Keyed Sublists for CSV Import. For a list of all sublists supported for CSV import, see Supported Sublist Imports.

Notes —
- Complete deletion of sublist data currently is not supported. Existing sublist data can only be overwritten with new CSV file sublist data, not with an absence of CSV file sublist data. For more information, see Replacing the Bill of Materials Sublist with the CSV File.
- Enabling the option cancels the effects of the Overwrite Missing Fields option on any sublists with mapped fields, because the result will be a sublist that looks exactly like the CSV file sublist data no matter what was there before.
- NetSuite recommends that you do not enable the Overwrite Sublists option for imports that include item pricing data or item demand plan imports. Enabling the option may result in errors when imported sublist data overwrites existing sublist values driven by body field values such as pricing schedule.

Ignore Read Only Fields

Check the box to indicate that read-only fields should be ignored during import job processing. Enabling the option to import CSV files containing values for read-only fields, such as auto-generated numbers, without causing errors. The option is enabled by default.

Important: For imports of entities and contacts together (Customers and Contacts Together, Leads and Contacts Together, Prospects and Contacts Together), the option must be enabled.

Prevent Duplicate Records

You can use the Prevent Duplicate Records option to block the import of records that appear to be duplicates. That is, when you select the option, the import of a record identified as a duplicate fails with an error reading “Duplicate record was detected.” Other records in the same CSV file will still be processed.

For more details, see:
- Availability of the Prevent Duplicate Records Option
- Preventing Duplicate Imports vs. Manually Reviewing Duplicates
- Setting Criteria to Identify Duplicates
- Default Behavior of the Prevent Duplicate Records Option
- Cases In Which Duplicates Are Still Imported

Availability of the Prevent Duplicate Records Option

When the Prevent Duplicate Records option is available, it displays under Advanced Options on page 2 of the Import Assistant.

The option is available only when the following statements are true:

- The Duplicate Detection & Merge feature is enabled at Setup > Company > Enable Features.
- On the page labeled Set Up Duplicates Detection Feature (Setup > Company > Duplicate Detection), you have selected one or more of the options labeled Detect (RecordType) Duplicates. When you detect duplicates for any of the available record types, the Prevent Duplicate Records option is
Step 2 Import Options

available for imports of that record type. Note that the feature is available for only four record types: Contact, Customer, Partner, and Vendor.

Preventing Duplicate Imports vs. Manually Reviewing Duplicates

When you select the Prevent Duplicate Records option and then try to import a record that appears to be a duplicate, the import of that record fails with an error reading “Duplicate record was detected.” If you do not select the Prevent Duplicate Records box, the duplicate record is created and marked as a duplicate. You can manage the new record, along with other duplicates, on the Lists > Mass Updates > Entity Duplicate Resolution page.

For this reason, if you prefer for potential duplicates to be reviewed on a case-by-case basis, you should not select the Prevent Duplicate Records option. As long as the Duplicate Detection & Merge feature is enabled, records identified as duplicates are marked as such and flagged for manual review.

Setting Criteria to Identify Duplicates

To identify duplicates, the Import Assistant uses the same criteria that you specify on the Setup > Company > Duplicate Detection page. For example, you might choose to specify that if two contact records have same phone number, one is probably a duplicate.

Default Behavior of the Prevent Duplicate Records Option

By default, the Prevent Duplicate Records box is not selected, and it is not possible to set a general preference for it. However, you can create a saved import that selects or de-selects this option as appropriate.

Cases In Which Duplicates Are Still Imported

Even when you select the Prevent Duplicate Records option for an import, it is possible for a duplicate record to be imported in the following situations:

- If two users are importing records at the same time, and both users are adding two similar records.
- If multi-threading is being used and two similar records are being processed in different queues at or around the same time.

Custom Multi-Select Value Delimiter

By default, the Import Assistant expects the pipe "|" to be the delimiter for multi-select field values. The Assistant also supports the use of any other single character as a custom multi-select delimiter. To use a custom character as a delimiter instead of the pipe, enter it in this field. The Import Assistant then interprets the custom character, and not the pipe, to indicate a multi-select relationship for this import job. The character you specify here overrides any account-level character set on the CSV Import Preferences page.

CSV Decimal Delimiter

The Import Assistant expects the period to be used as the decimal mark in CSV files. If the CSV data you are importing contains numbers that use the comma as the decimal mark, you can specify that on this page. The decimal mark you choose here overrides any account-level decimal mark preferences set on the CSV Import Preferences page and your subsidiary’s Preferences subtab.
Custom Form

When you import data for a record type, by default, the Field Mapping page includes the NetSuite fields available on your role's preferred form for the record type. Fields can be mapped for the import job if, on this form, they are displayed (not hidden) and not disabled.

Your preferred form may not include all the fields you need to import. For record types that allow custom forms, you have the option of selecting another form in the Import Assistant. You can specify an existing custom form that is available to your role, or you can create a custom form specifically for this purpose. The Custom Form dropdown in the Advanced Options section of the Import Assistant lists available custom forms for the record type to be imported.

If a custom form selected for a saved import is later deleted, an error displays when a user loads the saved import, indicating that the selected form cannot be found. The user can select a different form, or by default, their preferred form for the record type is used to determine mappable fields for the import.

The following table outlines how a selected custom form impacts a CSV import:

<table>
<thead>
<tr>
<th>Action</th>
<th>Transaction Forms</th>
<th>Entry Forms</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add</strong></td>
<td>■ Fields on selected form are mappable.</td>
<td>■ Fields on selected form are mappable.</td>
</tr>
<tr>
<td></td>
<td>■ Values for form's included fields can be added to transactions.</td>
<td>■ Values for form's included fields can be added to records.</td>
</tr>
<tr>
<td></td>
<td>■ Form is saved with added transactions.</td>
<td>■ If a form has the Store Form with Record option enabled, it is saved with added records. If a form has this option disabled, it is not saved with added records.</td>
</tr>
<tr>
<td><strong>Update</strong></td>
<td>■ Fields on selected form are mappable.</td>
<td>■ Fields on selected form are mappable.</td>
</tr>
<tr>
<td></td>
<td>■ For each updated transaction, import does not update fields that are not on the form stored with that transaction. If Ignore Read-Only Fields option is enabled, these fields are ignored, if this option is disabled, an error occurs.</td>
<td>■ Values for form's included fields can be updated on records.</td>
</tr>
<tr>
<td></td>
<td>■ Form is not saved with updated transactions.</td>
<td>■ If a form has the Store Form with Record option enabled, it is saved with updated records. If a form has this option disabled, it is not saved with updated records. If any stored forms are reverted to null, meaning that no forms are stored with updated records.</td>
</tr>
</tbody>
</table>

**Warning:** Popup Only forms are not supported as custom forms for CSV import. If you attempt an import with a Popup Only form as the custom form, the import fails with an invalid custom form reference error in the CSV response file.

For information about working with custom forms, see the help topic Custom Forms.

Server Scripting and Workflow Execution

Your administrator specifies which roles cannot change the setting for server SuiteScripts and workflow triggers on individual CSV imports. If the Run Server SuiteScript and Trigger Workflows box is available, you can change the setting for the current import. Clear the box to disable all server SuiteScripts and workflow triggers during import job processing. Check the Run Server SuiteScript and Trigger Workflows box to allow server SuiteScripts to run and workflows to trigger during the CSV import.

The Run Server SuiteScript and Trigger Workflow box option is set to the company preference by default, but you can change the setting for the current import. If you save the import, your preference for this field is saved.
Warning: Use this setting with caution. Disabling the running of server scripts and workflow triggers can result in data corruption.

Use Multi-Threaded Importing

Important: This option is available only in accounts that have purchased a SuiteCloud Plus license.

By default, a single thread is used to process an import job, and all CSV file rows are submitted in order. The Use Multi-Threaded option for an import enables the use of multiple threads to process the job, to optimize for best performance. By default, this option is disabled.

Check the Use Multi-Threaded box only if the rows in your CSV files do not need to be submitted in order. Note that with multi-threaded, the order in which rows are submitted cannot be predicted.

Your selection for this option is preserved if the import is saved, both when the import is reused in the same account and when it is bundled and reused in a different account.

For more information, see Use Multiple Threads and Multiple Queues to Run CSV Import Jobs.

Queue Number

Important: This option is available only in accounts that have purchased a SuiteCloud Plus license.

By default, every import job is assigned to queue 1. To spread import processing across multiple queues to improve performance, users can select other queues from 2 to 5.

The queue number selected for an import displays in the Queue column on the import Job Status page. For information about this page, see Checking CSV Import Status.

If you would like to change an import's queue number during the time that it is in progress, you need to cancel the job and resubmit it with the new queue number.

- If the job has a status of Pending, you can step through the Import Assistant again to change the queue number and resubmit.
- If the job has a status of Processing, you need to download the CSV results file, which has entries for every canceled CSV file row. You would need to use this results file as the CSV file when you step through the Import Assistant again to change the queue number and resubmit.

Your queue number selection is preserved if the import is saved and rerun is the same account. The queue number is always defaulted back to 1 for a saved CSV import that is bundled, so that users in a target account where the bundle is installed can make their own queue selection.

For more information, see Use Multiple Threads and Multiple Queues to Run CSV Import Jobs.

Use Multiple Threads and Multiple Queues to Run CSV Import Jobs

In accounts that have purchased one or more SuiteCloud Plus licenses, the Import Assistant includes two advanced import options that you can set to improve import performance.
For a summary of SuiteCloud Plus capabilities, see the help topic SuiteCloud Plus Settings.

- You can check the Use Multi-threading box, to use multiple threads instead of a single thread to process an import job. See Using Multiple Threads.
- You can set a queue number from 1 to 5, to spread the processing of import jobs across multiple queues, instead of using a single queue for all jobs. See Using Multiple Queues.

These options are available on the Step 2 Import Options page of the Import Assistant, under Advanced Options. For instructions for completing them, see Set Advanced CSV Import Options.

**Note:** In addition to supporting import job performance enhancement, the SuiteCloud Plus license also supports access to more concurrent web services sessions and to multiple processors for scheduled scripts and map/reduce scripts. To learn more about SuiteCloud Plus, or to purchase this add-on module, contact your NetSuite account manager.

### Using Multiple Threads

By default, a single thread is used for processing CSV import jobs, and each CSV file row is submitted in order. In accounts that have purchased a SuiteCloud Plus license, an option is available to use multiple threads. If this option is enabled for an import job, processing is optimized across multiple threads for best performance, and the order in which CSV file rows are submitted cannot be predicted. Accordingly, you should only enable multi-threading for an import job, if the order in which rows are submitted does not matter, meaning later CSV file row data is not dependent on any earlier row data.

**Note:** If you enable this option for an import job where order does matter, some records may fail to import, because they are dependent on records which have yet to be imported. When this situation occurs, you can rerun the job a second time to import the dependent records.

If you purchase one SuiteCloud Plus license, two threads are available for each import job. In some cases, you may be able to purchase two licenses to support 5 threads per job, or three licenses to support 10 threads per job.

### Using Multiple Queues

By default, all CSV import jobs use a single queue. This queue is defined as queue 1. In accounts that have purchased a SuiteCloud Plus license, five queues are available for import jobs, instead of a single
import job can be specified in a dropdown list in the Import Assistant. This ability allows the division of import job processing across multiple queues, enhancing performance.

**Important:** There are never more than five import job queues regardless of how many SuiteCloud Plus licenses are purchased.

Import jobs in each queue execute serially. For example, if there are two import jobs in queue 1, the first import job must complete before the second import job begins. Across all five queues, the import jobs execute concurrently. For example, if there is one import job in each of the five queues, all import jobs run at the same time.

Should you choose to purchase the SuiteCloud Plus add-on module, be aware that all of your saved import jobs are, by default, initially put into queue 1. You need to go to the Step 2 Import Options page of each import job and assign a different queue as desired. Also note that if you do not assign a queue number to a new import job, the job is automatically assigned to queue 1.

A Queue column displays on the import Job Status page to indicate which queue is processing the job. Users can set the Queue filter to sort import jobs based on queue number.

### Step 3 File Mapping

Complete the following tasks for step 3 of the Import Assistant:

(Note that this step is required only if you have chosen to upload multiple files for import.)

- Select a primary key column for the primary file to indicate how data will be mapped between this file and other linked files.
- Select a key column from the linked files to map to the primary key column.
- Click Next to go to **Step 4 Field Mapping**.

### Step 4 Field Mapping

Step 4 of the Import Assistant displays the automatic mappings of CSV file fields to NetSuite fields. For descriptions of tasks to complete in step 4 of the Import Assistant, see [CSV Field Mapping Tasks](#).
CSV file fields are listed in the left pane.

Field mappings display in the center pane; blank spaces indicate that a field needs to be mapped.
- Required fields are marked with (Req). You must map these fields or provide default values for them.

NetSuite fields are listed in the right pane.
- Fields that have already been mapped appear dimmed.
- Fields available for mapping are in darker text.
- Custom fields are marked with a special icon.
- Key fields are marked with a special icon.

**Note:** Only NetSuite fields that can be edited on the user’s preferred form for the record type are available for import mapping.

To get a better understanding of the NetSuite fields, you can do the following:

- Carefully review the NetSuite user interface form for the selected record type. You can click the field label for help that describes the field.
- See the SOAP Schema Browser for more descriptions of each field. For information about working with this tool, see the help topic SOAP Schema Browser.

By default, mappable NetSuite fields are those available on your preferred form for the selected record type. Fields can be mapped for the import job if they are displayed (not hidden) and not disabled on your preferred form. If these fields do not include all of the data you want to import, you can specify a custom form that includes the fields you need, as an Advanced Option in the CSV Import Assistant. This specification changes the NetSuite fields listed on the Field Mapping page. See Set Advanced CSV Import Options.

For help with completing the tasks in step 4 of the Import Assistant, review the following guidelines.

- **General CSV Field Mapping Tips**
Step 4 Field Mapping

- Required Fields on Records
- Select Reference Types
- Assign Default Values during Field Mapping
- Assign Null Values during Field Mapping

**Note:** If you make mistakes during mapping, you can click the Reset button to return the Field Mapping page to the automatic mappings or to the most recently saved mappings.

When you have completed field mapping tasks, click Next to go to Step 5 Save Mapping & Start Import.

- If the Assistant encounters fields that have not been mapped, an error popup appears and problem mappings are marked with a red X. You can add mappings, then click Next again.
- If the Assistant encounters improperly mapped fields, an error page appears. You then can download a zip of the CSV files with an additional column in each file indicating the errors. After you fix the errors, you can relaunch the Import Assistant and upload the files again.

CSV Field Mapping Tasks

On the Field Mapping page of the Import Assistant, complete the following tasks:

- To add a field to the mappings, highlight a line in the center pane and single-click a field in the right or left pane, or drag and drop a field from the right or left pane to the center pane.
- To provide a default value, null value, or reference type for a field, click its edit icon, and:
  - Choose Provide Default Value, and select or enter a value. For more information, see Assign Default Values during Field Mapping.
  - Choose the Set Value to Null option. This option is available only for fields that can have null values. You can set fields with no values in CSV files to null instead of enabling the Overwrite Missing Fields advanced option on updates. For more information, see Assign Null Values during Field Mapping.
  - Select a reference type. This option is available only for mapped fields that can have one or more list values, such as dropdown lists and multi-selects. For more information, see Select Reference Types.

After you have made a selection, click Done to close the popup.

- To delete a row in the center mappings pane, click the small X button.
- If at any point you want to undo changes to field mappings and return to auto mappings or to the most recently saved mappings, click Reset.
- Available sublists are displayed at the bottom of the NetSuite Fields pane. You can map sublist fields in the same manner that you map other fields. Initially, the Field Mapping page provides one instance node per sublist. You can dynamically add sublist instances by clicking Add New ( ). Up to 99 instances are supported per sublist. (Add New is not available for sublists with associated linked files.) For more information, see Required Fields for Sublist Import Mapping.

CSV Imports
For some transaction imports, transaction item options may be included as a flat list under the Items sublist folder. Item options are custom fields that can be set up in your NetSuite account and may be included in transaction line items to represent item-specific choices. You can map item options to columns in your CSV file, and you can set default or null values for them. For more information, see Importing Transaction Item Options.

General CSV Field Mapping Tips

- If your account is using NetSuite OneWorld, the Subsidiary field is a required field for the following record types: Chart of Accounts, Contacts, Customers, Employees, Jobs (Projects), Leads, Partners, Prospects, and Vendors. For imports of these record types, you must map the Subsidiary field to a field in your CSV file. If the import attempts to add or update records in a OneWorld account without identifying the subsidiary, the import will fail.
- NetSuite fields shown in the right pane of the Field Mapping page are dependent upon the fields available on the user’s preferred form for that record type. If the user’s preferred form does not allow access to certain NetSuite fields, those fields will not display or be available to map. If a custom form is in use for data entry in the NetSuite user interface, you can specify this custom form as an advanced option on the Import Options page, to ensure appropriate fields are available for mapping. By default, the standard form is used. For more information, see Set Advanced CSV Import Options.
- You can map a single CSV source field into multiple fields within the same NetSuite record or sublist.
- Be aware that if you do not map any fields for a sublist, no sublist data is imported, even if you set a default value for one or more sublist fields on the Field Mapping page. For more information about sublist data and the Import Assistant, see Sublist Data Import.
- If you want to create your own CSV import template files with columns that map to NetSuite data automatically, review the SOAP Schema Browser for details about fields for each record type. For information about working with this tool, see the help topic SOAP Schema Browser.
Required Fields on Records

Some NetSuite fields are required, meaning you must specify a value for them or the import cannot proceed. You can map these required fields to CSV column headers, or provide default values for them on the Import Assistant’s Field Mapping page.

NetSuite required fields are shown in the NetSuite Fields column with (Req) after the field name. Usually, NetSuite required fields are shown automatically in the mapping column, to alert you that they must be mapped. However, required fields that do not show, meaning they are rolled up in the tree node in the right column, must be clicked on and mapped. Note that required fields for sublists are handled somewhat differently; for information see Required Fields for Sublist Import Mapping.

Mapping a Required Field

1. On the Field Mapping page of the Import Assistant, click the required NetSuite field on the right if it is not already showing in the mapping column.
2. Click the appropriate field name from your CSV file on the left to add it to the mapping section next to the NetSuite required field.

Providing a Default Value for a Required Field

1. Click the edit icon next to your field.
2. Provide a default value for this field.
   For more information, see Assign Default Values during Field Mapping.

Be aware that even if you set a default value for one or more fields in a sublist, no sublist data is imported unless you map at least one field for that sublist. For more information about working with sublists, see Sublist Data Import.

Note: If Marketing Automation is enabled and you choose the “Add” data handling option on the Import Assistant’s Import Options page, you will be required to map the Unsubscribe field on the Field Mapping page, even if this field is not displayed on your preferred form for the record type. If the Unsubscribe field has not been mapped to a value, an error is thrown and you must go back and rectify the error.

Select Reference Types

A reference type enables you to map a column in an imported CSV file to a NetSuite field that can have one or more list values, such as a dropdown list or a multi-select. You specify reference types on the Import Assistant’s Field Mapping page by clicking the edit icon next to a mapped field that is a dropdown list or multi-select.
Step 4 Field Mapping

Note: Reference types are not available for all fields.

Possible reference types include External ID, Internal ID, and Name.

- **External ID.** If you select External ID as the reference type, the Assistant finds and references an identification string as defined by you (such as “CashSale_” or “Employee_”) in the mapped field.
  - A reference type of External ID is recommended if you select one of the following Import Assistant Data Handling options: Add, Add or Update.
  - The External ID reference type also is recommended for records with parent-child relationships, and records with auto-generated numbers.
  - The External ID reference type is suited for ongoing integration with external databases, where you are repeatedly importing external data into NetSuite, because you can store the foreign key to the external system in NetSuite. This allows for upfront record references during data migration.
  - External IDs can be updated through a CSV import or through SOAP web services. It is recommended that your organization use a single method for maintaining External IDs to avoid conflicting updates through the two separate methods.
  - Some record types, such as custom lists or custom records, do not support the use of External IDs as reference types.

- **Internal ID.** If you select Internal ID as the reference type, the Assistant finds and references numbers (such as “123”) in the mapped field.
  - A reference type of Internal ID is recommended if you select the following Import Assistant Data Handling option: Update.
  - The Internal ID reference type is suited for data that you export to an external application for manipulation and then reimport into NetSuite.
  - To include the Internal ID in your data, add it as a results column in a saved search of the data, and then export the search results to CSV.
  - You can set a preference to display internal IDs in the NetSuite user interface. For instructions, see Displaying Internal IDs.
- **Name.** If you select Name as the reference type, the Assistant finds and references text strings (such as "Joe Public") for the mapped field.
  - Name references can be prone to error.
    - For names that contain spaces, HTML rendering can sometimes distort the number of spaces included, causing mismatches between CSV file values and existing records, that result in import errors. To verify the number of spaces in names, you can create a saved search with a list of names and export it.
    - If you are unsure or unable to verify the name reference for a record, you should use the External ID field instead. For updates, you can use the Internal ID.
  - The requirements for name references are affected by the auto-generated numbering preference that you set in NetSuite. For information, see Effects of Auto-Generated Numbers during Imports.
  - If you use a name reference type, each child record in the CSV file must include a value for the parent name, in order for the import to successfully update records.
  - Name matching is case insensitive.

### Displaying Internal IDs

You can configure NetSuite to make internal IDs available in NetSuite. During development, internal IDs help you verify that the internal ID values submitted for import match those in the existing records.

Go to Home > Set Preferences and in the Defaults section of the General tab, check the **Show Internal IDs** box. Lists then include the Internal ID column, as shown in the following screenshot. This change affects the current user only.

If lists include Internal IDs, you may be able to export data from a NetSuite list page to get Internal IDs into a CSV file, because an Export to CSV button may be available from the list pages.

The assignment of internal IDs to new records is sequential. However, the sequence of internal IDs does not indicate when or in which order records were added. This is true even within specific record groups where internal IDs are unique. Therefore, you should not conclude that records with lower internal IDs were added first, whereas those with higher internal IDs were added last.
For custom applications that rely on the chronological aspect of when data was entered, you should use the Date Modified or Date Created fields, as they are guaranteed to be chronological. Additionally, for transactions with auto-generated numbers, the sequence number (for example, "tranid") is guaranteed to be sequential based on the date transactions were entered. The internal ID of a record should never be used to determine when data was entered, and you should not build any functionality based on the sequence of internal IDs.

**Note:** The user preference setting specifies the display of the internal ID, however, some records have an ID that cannot be hidden. For example, customer J Wolfe has an ID of 87 and an internal ID of 18834. The ID column cannot be removed from the customer list page.

### Assign Default Values during Field Mapping

The Import Assistant automatically populates some dependent field values when related field values are set, in the same manner that many dependent field values are automatically populated in the user interface.

In addition, it is possible to assign default values for required fields on the Import Assistant's Field Mapping page. A default provides a consistent value for a record reference field across all imported records. For example, the simplest thing to do when you import new lead records would be to set a default value for the lead status column to "LEAD-New".

To provide a default value for a field on the Field Mapping page, click the edit icon in its row to open a popup, choose Provide Default Value, and select a value from the dropdown or popup list. (Note that whether the list of available values is a dropdown or popup list depends on the number of values and your setting for Maximum Entries in Dropdowns at Home > Set Preferences.)

Be aware that even if you set a default value for one or more fields in a sublist, no sublist data is imported unless you map at least one field for that sublist. For more information about working with sublists, see [Sublist Data Import](#).

### Using Dependent Field Values as Defaults

When you click the edit icon for a dependent field, meaning a field with available values that vary according to the value selected for another field, the list does not filter values in the same manner that they are filtered in the user interface. These cases are most likely to occur in OneWorld accounts, for fields that are dependent on subsidiary values.

For example, in a OneWorld account, available tax code values for a transaction item vary according to the customer, and to the customer's associated subsidiary. In the user interface, the Tax Code field dropdown list filters the listed tax codes to only those that are valid. In the Import Assistant, the Default Value field lists all tax codes without any filtering.

You need to be careful when you select a default value for a dependent field. Because the Default Value does not filter the values for these fields, it is easy to select an invalid value. For example, you could select a tax code value that is not valid for some of the customers or subsidiaries listed in your CSV file. This type of invalid value can cause validation errors when you attempt to complete the Field Mapping step.

If a dependent field is not required, you have the option of entering values in the user interface after the import is complete.

### Assign a Default Value for the Primary Sales Rep Field

For Customer, Lead, or Prospect records added through CSV import, values for Primary Sales Rep do not default to be the user performing the import, so the Field Mapping page is a good place to specify a
default value for this field. This behavior differs from the NetSuite user interface, where the user entering data on the form is the default for Primary Sales Rep.

Assign Null Values during Field Mapping

It is possible to assign null values to fields on the Import Assistant’s Field Mapping page. This assignment causes the value for any existing fields to be set to an empty value.

- Null values are useful when a field has been assigned a default value that you do not wish to propagate across all of the records that you are importing.
  
  For example, if you are a sales representative and enter a lead record in the UI, the Sales Rep field automatically defaults to be you. The Import Assistant uses the same default values that would be assigned through the NetSuite user interface, so if you are a sales representative and import 10,000 lead records, the Sales Rep field automatically defaults to be you for all imported leads. This behavior may not be preferred for such a large volume of leads.

- Null values also are useful for fields with no values in CSV files. For imports that update NetSuite data, you can set fields with no values in CSV files to null instead of enabling the Overwrite Missing Fields advanced option. For more information, see Overwrite Missing Fields.

To provide a null value for a field on the Field Mapping page, click the edit icon in its row to open a popup, and choose the Set Value to Null option. This option is available only for fields that can have null values.

Step 5 Save Mapping & Start Import

Complete the following tasks for step 5 of the Import Assistant:

- In the Import Map Name field, enter a name that you can use as a reference when tracking the import's progress, or if you want to rerun or edit the import later.
- (Optional) Provide a description of this import.
In the Script ID field, enter a unique ID that can be used to reference this saved import mapping in SuiteScript.

- For example, you can execute the SuiteScript API `nlapiSubmitCSVImport(nlobjCSVImport)` to programmatically run a CSV import job. In this case, you will need to reference the import map by script ID when you create the `nlobjCSVImport` object.
- Only alphanumeric characters plus underline are allowed in this ID.
- The characters you enter are checked for syntax, and then prefixed with CUSTIMPORT and checked for uniqueness. If an import mapping with the same script ID already exists, an error is returned and the mapping is not saved.
- If you do not enter anything, the script ID is left blank. You can edit the import mapping later to add a script ID as needed.

**Note:** If the Multi-Language feature is enabled in your account, a separate page is available to enter translations for the import name and description. If you change the import name or description here, translations need to be edited to match the new values. See Translating Import Map Name and Description.

Choose one of the following options. Click:

- Save to save the settings without starting the Import Job.
- Run to start the import job without saving any of the settings defined on the previous page.
- Save & Run to save this import's settings (including field mappings) of this import for reuse and start the import job.
- Save As to save these settings under another name rather than overwriting the previously saved import job that you have edited.
- Save As & Run to save these settings under another name and start the import job.

After you have clicked a button, the Finished page appears. On this page, you can:

- Click Import Job Status to review the status of this and other imports. (Not available if you saved the import without running it.) For information, see Checking CSV Import Status.
- Click View Saved Imports to review the list of saved imports and/or start an import job based on one of those imports. For information, see Working with Saved CSV Imports.
- Click Share Import to open the Share Import dialog, where you can make the import available to other users. For information, see Sharing Imports.
- Click Start Another Import to launch the Assistant and start another import.

Immediately after you click the option to run an import, the job is put into a queue to be processed. Each company has its own work queue for CSV imports. If no other CSV import jobs are in the queue, an import job submitted by the Import Assistant is processed immediately. If other jobs are ahead of a newly initiated import, the new import job remains in a status of pending during the time that these other jobs are processed. You can cancel a job during the time that it is pending or being processed. For more information, see Canceling a CSV Import.

**Note:** To speed import processing time, it is recommended that you break large jobs into smaller chunks, to improve performance. There is a limit of 25,000 records per imported file.

Checking CSV Import Status

You can check the status of an import job on the Job Status page. For details, see Viewing the CSV Import Job Status Page.
After an import job has been processed, an email notification is sent to the email address used to log in when the import was initiated. This email provides the status of the import, the number of CSV file records imported successfully, and the number of records not imported. For details, see CSV Import Email Notifications.

Viewing the CSV Import Job Status Page

To view the Job Status page, go to Setup > Import/Export > View CSV Import Status.

For each import, the Job Status page includes the following details:

- Date the import was initiated.
- Job name for the import: defaults to <import type> - <CSV file name> - <email address of logged in user>. (Scripted imports can optionally set another name.)
- Current status of the import: Pending, Processing, Completed, or Canceled.
  There is also a less common Retry status. This status occurs when CSV import processing is stopped due to an infrastructure issue. Typically when the issue is resolved, the import should automatically start again from the point of stoppage.
- Percentage of the import that is complete.
- A message indicating the number of records imported of the total number of records in the CSV files (For example, “200 records of 205 imported”).
- (In accounts that support the use of multiple queues for imports:) A queue number indicating the queue (1-5) to which the job has been assigned. (Default is 1; this default can be changed on the Step 2 Import Options page of the Import Assistant. See Queue Number.)
- For pending and processing jobs, a Cancel link. (For administrators, this link is available for all pending and processing imports. For other users, this link is available only for their own pending and processing imports.)
- For completed and canceled jobs, a link to a results.csv file that includes any records not processed due to errors or cancellation.
  - The results.csv file provides an opportunity to correct errors and rerun the import for the outstanding records. See Post Processing Errors.
  - Note that users with access to the Job Status page can view the status of all import jobs in the company queue, but most users can only access results.csv files for their own import jobs. Only account administrators can access results.csv files for other users' jobs.
  - The CSV response also indicates if an afterSubmit script fails after a CSV import is finished. If an afterSubmit script runs after a CSV import and the script fails, the records are still created or updated in NetSuite. In this case, you only need to retry the user event script, but should not run the CSV import again. For more information, see AfterSubmit Script failed, record created with internalId xxx.

CSV import job statuses are stored for 30 days and for up to a maximum of 1,000,000 jobs. Import jobs that occurred more than 30 days ago, or which exceed this number of jobs, are eventually purged. Note that this purging can be delayed for technical reasons, so it is possible to see jobs older than 30 days on the status page.

It is not possible to manually delete jobs listed on the status page.

CSV Import Email Notifications

For every CSV import job that is processed, an email is sent to the email address used to log in to NetSuite when the import was initiated. Each email has text like the following:
Step 5 Save Mapping & Start Import

Greetings from NetSuite!

Thank you for using the CSV Import Assistant. The status of your import is Completed.

**Type of records imported:** Chart of Accounts
**Job Name:** Chart of Accounts - Account - Reuired Fields.csv - jwolfe@netsuite.com
**File Name:** Account - modifiedFile.csv
**Import Map Name:** journal entry
**Date and time of import:** 3.10.2014
**Number of records imported:** 98
**Number of records not imported:** 2

If any records were not imported:
1) Visit the Import status page at https://system.netsuite.com/app/setup/upload/csv/csvstatus.nl
2) On the Import status page, download the zip file of the record(s) that failed to import.
3) Review the error message(s) provided for each failed record and resolve the error(s).
4) Return to the CSV Import Assistant and re-import the record(s).

Sincerely,
The NetSuite Staff

***PLEASE DO NOT RESPOND TO THIS MESSAGE***

The number of records not imported includes any records with errors for which import failed. If the import job was canceled during processing, this number also includes any records that had not yet been processed at the time of cancellation.

**Note:** It is not possible to turn off email notifications.

**Note:** Email notification is not sent for single journal entry imports.

Canceling a CSV Import

On the CSV import job status page, you can cancel a CSV import job before it is completed. For example, you may need to cancel an import job that you have discovered includes incorrect data. Or, you may want to cancel a large CSV import job to allow smaller jobs to be processed first, and then restart the larger job later.

**To cancel a CSV import:**

1. Go to Setup > Import/Export > View CSV Import Status.
2. Click the Cancel link in the far right column of the page.
   - The Cancel link is available for an import job during the time that its status is Pending or Processing.
   - Administrators see the Cancel link for all pending and processing import jobs, whereas other users see this link only for their own jobs.
3. The Status column displays “Canceling” until cancellation is complete.
4. The next import job in the queue, if any, begins immediately after cancellation is complete.

Other results of import job cancellation vary depending on the job's status when you click the Cancel link.

- If a job's status is Pending when you cancel it, the job is removed from the Job Status page after cancellation is complete.
- If a job's status is Processing when you cancel it, the following occurs after cancellation is complete:
  - The Status column of the Job Status page displays “Canceled”.
  - The Message column lists the number of records imported before cancellation.
  - The CSV Response column displays a link to a results.csv file containing any rows that were processed before cancellation but had errors, and any rows not processed before cancellation.
An email status notification is sent to the email address used to log in when the import was initiated.
  ▪ This email indicates the number of CSV file records imported, and the number not imported.
  ▪ The number of records not imported includes both records with errors and records that were not processed due to the cancellation.
  ▪ For more details, see CSV Import Email Notifications.

Note: Because the next import job in the queue begins immediately after an import job’s cancellation is complete, if you need to cancel multiple import jobs, you should cancel them in reverse order, beginning with a job that is not yet processing.

CSV Import Error Reporting

The CSV Import Assistant provides robust error handling throughout all stages of the import process. Some basic validation is performed on the fields before the import is performed. For example, if a number is expected and a string is encountered, an error appears.

Invalid Character Errors

If a file cannot be processed due to invalid characters, you receive an error message. The error message describes the type of error and provides the row number, column name, and value that caused the error.

Incorrect Character Encoding

In many cases, an invalid character error occurs because the incorrect character encoding has been chosen. You may elect to:
  ▪ Return to the Scan & Upload CSV File step, change the character encoding option, and click next to scan the files again, or
  ▪ Close the Import Assistant, correct the source files, and then upload again.

For information about supported character encodings, see Choose Import Character Encoding.

Numbers Converted to Exponents

If you use Microsoft Excel to create your CSV file, you might notice that narrow columns containing long numbers appear with exponential notation. Excel uses exponential notation if the value is too long for the width of the column, which could result in the import taking longer than it should. To avoid a long import, open the CSV file in a text editor such as Notepad to ensure that the correct numbers are submitted in the import.

Invalid Country Codes

The Import Assistant does not support the use of country codes in imported CSV files. The following error is returned if a file includes country codes rather than localized country names: “Invalid country reference key US”.

To avoid this error, change country codes to country names. For more information, see Country Names for CSV Import.

Invalid Subsidiary Errors

For an import of entities such as customers, partners, or vendors, you may receive errors stating that subsidiaries are not valid for their associated entities, if the subsidiary names are not formatted as
expected. Errors are like the following: “Transaction subsidiary <subsidiary_name> is not valid for entity <customer_name>. Please choose a different entity.”

To avoid these errors, your CSV file needs to include the full hierarchical names for subsidiaries, with colons used as separators. The format is `<grandparent_name> : <parent_name> : <subsidiary_name>`. An example is Consolidated Parent Company : UK Subsidiary : German Subsidiary.

Invalid Department Reference Key

You may receive errors like the following: “Invalid department reference key for xxx”. If you receive this error, verify the following:

- Ensure that the department is spelled correctly. If a parent-child relationship exists, make sure that the names of the parent departments are included. For example, if Accounting is a child of Finance, the department must be entered as Finance : Accounting.
- Ensure that the department is active. Go to Setup > Company > Classifications > Departments. Check the Show Inactives box and make sure that the department specified in the error message is not inactive.
- If internal IDs are used, on the Field Mapping page, click the edit icon beside the Department field. Then, click Choose Reference Type and select Internal Id.
- If external IDs are used, on the Field Mapping Page of the CSV import, click the edit icon beside the Department field. Then, click Choose Reference Type and select External Id.

Exceeded Script Usage Limit Errors

You may receive errors stating that you exceeded the script execution usage limits. The SuiteScript governance model tracks usage points on the API level and script type level. When certain APIs are called in a script, their assigned usage points are added and the total is compared to the script's usage limit. If the total usage points consumed by all APIs in a script exceeds the usage limit for that script's type, the error is thrown. For more information, see the help topics Script Usage Unit Limits and SuiteAnswers article 45313.

Post Processing Errors

Post processing errors occur after the data has been imported into the NetSuite database. Application errors, such as an invalid value in an enumerated field, or a reference that does not match the record type, are examples of post processing errors.

Another example of a post processing error is a problem with an afterSubmit script. When an afterSubmit script runs after a CSV import, and the script fails, the records are still created or updated in NetSuite. The CSV response indicates that the record has been created or updated even if an afterSubmit script that runs after the CSV import fails. For more information, see AfterSubmit Script failed, record created with internalId xxx.

If your import incurs post processing errors, the import email notification, that goes to the email address used to log in to the session that initiated the import job, contains a zip file that lists the errors, including the column name and number of rows affected. You can go back and fix these errors, start the Import Assistant, and upload your corrected file. For more details, see CSV Import Email Notifications.

For additional information about CSV import errors, see CSV Import Error Messages.

Deleting Incorrect CSV Data

If multiple records with data loaded through the CSV import are incorrect, you must delete each record one at a time. No mass delete option is provided at this time.
However, you can speed up the process of deleting the field data, instead of having to edit the data inline one field at a time.

**To delete field data by editing inline:**

1. Enable the **Edit** button on the search results of the data containing the fields you want to delete.
2. Select an editable element, in the first row, then hold down the Shift key and select the same element in the last row.
3. With all of those fields in the column highlighted, choose delete from the menu on the left.
   
   You can also set your segment size higher in Home > Set Preferences, to do more than 50 at a time.

For more information, see the help topic **Using Inline Editing**.

### Working with Saved CSV Imports

The Import Assistant can save import settings so that you can reuse them for later jobs. You can review mappings for your previously completed import jobs on the Saved CSV Imports page. If you are an administrator, you can review mappings for all previously completed import jobs in your account.

**To work with a previously saved CSV import:**

1. Go to Setup > Import/Export > Saved CSV Imports.
2. The Saved CSV Imports page lists all of the saved import mappings to which you have access. These include mappings you have saved as well as those saved by others that include you in the audience.
3. This page includes the following columns:
   - **ID** – unique internal ID for saved mapping
   - **Name** – name given to the field mapping in the Import Assistant
   - **Translate** – link to CSV Import Map Translation dialog (only in accounts where the Multi-Language feature is enabled)
   - **Field Map** – link to popup view of field mappings
   - **Description** – description entered in the Import Assistant
   - **Type** – record type of field mappings
   - **Owner** – user who created the field mapping in the Import Assistant, or another user selected in the Share Import dialog
   - **Created** – date when mapping was first saved
   - **Script ID** – unique ID defined on the Save Mapping & Start Import page, used to reference the import map in SuiteScript
   
   **Note:** By default, import jobs created before Version 2012 Release 2, when this field was added, do not have script ID values. Import jobs created as of that release or later default to a script ID of CUSTIMPORT. If a script ID is set, it is prefixed with CUSTIMPORT.
   - **Last Modified** – date when mapping was last changed
   - **Access** – indicator of whether mapping is private, shared, or public, and link to Share Import dialog
   - **Delete** – button to delete mapping, available only if you are the owner
4. On the Saved CSV Imports page, you can do the following:
Select from the Record Type list to display mappings for a single record type.

Open the saved import in the Import Assistant to edit its settings or rerun it, by clicking the link in the Name column. See Editing a Saved Import.

In accounts where the Multi-Language feature is enabled, enter translations for a saved import's name and description. See Translating Import Map Name and Description.

Review the import’s mappings by clicking the View link in the Field Map column. A popup opens displaying the mapped source and target fields, helping you to identify the correct import without having to go through the pages of the Import Assistant.

Make an import mapping available to other users, or define a different owner for it, by clicking the link in the Access column. For more information, see Sharing Imports.

Delete a saved import mapping, by clicking the button in the Delete column. This button is available only for mappings that you own. Only an administrator can delete saved CSV imports owned by other users.

Click the New button to start the Import Assistant and create another import job.

The popup available from the View link in the Field Map column looks like the following:

Note: You can use SuiteBundler to include CSV import maps in customization bundles. See Including Import Maps and CSV Files in SuiteBundler.

Note: The SuiteCloud Development Framework (SDF) supports saved CSV imports. You can create, modify, import, and export saved CSV imports, and move your saved CSV imports between accounts. For more information, see the help topic savedcsvimport.

**Editing a Saved Import**

A saved import map that is close to what you need for your import job may be available. You can edit this saved import to run your import job instead of creating a new import map.

**To edit a saved import for reuse:**

1. Go to Setup > Import/Export > Saved CSV Imports.
2. On the Saved CSV Imports page, find the import map that you want to edit, and click its link in the Name column. This action starts the Import Assistant.
3. In the Import Assistant, make changes to the import as necessary, as described in Step 1 Scan & Upload File, Step 2 Import Options, Step 3 File Mapping, and Step 4 Field Mapping.

   **Note:** You cannot remove a previously mapped required field from a saved import.

4. On the Save Mapping & Start Import page, review the Import Map Name.
   - If you want your changes to overwrite the existing saved import map, and to maintain the same name, do not change the name here.
   - If you want to give the import map a different name, edit the name here.
   - If you want to edit the description, edit it here.

   **Note:** If the Multi-Language feature is enabled in your account, a separate page is available to enter translations for the import name and description. If you change the import name or description, translations need to be edited to match the new values. See Translating Import Map Name and Description.

5. Review the options available under the Save button in the lower right corner of the Import Assistant:
   - If you want your changes to overwrite the existing saved import map, click **Save**, or click **Save & Run**.
   - If you want to create an additional import map, click **Save As**, or click **Save As & Run**. Be sure to change the name of the import from what it was previously.

6. You can use SuiteCloud Development Framework (SDF) to manage saved CSV import maps as part of file-based customization projects. For information about SDF, see the help topic **SuiteCloud Development Framework Overview**.

   You can use the Copy to Account feature to copy an individual saved CSV import map to another of your accounts. When you open a saved CSV import map in the Import Assistant, a clickable **Copy to Account** option is available in the upper right corner. For information about Copy to Account, see the help topic **Copy to Account Overview**.

### Sharing Imports

You can share your saved import maps with other users. After you make an import available to other users, they can see the import on their Saved CSV Imports list, and can use it to run an import job. This feature prevents duplication of effort, and ensures consistency of imported data.

- In the Share Import dialog, you can:
  - Check the Public box to make the import map available to all users.
  - Check the Allow Audience to Edit box to allow users with whom you share the import map to make changes and save it with the same name. If you do not enable this option, users can make changes but can only select Save as to save the import map with a different name.
  - Change the owner by selecting another user from the dropdown list.
  - If you do not want to share the import map with all users, create a more limited audience by making selections from the fields provided.
    - Only roles and departments that include users with the Import CSV file permission are listed in this dialog.
    - Note that if you choose both role and department options, a user must belong to one of the selected roles and one of the selected departments to access the import map. For all other cases, a user need only belong to one or the other.
Opening the Share Import Dialog from the Import Assistant

1. After you have saved an import job, on the Finished page, click the Share Import link.

Opening the Share Import Dialog from the Saved CSV Imports Page

1. Go to Setup > Import/Export > Saved CSV Imports to see all imports to which you have access.
2. Review an import's setting in the Access column to see if it has been shared. Three settings are possible:
   - Private: Only the import owner (by default, the creator) can access the import map.
   - Public: All users with the Import CSV File permission can access the import map.
   - Shared: Selected users can access the import map.
3. Click a link in the Access column to open the Share Import dialog.

Note: If you are an administrator, you can see all users' saved import maps on the Saved CSV Imports page, and you can set them to be shared with other users.

Translating Import Map Name and Description

If the Multi-Language feature is enabled in an account, saved import owners and account administrators can define translations for saved CSV imports' names and descriptions so they match the language of the NetSuite user interface.

When the NetSuite user interface is set to a different language, translated import names and descriptions display in the Saved CSV Imports list page.
Before you can translate import map names and descriptions, translation languages need to be selected at Setup > Company > General Preferences, on the Languages subtab. For details, see the help topic Configuring Multiple Languages.

**Note:** The Languages subtab at Setup > Company > General Preferences lists both system-supported languages that can be used for the NetSuite user interface (and are available at Home > Set Preferences), and additional languages that can be used for website translations only (and are not available at Home > Set Preferences). You should only enter translations for role names in system-supported languages, because these are the only languages that can be displayed in the user interface.

When languages have been set, you can enter translations in the CSV Import Map Translation dialog, available from the Saved CSV Imports list page.

**To define translations for a saved CSV import map:**

1. Go to Setup > Import/Export > Saved CSV Imports.
2. On the Saved CSV Imports page, click the **Translate** link for the import.

   **Important:** This link is only available if you are the owner of a saved import or an account administrator.

3. In the **CSV Import Map Translation** dialog, enter translations for the name and click **Done**, enter translations for the description and click **Done**, and click **Save**.

   - You can return to this page as needed to edit translations later.
   - You also can edit the original Name and Description values on this page. (Be sure to edit related translations after you edit an original value.)

**Including Import Maps and CSV Files in SuiteBundler**

Saved import mappings are available on the Saved CSV Imports page, according to the access and audience defined for them, as described in Sharing Imports. All of the mappings listed on your Saved CSV Imports...
Imports page also are available to you in SuiteBundler, a NetSuite tool for packaging customization and configuration objects for sharing among accounts, if you have access to SuiteBundler.

You can add saved import mappings to a customization bundle by selecting the Saved CSV Imports object type in the Bundle Builder.

You also can include CSV files in SuiteBundles. These CSV files may be used as import template files or to store actual data to be imported. If you want to include a CSV file in a SuiteBundle, upload the file to the File Cabinet, and after it has been uploaded, edit the file record to check the Available for SuiteBundles box, as shown in the following screenshot. The file is then listed under the Files object type in the Bundle Builder, as shown in the above screenshot.

**Note:** When including CSV files in a bundle, do not specify default field values, because the target account field values use internal IDs that are different between accounts. SuiteBunder does not remap those values to ones on the target account. After the bundle has been installed in the target account, the default values can be manually mapped using the Import Assistant.

For more information about using the File Cabinet, see the help topic Working with the File Cabinet. For information about building SuiteBundles, see the help topic Creating a Bundle with the Bundle Builder.
Setting CSV Import Preferences

**Note:** These preferences do not apply to simple imports.

If you are an account administrator, or you have the Set Up CSV Preferences permission, you can set the following CSV preferences. These settings appear on the Import Assistant's Import Options page, and the settings that you enter are the defaults seen by all users.

Any changes that users make in the Import Assistant override the default preferences entered on the CSV Import Preferences page.

**To set CSV import preferences:**

1. Go to Setup > Import/Export > CSV Import Preferences.
2. On the CSV Import Preferences page, enable or disable options, and click **Save**.

See the sections below for information about available preferences:

- Custom Multi-Select Value Delimiter
- Log System Notes For Custom Fields
- Run Server SuiteScript and Trigger Workflows
- CSV Column Delimiter
- CSV Decimal Delimiter

**Custom Multi-Select Value Delimiter**

By default, the Import Assistant expects the pipe "|" to be the delimiter for multi-select field values. The Assistant also supports the use of any single character as a custom multi-select delimiter.

To specify that a custom character be used as a delimiter, instead of the pipe, for all import jobs in your account, enter the character in this field. The Import Assistant then interprets the custom character, and not the pipe, to indicate a multi-select relationship. Users can enter an alternate character in the Advanced Options area of the Import Options page, that overrides the account-level character for a specific import job.

**Log System Notes For Custom Fields**

Enable this option to create system notes during the import of data from custom fields. This option is disabled by default. Disabling system notes for custom fields improves performance and is recommended for imports that add data.

**Important:** System-generated notes are used in NetSuite to track changes to a record, including what action was taken, when the record was modified, and the user that was responsible for the change. These notes are important for maintaining a complete audit trail. If you turn off system-generated notes for custom fields, specific changes related to custom fields within the imported record are **not** recorded in NetSuite, although all changes for standard fields are logged as usual. If a custom field contains sensitive information that is critical for audit purposes, you should **not** disable system-generated notes.

**Run Server SuiteScript and Trigger Workflows**

Enable this option to run any server-side SuiteScript during the CSV import process. Note that running server SuiteScript will slow the save process.
This option must be enabled for a CSV import to trigger a workflow that is based on record creation or update. If this option is not enabled, workflows do not run when a CSV import creates or updates records.

You typically should enable this option when you are synching “live” data or running a partner application (for example, Outlook synchronization).

NetSuite recommends that you disable this option when you are doing a historical import.

**CSV Column Delimiter**

By default, the Import Assistant expects comma-separated values. However, you can also import CSV data that uses a different type of separator. Other valid options are the colon (:), semicolon (;), pipe (|), space ( ), and tab.

**CSV Decimal Delimiter**

By default, the Import Assistant expects the period to be used as the decimal mark in numbers. If you use the comma as the decimal mark in the CSV files you import, you can set it to be the default decimal delimiter for CSV data.
Guidelines for CSV Import Files

**Note:** NetSuite recommends that you scrub your data before importing it into NetSuite.

Before you attempt to import data with the Import Assistant, you need to set up CSV files and review their formatting carefully, to avoid errors that prevent import and to ensure that data is imported with correct values.

To help with the setup of your CSV files:

- Review guidelines particular to each record type, available from links in Supported Record Types for CSV Import.
- Review general tips that apply to imports of all record types, in Tips for Successful CSV Imports.

You can create a CSV import template file using the list view for the record type, even if the list is empty. Select the view that displays the most appropriate columns, set the view to show only the columns needed for your import, and then click the Export — Microsoft Excel icon at the top of the list. Open the exported file and save the values to be imported. The following example shows a customized view of the Items list page. Click Export — Microsoft Excel, and then use the exported file to create the CSV import file.

If you want to create your own CSV import template files with columns that automatically map to NetSuite data, review the SOAP Schema Browser for details about fields for each record type. For information about working with this tool, see the help topic SOAP Schema Browser.

**Supported Record Types for CSV Import**

The Import Assistant includes an Import Type list where you can select the category of data you want to import. After you select an import type, you select the record type of data to import. The Import Assistant supports the following record types. Click a link below to review guidelines for a record type, so that you can prepare your CSV data for import.

**Note:** The data that you can import depends on your assigned role and permissions, and on your account’s enabled features. To use the Import Assistant for most record types, you must have the Import CSV File permission. For questions about roles or permissions, contact your administrator.

- Accounting Import Type
Supported Record Types for CSV Import

- Budget Exchange Rates Import
- Chart of Accounts Import
- Consolidated Exchange Rates Import
- Currency Exchange Rates Import
- Expense Categories Import
- Fair Value Price CSV Import
- Global Account Mapping Import
- Item Account Mapping Import

Activities Import Type
- Events Import
- Phone Calls Import
- Resource Allocations Import
- Tasks Import

Classification Import Type
- Class Import
- Custom Segment Value Import
- Department Import
- Location Import
- Merchandise Hierarchy Node Import

Communications Import Type
- Messages Import
- Notes Import

Custom Records Import

Customization Import Type
- Custom List Import

Employees Import Type
- Employees Import
- Expense Report Import
- Job Import
- Time-Off Change CSV Import
- Track Time Import

Items Import

Payment Instruments Import Type

Relationships Import Type
- Billing Account Import
- Contacts Only Import
- Customer-Subsidiary Relationship Import
- Customers Only Import
- Customers and Contacts Together Import (See Importing Entities and Contacts Together)

Projects (Jobs) Import
Supported Record Types for CSV Import

- Leads Only Import
- Leads and Contacts Together Import (See Importing Entities and Contacts Together)
- Partners Import
- Prospects Only Import
- Prospects and Contacts Together Import (See Importing Entities and Contacts Together)
- Vendor-Subsidiary Relationship Import
- Vendors Import

- Rules Setup Import Type
  - Foreign Currency Variance Posting Rule Import

- Subscription Billing Import Type
  - Price Book Import
  - Price Plan Import
  - Subscription Import
  - Subscription Change Order Import
  - Subscription Line Import
  - Subscription Plan Import
  - Usage Import

- Supply Chain Import Type
  - Bill of Materials Import
  - Bill of Materials Revision Import
  - Bin Import
  - Item Location Configuration Import
  - Item Revision Import
  - Manufacturing Cost Template Import
  - Manufacturing Routing Import

- Support Import Type
  - Issues Import
  - Solutions Import
  - Support Cases Import
  - Topics Import

- Transactions Import Type
  - Advanced Intercompany Journal Entry Import
  - Cash Sale Import
  - Check Import
  - Credit Card Charge Import
  - Credit Card Refund Import
  - Credit Memo Import
  - Custom Transactions Import
  - Customer Payment Import
  - Estimate Import
Supported Record Types for CSV Import

- Fixed Assets Import (see the help topic Updating Asset Records Using CSV Import)
- Inventory Adjustment Import
- Inventory Cost Revaluation Import
- Inventory Transfer Import
- Invoice Import
- Item Demand Plan Import
- Item Supply Plan Import
- Journal Entry Import and Intercompany Journal Entry Import (Use this record type to import multiple journal entries at a time. To import a single journal entry, see Single Journal Entry Import.)
- Opportunity Import
- Paycheck Import
- Period End Journal Entry Import
- Purchase Order Import
- Return Authorization Import
- Sales Order Import
- Statistical Journal Entry Import
- Transfer Order Import
- Vendor Bill Import
- Vendor Credit Import
- Vendor Payment Import
- Vendor Return Authorization Import

Website Import Type
- Site Category Import
- CMS Page Import
- Commerce Category Import

Specialized two-step Import Assistants are available for the following import tasks:
- Single Journal Entry Import
- Budget Import
- Single Inventory Worksheet Import
- Project Tasks Import
- Web Site Redirects Import

Accounting Import Type

For information about accounting imports, see the following:
- Budget Exchange Rates Import
- Chart of Accounts Import
- Consolidated Exchange Rates Import
- Currency Exchange Rates Import
- Expense Categories Import
Budget Exchange Rates Import

You can import budget exchange rates using CSV import if your organization.

The Budget Exchange Rates table is available at Lists > Accounting > Budget Exchange Rates. In this table you can maintain exchange rates between the child and parent subsidiaries for use in the budgeting process.

**Note:** To access this table, the Multiple Currencies and Multiple Budgets features must be enabled.

The Budget Exchange Rates table is very similar to the Consolidated Exchange Rates table. In NetSuite OneWorld, NetSuite uses the Consolidated Exchange Rates table to initially populate the Budget Exchange Rates table. Then, you can update and maintain the Budget Exchange Rates table as necessary.

This table shows the exchange rates for each subsidiary's base currency in relation to the currencies used by its parent subsidiaries, for each period. Table columns include: accounting period, accounting book, whether the period is closed, the From (child) subsidiary, the To (parent) subsidiary, and exchange rates.

Rates in this table are either direct or indirect (derived). Direct rates are rates set between a child and parent subsidiary. Direct rates are set by a user and may be edited. Indirect rates are rates set between a grandchild and grandparent subsidiary. Indirect rates are always calculated by the system and cannot be edited. Budget exchange rates include three different rate types per period, subsidiary, and accounting book: Average, Current, and Historical.

To import updated budget exchange rate data, in the Import Assistant, set the Import Type to Accounting and the Record Type to Budget Exchange Rate. Only the Update data handling option can be selected for the import.

The fields that you can map and update are:

- Average Exchange Rate
- Current Exchange Rate
- Historical Exchange Rate

The import also requires an external ID or internal ID. For information about using external and internal IDs, see Select Reference Types. The import updates successfully if the period is not closed, is not derived, and does not include an elimination subsidiary.

For more details about how budget exchange rates are handled in NetSuite, you can review the Lists > Accounting > Budget Exchange Rates page, and see the help topic Budget Exchange Rates.

For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Chart of Accounts Import

The Chart of Accounts import adds ledger accounts to the Account list record. Because the Chart of Accounts is the basis for all company data, you should complete this import first when you are setting up a new NetSuite account.
Please note the following before importing or updating account records with the Import Assistant:

- This import is not available in the NetCRM product.
- You cannot create a new account or update an existing account with an account number that already exists. You receive an error that the account number is already used.
- To update account numbers on the import, the Use Account Numbers option must be enabled in Setup > Accounting > Accounting Preferences > General.
- If your account is using NetSuite OneWorld, the Subsidiaries field is a required field for Chart of Accounts imports. You must map the NetSuite Subsidiaries field to a field in your CSV file, or the import will fail.
- For information about setting up parent/child relationships for imported account records, see Referencing Child Accounts by Name and Number.

For details about fields that can be mapped in the Account record, see the SOAP Schema Browser’s account reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Account Localization Sublist**

In OneWorld accounts that have multiple languages enabled, Account Localization sublist information can be included in the chart of accounts import. The Account Localization sublist does not have a key. The records in the sublist can be language, name, accounting context, and number.

**Chart of Accounts Import Example**

The following tables illustrate sample data in a Chart of Accounts import.

<table>
<thead>
<tr>
<th>External Id</th>
<th>Account Number</th>
<th>Account Name</th>
<th>Account Type</th>
<th>Description</th>
<th>Date</th>
<th>Currency</th>
<th>Restrict to Class</th>
<th>Subaccount of</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA-ACCT-01</td>
<td>515652</td>
<td>Direct Labor</td>
<td>Expense</td>
<td>Expense account for labor</td>
<td>01/01/2016</td>
<td>YEN</td>
<td>Recurring Business</td>
<td>Project Cost</td>
</tr>
<tr>
<td>CA-ACCT-02</td>
<td>987546</td>
<td>Sales Tax Payable</td>
<td>Other Current Liability</td>
<td>Sales tax liability</td>
<td>01/16/2016</td>
<td>USD</td>
<td>Recurring Business</td>
<td>Tax Liability</td>
</tr>
</tbody>
</table>

**Referencing Child Accounts by Name and Number**

For reference types in the CSV file, data values must be written exactly as they appear in the list in the NetSuite record form.

For example, if the Income Account dropdown list has an option entitled 40500 Sales, you must specify the full name “40500 Sales” in the CSV file in order for the reference type to be imported correctly after it is mapped on the Import Assistant’s Field Mapping page.

- You cannot provide only the value “40500”.
- You cannot provide only the value “Sales”.
- The account number and name must be separated by a single space, not a colon or other separator.

For more information about reference types, see Select Reference Types.
Consolidated Exchange Rates Import

You can import consolidated exchange rate updates using CSV import if your organization:

- Uses NetSuite OneWorld.
- Has multiple subsidiaries with different base currencies.
- Maintains a table of consolidated exchange rates. The Consolidated Exchange Rates table is available at Lists > Accounting > Consolidated Exchange Rates. For more information, see the help topic Consolidated Exchange Rates.

To import updated consolidated exchange rate data, in the Import Assistant, set the Import Type to Accounting and the Record Type to Consolidated Exchange Rate. Only the Update data handling option can be selected for the import.

The fields that you can map and update are:

- Average exchange rate
- Current exchange rate
- Historical exchange rate

The import also requires an external ID or internal ID. For information about using external and internal IDs, see Select Reference Types. The import updates successfully if the period is not closed, is not derived, and does not include an elimination subsidiary.

For more details about how consolidated exchange rates are handled in NetSuite, you can review the Lists > Accounting > Consolidated Exchange Rates page, and see the help topic Consolidated Exchange Rates.

Currency Exchange Rates Import

When the Multiple Currencies feature is enabled, you can use the Import Assistant to import currency exchange rates into NetSuite. Exchange rates are stored as a list in NetSuite, with each line in the list representing an exchange rate between a base currency and a foreign currency. For more information, see the help topic Currency Management.

NetSuite OneWorld accounts may have multiple base currencies, with different base currencies set for different subsidiaries. Accounts that are not OneWorld have a single base currency only. Note that exchange rates defined for a base currency in a OneWorld account apply to all subsidiaries using that base currency.

The Currency Exchange Rates import requires the following values for each rate to be imported:

- Currency - the foreign currency to which the rate is applied
- Exchange Rate - the number of base currency units that equal one foreign currency unit
- Effective Date - the first date that the rate should be used
- Base Currency (OneWorld only) - the base currency to which the rate is applied

For accounts that are not OneWorld, you do not have to define a base currency per rate, because the base currency is always the same.

Update data handling is not supported for this import, to be consistent with currency exchange rates functionality in the user interface. To update a rate between two currencies, add a record with the same base currency and foreign currency, the new exchange rate, and a new effective date. For example:

- If NetSuite has the following exchange rate stored:

<table>
<thead>
<tr>
<th>Base Currency</th>
<th>Foreign Currency</th>
<th>Exchange Rate</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Dollar</td>
<td>Euro</td>
<td>1.2287</td>
<td>7/1/2012</td>
</tr>
</tbody>
</table>

- To change the rate, you include a line like the following in your CSV import file, with a new exchange rate and a new effective date. When the import is completed, this new rate will be used from the new date going forward.

<table>
<thead>
<tr>
<th>Base Currency</th>
<th>Foreign Currency</th>
<th>Exchange Rate</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Dollar</td>
<td>Euro</td>
<td>1.2298</td>
<td>8/1/2012</td>
</tr>
</tbody>
</table>

For more details about how currency exchange rates are handled in NetSuite, you can review the Lists > Accounting > Currency Exchange Rates page, and see the help topic Currency Exchange Rates.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Expense Categories Import**

An expense category record represents a type of expense that can be referenced on an employee's expense report. For example, you might have expense categories named “Meals,” “Transportation,” and “Lodging.” Every expense listed on an expense report must belong to an expense category. You can create and update expense category records using the CSV Import Assistant.

The expense category record is available only when the Expense Reports feature is enabled, at Setup > Company > Enable Features, on the Employees subtab. When the feature is enabled, “Expense Categories” appears as an option in the Record Type dropdown list when you set Import Type to Accounting.

In the UI, you access the expense category record by choosing Setup > Accounting > Expense Categories > New. For details on the process of manually creating an expense category, see the help topic Creating an Expense Category.

**Understanding the Rate is Required Field**

Before you begin working with expense categories, you need to understand the Rate is Required field. The purpose of this field is to determine the behavior of expenses that use this category. That is, when Rate is Required is set to Yes, an expense report line item using this category must have values in the Rate and Quantity fields. These values are then used to determine the amount of the expense. Note that you can also set default rates for your expense categories. You set default rates by using either the Default Rate body field (in accounts that are not OneWorld) or the Rates sublist (in OneWorld accounts).
Related to your ability to create defaults, be aware of the following: If your account is not a OneWorld account, the Rate is Required value affects the availability of the Default Rate field. That is, when the value of Rate is Required is Yes for any particular expense category, you can import a value for Default Rate for that category. Otherwise, the field is not available. The Default Rate field determines the default rate for the category throughout your organization.

If your account is a OneWorld account, you use the Rates sublist, which stores a default rate for the category for each subsidiary. Unlike the Default Rate body field, an expense category's Rates sublist is available even when you set the Rate is Required value to No.

The default value of Rate is Required is No.

### Expense Category Fields

This section summarizes the body fields supported for mapping.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Rate</td>
<td>Available only for expense category records on which Rate is Required is set to a value of Yes. Further, available only when the account is not a OneWorld account. (In OneWorld accounts, this field is replaced by the Rates sublist.)</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>The description displays on the Expense Categories list view and on the expense category record. The description is not visible to employees using the standard expense report form.</td>
<td>No</td>
</tr>
<tr>
<td>Expense Account</td>
<td>The account to which all expenses of this category will post. If you use NetSuite OneWorld, the account determines for whom the new expense category is available. Specifically, a category is available only to employees within the subsidiaries associated with this account.</td>
<td>Yes</td>
</tr>
<tr>
<td>ExternalId</td>
<td>Can be used as a unique identifier for the record.</td>
<td>No</td>
</tr>
<tr>
<td>Inactive</td>
<td>Possible values are:</td>
<td>No, but if you do not map a recognizable value for this field, the system uses the default value, which is No.</td>
</tr>
<tr>
<td>Internal ID</td>
<td>A read-only field that is a unique identifier of the record. Internal ID is available for mapping only when the Data Handling option on page 2 of the Import Assistant is set to 'Update.'</td>
<td>No</td>
</tr>
<tr>
<td>Name</td>
<td>A label for the category. If the category is active, the Name text displays as a choice in the Category list on the standard expense report form.</td>
<td>Yes</td>
</tr>
<tr>
<td>Rate is Required</td>
<td>When Rate is Required is set to a value of Yes, an expense report line item using this category must have values in the Rate and Quantity fields. These values are then used to determine the amount of that expense.</td>
<td>Yes, but if you do not map a value, the system uses the default value, which is No.</td>
</tr>
</tbody>
</table>

For details about the Rates sublist fields, and for other details on the expense category record, see the SOAP Schema Browser’s expense category reference page. You can use the field definitions here as a
basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

Expense Category CSV Examples

The following table shows how you might structure a file for importing expense categories.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Name</th>
<th>Expense Account</th>
<th>Description</th>
<th>Inactive</th>
<th>Rate is Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Meals</td>
<td>1000 Meals &amp; Entertainment</td>
<td>Should be available year-round.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>Lodging</td>
<td>2000 Lodging</td>
<td>Should be available year-round.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>Annual Conference</td>
<td>9500 Conferences</td>
<td>Should be made available on Sep. 1.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

In this example, the first two records are automatically active and available to employees following the import (because the Inactive field defaults to No when left blank). If all the items in your CSV file are meant to be active, you could simply omit this column.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Fair Value Price CSV Import

The fair value price import is available only when the Advanced Revenue Recognition feature is enabled at Setup > Company > Enable Features, the Accounting subtab. For details, see the help topic Enabling the Advanced Revenue Management Feature.

When this feature is enabled, you must add a formula for calculating a Fair Value Price before you can perform this import. To create such a formula, go to Setup > Accounting > Fair Value Formulas > New, enter the formula name and formula expression, and click Save. For details, see the help topic Adding Fair Value Formulas.

After you have enabled this feature and added a fair value formula, you can import fair value price CSV data.

Fair Value Price Fields

To prepare fair value price CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **External ID** – Used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports.
- **Item** – The item this fair value price is related to.
- **Base Fair Value** – Item’s base price that is used for range checking.
- **Fair Value Formula** – The formula used to calculate the prices range.

To learn about other supported fields, see the help topic Creating the Fair Value Price List.
In addition to standard fields, the CSV data you import may also contain Fair Value Dimensions fields. To learn more about Fair Value Dimensions, see the help topic Adding Fair Value Dimensions.

**Fair Value Price CSV File Example**

The following table shows how you might structure a file for importing a fair value price list.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item</th>
<th>Base Fair Value</th>
<th>Fair Value Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>FV-PRICE-01</td>
<td>Cable - IDE</td>
<td>12.49</td>
<td>FV Formula - NGO</td>
</tr>
<tr>
<td>FV-PRICE-02</td>
<td>Cable - Parallel</td>
<td>9.99</td>
<td>FV Formula - NGO</td>
</tr>
<tr>
<td>FV-PRICE-03</td>
<td>Cable - SCSI</td>
<td>17.49</td>
<td>FV Formula - NGO</td>
</tr>
<tr>
<td>FV-PRICE-04</td>
<td>Cable - USB</td>
<td>8.69</td>
<td>FV Formula - NGO</td>
</tr>
</tbody>
</table>

**Importing a Fair Value Price CSV File**

To import the data, use the Import Assistant, which you can find at Setup > Import/Export > Import Tasks > Import CSV Records if you have the Import CSV File permission. Set the Import Type to Accounting and the Record Type to Fair Value Price.

For more information about using the Import Assistant and importing CSV records, see Importing CSV Files with the Import Assistant.

**Global Account Mapping Import**

For accounts using Multi-Book Accounting, the global account mapping record enables you to configure secondary accounting books to post to accounts different from the primary book. These mappings are used by transactions where the user can manually select the account to which the transaction posts.

This import is available when you enable the Chart of Accounts Mapping option at Setup > Company > Enable Features, on the Accounting subtab. Note that this choice is part of the overall setup required for Multi-Book Accounting.

NetSuite Professional Services handles the setup and implementation of the Multi-Book Accounting feature.

For details, see the help topic Multi-Book Accounting Overview.

In the user interface, you access this record at Setup > Accounting > Global Account Mappings > New.

**Global Account Mapping Fields**

The Import Assistant supports all the fields that are available in the user interface. It also supports external ID — that is, you can give each global account mapping record an external ID of your choosing, which you can later use as a unique identifier when updating the record.

For details about fields that can be mapped in this record, see the SOAP Schema Browser’s global account mapping reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

For help working with this record in the user interface, see the help topic Global Account Mapping.
Global Account Mapping CSV File Example

The following table shows how you might format your CSV file when importing global account mapping records. In this example, the custom dimension field has been configured to reference the customer record. Note that because this record has no sublist, you always use a single CSV file for the import.

<table>
<thead>
<tr>
<th>External Id</th>
<th>Effective Date</th>
<th>Accounting Book</th>
<th>Subsidiary</th>
<th>Source Account</th>
<th>Destination Account</th>
<th>Custom Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>101A</td>
<td>1/31/2014</td>
<td>Canadian</td>
<td>Parent</td>
<td>1100</td>
<td>1130 AR CA</td>
<td>Customer A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accounting Book</td>
<td>Company : CA Subsidiary</td>
<td>Accounts Receivable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>102A</td>
<td>1/31/2014</td>
<td>Canadian</td>
<td>Parent</td>
<td>1100</td>
<td>1182 AR CA</td>
<td>Customer B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accounting Book</td>
<td>Company : CA Subsidiary</td>
<td>Accounts Receivable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>101A</td>
<td>1/31/2014</td>
<td>Czech</td>
<td>Parent</td>
<td>1100</td>
<td>1125 AR CZ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accounting Book</td>
<td>Company : CZ Subsidiary</td>
<td>Accounts Receivable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Exercise care with the formatting of your date and subsidiary values. With the date field, the value must match the NetSuite formatting preference for the person doing the import. With the subsidiary field, the value must be hierarchal; for example: “Parent Company : UK Subsidiary.” If the formatting of either the date or subsidiary value is incorrect, the import fails.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Item Account Mapping Import

For accounts using Multi-Book Accounting, the item account mapping record enables you to configure secondary accounting books to post to accounts different from the primary book. These mappings are used by transactions where the item determines the account to which the transaction posts.

This import is available when you enable the Chart of Accounts Mapping option at Setup > Company > Enable Features, on the Accounting subtab. Note that this choice is part of the overall setup required for Multi-Book Accounting.


For details, see the help topic Multi-Book Accounting Overview.

In the user interface, you access this record at Setup > Accounting > Item Account Mappings > New.

Item Account Mapping Fields

The Import Assistant supports all the fields that are available in the user interface. It also supports external ID — that is, you can give each item account mapping record an external ID of your choosing, which you can later use as a unique identifier when updating the record.
For details about fields that can be mapped in this record, see the SOAP Schema Browser’s item account mapping reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

For help working with this record in the user interface, see the help topic Item Account Mapping.

**Note:** The field labeled Custom Dimension is available only if you have configured the field at Setup > Accounting > Accounting Preferences, on the Accounting Books tab. (For details on this process, see the help topic Custom Mapping Dimensions.)

**Item Account Mapping CSV File Example**

The following table shows how you might format your CSV file when importing item account mapping records. In this example, the custom dimension field has been configured to reference costing method. Note that because this record has no sublist, you always use a single CSV file for the import.

<table>
<thead>
<tr>
<th>External Id</th>
<th>Effective Date</th>
<th>Accounting Book</th>
<th>Subsidiary</th>
<th>Item Account Type</th>
<th>Source Account</th>
<th>Destination Account</th>
<th>Custom Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>111A</td>
<td>1/31/2014</td>
<td>Philippine</td>
<td>Parent Company : PH Subsidiary</td>
<td>Expense</td>
<td>6012 Advertising</td>
<td>6160 Outside Services</td>
<td>Average</td>
</tr>
<tr>
<td>111A</td>
<td>1/31/2014</td>
<td>Czech</td>
<td>Parent Company : CZ Subsidiary</td>
<td>Asset</td>
<td>1200 Inventory</td>
<td>1221 AT CZ</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Exercise care with the formatting of your date and subsidiary values. With the date field, the value must match the NetSuite formatting preference for the person doing the import. With the subsidiary field, the value must be hierarchal; for example: “Parent Company : UK Subsidiary.” If the formatting of either the date or subsidiary value is incorrect, the import fails.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Activities Import Type**

For information about activities imports, see the following:

- Events Import
- Phone Calls Import
- Resource Allocations Import
- Tasks Import

**Events Import**

An event record stores details about an activity such as an appointment or meeting. You can create and update event records using the CSV Import Assistant.

On page 1 of the Import Assistant, “Events” appears as an option in the Record Type dropdown list when you set Import Type to Activities.
In the UI, you can view the event record by choosing Activities > Scheduling > Events > New. For details on how to manually create an event record, see the help topic Creating a New Event Record.

For more on Events import, see the following:

- Event Date and Time Fields
- Event Body Fields
- Event Sublists
- Event CSV File Examples
- Common Errors When Importing Events

**Event Date and Time Fields**

Before using the CSV Import Assistant to work with event records, you need to understand the Reserve Time, Date, and End Date fields. These fields are closely related to one another.

**Reserve Time**

The Reserve Time field indicates whether or not the system blocks off time on attendees’ calendars for the event.

Possible values are:

- Yes — Indicates that the event shows up on attendees’ calendars. A value of Yes also means that the event must have a start time and an end time. You set the start time using the Date field. You set the end time using the End Date field.
- No — Indicates that the event does not show up on attendees’ calendars, and that it does not have start and end times. In this case, the event has only a date, which you set using the Date field.

The Reserve Time field is required, but if you do not include a mapping for this value, the system uses the default, which is Yes. This default does not show up on the Import Assistant mapping page.

**Date**

The Date field indicates the day an event takes place and, in some cases, the exact time it begins. The behavior of this field varies depending on the value of the Reserve Time field, as follows:

- When Reserve Time is set to Yes, the Date field must include a date with a time. For example: 08/12/2013 09:00 AM. Together these values indicate when the event begins. This value also determines the start of the time reserved on attendees’ calendars.
- When Reserve Time is No, the Date field includes only a date. For example: 08/12/2013. In these cases, if a time is included, it is ignored.

**End Date**

The End Date field is used to indicate the date and time that the event ends. It also marks the end of the time that is reserved on attendees’ calendars for the event.

The End Date field is used only if Reserve Time is set to Yes, and in these cases the field is required. However, you can omit an End Date column from your CSV file and the system will automatically create end dates and times.

If you do map values for End Date, the date you choose for any event must be the same as the date used in the Date field. The reason is that an event cannot span two days. Further, the End Date column must include both a date and a time. For example: 08/12/2013 10:00 AM.
Important: The values in both the Date and End Date fields must match the NetSuite formatting preference for the person doing the import. For additional tips, see Avoiding Event Date/Time Formatting Errors.

Note: The values for dates and times are not labeled the same way in the Import Assistant as they are in the standard event form in the UI. For a comparison, see How Mapped Event Date Values Display in the UI.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

How Mapped Event Date Values Display in the UI

An event’s date and time values are represented slightly differently in the CSV Import Assistant compared with the standard Event form in the UI (at Activities > Scheduling > Events > New).

The standard Event form, as shown in the following screenshot, includes fields labeled Date (1) and Start Time (2). Together, these two values map to one field in the Import Assistant — Date.

Similarly, the standard Event form, shown in the following screenshot, includes a field labeled End Time. Together, the Date (1) and End Time (3) fields map to one field in the Import Assistant — End Date.

Whether you are working in the UI or importing records using the Import Assistant, you can specify start and end only times if the Reserve Time option is selected. For more details on how to successfully map these three fields during your CSV import, see Event Date and Time Fields.

Avoiding Event Date/Time Formatting Errors

When using the CSV Import Assistant to work with event records, you must be careful to format the dates and time values correctly.

For both the Date and End Date fields, the values you enter should match the NetSuite formatting preferences of the person doing the import, as set at Home > Set Preferences, under the Formatting heading. The two relevant fields are Date Format and Time Format.

For example, suppose you want to enter a date and time in the Date field, and your NetSuite preferences are as follows:

- Date Format is MM/DD/YYYY.
- Time Format is hh:mm:ss AM/PM.

In your CSV file, any date and time values you include should use these formats. The date and time values should be separated by one space. For example: 12/16/2013 12:00:00 PM.

If you are using Microsoft® Excel to create your CSV file, NetSuite recommends that you right-click the column and choose Format Cells to explicitly select a format that matches the Date Format (and if applicable, the Time Format) specified in NetSuite. Be careful not to apply date formatting to any empty cells.
For more details on how to successfully map the Date and End Date fields for a CSV import, see Event Date and Time Fields.

**Event Body Fields**

This topic describes some of the important body fields on the event record and how they are handled during the import process. You may want to review these details before you begin importing event records using the CSV Import Assistant.

**Important:** Three of the most important fields on the event record — Reserve Time, Date, and End Date — are unusual in that their behavior can vary. They are described in a different topic: Event Date and Time Fields. Exercise care when mapping to these fields.

**Event Access**

Valid choices for Event Access are Private, Public, and Show as Busy. (For details on what these choices mean, see the help topic Creating a New Event Record.)

If you choose a data handling option of Add on page 2 of the Import Assistant and your CSV file does not include a column for Event Access, the system creates a default mapping setting the value to Show as Busy. If you do map to a column in your CSV file, be aware that every row in your file must have a value in this column. Otherwise, the Import Assistant does not allow you to proceed past the mapping page. Instead, it displays an error reading in part Mandatory Field Missing.

**Organizer**

In general, the organizer of an event is the only person who can make changes to the event record. The organizer must be an active employee.

If you choose a data handling option of Add on page 2 of the Import Assistant and your CSV file does not include a column for Organizer, the Import Assistant creates a default mapping that sets the value to the name of the person doing the import. If you do map to a column in your CSV file, be aware that every row in your file must have a value in this column. Otherwise, the Import Assistant does not allow you to proceed past the mapping page. Instead, it displays an error reading in part ‘Mandatory Field Missing.”

Note that the organizer is not the same as the owner. The owner of an event is always the person who created the record (in this case, the person who completed the import).

**Status**

The Status field indicates whether the event is expected to take place. Valid choices for Status are Confirmed, Tentative, and Canceled.
If you choose a data handling option of Add on page 2 of the Import Assistant and your CSV file does not include a column for Status, the Import Assistant creates a default mapping that sets Status to Confirmed. If you do map to a column in your CSV file, be aware that every row in your file must have a value in this column. Otherwise, the Import Assistant does not allow you to proceed past the mapping page. Instead, it displays an error reading in part “Mandatory Field Missing.”

**Title**

You use the Title field to name your event. This field is required. Note that this value does not have to be unique.

**For More Information**

For details on other fields available for mapping, see the following:

- For details on the event date and time fields, see Event Date and Time Fields.
- For details on the events sublists available for import, see Event Sublists.
- For help with additional body and sublist fields available for import, see the SOAP Schema Browser’s calendar event reference page. For help working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Event Sublists**

When using the CSV Import Assistant to work with events records, you can interact with three sublists:

- Attendees
- Resources
- Time Tracking

**Attendees**

You use the Attendees sublist to invite people to the meeting. Each sublist record represents a single attendee. Important fields in this sublist are:

- Attendance Status — Indicates whether the invitee is required to attend. Possible values are Optional and Required. If you do not map a value for this field, the Import Assistant sets a value of Required.
- Attendee — Identifies the person invited. This field is required. Valid values are active Employee IDs, Customer IDs, and so on. Note that each attendee of a single event record must be unique. If you mistakenly include the same person twice, the import of the record fails. Note that the owner of the record (the person doing the import) is always listed as an attendee.
- Response Status — Indicates whether the invitee is planning to attend. Possible values are Accepted, Declined, No Response, and Tentative. If you do not map a value for this field, the system creates a default mapping of No Response.

This sublist is selectively updatable based on the Attendee field.

**Resources**

You use the Resources sublist to reserve things needed for the event, such as a conference room or projector. This sublist has only one field (Resource). This field must reference a record listed at Activities > Setup > Resources. For details on resource records, see the help topic Using Resource Records on Events.
This sublist is selectively updatable based on the Resource field.

**Time Tracking**

You use the Time Tracking sublist to charge employee time for the meeting. Required values include:

- **Duration** — The amount of time for which to charge, in hours and minutes, separated by a colon. For example, to specify four and a half hours, use the following value: 4:30.
- **Employee** — The ID of the employee for whom time is being charged. The employee does not have to be an attendee.
- **Location** — Must identify a location listed at Setup > Company > Locations.
- **Date** — If you do not map a value for this field, the system sets the value to today's date.

The Time Tracking sublist is not keyed, which means that you cannot selectively update individual records in this sublist. For more details on non-keyed sublists, see Sublist Data Import.

**For More Information**

For details on other fields available for mapping, see the following:

- For details on the event date and time fields, see Event Date and Time Fields.
- For details on other required body fields, see Event Body Fields.
- For help with additional body and sublist fields available for import, see the SOAP Schema Browser's calendar event reference page. For help working with this tool, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Event CSV File Examples**

When importing events, you can use multiple-file or single-file upload techniques.

**Multiple Files Import**

With the multiple-file approach, you use a separate file to import values for each of the following:

- The Event Body Fields
- The Attendees sublist
- The Resources sublist
- The Time Tracking sublist

The first file should include a unique identifier for the event, the event's title, and any other needed body field values, as shown below.

You should create an additional file for each sublist you want to import. Each file should include a unique identifier that can link each sublist record to the appropriate body field values.

For example, the file representing the Attendees sublist might include columns for External ID, Attendee, Attendance Status, and Response Status.

The Resources sublist has only one field (Resource). Therefore, this file requires only two columns — one for the Resource field, and one for the unique identifier linking the sublist records to the relevant body field values.
Single File Import

With a single-file import, all data for a single event record must exist on a single row. For this reason, if the sublist data for any event must include more than one record, you must create a discrete set of columns for mapping each sublist record. For example, the following sample would create two event records. The first has four attendees (four records in the Attendees sublist), and the second has three.

Formatting restrictions make the table unreadable in the PDF output.

If you name your columns as shown in this example, the mapping should happen automatically. If you choose column headings that do not match what the system expects, you must map the fields manually.

Common Errors When Importing Events

This topic describes typical problems you might experience when using the CSV Import Assistant to create or update event records.

Date Field Not in Preferred Format

Sometimes when you click Next on the field mapping page, the system stops you from progressing and displays a dialog stating “Date field not in your preferred date format for field ‘Date.” This error indicates that at least one cell in the Start or End Date column of the CSV file is not formatted consistently with the NetSuite date format preference of the person doing the import. This preference is viewable at Home > Set Preferences, under the Formatting heading.

For additional guidance, see Avoiding Event Date/Time Formatting Errors.

Mandatory Field Missing for Field Date

Sometimes when you click Next on the field mapping page, the system displays a dialog stating “Mandatory Field Missing for field ‘Date” or “Mandatory Field Missing for field ‘End Date.” Review the column in your CSV file for Date (or End Date), and make sure that all rows have values.

If all records in your CSV file do contain a value for the field, the problem may be that date formatting was inadvertently applied to an empty cell. If you are using Microsoft® Excel, the solution is to highlight the rows below your records, right-click and select Delete > Entire Row. Save your file, and then try the import again.

Parse of Date/Time Failed

Sometimes the Import Assistant lets you complete all the steps of the import process, but the import fails with a reason of “Parse of date/time date time failed with date format format.”

This error can be caused by different problems, including:

- At least one cell in your Date or End Date column is not formatted consistently with the NetSuite date/time format preference of the person doing the import. These preferences are viewable at Home > Set Preferences, under the Formatting heading. For further help, refer to Avoiding Event Date/Time Formatting Errors.
- For one of your records, your CSV file does not include a date in the End Date column, and the system automatically generated an invalid date. To resolve this problem, review your CSV file and make sure every value in the End Date column has a valid date.
Activities Import Type

Start Time Must Be Earlier Than the End Time

Sometimes the Import Assistant lets you complete all the steps of the import process, but the import fails with a reason of "Start time must be earlier than the end time." This error can indicate one of the following problems:

- You mistakenly included an End Date value that is earlier than the Date value.
- Your End Date value includes a date later than the one indicated by the Date value, but the End Date time is earlier in the day than the Date time. For example, you would see this error if your Date value was 11/13/13 5:00 PM and your End Date value was 11/14/13 12:00 PM. Note that an event cannot span two days, so the solution is change both the date and time of the End Date value.

Phone Calls Import

A phone call record stores details about a business call, such as its organizer, its subject, and its date and time. A phone call can be linked to another record type such as customer or contact. After a phone call is linked to another record type, the phone call appears on the Activities subtab of that record.

The phone call data that you can import depend on the fields available on either your preferred Phone Call form, or the custom phone call form selected on the Import Assistant Import Options page. For details about specifying a custom form, see Set Advanced CSV Import Options.

For details about fields that can be mapped in the Phone Call record, see the SOAP Schema Browser's phone call reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

Be aware of the following:

- Required phone call fields for import are: Organizer, Status, Subject, and Date.
- You need to understand the use of the Date and End Date fields on phone call records, and to exercise care when you format values for them in your CSV files. To avoid errors, review and follow the guidelines in Setting Date Field Values for Phone Calls Imports.
- Unlike in the user interface, the Organizer field does not default to be the logged in user. You need to include values for this field in your CSV file or set up a default on the Import Assistant Field Mapping page. See Assign Default Values during Field Mapping.
- The Phone Calls import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts</td>
<td>Selectively updatable based on Participant(Entity) or Contact key field.</td>
</tr>
<tr>
<td></td>
<td>Maps to Companies and Contacts subtab on Related Records subtab of Phone Call record, can include other records, such as customers and contacts, that are related to each phone call.</td>
</tr>
<tr>
<td>Time Tracking</td>
<td>When Time Tracking feature is enabled.</td>
</tr>
</tbody>
</table>

For more information, see Sublist Data Import.

- If you are doing a phone calls import for the addition of new phone calls, select the Add data handling option, rather than Add or Update.
- If you need to use an import to update existing phone call records, you must map either the Internal ID or External ID field to uniquely identify records. This requirement is enforced when you select the Update data handling option and when you select the Add or Update data handling option.
Setting Date Field Values for Phone Calls Imports

Before you set up a CSV file for a phone calls import, you need to understand how Date and End Date fields are used, and you need to be aware of formatting requirements for their values.

Understanding Date and End Date Fields

You can review the standard Phone Call form to understand the use of the Date and End Date fields in phone call records, to properly specify their values in your CSV files.

- Reserve Time - Indicates whether to schedule a time for the phone call on the organizer's calendar. How the Start Date and End Date fields are used depends upon whether Reserve Time is enabled (set to True). By default, Reserve Time is not enabled (set to False).
- Date - The date when a phone call is started, in the field labeled Date on the standard Phone Call form, number 1 in the following screenshot. If Reserve Time is enabled, the Date value should also include a time that is the beginning of reserved time on the organizer's calendar, as shown in the field labeled Start Time, number 2 in the following screenshot.
- End Date - If Reserve Time is enabled, the time that is the end of reserved time on the organizer's calendar, as shown in the field labeled End Time on the standard Phone Call form, number 3 in the following screenshot. The date is not shown, and is assumed to be the same as the date in the Date field.

![Phone Call Form Screenshot]

Formatting Guidelines for Phone Call Date Field Values

Follow these guidelines when you enter values for date fields in CSV files used for phone calls imports.

- For Date fields:
  - If Reserve Time is set to False, a Date value requires only a date, for example: 04/12/2010. If a time is included, it is ignored.
  - If Reserve Time is set to True, Date requires both a date and a time, for example: 04/12/2010 09:00 AM.
- For End Date fields:
  - If Reserve Time is set to False, no End Date value is required.
  - If Reserve Time is set to True, End Date requires both a date, that should be the same as the date set for Date, and a time, for example: 04/12/2010 11:00 AM.
- For both Date and End Date fields, values should be specified according to the NetSuite Date Format, and if applicable, Time Format, set at Home > Set Preferences for the user doing the import. The following are example formats:
  - Date Format is **MM/DD/YYYY**.
  - Time Format is **hh:mm AM/PM**.
  - For a Date field that includes both date and time, a space should be included between them, for example: **04/12/2010 10:00 AM**.

- To avoid Excel formatting errors for Date and End Date values, NetSuite recommends that you right-click the column and choose Format Cells to explicitly select a format that matches the Date Format (and if applicable, Time Format) set up in NetSuite.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Resource Allocations Import

A resource allocation record stores details about project resource time allocated to a specific project. After a resource allocation record has been created and approved, the allocated time is shown on the project record. Resource allocation records are available for import in accounts where the Project Management and Resource Allocation features are enabled.

The resource allocation data that you can import depend on the fields available on either your preferred resource allocation form, or the custom form selected on the Import Assistant Import Options page. For details about specifying a custom form, see Set Advanced CSV Import Options.

For details about fields that can be mapped in the resource allocation record, see the SOAP Schema Browser’s resource allocation reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

For information about working with resource allocations in the user interface, see the help topic Resource Allocations.
Activities Import Type

Be aware of the following:

- Required resource allocation fields for import are: Resource, Customer:Project, Allocate, Allocation Type, Start Date, and End Date.

- Allocations imported with CSV are automatically allocated by hours. If you would like to allocate by percentage, you must include an Allocation Unit column with the value of Percent of Time.

- You need to exercise care when you format values for the Start Date and End Date fields in your CSV files. To avoid errors, review and follow the guidelines in Formatting Guidelines for Resource Allocation Date Field Values.

- The Requested By field is automatically populated with your name. You can add Requested By to your CSV file to populate this field with a different user name.

- If you are doing a resource allocation import for the addition of new allocations, select the Add data handling option, rather than Add or Update.

- If you need to use an import to update existing allocation records, you must map either the Internal ID or External ID field to uniquely identify records. This requirement is enforced when you select the Update data handling option and when you select the Add or Update data handling option.

Formatting Guidelines for Resource Allocation Date Field Values

Follow these guidelines when you enter values for date fields in CSV files used for resource allocation imports.

- For Start Date and End Date fields, values should be specified according to the NetSuite Date Format set at Home > Set Preferences for the user doing the import.

  **Important:** If your resource allocation import returns date-related errors such as “You have entered an Invalid Field Value” or “End Date occurs before Start Date”, try removing leading zeros from date values in your CSV file, for example changing 08/01/2010 to 8/1/2010.

- To avoid Excel formatting errors for Start Date and End Date values, NetSuite recommends that you right-click the column and choose Format Cells to explicitly select a format that matches the Date Format set up in NetSuite.
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Tasks Import

A task record stores details about a unit of work to be completed. NetSuite supports the creation of two different types of tasks: CRM Tasks and Project Tasks. The Tasks import supports the import of CRM tasks, not project tasks. CRM tasks, usually labeled Tasks in the NetSuite user interface, do not have to be associated with projects.

Note: Project tasks are available in accounts where the Project Management feature is enabled, and are used only in association with project records. A different import process for project tasks is available at Activities > Scheduling > Project Tasks > Import. See Project Tasks Import.

The CRM tasks data that you can import depend on the fields available on either your preferred Task form, or the custom task form selected on the Import Assistant Import Options page. For details about specifying a custom form, see Set Advanced CSV Import Options.

For details about fields that can be mapped in the Task record, see the SOAP Schema Browser’s task reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Be aware of the following:

- Required task fields for import are: Assigned To, Due Date, Priority, Start Date, Status, and Title.
- You need to understand the use of the Start Date and End Date fields on task records, and to exercise care when you format values for the Start Date, End Date, and Due Date fields in your CSV files. To avoid errors, review and follow the guidelines in Setting Date Field Values for Tasks Imports.
- Unlike in the user interface, the Assigned To field does not default to be the logged in user. You need to include values for this field in your CSV file or set up a default on the Import Assistant Field Mapping page. See Assign Default Values during Field Mapping.
- The Send Email field is not available for import mapping. Imports cannot send email to task assignees.
- The Tasks import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts</td>
<td>Selectively updatable based on Company/Project(Entity) or Contact key field. Maps to Companies and Contacts subtab on Related Records subtab of Task record, can include other records, such as customers and contacts, that are related to each task.</td>
</tr>
<tr>
<td>Time Tracking</td>
<td>When Time Tracking feature is enabled.</td>
</tr>
</tbody>
</table>

For more information, see Sublist Data Import.

- If you are doing a tasks import for the addition of new tasks, select the Add data handling option, rather than Add or Update.
- If you need to use an import to update existing task records, you must map either the Internal ID or External ID field to uniquely identify records. This requirement is enforced when you select the Update data handling option and when you select the Add or Update data handling option. The Title field is not a key field and does not have to be unique.
Setting Date Field Values for Tasks Imports

Before you set up a CSV file for a tasks import, you need to understand how Start Date and End Date fields are used, and you need to be aware of formatting requirements for Start Date, End Date, and Due Date field values.

Understanding Start Date and End Date Fields

You can review the standard Task form to understand the use of the Start Date and End Date fields in task records, to properly specify their values in your CSV files.

- Reserve Time - Indicates whether to schedule time for the task on the assignee's calendar. How the Start Date and End Date fields are used depends upon whether Reserve Time is enabled (set to True). By default, Reserve Time is not enabled (set to False).
- Start Date - The date when a task is started, as shown in the field labeled Start Date on the standard Task form, number 1 in the following screenshot. If Reserve Time is enabled, the Start Date value should also include a time that is the beginning of reserved time on the assignee's calendar, as shown in the field labeled Start Time, number 2 in the following screenshot.
- End Date - If Reserve Time is enabled, the time that is the end of reserved time on the assignee's calendar, as shown in the field labeled End Time on the standard Task form, number 3 in the following screenshot. The date is not shown, and is assumed to be the same as the date in the Start Date field.

Formatting Guidelines for Task Date Field Values

Follow these guidelines when you enter values for date fields in CSV files used for tasks imports.

- For Start Date fields:
  - If Reserve Time is set to False, a Start Date value requires only a date, for example: 04/12/2010. If a time is included, it is ignored.
  - If Reserve Time is set to True, Start Date requires both a date and a time, for example: 04/12/2010 09:00 AM.
- For End Date fields:
  - If Reserve Time is set to False, no End Date value is required.
If Reserve Time is set to True, End Date requires both a date, that should be the same as the date set for Start Date, and a time, for example: **04/12/2010 11:00 AM**.

- For Start Date, End Date, and Due Date fields, values should be specified according to the NetSuite Date Format, and if applicable, Time Format, set at Home > Set Preferences for the user doing the import. The following are example formats:
  - Date Format is **MM/DD/YYYY**.
  - Time Format is **hh:mm AM/PM**.
  - For a Start Date or End Date field that includes both date and time, a space should be included between them, for example: **04/12/2010 10:00 AM**.

**Important:** If your tasks import returns date-related errors such as “You have entered an Invalid Field Value” or "Due Date occurs before Start Date", try removing leading zeros from date values in your CSV file, for example changing **08/01/2010** to **8/1/2010**.

- To avoid Excel formatting errors for Start Date, End Date, and Due Date values, NetSuite recommends that you right-click the column and choose Format Cells to explicitly select a format that matches the Date Format (and if applicable, Time Format) set up in NetSuite.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Classification Import Type**

Departments, Locations, and Classes are classifications you can use to identify and group many areas of your NetSuite account to keep your data organized and accurate. Departments usually indicate groupings of records according to management responsibility. Locations usually indicate groupings according to geographic areas. Classes can indicate a wide variety of categorizations.

To use each classification, you need to enable the feature and then set up records for each. One technique to set up these records is to use the Import Assistant to import them. After you set up...
classification records, you can use them to group records in your NetSuite account, and to sort account
data in report and search results.

For information about classification imports, see the following:

- Class Import
- Custom Segment Value Import
- Department Import
- Location Import
- Merchandise Hierarchy Node Import

### Class Import

Classes are type definitions that can be used to categorize records such as financials, transactions, and
employees. Classes can provide more generalized categories than departments or locations. For more
information, see the help topic Creating Classes.

You can use the Import Assistant to set up and update class records in your NetSuite account.

Before you can import classes, an administrator, or another user with permission to enable features, must
go to Setup > Company > Enable Features, and on the Company subtab, check the Classes box and click
Save.

Class fields for which data can be imported include Name, External ID, Subclass of (the parent class, if
any), and whether the class is inactive. If you are using NetSuite OneWorld, these additional fields also are
available: Subsidiaries (the subsidiaries associated with a class), and Include Children (a Boolean indicating
whether to associate a class with all child subsidiaries of those specified in the Subsidiaries field).

For details about fields that can be mapped in the Class record, see the SOAP Schema Browser's class
reference page. You can use the field definitions here as a basis for creating your own CSV import
template file. For information about working with the SOAP Schema Browser, see the help topic SOAP
Schema Browser.

After you have imported class records successfully, you can review them at Setup > Company > Classes.

**Note:** If you plan to import other record types that include fields referencing class values,
complete the import of classes first.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you
select the record type for import, you choose the import character encoding. For more information, see
Select a Record Type for Import and Choose Import Character Encoding.

### Custom Segment Value Import

Custom segments are classification fields similar to class, department, and location. When the Custom
Segments feature is enabled, you can use the NetSuite UI to create as many custom segments as
necessary for your organization. For example, you might create a custom segment called Sales Channel
that has values such as Brick-and-Mortar Store, Call Center, and Web Store. For general details about
creating and managing custom segments, see the help topic Custom Segments.

After custom segments have been created in your NetSuite account, you can use the Import Assistant to
add and update values for each segment. For example, with the segment called Sales Channel, you could
use the Import Assistant to import new values such as Catalog and Partner Outlet.
To import values, set the Import Type to Classification. In the Record Type dropdown list, the system displays both the names of your custom segments and any other classifications enabled in your account. For example, custom segments named Brand and Product Line would display alongside Class, Department, and Location, if those features are enabled.

Before you begin importing custom segments, it might be useful to view the form you would use to manually create these records, at Customization > Lists, Records, & Fields > Custom Segments > New.

See the following for more information about custom segment value imports:

- Prerequisites for Importing Custom Segment Values
- Custom Segment Value Body Fields
- Custom Segment Value Translations

### Prerequisites for Importing Custom Segment Values

Before you can import values for custom segments, you must do both of the following:

- Enable the Custom Segments feature at Setup > Company > Enable Features, on the SuiteCloud subtab.
- Create at least one custom segment in your account. You can create custom segments at Customization > Lists, Records, & Fields > Custom Segments > New.

By default, only administrators have permission to import custom segment values. However, you can grant permission to other roles. The following permissions are required:

- **The global Custom Segments permission** – You can add this permission on the Permissions > Setup subtab of the role record. At least the View level is required.
- **The Value Access Level permission for the custom segment** – You can add this permission on the Custom Record subtab of the role record. To be able to add values, the role needs at least the Create level. To be able to update values, or to be able to set the parent for a value, the user needs at least the Edit permission.

### Custom Segment Value Body Fields

For each import, you can define values for the following body fields:

- **ExternalId** – When adding values, you can optionally use this field to import a unique identifier for the value. This identifier may be useful if you want to update the value later.
- **Inactive** – If you want the segment value to be available to users, you can omit a mapping for this field. In this case, the system uses the default choice of false. If you want to hide the new value from users, set Inactive to true.
- **InternalId** – InternalId is available only during updates. You can use this read-only field to reference the value that you want to change.
- **Name** – The name of the value. This field is required. Note that the name can denote a parent. For example, suppose the segment already includes a value called Americas. You may want to add a new value, Brazil, which uses Americas as its parent. To do so, use the following format: [Parent value]:[Child value].

**Custom Segment Value Translations**

If your account uses the Multi-Language feature, you can import translations of a segment value’s name. To import translations, you use a sublist. The sublist uses the same name as the segment. For example, a segment called Sales Channel would have a sublist called Sales Channel. You can create a new sublist entry for each language. Within each sublist entry, there are two fields:

- **Name** – The translation of the segment value name.
- **Language** – The language for which you are providing this translation.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Department Import**

Departments can be used to categorize records, such as accounts, employees, and items. Departments usually indicate groupings of records according to management responsibility. For more information, see the help topic Creating Departments.

You can use the Import Assistant to set up and update department records in your NetSuite account. To import department records, select Classification as the import type, and Department as the record type.

Before you can import departments, an administrator, or another user with permission to enable features, must go to Setup > Company > Enable Features, and on the Company subtab, check the Departments box and click Save.

Department fields for which data can be imported include Name, External ID, Subdepartment of (the parent department, if any), and whether the department is inactive. If you are using NetSuite OneWorld, these additional fields also are available: Subsidiaries (the subsidiaries associated with a department), and Include Children (a Boolean indicating whether to associate a department with all child subsidiaries of those specified in the Subsidiaries field).

For details about fields that can be mapped in the Department record, see the SOAP Schema Browser’s department reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

After you have imported department records successfully, you can review them at Setup > Company > Departments.

**Note:** If you plan to import other record types that include fields referencing department values, complete the import of departments first.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you Select a Record Type for Import, Choose Import Character Encoding.
Location Import

Locations can be used to categorize records according to geographic area. You can use the Import Assistant to set up and update location records in your NetSuite account.

Before you can import locations, an administrator, or another user with permission to enable features, must go to Setup > Company > Enable Features, and on the Company subtab, check the Locations box and click Save.

After you have imported location records successfully, you can review them at Setup > Company > Locations.

**Note:** If you plan to import other record types that include fields referencing location values, complete the import of locations first.

Location body fields for which data can be imported include Name, External ID, Sublocation of (the parent location if any), whether the location is inactive, and a transaction prefix field you can use to make auto-generated transaction numbers independent per location. (Transaction prefix values can be up to 8 alphanumeric characters.) If you are using NetSuite OneWorld, the Subsidiary field is also available.

**Important:** The location import supports the import of multiline sublists. When importing a file where the sublist data contains multiple lines for each sublist item, you should include an external ID for each location record to uniquely identify the record the sublist data belongs to. For more information, see Multiline Sublists for CSV Import and Import Format and Mapping Considerations in Importing Sublist Data in a Single File.

As of Version 2015 Release 2, fields formerly in the Address sublist for Location are mapped as body fields, and fields formerly in the Return Address sublist are structured as a subrecord. By default, the Address body field is read-only, and data from other related body fields is copied into it. If you map the Override body field and set it to Yes (meaning true), you can import data for the Address body field. Similarly, the Address field in the Return Address subrecord is read-only, and data from other related subrecord fields is copied into it. If you map the Override subrecord field and set it to Yes (meaning true), you can import data for the Address subrecord field.

**Supported Location Sublist Imports**

The Location import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation</td>
<td>When the Multi-Language feature is enabled.</td>
</tr>
<tr>
<td></td>
<td>You can map multiple instances of this sublist to import translations for multiple languages.</td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td>Business Hours</td>
<td>You can map multiple instances of this sublist to import more than one set of business hours. For information about setting up business hours, see the help topic Defining Store Business Hours.</td>
</tr>
</tbody>
</table>

Every sublist on each record can optionally have a separate file. For imports that update existing Location records, handling of sublist data updates depends on the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

For more details about fields that can be mapped in the Location record, see the SOAP Schema Browser’s location reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Merchandise Hierarchy Node Import

NetSuite merchandise hierarchy nodes provide a way to group items in your merchandise hierarchy. You can use the Merchandise Hierarchy Nodes import to import new nodes to an existing merchandise hierarchy version. Before you can import hierarchy nodes, you must first create a hierarchy version and the required hierarchy levels. For more information regarding creating a merchandise hierarchy, see the help topic Creating a Merchandise Hierarchy.

To import merchandise hierarchy nodes, set the Import Type to Classification. In the Record Type list, select Merchandise Hierarchy Node.

For details about fields that can be mapped in the merchandise hierarchy node record, see the Records Browser's [merchandise hierarchy node](#) reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the Records Browser, see the help topic [Working with the SuiteScript Records Browser](#).

Review the following guidelines for Merchandise Hierarchy Node imports:

- Supported Merchandise Hierarchy Node Sublist Data Imports
- Using Import Assistant for Merchandise Hierarchy Node Mass Update
- Merchandise Hierarchy Node Import Example

### Supported Merchandise Hierarchy Node Sublist Data Imports

The Merchandise Hierarchy Node import supports the import of the following sublist data:
Using Import Assistant for Merchandise Hierarchy Node Mass Update

The following are typical use cases for importing merchandise hierarchy nodes:

- Initial merchandise hierarchy setup
- Adding new nodes to a merchandise hierarchy
- Re-parenting existing nodes in a merchandise hierarchy

Merchandise Hierarchy Node Import Example

The following example shows how you might structure a file for importing merchandise hierarchy node data.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>ExternalID</th>
<th>VersionID</th>
<th>LevelID</th>
<th>parentnodeID</th>
<th>IsIncluded</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORSO</td>
<td>Company name</td>
<td>100</td>
<td>1</td>
<td>1</td>
<td></td>
<td>T</td>
</tr>
<tr>
<td>Women's Wear</td>
<td>Women's apparel department</td>
<td>101</td>
<td>1</td>
<td>2</td>
<td>100</td>
<td>T</td>
</tr>
<tr>
<td>Tops</td>
<td>Women's upper body apparel</td>
<td>102</td>
<td>1</td>
<td>3</td>
<td>101</td>
<td>T</td>
</tr>
<tr>
<td>Bottoms</td>
<td>Women's lower body apparel</td>
<td>103</td>
<td>1</td>
<td>3</td>
<td>101</td>
<td>T</td>
</tr>
<tr>
<td>Shoes</td>
<td>Women's footwear</td>
<td>104</td>
<td>1</td>
<td>3</td>
<td>101</td>
<td>T</td>
</tr>
<tr>
<td>Jackets</td>
<td>Women's jackets</td>
<td>105</td>
<td>1</td>
<td>4</td>
<td>102</td>
<td>T</td>
</tr>
<tr>
<td>Shirts</td>
<td>Women's shirts</td>
<td>106</td>
<td>1</td>
<td>4</td>
<td>102</td>
<td>T</td>
</tr>
<tr>
<td>Pants</td>
<td>Women's pants</td>
<td>107</td>
<td>1</td>
<td>4</td>
<td>103</td>
<td>T</td>
</tr>
<tr>
<td>Skirts</td>
<td>Women's skirts</td>
<td>108</td>
<td>1</td>
<td>4</td>
<td>103</td>
<td>T</td>
</tr>
<tr>
<td>Boots</td>
<td>Women's boots</td>
<td>109</td>
<td>1</td>
<td>4</td>
<td>104</td>
<td>T</td>
</tr>
<tr>
<td>Sandals</td>
<td>Women's sandals</td>
<td>110</td>
<td>1</td>
<td>4</td>
<td>104</td>
<td>T</td>
</tr>
</tbody>
</table>

**Note:** To establish the parent node of a node, enter the External ID for the parent node in the parentnodeID column. In the above example, the parent node for Women's Wear is Nors. The External ID for NORSO is 100, so this is the value entered in the parentnodeID column for Women's Wear.

Communications Import Type

For information about communications imports, see the following:
Messages Import

The Messages import adds message records to NetSuite. Messages are used to attach email messages to NetSuite entities and transactions.

The fields available for messages imports correspond to those on the Recipients and Messages subtabs of the Attach Message dialog. This dialog appears when a user clicks Attach on the Messages subtab of one an entity or transaction record.

For details about fields that can be mapped in the Message record, see the SOAP Schema Browser's message reference page. You can use the field definitions as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Be aware of the following:

- Because messages are not editable in the UI, they are not editable through CSV import. You can use CSV import to add new message records only, not to edit existing message records. For messages imports, the Update and Add or Update data handling options are grayed out on the Step 2 Import Options page of the Import Assistant.
- Required messages fields for import are: From (the sender of the message), Attach to (the recipient of the message and the record to which the message is attached in NetSuite), and Subject (which also serves as a title). Entities provided as From and Attach to field values must already exist in NetSuite. If the From and Attach to entity records do not have email addresses, then the From Email Address and To (Email) fields are required.
- Unlike in the user interface, the Attach to field does not default to be the logged in user. You need to include values for this field in your CSV file or set up a default on the Import Assistant Field Mapping page. See Assign Default Values during Field Mapping.
- To attach messages to transactions, map the Transaction field, and either set a default value or include transaction values in the CSV file.
- The Emailed field is a Boolean that indicates whether or not an email message was sent. Messages imports do not send any email messages.
- Import of file attachments is not supported, although files can be attached to messages in the NetSuite user interface.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Notes Import

The Notes import adds or updates Note records in NetSuite. Notes are used to attach information to other NetSuite records.

CSV file note records should include references to the NetSuite record to which they are attached. These reference values can be in one of the following fields (as shown on the Import Assistant Field Mapping page:

- CRM/Support Record
- Entity (for Customer or Contact records)
- Item
Communications Import Type

- Transaction (for Opportunity records)

The Date field on note records is a Date/Time type. CSV file values for this field can be include dates only or both dates and times. If a value is date-only, the time defaults to the current time (time of the import).

If you are doing a notes import for the addition of new notes, select the Add data handling option, rather than Add or Update.

If you need to import updates to existing note records, NetSuite recommends that you use an identifier of internal ID or external ID, to prevent duplication of records.

- If you select the Update data handling option, you can use the Title as an identifier to match records and perform updates.
- If you select the Add or Update data handling options, no Title lookups are performed, so in the absence of internal ID or external ID, multiple notes with the same title may be added.

For details about fields that can be mapped in the note record, see the SOAP Schema Browser's note reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Custom Records Import

A custom record type is an entry form you can create to collect information specific to the needs of your business, when the Custom Records feature is enabled. To enable the Custom Record feature, go to Setup > Company > Enable Features, on the SuiteCloud subtab.

For more details, see: Custom Records

For already existing custom record types, you can use the CSV Import Assistant to:

- Add new custom record instances
- Update the data in existing custom record instances and sublists
- Delete data from existing custom record instances and sublists

When adding a new custom record instance, the Name field is a mandatory field, that can also be used as a reference type when updating or deleting data in existing custom record instances, but it is not a Unique Key. Therefore it is more susceptible to errors because of matching failures. Unique Keys are the External ID (if enabled) and the Internal ID.

For more information on Reference Types, see: Select Reference Types

For more details about fields that can be mapped in custom records, see the SOAP Schema Browser’s custom record reference page. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Note:** When you create new custom record instance through CSV Import, it is possible to import values for the Translations sublist, if the Enable Name Translation field is enabled for the corresponding custom record type. For more details on configuring a custom record type to allow for translations, see the help topic Translating Custom Record Instance Names.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. For more information on the Import Assistant, see: Importing CSV Files with the Import Assistant
Customization Import Type

For information about customization imports, see the following:

- Custom List Import

Custom List Import

⚠️ Important: CSV import is not supported for custom lists with more than 25,000 values.

A custom list is a list of values that can be used to populate dropdown lists on NetSuite forms. With the custom list import, you can import several custom lists together. You can use the Import Assistant to create new custom lists and update existing custom lists.

After you import a custom list, you can add it to a form by completing a few other steps: creating a custom field of type List/Record or Multiple Select, choosing the imported list as the List/Record value for the field, and adding the field to the form. You can add the custom field to multiple forms as needed. For more information, see the help topics Custom Lists and Creating a Custom Field.

To import custom lists, select Customization as the import type, and Custom List as the record type.

Review the following guidelines for more details about custom list imports:

- Custom List Body Fields
- Custom List Sublist Data
- Custom List CSV File Examples
- Common Errors When Importing Custom Lists

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Custom List Body Fields

The following custom list body fields are available for mapping:

- ID
- Inactive
- Internal ID
- Matrix Option List
- Name
- Owner
- Show options in order entered

ID

The field labeled “ID” on the Import Assistant mapping page corresponds to the scriptId element in customization.xsd. It is neither the Internal ID nor an External ID.
**Important:** The Custom List record does not support the External ID field.

The ID field is available only if Client SuiteScript and Server SuiteScript have been enabled at Setup > Company > Enable Features, on the SuiteCloud tab.

The value entered for the ID field must be unique.

**Note:** The system adds the prefix `customlist` to whatever value you enter. For example, if you enter `_listColors`, the system saves the ID as `customlist_listColors`. This value can be used as an identifier for the record.

**Inactive**

A value of Yes makes the list unavailable to be selected as the List/Record of a new custom field. The default is No.

**Internal ID**

This field is available for mapping only if the import has a data handling option of Update, or Add or Update.

**Matrix Option List**

This field is available only if the Accounting Matrix Items feature has been enabled at Setup > Company > Enable Features, on the Items & Inventory tab. When the value is Yes, the system can display abbreviations for each value in the list. The default is No.

**Name**

The value for Name shows up in the form you use to create a new custom field, as a choice in the List/Record dropdown list (unless you have chosen a value of Yes for the custom list's Inactive field, which hides the list name from this view). The Name is **not** the user-facing label that ultimately appears on the custom form next to the list. (That label is the value you enter for the Label field on the custom field record.)

The illustration below shows where the name of the custom list appears when you create a new custom field, in this example, “List of days” in the List/Record dropdown list.
The Name field is required, and its value must be unique.

**Owner**

If you do not create a mapping for Owner, the system identifies you as the owner. The mapping page does not indicate you are mapped as owner, but the import sets you as the owner for all imported records. If you do not want to be set as owner, create a mapping that sets the Owner field to another user or to null.

**Show options in order entered**

A value of Yes places your custom list’s values (which are defined by the Custom List Values sublist) in the order they are listed in the CSV import file. A value of No places the values in alphabetical order.

If you do not create a mapping for this field, the import sets the value to Yes. The mapping page does not indicate that this default is being chosen, but you can see it on the resulting record after the import.

**For more details**

For further details about fields that can be mapped, see the SOAP Schema Browser’s custom list reference page. However, note that the Convert to Custom Record field is not currently supported in the Import Assistant. With that exception, you can use the field definitions in the SOAP Schema Browser as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Custom List Sublist Data**

You can import data for two sublists — Custom List Values and Custom List Translation. This topic describes these sublists in more detail. See also Custom List CSV File Examples for tips on organizing CSV files that include sublist data.
Custom List Values

The Custom List Values sublist specifies the options, or values, to be displayed in the custom list. For example, in a custom list named “Sizes,” sublist values might be “small,” “medium,” and “large.” The sublist fields are described in the following table.

This sublist is selectively updatable based on the ID field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbreviation</td>
<td>Available only if the Matrix Items feature is enabled for your account (at Setup &gt; Company &gt; Enable Features &gt; Items &amp; Inventory). You can use this field to add an abbreviation for each Custom List Values in your list. If, after the import, you review the newly imported record in the UI, note that the Abbreviation field shows up only if Matrix Option List is set to Yes for this particular custom list. However, even if you import abbreviations when setting Matrix Option List to No, the system saves your abbreviations, and they can be displayed later.</td>
<td>No</td>
</tr>
<tr>
<td>ID</td>
<td>This field — which is the key for the sublist — is automatically generated and read only. Do not attempt to populate this field with a value of your own choosing. Attempts to do so are generally ignored and in some cases (if you use illegal characters) result in errors that halt your import. You should use this field only when attempting to selectively update a record in the sublist using the automatically generated value for the field. This field is not related to the ID field that is available to be mapped as a body field when SuiteScript is enabled.</td>
<td>No, but if you are trying to selectively update the sublist, you must include a mapping for the ID of those records you want to modify.</td>
</tr>
<tr>
<td>Inactive</td>
<td>A value of No means that the value displays as an option in your custom list. A value of Yes means the value is hidden. No, but if you do not include a mapping for this field, the system uses the default value, which is No.</td>
<td></td>
</tr>
<tr>
<td>Translation:</td>
<td>Available when both of the following are true: The Multi-Language feature is enabled for your account (at Setup &gt; Company &gt; Enable Features). You have added one or more languages to the Languages subtab at Setup &gt; Company &gt; General Preferences. For each language listed on the Languages subtab, the Import Assistant mapping page offers a corresponding Translation: (Language) field. For each sublist record, you can use these fields to add translations for the corresponding entry in the Custom List Values column for this sublist record.</td>
<td>No</td>
</tr>
<tr>
<td>(Language)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>The value, or option, to be shown in the custom list. For example, for a list of colors, values might be “red,” “blue,” and “green.” Yes</td>
<td></td>
</tr>
</tbody>
</table>

Custom List Translation

The Custom List Translation sublist lets you add translations for the name of the sublist. In order for you to use this sublist, both of the following must be true:

- The Multi-Language feature has been enabled (at Setup > Company > Enable Features).
You have added one or more languages to the Languages subtab at Setup > Company > General Preferences.

This sublist is selectively updatable based on the Language field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Use this field to identify the language of the translation. This field is also the key for the sublist.</td>
<td>Yes. This field is not marked as required on the mapping page, but if you try to import data to this sublist and fail to map a value for Language, the import fails.</td>
</tr>
<tr>
<td>Name</td>
<td>The translation of the Name body field that corresponds with the locale you entered for this sublist record.</td>
<td>No</td>
</tr>
</tbody>
</table>

For general information on translations for custom lists, see the help topic Adding Translations for Custom Lists.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Custom List CSV File Examples

When importing custom lists, you can use multiple-file or single-file upload techniques.

Multiple Files Import

With the multiple-file approach, you can organize your data into two or three files. You can use a separate file to import values for each of the following:

- The Custom List Body Fields
- The Custom List Values sublist
- The Custom List Translation sublist

The first file, or main file, should include a unique identifier for the custom list, the custom list's name, and any other needed body field values, as shown in the following example of the main file. In this example, row 2 in the file is the first custom list (_listSizes), row 3 is the second custom list (_listColors).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID</td>
<td>Name</td>
<td>Description</td>
<td>Matrix Option List</td>
</tr>
<tr>
<td>2</td>
<td>_listSizes</td>
<td>Size</td>
<td>This is a list of sizes</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>_listColors</td>
<td>Colors</td>
<td>This is a list of colors</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The second file should include one row for each value in each custom list, along with that value's abbreviation and translations, if needed. Each row must also include a unique identifier to match the sublist record with the appropriate row from the main file.

For example, the illustration below uses the value from the ID body field to link the body data with each sublist record. However, note that in the second file, the ID body value is referred to as “List ID.” The second file should not refer to the ID body field using the column heading “ID,” because this file maps to the Values sublist, and the Values sublist has its own ID field that is unrelated to the body field of the same name. (You map to the sublist's ID field only when selectively updating the sublist, and only using
the ID value that was generated by the system when the list was created. Other attempts to map to the sublist's ID field can cause your import to fail.)

In the following example of the second file, the first three sublist records (rows 2, 3, and 4) belong to the first custom list (_listSizes) defined in the main file. The last three sublist records (rows 5, 6, and 7) belong to the second custom list (_listColors) defined in the main file.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List ID</td>
<td>Value</td>
<td>Abbreviation</td>
<td>Translation: Czech</td>
<td>Translation: Spanish</td>
</tr>
<tr>
<td>2</td>
<td>listSizes</td>
<td>small</td>
<td>S</td>
<td>malé</td>
<td>pequeños</td>
</tr>
<tr>
<td>3</td>
<td>listSizes</td>
<td>medium</td>
<td>M</td>
<td>střední</td>
<td>mediano</td>
</tr>
<tr>
<td>4</td>
<td>listSizes</td>
<td>large</td>
<td>L</td>
<td>velký</td>
<td>grande</td>
</tr>
<tr>
<td>5</td>
<td>listColors</td>
<td>red</td>
<td>R</td>
<td>červený</td>
<td>rojo</td>
</tr>
<tr>
<td>6</td>
<td>listColors</td>
<td>green</td>
<td>G</td>
<td>zelený</td>
<td>verde</td>
</tr>
<tr>
<td>7</td>
<td>listColors</td>
<td>blue</td>
<td>B</td>
<td>modrý</td>
<td>azul</td>
</tr>
</tbody>
</table>

The third file should include one row for each translation of each custom list name. No more than one translation should exist in any row. Further, each row must include a unique identifier matching the translation with the appropriate body data from the main file. The following example uses the ID value, which is again referred to using the column heading "List ID."

In the following example of the third file, the first two sublist records (rows 2 and 3) are belong to the first custom list (_listSizes) defined in the main file. The last two sublist records (rows 4 and 5) belong to the second custom list (_listColors) defined in the main file.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List ID</td>
<td>Language</td>
<td>Name</td>
</tr>
<tr>
<td>2</td>
<td>listSizes</td>
<td>Czech</td>
<td>Velikosti</td>
</tr>
<tr>
<td>3</td>
<td>listSizes</td>
<td>Spanish</td>
<td>Tamaños</td>
</tr>
<tr>
<td>4</td>
<td>listColors</td>
<td>Czech</td>
<td>Barny</td>
</tr>
<tr>
<td>5</td>
<td>listColors</td>
<td>Spanish</td>
<td>Colores</td>
</tr>
</tbody>
</table>

With this approach, each CSV file corresponds to one of the categories shown on the right side of the mapping page under "NetSuite Fields."

---

### Single File Import

With the single-file approach, be aware of a few rules that affect the way you format data intended for the two sublists, Custom List Values and Custom List Translation.
If you want to import multiple values into the Custom List Values sublist (for any custom list represented in your file), the file must include multiple rows for that particular custom list. For example, if you want the custom list to have five options for users to choose from, you must create five rows for it in your CSV file. Each row must include one of the values to be mapped to the Custom List Values field of the sublist, and any other sublist data needed for that value, such as an abbreviation or a translation. However, the second through fifth rows do not need to contain any body data except for the name of the custom list record.

For example, the following illustration shows how you would format a CSV file to import one custom list record that has five values. Note that the ID, Description, and Owner values do not have to be repeated. The Name value does have to be repeated.

The single-file approach also lets you import multiple records into the Custom List Translation sublist. In these cases, your CSV file must include a language column and a name column for each needed translation. For example, suppose you want to import Czech and Spanish translations for the name of your custom list. Your file must include four columns for the Custom List Translation sublist: two columns to map to the Language field and two columns to map to the Name field.

When naming your columns, NetSuite recommends that you use the same naming conventions used by the Import Assistant (for example: Custom List Translation 1: Language, Custom List Translation 1: Name, Custom List Translation 2: Language, and so on). With this approach, your columns are automatically mapped. For example, the following table shows how you might use one file to include data for two translations.

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Custom List Translation 1: Language</th>
<th>Custom List Translation 1: Name</th>
<th>Custom List Translation 2: Language</th>
<th>Custom List Translation 2: Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>_listClothes</td>
<td>Clothes</td>
<td>_listClothes</td>
<td>oblečení</td>
<td>Spanish</td>
<td>ropa</td>
</tr>
</tbody>
</table>

The following illustration shows how you populate both sublists using one file. This file would create two custom lists, each with two translations for its name, and each with three values in its list. In this example, you would also be creating two translations for each value in each custom list.

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Custom List Translation 1: Language</th>
<th>Custom List Translation 1: Name</th>
<th>Custom List Translation 2: Language</th>
<th>Custom List Translation 2: Name</th>
<th>Value</th>
<th>Translation: Czech</th>
<th>Translation: Spanish</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Sz</td>
<td>Sizes</td>
<td>Czech</td>
<td>Velikosti</td>
<td>Spanish</td>
<td>Tamaños</td>
<td>Sm</td>
<td>Me</td>
<td>Ma</td>
</tr>
<tr>
<td></td>
<td>Sizes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>St</td>
<td>St</td>
<td>Me</td>
</tr>
<tr>
<td></td>
<td>Sizes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lg</td>
<td>Ve</td>
<td>Gr</td>
</tr>
<tr>
<td>_Cl</td>
<td>Colors</td>
<td>Czech</td>
<td>Barvy</td>
<td>Spanish</td>
<td>Colores</td>
<td>red</td>
<td>červený</td>
<td>rojo</td>
</tr>
<tr>
<td></td>
<td>Colors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>blue</td>
<td>modrý</td>
<td>azul</td>
</tr>
</tbody>
</table>
When you import using a single file, be aware that if your file includes more than one record for the Custom List Translation sublist, the mapping page must include multiple instances of the sublist fields. If you name the columns in your CSV file using the same naming conventions as shown in the table above (with the name of the sublist as a prefix), these instances are created for you automatically.

If you have given the columns different names, you must manually create the additional instances. You can add an extra instance by clicking the plus sign next to the Custom List Translation label.

The reason you create multiple instances is because the system must know how to pair the language-name combinations in your file. The following illustration shows how you might complete your mapping in this situation:

**Common Errors When Importing Custom Lists**

The “Results” file for a failed custom list import might include any of the following messages.

**‘Adding new line to sublist translations is not allowed’**

This error might indicate that you tried to map data to the Custom List Translation sublist when the Multi-Language feature was not properly set up. For imports to this sublist to work, the Multi-Language feature must be enabled, and at least one language must be listed on the Languages subtab at Setup > Company > Enable Features. For more details, see Custom List Translation.

**‘Unable to find a matching line for sublist translations’**

This error might indicate that you created a static mapping for the Language field (using the edit icon on the mapping page) when your CSV file included translations for more than one language. You can use the static mapping successfully only if the CSV file includes translations for one language and no others.
'One of the columns [id, name] must be mapped in the CUSTOMLIST import'

This error might indicate that neither a name, nor an internal or external ID was mapped on the field mapping page of the Import Assistant. For the import to succeed, you must select a reference type, either a name or an ID, and map it to your CSV file content, using the edit icon on the mapping page. For more information about using reference types, see Select Reference Types.

Employees Import Type

For information about employee imports, see the following:

- Employees Import
- Expense Report Import
- Job Import
- Time-Off Change CSV Import
- Track Time Import

Employees Import

The Employees import adds employees to the Employee list.

- Starting from version 2017.1, you can only import employee records if you are logged in with a role that has the Employees permission assigned to it.
- When you import employee records, you can flag employees as sales representatives. This flagging is important if you plan to use CSV import to assign sales representatives to customer records.
- If your account is using NetSuite OneWorld, and if the subsidiary is not set as a default value on the employee record, the Subsidiary field is required for Employees imports when you are creating new records. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. The CSV file value for subsidiaries should be the name of the subsidiary.
- The Employees import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Accrued Time</td>
<td>Selectively updatable based on Payroll Item key field.</td>
</tr>
<tr>
<td></td>
<td>When Payroll feature enabled.</td>
</tr>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Keyed Sublists for CSV Import.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Payroll Contributions</td>
<td>Selectively updatable based on Payroll Item key field.</td>
</tr>
<tr>
<td></td>
<td>When Payroll feature enabled.</td>
</tr>
<tr>
<td>Payroll Deductions</td>
<td>Selectively updatable based on Payroll Item key field.</td>
</tr>
<tr>
<td></td>
<td>When Payroll feature enabled.</td>
</tr>
</tbody>
</table>
### Expenses Import Type

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Earnings</td>
<td>Selectively updatable based on Payroll Item key field.</td>
</tr>
<tr>
<td></td>
<td>When Payroll feature enabled.</td>
</tr>
<tr>
<td>Direct Deposit</td>
<td>Selectively updatable based on Internal ID key field.</td>
</tr>
<tr>
<td></td>
<td>When Direct Deposit feature enabled.</td>
</tr>
<tr>
<td>Education</td>
<td></td>
</tr>
<tr>
<td>Emergency Contacts</td>
<td></td>
</tr>
<tr>
<td>Roles</td>
<td></td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>HCM Position</td>
<td>Available when the HRIS module is enabled.</td>
</tr>
<tr>
<td></td>
<td>By default, the fields on this list are read-only. The following</td>
</tr>
<tr>
<td></td>
<td>fields are writable: Position, Primary Position, and Position</td>
</tr>
<tr>
<td></td>
<td>Allocation.</td>
</tr>
<tr>
<td></td>
<td>You must map a value for the workAssignment field to distinguish</td>
</tr>
<tr>
<td></td>
<td>between a job and a position. By default, the workAssignment field</td>
</tr>
<tr>
<td></td>
<td>is set to job.</td>
</tr>
<tr>
<td></td>
<td>This sublist does not support the import of multiline sublist data.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Importing Sublist Data in a Single File.</td>
</tr>
</tbody>
</table>

For imports that update existing Employee records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

For details about fields that can be mapped in the Employee record, see the SOAP Schema Browser’s employee reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

### Expense Report Import

The expense report record is used to document an employee's expenses for reimbursement. You can create and update expense report records using the CSV Import Assistant.

This record is available for import when the Expense Reports feature is enabled at Setup > Company > Enable Features, on the Employees subtab. When the feature is enabled, the Expense Report option is available in the Record Type list when you set Import Type to Employees.

In the UI, you can view the expense report record by choosing Transactions > Employees > Enter Expense Reports. For details on the process of manually creating an expense report, see the help topic Entering an Expense Report.

For more details on importing expense reports, see the following:

- Expense Report Body Fields
- Expense Report Sublist Fields
- Expense Report CSV Examples
- Common Errors When Importing Expense Reports

For more information about employees and expense reports, see the help topics Employee Information Management and Expense Reporting.
Expense Report Body Fields

Key expense report body fields include the following.

Accounting Approval

The Accounting Approval field can have either of the following values:

- **Yes** — Use this value if you want to give the expense report accounting approval, indicating it is ready to be paid. A value of Yes also makes two other fields, Account and Posting Period, modifiable.
- **No** — Use this value if you do not want to give the expense report accounting approval. A value of No also means that the Account field and the Posting Period field are automatically populated by the system and cannot be modified by the user. In this case, if you try to populate the Account or the Posting Period fields, your mappings are ignored.

Do not use an abbreviation such as "Y" or "N." If you do, the Import Assistant ignores your input and uses the default value, which is No.

For more on the significance of accounting approval, see the help topic Giving Accounting Approval for Expense Reports.

Date

The Date field represents the date that the expense was incurred. Make sure that the format of the date in your CSV file matches your NetSuite date format preference, which is viewable at Home > Set Preferences, under the Formatting heading.

Every expense report record must have a date. Therefore, if you choose the Add data handling option on page 2 of the Import Assistant, and if your CSV file does not include a column named "Date," the system creates a static mapping that uses today's date. If you are creating new records and you do map the Date field to a column in your CSV file, make sure that every row has a value in this column. Otherwise, the Import Assistant does not allow you to proceed past the mapping page. Instead, it displays an error reading in part 'Mandatory Field Missing for field "Date."

If you choose the "Update" operation on page 2 of the Import Assistant, you do not have to include a date value for every record, even if you map to a date column.

Employee

This field must identify an active employee listed at Lists > Employees > Employees. The Employee field is required.

External ID

If appropriate, you can create a unique external ID for this record.

Posting Period

Your ability to map a value for the Posting Period field depends on the value of the Accounting Approval field. That is, if Accounting Approval is set to Yes, you can map a value for Posting Period. When you map a value for posting period, be careful of the formatting in your CSV file. If the field is formatted incorrectly, the operation for that record will fail. If you are using Microsoft® Excel, you may want to set the formatting of the Posting Period column to “Text.” Further, you should make sure that the text of these entries exactly matches the name of the appropriate posting period.
Use Multiple Currencies

The Use Multiple Currencies field is available only if the Multiple Currencies feature is enabled (at Setup > Company > Enable Features, on the Company subtab). For more information, see the help topic Currency Management.

Possible values for the Use Multiple Currencies field are:

- **Yes** — Choosing this value adds three additional fields to the Expenses sublist: Foreign Amount, Currency, and Exchange Rate. In this case, the Currency field is required. You must also enter a value for either Foreign Amount or Amount, as well as the other required sublist field, Category.

- **No** — Choosing this value means that the same currency is applied to all amounts entered. (The currency used is the base currency of the subsidiary the Employee is associated with.) In this case, for every record in the Expenses sublist, there are only two required fields: Amount and Category.

Do not use an abbreviation such as “Y” or “N.” If you do, the Import Assistant ignores your input and uses the default value, which is No.

For More Information

The SOAP Schema Browser includes definitions for all body fields, sublist fields, search filters, and search joins available to this record. For details, see the SOAP Schema Browser’s employee reference page.

**Note:** For information on using the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Expense Report Sublist Fields

You use the Expenses sublist to add or update individual expenses on an expense report record. This sublist can be selectively updated by either the Line ID or Ref No. field.

Accounting Book Detail

The Accounting Book Detail sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.

Amount

The behavior of the Amount field varies depending on the value you choose for the Category field.

In some cases, you might use the Category field to select an expense category record not configured to use the Rate is Required option. In these cases, the handling of the Amount value is fairly straightforward — you must specify an amount either in the Amount field or in the Foreign Amount field. (Note that Foreign Amount is available only if the Use Multiple Currencies body field is set to Yes.)

If the expense category record you choose does have the Rate is Required option selected, then you generally do not populate the Amount field manually. Instead, the Amount value is calculated by the system using the values that you specify for Quantity (which in this case is a required field) and Rate (also...
required in this case, although the field may populate automatically with a default value, which you can override).

If you are using a Tax Code, you need to enter the amount without the tax. The tax amount will be calculated automatically, based on the tax rate, and the sum of the two amounts will appear under Gross Amount.

**Category**

You use the Category field to identify an existing expense category record. Expense category records are listed at Setup > Accounting > Expense Categories. Each category represents a general type of expense (for example, lodging or meals), and a corresponding expense account. A category might also be configured to use the Rate is Required option, which means that any expense that falls into this category is charged according to a flat rate (entered on the expense report) times a quantity.

The Category field is required. For more on expense categories, see the help topic Understanding Expense Categories.

**Currency**

The Currency field is available only if the Use Multiple Currencies body field is mapped to a value of Yes. In these cases, Currency is required.

**Date**

The Date field represents the date that the expense was incurred. Make sure that the format of the date in your CSV file matches your NetSuite date format preference, which is viewable at Home > Set Preferences, under the Formatting heading.

Every sublist record must have a date. Therefore, if you choose a data handling option of Add on page 2 of the Import Assistant, and if your CSV file does not include a sublist column named "Date," the system creates a static mapping that uses today's date. If you are creating new records and you do map the Date field to a column in your CSV file, make sure that every row has a value in this column. Otherwise, the Import Assistant does not allow you to proceed past the mapping page. Instead, it displays an error reading in part 'Mandatory Field Missing for field "Date."

If you choose a data handling option of Update on page 2 of the Import Assistant, you do not have to include a date value for every sublist record, even if you map to a column in your CSV file.

**Foreign Amount**

The Foreign Amount field is available only if the Use Multiple Currencies body field is mapped to a value of Yes.

The behavior of the Foreign Amount field varies depending on the value you choose for the Category field.

In some cases, you might use the Category field to select an expense category record that does not have the Rate is Required option selected. In these cases, you are required to enter an amount either in the Amount field or in the Foreign Amount field.

If the expense category record you choose does have the Rate is Required option selected, then you cannot populate the Foreign Amount field manually. Instead, the amount value is calculated by the system using the values that you specify for Quantity (which in this case is a required field) and Rate (also required in this case, although the Rate field may populate automatically with a default value, which you can override).
Line ID

Line ID is one of the key fields for the Expenses sublist. Line ID is a read-only field. It is not viewable in the UI. However, you can obtain this value using SOAP web services. Alternatively, you can use the Ref No. value to update your expense line. (Ref No. is viewable in the UI.)

Quantity

The Quantity field is available only if you choose an expense category for which the Rate is Required option is selected. In this case, the Quantity field is required. The system uses the product of the Quantity value and the Rate value to populate the Amount field.

Rate

The Rate field is available only if you the Category field points to an expense category for which the Rate is Required option is selected. In this case, you specify a rate, which is used to determine the cost of the item. Note that the expense category may be configured to insert a default rate, which you can change if needed. If the Rate field is available, a value for it is required.

Ref No.

Ref No. is one of the key fields for the Expenses sublist. You can create a value for Ref No. when you create the expense report record. If you do not create a value, the system creates one.

If you create a value, note that it must be unique, and it must be an integer. If you attempt to populate the Ref No. field with an illegal value (such as an alphabetic value), the Import Assistant does not allow you to proceed past the mapping page.

Tax Amount, Tax Code

The availability of the Tax Amount and Tax Code fields varies depending on the nexus that the Employee is associated with. For example, for an employee associated with a US nexus, these fields are not available. For an employee associated with a UK account, these fields are available. If you submit values for these fields when they are not available, the values you submit are ignored.

Tax Code can be country specific taxes, like the Value Added Tax (VAT), Goods and Services Tax (GST), Harmonized Sales Tax (HST) and so on. For more information on Tax Codes, see the help topic Tax Codes Overview.

For More Information

The SOAP Schema Browser includes definitions for all body fields, sublist fields, search filters, and search joins available to this record. For details, see the SOAP Schema Browser’s expense report reference page.

Note: For information on using the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Expense Report CSV Examples

When importing expense reports, you can use multiple-file or single-file upload techniques.
Multiple Files CSV Example

With a multiple-file import, you use one file for the expense report body fields and another file for the Expenses sublist fields. The file holding the body data must include, at a minimum, a value in the Employee field. An External ID is also recommended. For example:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Smith, John</td>
</tr>
<tr>
<td>102</td>
<td>Brown, Jane</td>
</tr>
<tr>
<td>103</td>
<td>Martin, Ann</td>
</tr>
</tbody>
</table>

Each row in the second file must include values for the Category field and, typically, for the Amount field. (If the body data for the record has Use Multiple Currencies set to No, which is the default, then Amount is required.)

Each sublist record must also include a unique identifier that links the sublist record to an entry in the main file. The following example uses the External ID field for this purpose.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Amount</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>25</td>
<td>Meals</td>
</tr>
<tr>
<td>101</td>
<td>756</td>
<td>Transportation</td>
</tr>
<tr>
<td>102</td>
<td>12.50</td>
<td>Meals</td>
</tr>
<tr>
<td>102</td>
<td>389</td>
<td>Lodging</td>
</tr>
<tr>
<td>103</td>
<td>488.50</td>
<td>Training</td>
</tr>
</tbody>
</table>

Multi-Files Example Using Multiple Currencies

In the following example, two import files are used to import expense reports that contain expenses in multiple currencies. In this case, your main import file might look as follows.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Date</th>
<th>Employee</th>
<th>Use Multiple Currencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
<td>8/14/2017</td>
<td>Agneta Simpson</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The linked file for the Expenses sublist might look as follows. When you map these fields to the fields of the expenses sublist, map the external ID to the Line ID field, and map Line Reference Number to Ref No.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Line Reference Number</th>
<th>Category</th>
<th>Amount</th>
<th>Currency</th>
<th>Date</th>
<th>Tax Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
<td>1</td>
<td>Entertainment</td>
<td>450</td>
<td>CA CAD</td>
<td>8/14/2017</td>
<td>CA-Zero</td>
</tr>
<tr>
<td>321</td>
<td>2</td>
<td>Travel</td>
<td>300</td>
<td>US USD</td>
<td>8/14/2017</td>
<td>CA-Zero</td>
</tr>
</tbody>
</table>

Single File CSV Example

With a single-file import, all data for each expense report record must exist on a single row. For this reason, if the sublist data for any expense report record includes more than one expense, you must create a discrete set of columns for each expense. For example, the following sample would create three expense report records. The first two records would each have two expenses and the third would have only one.
When naming your columns, it's recommended that you use the same naming conventions used by the Import Assistant, so that your columns automatically map. For this to happen, each sublist column should have prefixes that begin with “Expense List Expenses” — for example “Expense List Expenses 1:“, “Expense List Expenses 2:“, and so on).

### Common Errors When Importing Expense Reports

The “Results” file for a failed expense report import might include any of the following messages.

#### ‘Please enter value(s) for: Amount’

This error can indicate that you failed to provide a value for one of the following sublist fields:

- **Amount**
- **Rate**
- **Quantity**

Problems with any of these fields are referred to as problems with “Amount” because, depending on the exact details of the record, all of these fields can be critical for determining the amount of the expense.

#### ‘You must enter at least one line item for this transaction’

This error indicates that you failed to include sublist data for every expense report record. Each expense report record must have at least one sublist record. If you are doing a multiple-file import, this error might point to a problem with the key column you are using to link the files. For example, one of the files might include a typo in this column, preventing proper linking of the expense report's body data to its sublist data.

#### ‘Invalid postingperiod reference key for subsidiary 1’

This error indicates a problem with the Posting Period value. Double-check that you entered the name of an existing posting period. After you have done that, make sure that your CSV files formatting is not set up to add any punctuation or special handling to the text in this column. If you are using Microsoft® Excel, you may want to set the formatting of the Posting Period column to “Text.”

### Job Import

**Important:** This topic describes a feature that is currently available only in some customer accounts. For information on the availability of this feature for your account, please contact your NetSuite account manager.

The job record is available when the Job Management feature is enabled on the Setup > Company > Setup Tasks > Enable Features.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Smith, John</td>
<td>25</td>
<td>Meals</td>
<td>756</td>
<td>Transportation</td>
</tr>
<tr>
<td>102</td>
<td>Brown, Jane</td>
<td>12.50</td>
<td>Meals</td>
<td>389</td>
<td>Lodging</td>
</tr>
<tr>
<td>103</td>
<td>Martin, Ann</td>
<td>488.50</td>
<td>Training</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In the user interface, you can access the job record at Setup > HR Information System > Jobs. For information about working with this record in the user interface, see the help topic Managing Jobs.

To import job records, set the Import Type to Employee and the Record Type to Job in the first step of the Import Assistant.

The job import does not contain any sublist fields.

For details about fields that can be mapped in the job record, see the SOAP Schema Browser’s HCM job reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

After the import is complete, you can assign employees to the newly created or updated jobs. For more information, see the help topic Assigning Employees to Jobs.

**Job Import Example**

The following example shows a job import where two new jobs are added.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Job Title</th>
<th>Employment Category</th>
<th>Inactive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6542</td>
<td>Senior Sales Engineer</td>
<td>Full-time</td>
<td>F</td>
<td>Sales engineer with 5+ years of experience</td>
</tr>
<tr>
<td>6543</td>
<td>QA Intern — Summer</td>
<td>Part-time</td>
<td>T</td>
<td>Summer intern — active from July 1</td>
</tr>
</tbody>
</table>

For updating job records, you must map an external ID, an internal ID, or the job title in the field mapping page of the import assistant.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Job Title</th>
<th>Employment Category</th>
<th>Inactive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6542</td>
<td>Senior Sales Engineer</td>
<td>Full-time</td>
<td>F</td>
<td>Sales engineer with 10+ years of experience</td>
</tr>
<tr>
<td>6543</td>
<td>QA Intern — Fall</td>
<td>Part-time</td>
<td>F</td>
<td>Fall intern — active from September 1</td>
</tr>
</tbody>
</table>

**Time-Off Change CSV Import**

**Important:** This topic describes a feature that is currently available only in some customer accounts. For information on the availability of this feature for your account, please contact your NetSuite account manager.

You can import time-off change CSV data when the Time-Off Management feature is enabled at Setup > Company > Setup Tasks > Enable Features. Under the Employees subtab, check the Time-Off Management box. For more information about time-off changes, see the help topic Viewing Time-Off Changes.

**Time-Off Change Fields**

To prepare time-off change CSV data for import, make sure that your CSV file includes the following fields.

- **External ID** — Used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports. This field is recommended, but not required.
Employees Import Type

- Employee — Name of the employee. A record for the employee must exist in the account.
- Time-Off Type — The time-off type must already exist in the account.
- Amount — The number of days or hours for this time-off.
- Time-Off Time Unit — Use Days or Hours. After the record is saved, the time-off unit is automatically changed to hours. For any amount entered in days, the time-off unit type is changed to hours and the Amount value is converted to hours. For example, seven days, is converted to 56 hours when saved.
- Date Applied — Date when the time-off change was applied.

CSV File Example

The following table shows how you might structure a file for importing time-off change data in a CSV file.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Employee</th>
<th>Time-Off Type</th>
<th>Amount</th>
<th>Time-Off Time Unit</th>
<th>Date Applied</th>
<th>Time-Off Request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOC-EMP-398</td>
<td>Jennifer Sanders</td>
<td>Vacation</td>
<td>7</td>
<td>Days</td>
<td>07/01/2015</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>TOC-EMP-400</td>
<td>Julie Bauer</td>
<td>Vacation</td>
<td>4</td>
<td>Days</td>
<td>09/01/2015</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>TOC-EMP-402</td>
<td>Daniel White</td>
<td>Vacation</td>
<td>5</td>
<td>Days</td>
<td>08/15/2015</td>
<td>43</td>
<td>Summer Vacation</td>
</tr>
</tbody>
</table>

Importing a Time-Off Change CSV Table

To import time-off change CSV data:

1. Go to Setup > Import/Export > Import Tasks > Import CSV Records.
2. In the Import Assistant, choose Employees as the Import Type, and Time-Off Change as the Record Type.
3. Click Select and specify the CSV file you want to import. Click Next.
4. Select the appropriate data handling for your import. In most cases you will add new time-off change records. Click Next.
5. Review the field mappings to make sure that your CSV data fields map into NetSuite fields.
6. Click Next and follow the assistant's instructions.

For more information about using the import assistant and importing CSV records, see the help topics Importing CSV Files with the Import Assistant and Guidelines for CSV Import Files.

Track Time Import

The track time record is used to keep track of hours worked by an employee. You can create and update track time records using the CSV Import Assistant.

This record is available for import when the Time Tracking feature is enabled at Setup > Company > Enable Features, on the Employees subtab.

In the UI, you access the track time record by choosing Transactions > Employees > Track Time. For details on how to manually create a record, see the help topic Entering a Time Transaction.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.
To import track time records, set the import type to Employees, and the record type to Track Time.

For more on importing track time records, see the following:

- **Track Time Body Fields**
- **Track Time CSV Example**

**Track Time Body Fields**

The following table describes some of the body fields available for mapping when you create a new track time record using the CSV Import Assistant.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The posting date of the transaction. Note that the date value should be specified according to the NetSuite formatting preferences of the person doing the import. You can view this preference at Home &gt; Set Preferences.</td>
<td>Yes, but if you do not include a date, the system creates a default mapping to today’s date.</td>
</tr>
<tr>
<td>Duration</td>
<td>The number of hours the employee worked.</td>
<td>Yes</td>
</tr>
<tr>
<td>Employee</td>
<td>The employee ID of the person whose time is being logged. This value must point to an active employee listed at Lists &gt; Employees &gt; Employees.</td>
<td>Yes</td>
</tr>
<tr>
<td>External ID</td>
<td>A unique identifier that can be used to update the record.</td>
<td>No</td>
</tr>
<tr>
<td>Location (if the Locations feature has been enabled)</td>
<td>A location specified at Setup &gt; Company &gt; Locations.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Additional fields are also available. For details, see the SOAP Schema Browser’s time bill reference page. For information on using the SOAP Schema Browser, see the help topic [SOAP Schema Browser](#).

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see [Select a Record Type for Import](#) and [Choose Import Character Encoding](#).

**Track Time CSV Example**

The following table shows how you might format your CSV file when importing track time records.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Employee</th>
<th>Duration</th>
<th>Date</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>111A</td>
<td>Smith, John</td>
<td>8.0</td>
<td>8/16/13</td>
<td>East Coast</td>
</tr>
<tr>
<td>112A</td>
<td>Carter, Susan</td>
<td>8.0</td>
<td>8/16/13</td>
<td>East Coast</td>
</tr>
<tr>
<td>113A</td>
<td>Doe, Jane</td>
<td>8.0</td>
<td>8/16/13</td>
<td>East Coast</td>
</tr>
<tr>
<td>114A</td>
<td>Miller, James</td>
<td>4</td>
<td>8/16/13</td>
<td>East Coast</td>
</tr>
</tbody>
</table>

**Items Import**

Item records allow you to track and manage the goods and services your company buys and sells in the course of doing business.
For a list of the types of items that you can add or update with the Import Assistant, see Item Record Types that Can Be Imported.

For a table of item sublist data that can be imported, see Item Sublists Available for Import.

To review issues you may encounter when you import Items data, see Notes about Items Imports and Selecting General Ledger Accounts for Item Imports.

If the Demand Planning feature is enabled in your account, review Importing Demand Planning Data for Items for information about importing related data.

If the Web Site feature is enabled in your account, review Importing Related Items Groups.

For information about using the Import Assistant to set up matrix options for items, see Importing Matrix Options for Items.

For tips about importing price levels for items, see Importing Pricing Data for Items.

For an example of replacing the contents of a sublist with the content from the CSV import, see Replacing the Bill of Materials Sublist with the CSV File.

**Important:** Because the Quantity on Hand field is not available for entry on NetSuite user interface Item forms, CSV imports can add Quantity on Hand values for new item records being imported, but cannot update Quantity on Hand values for existing NetSuite item records. The Quantity on Hand field should only be available on the Field Mapping page for Adds, but currently may appear for Updates as well. If you map this field for an update, currently no error occurs, but Quantity on Hand field values are not updated.

For details about fields that can be mapped in Item records, refer to the SOAP Schema Browser, which has a reference page for each supported item type. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Item Record Types that Can Be Imported**

The Items import type provides the ability to import the following NetSuite items record types, as shown in the Record Type dropdown list on the first page of the Import Assistant.

- Assembly/BOM Item
  - Lot Numbered Assembly/BOM Item
  - Serialized Assembly/BOM Item
- Description Item
- Discount Item
- Inventory Item (Not supported in NetCRM), including:
  - Lot Numbered Inventory Item
  - Serialized Inventory Item

**Important:** For OneWorld accounts, the import of inventory item historical data dated prior to the date of the OneWorld upgrade in your account is not supported. To maintain accurate inventory information, you should import only data that is dated later than the OneWorld upgrade and initial Multi-Location Inventory distribution.

- Item Group
- Kit/Package Item
- Markup Item
- Non-Inventory Item, including:
  - for Purchase
  - for Resale
  - for Sale
- Other Charge Item, including:
  - for Purchase
  - for Resale
  - for Sale
- Payment Item
- Service Item, including:
  - for Purchase
  - for Resale
  - for Sale
- Subtotal Item

**Note:** You can use the Import Assistant to import matrix options for Inventory Item, Non-Inventory Item, and Service Item imports, but you need to use the NetSuite user interface to set up possible matrix options as custom lists and custom item fields before you can complete an import of matrix item options. For information about importing matrix options for items, see Importing Matrix Options for Items. For general information about matrix items in NetSuite, see the help topic Matrix Items.

For details about fields that can be mapped in item records, refer to the SOAP Schema Browser, which includes a reference page for supported item types. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Item Sublists Available for Import

Item sublist data supported for import varies according to the type of item data to be imported, and the related features enabled. The following table indicates these limitations:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bills of Materials</td>
<td>Available for the following import types:</td>
</tr>
<tr>
<td></td>
<td>- Assembly Item</td>
</tr>
<tr>
<td></td>
<td>- Serialized Assembly Item</td>
</tr>
<tr>
<td></td>
<td>- Lot Numbered Assembly Item</td>
</tr>
<tr>
<td></td>
<td>Available if the Advanced Bill of Materials feature is enabled at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features (Administrator), on the Items &amp; Inventory subtab.</td>
</tr>
<tr>
<td>Bin Numbers</td>
<td>When Bin Management feature or Advanced Bin/Numbered Inventory Management enabled.</td>
</tr>
<tr>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Items Import</td>
<td>Selectively updatable based on Bin Number key field. For Assembly/BOM Item and Inventory Item imports.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are importing bin records, you should complete this import before you import items with associated bin numbers. See Bin Import.</td>
</tr>
</tbody>
</table>

Locations

- When Multi-Location Inventory feature enabled.
- Selectively updatable based on Internal ID, External ID, or Location. (See Updating Locations on Items.)
- For Assembly/BOM Item and Inventory Item imports.

Members

- For Assembly/BOM Item, Item Group, and Kit/Package Item imports.

Merchandise Hierarchy

- Available for the following item types:
  - Inventory Item
  - Lot Numbered Inventory Item
  - Serialized Inventory Item
- Available if the Merchandise Hierarchy feature is enabled at Setup > Company > Setup Tasks > Enable Features, on the Items & Inventory subtab.

Pricing

- When any of Multiple Prices, Quantity Pricing, or Multiple Currencies feature enabled.
- Selectively updatable based on fields of Currency, Quantity, and Level, depending on enabled features (See Keys for Item Pricing Sublist.)

Related Items

- When Web Site feature enabled.
- Not available for Non-Inventory Item for Purchase, Service Item for Purchase, Other Charge Item imports.
- For more information, see Importing Related Items Groups.

Site Category

- When Web Site feature enabled.
- Not available for Non-Inventory Item for Purchase, Service Item for Purchase, Other Charge Item imports.

Task Templates

- When Project Management feature enabled.
- For Service Item for Sale imports.

Translation

- When Multi-Language feature enabled.
- Selectively updatable based on Language key field.

Vendors

- When Multiple Vendors feature enabled.
- Selectively updatable based on Vendor key field.
- For Inventory Item, Non-Inventory Item for Resale or Purchase, Service Item for Resale or Purchase, and Other Charge Item for Resale or Purchase imports, and Assembly/BOM Item when Allow Purchase of Assembly Items preference is enabled.
- Note that if multiple vendors are defined as preferred, the last one listed is the only one marked preferred by the import.
- See Updating Vendors on Items.

Every sublist on each record can optionally have a separate file. For imports that update existing Item records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced CSV Imports.
option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Notes about Items Imports

The following information may apply to your items imports:

- Import of Inventory Detail Data Currently Not Supported
- Unique Item Lookups by Internal ID and External ID
- Updating Inventory with Imported Items Data
- Updating Vendors on Items
- Updating Locations on Items

Import of Inventory Detail Data Currently Not Supported

When the Advanced Bin / Numbered Inventory Management feature is enabled, the following types of items include an Inventory Detail subrecord in the user interface: Assembly/BOM Item (when Use Bins is set to True), Lot Numbered Assembly/BOM Item, Serialized Assembly/BOM Item, Inventory Item (when Use Bins is set to True), Lot Numbered Inventory Item, and Serialized Inventory Item.

The Inventory Detail subrecord includes quantity on hand and quantity available values per bin number and/or per serial/lot number. Import of this subrecord’s data is not currently supported. If you enable the Advanced Bin / Numbered Inventory Management feature, CSV import of the types of items listed above may result in incomplete data. For details about this feature, see the help topic Advanced Bin / Numbered Inventory Management.

Unique Item Lookups by Internal ID and External ID

To help eliminate ambiguous or missed lookups, the Import Assistant lets you reference an Item’s Internal ID or External ID.

- The Internal ID can be obtained by performing an Item saved search and exporting the results to CSV.
- The External ID is similar to handle, and can be set to any string during add, but must be unique across all items.

For more information, see Select Reference Types.

Updating Inventory with Imported Items Data

After you have completed an import of items, you can use the Adjust Inventory Worksheet to update inventory levels. For more information, see the help topic Adjusting Inventory.

Updating Vendors on Items

You can use the Import Assistant to update Vendor sublist information for items. For these updates, depending upon your setting for the Overwrite Sublists option, you can overwrite items’ existing vendors sublists, or you can selectively update based on a key of Vendor name.
You also can use an alternate method to set preferred vendors for items through a CSV import. The Import Assistant supports the addition of a Preferred Vendor column to an Items CSV file. If the vendor specified in this field currently is on the vendor list, the import marks it as preferred; if it is not on the list, the import adds it. This method is available whether or not the Multiple Vendors feature is enabled.

**Important:** If your CSV file defines more than one vendor as preferred for an item, the last vendor listed is the one that is marked as preferred by the import.

### Updating Locations on Items

You can use the Import Assistant to update location sublist information for items, when the Multi-Location Inventory feature is enabled. The fields that are updatable per location are Preferred Stock Level, Quantity on Hand, and Reorder Point. Also, if the Demand Planning feature is enabled, additional demand planning fields are available for items where the Time Phased replenishment method is used. See Selecting General Ledger Accounts for Item Imports.

After you have completed an import of items for multiple locations, you can use the Transfer Inventory form or Transfer Orders to move inventory among locations as necessary. For information, see the help topic Transferring Inventory.

The Location sublist is a keyed sublist, based on Internal ID, External ID, or Location name. Updates of this sublist vary depending upon your setting for the Overwrite Sublists option.

### Importing Default ATP Method Data

As of 2017.1, you can use the Import Assistant to import default available to promise (ATP) methods when you import inventory items, and you have the Available to Promise feature enabled in your account. For information about the Available to Promise feature, see the help topic Available to Promise.

### Selecting General Ledger Accounts for Item Imports

Different item types have different accounting requirements and considerations. If you are setting up your account for the first time, you should review this topic and consider creating General Ledger (GL) accounts before you import items.

In regard to their General Ledger (GL) impact, item types fall into two categories:

- Some item types have no accounting component.
- Some item types can optionally be created as posting items that require an account, or as non-posting items that do not.

For items in the second category, note that if you choose to make them non-posting, they cannot be used on transactions and have no direct impact on your General Ledger. However, you might choose to make items non-posting if they are to be used as parent items, or as components of kits and assemblies.

The following table summarizes the primary accounting considerations for each item type that can be imported. Note that, for those item types that can be associated with one or more accounts, the list of valid account types you can choose from varies depending on whether the Expand Account Lists option has been enabled. If enabled (at Setup > Accounting > Accounting Preferences), Expand Account Lists let you choose from a greater number of account types than would otherwise be available. Except where noted, the table below assumes that you do not have this preference enabled. Note also that this table summarizes only the minimal accounting components that exist. Some items have additional optional accounting choices. For full details, see the help topic for the relevant item.
Map your account fields with some care. If you map to an account that is not considered valid for the item type, the import fails with an “invalid account reference key” error. Of course, if you already have your accounts set up, you can double-check which accounts are valid by referring to the various Account lists on the forms where you manually create items.

<table>
<thead>
<tr>
<th>Item Type/Subtype</th>
<th>Accounting Component?</th>
<th>Valid Account Types to Choose when Adding</th>
<th>Valid Account Changes when Updating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly/Bill of Materials</td>
<td>Yes, but you can make the item non-posting by mapping the Cost of Goods Sold (COGS), Asset, and Income account fields to values of “null” (all lowercase) in your CSV file, or creating default values of null on the mapping page.</td>
<td>Cost of Goods Sold (COGS), Asset, and Income</td>
<td>You can update only to the same type of account selected when the record was created. For example, if you chose an expense account originally, the update can be only to another expense account. With Expand Account Lists enabled, the Account field can be updated to a different account type other than the one chosen when the item record was created.</td>
</tr>
<tr>
<td>Discount</td>
<td>Yes, but you can avoid entering an account by mapping the Non-Posting field to Yes. You can do this either by mapping to a Non-Posting column in your CSV file or creating a default value on the mapping page.</td>
<td>Expense or Income</td>
<td></td>
</tr>
<tr>
<td>Inventory</td>
<td>Yes, but you can make the item non-posting by mapping the Cost of Goods Sold (COGS), Asset, and Income account fields to values of “null” (all lowercase) in your CSV file, or creating default values of null on the mapping page.</td>
<td>Cost of Goods Sold (COGS), Asset, and Income</td>
<td></td>
</tr>
<tr>
<td>Item Group</td>
<td>No</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>Kit/Package</td>
<td>Yes, but you can make the item non-posting by mapping the Income account field to a value of “null” (all lowercase) in your CSV file, or creating a default value of null on the mapping page.</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>Markup</td>
<td>Yes, but you can avoid entering an account by mapping the Non-Posting field to Yes. You can do this either by mapping to a Non-Posting column in your CSV file or creating a default value on the mapping page.</td>
<td>Expense or Income</td>
<td>You can update only to the same type of account selected when the record was created. For example, if you chose an income account originally, the update can be only to another income account. With Expand Account Lists enabled, the Account field can be updated to a different account type.</td>
</tr>
</tbody>
</table>
### Importing Demand Planning Data for Items

The Demand Planning feature supports the use of demand plan and supply plan records to track anticipated supply and demand for inventory and assembly/BOM items. When this feature is enabled, you can include demand planning data in inventory items imports. If the Work Orders feature is also enabled, you can include demand planning data in assembly/BOM items imports.

**Note:** You also can import data from Item Demand Plan transactions. See Item Demand Plan Import.

The Import Assistant supports the import of values for the following fields related to demand planning. Review the notes in the following table before setting up your CSV files and mapping these fields on the Import Assistant Field Mapping page. It is also recommended that you read the help topics Demand Planning and that you review details about other items record fields in the SOAP Schema Browser.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replenishment Method</td>
<td><strong>Reorder Point</strong> is the default value for this field. You must set a value of <strong>Time Phased</strong> for each item you want to use with Demand Planning. When this value is set:</td>
</tr>
<tr>
<td></td>
<td>- Orders are created based on item demand plans instead of the Advanced Inventory Management settings.</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Alternate Source Item</strong></td>
<td>An alternate item to be used as the source of historical sales data used for demand planning. When this field is left blank, the source for historical data is the original item.</td>
</tr>
<tr>
<td><strong>Lead Time</strong></td>
<td>The average number of days between ordering this item from the vendor and receiving it. If no value is set, the default value from the Inventory Management Preferences page is used.</td>
</tr>
<tr>
<td><strong>Auto-Calculate Lead Time</strong></td>
<td>Boolean indicating whether lead time is auto-calculated or based on a value set in the Lead Time field. By default set to True.</td>
</tr>
<tr>
<td><strong>Safety Stock Level</strong></td>
<td>The amount of an item that should be kept in stock at all times. When the Replenish Method field is set to Time Phased, this value can only be defined as a quantity of items, not as a number of days supply. If no value is set, the default value from the Set Up Inventory Management page is used.</td>
</tr>
<tr>
<td><strong>Expected Demand Change</strong></td>
<td>Used when an item's demand plan forecast method is set to Seasonal Change. The percentage used to augment the forecasted amount according to seasonal variations in demand. Format is numeric; you do not need to include the % sign, for example: 32.5.</td>
</tr>
</tbody>
</table>
| **Lot Sizing Method**         | Possible values are:  
  - **Lot For Lot** – Orders are suggested for procurement based on the exact projections for that day. The suggested order quantity may vary from day to day depending on demand calculations.  
  - **Fixed Lot Size** – Orders are suggested for procurement based on a fixed amount or a multiple of the fixed amount.  
  - **Periods of Supply** – Select this option to generate aggregated purchase orders or work orders based on the overall demand requirements extended over a designated period, such as weekly or monthly. |
<p>| <strong>Fixed Lot Size</strong>            | Used when Lot Sizing Method is set to Fixed Lot Size. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items Import</td>
<td><strong>Notes:</strong> If the Multi-Location Inventory feature is enabled, this field is in the Locations sublist on the Field Mapping page, and can have different values per location.</td>
</tr>
<tr>
<td>Periodic Lot Size Type</td>
<td>If you selected Periods of Supply as the lot sizing method, then make a selection in the Periodic Lot Size Type field:</td>
</tr>
<tr>
<td></td>
<td>■ Interval – Order aggregation starts when a requirement is established and continues for a fixed period defined in the Interval field.</td>
</tr>
<tr>
<td></td>
<td>■ Monthly – Order aggregation starts at the beginning of each month. The requirement date is always the first day of each month.</td>
</tr>
<tr>
<td></td>
<td>■ Weekly – Order aggregation starts at the beginning of each week. The requirement date is always the first day of the week as defined under Company Settings.</td>
</tr>
<tr>
<td>Periodic Lot Size Increment</td>
<td>In the Periodic Lot Size Increment field, enter a number from 1 to 90. The increment starts on the first day an order is required. From the first day, NetSuite aggregates all orders in the increment. Orders are placed on the first day of the period.</td>
</tr>
<tr>
<td>Supply Type</td>
<td>This field's value can only be set for assembly items when the Allow Purchase of Assembly Items preference is enabled at Setup &gt; Accounting &gt; Accounting Preferences. In this case, the value can be either <strong>Build</strong> or <strong>Purchase</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Multi-Location Inventory feature is enabled, this field is in the Locations sublist on the Field Mapping page, and can have different values per location.</td>
</tr>
<tr>
<td>Demand Source</td>
<td>Determines where demand data is sourced for an item. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Forecast from Demand Plan</strong> – Demand is sourced only from the item's demand plan record.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Entered and Planned Orders</strong> – Demand is sourced from open orders and the expected ship date is used as the demand date. (If the item is a member of an assembly, demand for the assembly is included in demand calculations for the item.)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Multi-Location Inventory feature is enabled, this field is in the Locations sublist on the Field Mapping page, and can have different values per location.</td>
</tr>
<tr>
<td>Preferred Stock Level</td>
<td>The Demand Source field determines where demand data is sourced for an item. Possible values are:</td>
</tr>
<tr>
<td></td>
<td><strong>Forecast from Demand Plan</strong> – Source only the item's demand plan record.</td>
</tr>
<tr>
<td></td>
<td><strong>Entered and Planned Orders</strong> – Source open orders and use the expected ship date as the demand date. If the item is a member of an assembly, demand for the assembly is included demand calculations for the item.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
</table>
| **Order and Forecast** – Calculates demand for an item by including both the forecast amount and the amount on orders that have been entered.  
  - Forecast demand for an item is calculated by combining the following: (Quantity forecast over time) + (quantity on sales orders and invoices entered)  
  - The total forecast includes the forecast demand and the actual demand order quantities from transfer orders, work orders, and sales orders.  

**Forecast Consumption** – Calculates demand for an item by subtracting from the forecast quantity any item quantities on orders entered. This removes duplication if an order is already included as part of a forecast.  
  - Demand for an item is calculated as follows: (Quantity forecast over time) - (Quantity on sales orders and invoices entered) |

**Note:** If the Multi-Location Inventory feature is enabled, this field is in the Locations sublist on the Field Mapping page, and can have different values per location.

### Importing Related Items Groups

Related items groups are defined for items in Web stores to cross-sell items that complement each other. The Import Assistant supports the import of related item sublist data for item records when the Web Site feature is enabled.

On the Import Assistant Field Mapping page, you must map two fields for the Related Items sublist: Item and Type.

The Item field represents the item name that appears in the browser, whereas the Type field indicates the NetSuite type of relation, for example File Cabinet Item, Information Item, Item, Presentation Category Item.

- To see available values for the Type field, create a new item in the browser, go to the Related Items subtab, and click the List button for the Item field. The top of the popup displays a dropdown list of available values for the Type field.
- You can include Type values in your CSV files, and/or select a default value for Type on the Field Mapping page by clicking the edit icon.

In the Default Value popup, select a default Type value (File Cabinet Item, Information Item, Item, or Presentation Category) from the dropdown list next to the Provide Default Value option.
Note the following:

- For an import job that includes large numbers of related item records, the upload of multiple CSV files is recommended.
- Import of related items is not supported for Non-Inventory Item for Purchase, Service Item for Purchase, or any Other Charge Item imports.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Importing Matrix Options for Items

You can use the Import Assistant to add matrix options for some types of item records. You can do this import instead of using the Matrix Item Assistant or creating matrix items manually.

An item matrix, which enables tracking your items by options such as size and color, consists of a parent item and subitems, or children. Each individual combination of matrix options is stored as a separate item record. For example, a parent item record for a sweater could have a list of subitems, with each subitem record representing a different size and color combination.

You can import parent and child item records together in a single CSV file. A limit of 2000 child matrix items is permitted for each parent matrix item.

- Item Types that Support Matrix Options Import
- Prerequisites for Importing Matrix Items
- Setting Up Custom Lists and Item Fields for Matrix Options
- Setting Up Your CSV File for Matrix Items Import
- Mapping Fields for Matrix Items Import
- Tips for Matrix Items Import

Note: For general information about matrix items in NetSuite, see the help topic Matrix Items.

Item Types that Support Matrix Options Import

You can import matrix options for the following types of items:

- Assembly/Bill of Materials
- Lot Numbered Assembly
- Serialized Assembly
- Inventory Item
- Lot Numbered Inventory Item
- Serialized Inventory Item
Prerequisites for Importing Matrix Items

Before you can import matrix items, you must do the following:

- Ensure that the Matrix Items feature is enabled, at Setup > Company > Enable Features, on the Items & Inventory subtab.
- Set up a custom list and a custom item field for each matrix option, at Setup > Customization > Lists > New and . (See detailed instructions below.)

Setting Up Custom Lists and Item Fields for Matrix Options

Before you import matrix items, you need to set up a custom list and a custom item field for each matrix option. Each custom list represents a matrix option such as size or color, and includes the set of possible values for that option. Each custom item field provides an interface for display and selection of that matrix option on item forms. The matrix options that you have set up in this manner are displayed on the Import Assistant's Field Mapping page as fields to be mapped.

To set up a custom list for a matrix option:

1. Go to Setup > Customization > Lists > New.
2. Enter a name for the option, choose the display order for option values, check the Matrix Option List box, add the values that you want to be available for that option, and click Save.

For more information, see the help topic Setting Up Custom Lists.
To set up a custom item field for a matrix option:

1. Go to Setup > Customization > Item Fields > New.
2. On this page, do the following:
   a. Enter the name of a custom list in the Label field.
   b. Check the Matrix Option box.
   c. Select the custom list from the List/Record list.
   d. On the Applies To subtab check the boxes for the types of items that can have this matrix option.
   e. Click Save.

Setting Up Your CSV File for Matrix Items Import

The CSV file containing your matrix items data should include columns that map to the following fields. For best results, set the column headers to match these field names.

- External ID: Recommended for all CSV imports, to serve as a unique identifier for each record.
- Item Name/Number: Name for each matrix item.
- Matrix Type: Possible values for this column are Parent Matrix Item, Child Matrix Item.
- Subitem of: For each child matrix item, this column's value is the name of the parent matrix item. For each parent matrix item, this column is blank.
- Columns that map to custom lists, such as Color, Size. Values for these columns should match those in the custom lists you set up.

Your CSV file also can include columns that map to other Item record fields.

⚠️ Important: In CSV import, updating parent item values for the Asset Account, Cost of Goods Sold (COGS) account, or Income Account fields does not automatically update child item field values. You need to set these values for each child item row. The system does not enforce that child item values match the parent item values for these fields, so you need to ensure that they match yourself.

The following table shows the contents of a sample matrix items CSV file. Notice that the parent matrix item is an individual record, and each child matrix item also is an individual record.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item Name/Number</th>
<th>Display Name/Code</th>
<th>Color</th>
<th>Size</th>
<th>Matrix Type</th>
<th>Subitem of</th>
</tr>
</thead>
<tbody>
<tr>
<td>12000</td>
<td>CottCrewSweat</td>
<td>Cotton Crewneck</td>
<td></td>
<td></td>
<td>Parent Matrix Item</td>
<td></td>
</tr>
</tbody>
</table>
## Mapping Fields for Matrix Items Import

On the Import Assistant Field Mapping page, you need to map CSV file columns to NetSuite fields, so that data is imported into records correctly. For a matrix items import, the key fields that you need to map are:

- Item Name/Number
- Matrix Type
- Subitem of
- Each matrix option field

Depending on your CSV file column names, the first three fields may be mapped automatically. You must manually map each matrix option field. Notice that in the NetSuite Fields pane, matrix option fields have names with the format `Matrix Option - <Custom_List_Name>`.

The following screenshot shows a sample mapping for a matrix items import:

![Sample Mapping for Matrix Items Import](image)

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item Name/Number</th>
<th>Display Name/Code</th>
<th>Color</th>
<th>Size</th>
<th>Matrix Type</th>
<th>Subitem of</th>
</tr>
</thead>
<tbody>
<tr>
<td>12011</td>
<td>CottCrewSweat-ES</td>
<td>Cotton Crewneck Sweater</td>
<td>Ecru</td>
<td>S</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
<tr>
<td>12012</td>
<td>CottCrewSweat-EM</td>
<td>Cotton Crewneck Sweater</td>
<td>Ecru</td>
<td>M</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
<tr>
<td>12021</td>
<td>CottCrewSweat-RS</td>
<td>Cotton Crewneck Sweater</td>
<td>Rose</td>
<td>S</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
<tr>
<td>12022</td>
<td>CottCrewSweat-RM</td>
<td>Cotton Crewneck Sweater</td>
<td>Rose</td>
<td>M</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
<tr>
<td>12031</td>
<td>CottCrewSweat-SS</td>
<td>Cotton Crewneck Sweater</td>
<td>SkyBlue</td>
<td>S</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
<tr>
<td>12032</td>
<td>CottCrewSweat-SM</td>
<td>Cotton Crewneck Sweater</td>
<td>SkyBlue</td>
<td>M</td>
<td>Child Matrix Item</td>
<td>CottCrewSweat</td>
</tr>
</tbody>
</table>
**Tips for Matrix Items Import**

- When you select matrix options for a parent in the NetSuite user interface, child matrix items are created automatically. The CSV import process is different. Each parent matrix item and each child matrix item must be added or updated individually, and the CSV file should include a separate line for each parent matrix item and child matrix item. Otherwise, the rules for creation of matrix items in the NetSuite user interface generally also apply to matrix items imports.

- Each child matrix item can have separate pricing data.

- A limit of 2000 child matrix items are permitted for each parent matrix item.

- You can use the Import Assistant to add child matrix items to existing parent matrix items. Use the Subitem of field to store the value of the parent matrix item for each child.

- The following limitations apply to updates of matrix items with the Import Assistant:
  - You cannot change matrix option values for existing child matrix items.
  - You cannot change the parent matrix item (Subitem of value) for existing child matrix items.
  - You cannot change the matrix type value for existing matrix items.
  - Unlike in the user interface, matrix items imports cannot update child matrix items as a group in the parent item record. Each child matrix item record must be updated individually.

- You cannot use the Import Assistant to delete matrix options.

- In the user interface, child matrix items inherit Units Type field values from parent matrix items. However, items imports set Units Type field values separately on parent and child matrix items. You should map this field for both parent and child items and include values for both in CSV import files. Also note that Stock Units, Purchase Units, and Sale Units values are dependent on Units Type values.

- When you are using a CSV import for populating facet field values, ensure that the facet field values are not missing for the child matrix items. If the facet field values are missing for the child matrix items, the facet filter might not work as expected. This issue is observed only when you use non-matrix options as facet fields.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Importing Pricing Data for Items**

The way you import prices varies depending on the features enabled in your account. If your account uses Multiple Prices, Quantity Pricing, and/or Multiple Currencies, you use the Item Pricing sublist. Otherwise, your pricing data is fairly simple, and you map prices using the Purchase Price body field. This topic deals primarily with the Item Pricing sublist.

When using the sublist, be aware of the following:

- The recommended column headers for item pricing in CSV files vary, depending on whether you plan to upload a single file or multiple files. For more information, see Formatting for Item Pricing CSV Files.

- The Item Pricing sublist can be selectively updated based on key field values. The key fields vary depending on the pricing-related features that are enabled. For more information, see Keys for Item Pricing Sublist.

- For multiple pricing levels, if the CSV file data includes a base price for an item, all discount or markup price levels are always calculated during import. You do not need to supply discount or markup price values, because the import process overrides any values specified in the CSV files.

- If you are using both multiple price levels and quantity-based pricing, every quantity must have a price defined at every price level. For more details, including examples of how to set up your CSV files to accommodate these fields, see Example - Imports Using Multiple Price Levels and Quantities.
For any items that have quantity pricing schedules applied to them, you need to specify only a price for quantity zero for the price levels that you are using. The import process calculates other quantity prices. If you try to specify a price for any quantity besides zero for an item with a pricing schedule, the import fails. For more details, including examples of how to set up your CSV files, see Example - Imports Using Quantity Pricing Schedules.

For CSV updates to items with quantity-based pricing, base price updates do not result in updates to other price levels, unless import data specifies a quantity pricing schedule or schedules.

For multiple currencies, the Import Assistant calculates price levels for the base currency specified. The Currency field is required to be mapped for item pricing imports in accounts where the Multiple Currencies feature is enabled.

NetSuite recommends that you do not enable the Overwrite Sublists option for imports that include item pricing data. Enabling this option may result in errors when imported sublist data overwrites existing sublist values driven by body field values such as pricing schedule.

When multiple item-pricing fields (price level, currency, quantity, and price) are mapped for an import job, and a row has values for some of these fields but not for others, none of the values for pricing fields are imported for the row. The assumption is that the populated values for pricing fields are defaults, and the empty values in other pricing fields indicate that complete pricing data is not available and so pricing field values should not be imported at all.

**Keys for Item Pricing Sublist**

The import of pricing sublist data for items is supported when one or more of the following features are enabled: Multiple Currencies, Multiple Prices, and/or Quantity Pricing.

The Import Assistant can selectively update existing NetSuite records that match CSV file key field values. The key for this sublist's records is based on a unique field value or a unique combination of field values, depending on the enabled features. The following table describes possible key combinations.

<table>
<thead>
<tr>
<th>Enabled Features</th>
<th>Key Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Currencies only</td>
<td>Currency</td>
</tr>
<tr>
<td>Multiple Currencies, Multiple Prices</td>
<td>combination of Currency, Level</td>
</tr>
<tr>
<td>Multiple Currencies, Quantity Pricing</td>
<td>combination of Currency, Quantity</td>
</tr>
<tr>
<td>Multiple Currencies, Multiple Prices, Quantity Pricing</td>
<td>combination of Currency, Level, Quantity</td>
</tr>
<tr>
<td>Multiple Prices only</td>
<td>Level</td>
</tr>
<tr>
<td>Multiple Prices, Quantity Pricing</td>
<td>combination of Level, Quantity</td>
</tr>
<tr>
<td>Quantity Pricing Only</td>
<td>Quantity</td>
</tr>
</tbody>
</table>

**Formatting for Item Pricing CSV Files**

The formatting of CSV import files differs for multiple file and single file uploads of item pricing data. It may also vary depending on the features enabled in your account. To see how you might set up your files, refer to Example - Imports Using Multiple Price Levels and Quantities and Example - Imports Using Quantity Pricing Schedules.

**Example - Imports Using Multiple Price Levels and Quantities**

If both Multiple Prices and Quantity Pricing are enabled, the sublist area of the item record form includes a row for each price level, and a column for each quantity. You can view this form at Lists > Accounting.
Items Import (or any item type that uses pricing), and looking at the Sales / Pricing subtab.

Whenever you try to save a record of this type, the system enforces the following rule: A price level row that contains any values must include values for all defined quantity columns (all columns that have a number in the Qty field). Similarly, if a quantity column contains any values, it must include values for all price level rows that contain any other values.

For example, the following data could not be saved because two prices are missing in one row.

![Table 1](image1)

Similarly, the following data could not be saved because two prices are missing in one column.

![Table 2](image2)

By contrast, the following record has fully populated pricing data and could be saved. Note that it is acceptable for the Alternate Price 3 row to be empty. A row can be empty, but if it contains any data, it must be fully populated.

![Table 3](image3)

This rule also applies to your CSV import. If the Import Assistant cannot create fully populated pricing rows and columns as shown in the third of the preceding screenshots, an error like the following occurs: “Please enter missing price(s).” If you see this error and you believe that all required prices exist in your CSV file, the problem is likely that the file and/or the mapping were not set up correctly.

The “enter missing price(s)” error can occur in the following situations:

- During an import with update data handling that does either of the following:
  - Adds a new quantity threshold for an item
  - Adds a price to a previously unused pricing level
- During an import that creates a new item that uses multiple quantities and price levels

To avoid problems, make sure that your CSV data is formatted and mapped correctly. Two approaches are supported — multiple-file and single-file. For the purposes of the following examples, assume you are trying to create the pricing data pictured in the preceding figure.
Multiple Files Import

If you are using multiple CSV files, you should include one file for the body data and a second file for the pricing data.

The primary file should include required body fields such as the item's name and the tax schedule, plus any account data you want to include, as shown here:

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Item Name/Number</th>
<th>Cost of Goods Sold (COGS) Account</th>
<th>Asset Account</th>
<th>Income Account</th>
<th>Tax Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>item100</td>
<td>Widget</td>
<td>1000 COGS</td>
<td>1000 Asset</td>
<td>1000 Income</td>
<td>S1</td>
</tr>
</tbody>
</table>

The secondary file containing pricing data must repeat one row for each desired quantity/price-level/price combination. Further, each of these rows must include a unique identifier for the item record, such as the repeating ExternalId values shown here:

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Currency</th>
<th>Price</th>
<th>Price Level</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>item100</td>
<td>USA</td>
<td>160</td>
<td>Base Price</td>
<td>0</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>180</td>
<td>Alternate Price 1</td>
<td>0</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>200</td>
<td>Alternate Price 2</td>
<td>0</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>135</td>
<td>Base Price</td>
<td>12</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>155</td>
<td>Alternate Price 1</td>
<td>12</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>180</td>
<td>Alternate Price 2</td>
<td>12</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>110</td>
<td>Base Price</td>
<td>24</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>140</td>
<td>Alternate Price 1</td>
<td>24</td>
</tr>
<tr>
<td>item100</td>
<td>USA</td>
<td>170</td>
<td>Alternate Price 2</td>
<td>24</td>
</tr>
</tbody>
</table>

When you do your mapping, you match the price columns to a single instance of the Item Pricing sublist fields.

Single File Import

If you are using a single CSV file for item body data and pricing data, all pricing fields for each item must be included in a single row. Each of the pricing groups should be represented by quantity, price level,
price, and currency columns (unless you prefer to create a default value for some of these, such as currency, on the mapping page). The following example illustrates the first several columns for an item that includes nine pricing groups. Note that the columns for Item Pricing 4 through Item Pricing 9 are not pictured here.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>item111</td>
<td>0</td>
<td>Base Price</td>
<td>160</td>
<td>12</td>
<td>Base Price</td>
<td>135</td>
<td>24</td>
<td>Base Price</td>
<td>110</td>
</tr>
</tbody>
</table>

On the Import Assistant Field Mapping page, each of these groups maps to a separate instance of the Item Pricing sublist. The following illustration shows how the first part of this mapping would look. (Not pictured are the Item Pricing instances 5 through 9.)

Considerations when Data Handling is Set to Update

When you are setting Data Handling to Update, be aware of the following:

- If you want to update a single price on an item record, you must identify both the price level and the quantity associated with that price.
- Remember that if you are doing an update that adds a new quantity to the record, you must identify a price for that quantity at every price level. Otherwise, the system generates an error about missing prices.
- If you are doing an update that adds a price for a new or previously unused price level, you must identify prices for that price level for every quantity that's already used by the item record. Otherwise, the system generates an error about missing prices.

Example - Imports Using Quantity Pricing Schedules

Quantity pricing schedules are templates that allow you to automatically apply quantity discounts to an item. For example, a schedule defined as Schedule 1 might automatically create a 10 percent discount on
when a customer buys 15 of your items. For more on quantity price schedules, including how to create them, see the help topic Quantity Pricing Schedules.

When an item to be imported uses a quantity pricing schedule, note that your CSV file should define a price only for a quantity of zero for that item. The pricing schedule creates the additional quantities. If you try to define a price for any quantity besides 0 for an item associated with a schedule, your import fails.

**Multiple Files Import**

If you are using multiple CSV files, you should create one file for the body data and a second file for the pricing data.

The primary file should include body fields such as the item's name, the tax schedule, any account data you want to use, and the quantity pricing schedule for any items that should use a schedule, as shown here:

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Item Name/Number</th>
<th>Quantity Pricing Schedule</th>
<th>Cost of Goods Sold (COGS) Account</th>
<th>Asset Account</th>
<th>Income Account</th>
<th>Tax Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>item101</td>
<td>Widget 1</td>
<td>Schedule 1</td>
<td>1000 COGS</td>
<td>1000 Asset</td>
<td>1000 Income</td>
<td>S1</td>
</tr>
<tr>
<td>item102</td>
<td>Widget 2</td>
<td>Schedule 2</td>
<td>1000 COGS</td>
<td>1000 Asset</td>
<td>1000 Income</td>
<td>S1</td>
</tr>
<tr>
<td>item103</td>
<td>Widget 3</td>
<td></td>
<td>1000 COGS</td>
<td>1000 Asset</td>
<td>1000 Income</td>
<td>S1</td>
</tr>
</tbody>
</table>

The pricing file must include a separate row for each price level being created for each item. Two price levels cannot be represented on the same row. For example, if you are importing two items and you want to define two price levels for each for Quantity 0, your file must include four rows.

Again, you do not define any quantities besides zero because you are relying on your pricing schedule to create them. If you try to define other quantities for an item associated with a schedule, the import fails. However, note that it is permissible to define different quantities in the file for item records that are not associated with a pricing schedule, as is the case with item103, below.

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Currency</th>
<th>Price</th>
<th>Price Level</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>item101</td>
<td>USA</td>
<td>125</td>
<td>Base Price</td>
<td>0</td>
</tr>
<tr>
<td>item101</td>
<td>USA</td>
<td>100</td>
<td>Alternate Price 1</td>
<td>0</td>
</tr>
<tr>
<td>item102</td>
<td>USA</td>
<td>1999</td>
<td>Base Price</td>
<td>0</td>
</tr>
<tr>
<td>item102</td>
<td>USA</td>
<td>1699</td>
<td>Alternate Price 1</td>
<td>0</td>
</tr>
<tr>
<td>item103</td>
<td>USA</td>
<td>550</td>
<td>Base Price</td>
<td>0</td>
</tr>
<tr>
<td>item103</td>
<td>USA</td>
<td>525</td>
<td>Alternate Price 1</td>
<td>0</td>
</tr>
<tr>
<td>item103</td>
<td>USA</td>
<td>475</td>
<td>Base Price</td>
<td>5</td>
</tr>
<tr>
<td>item103</td>
<td>USA</td>
<td>400</td>
<td>Alternate Price 1</td>
<td>5</td>
</tr>
</tbody>
</table>

**Single File Import**

To import similar data using one file only, you should include one row for each item. All of that item's data must be on the same row. (Note that the example below omits the item's name, which would be required if the Add data handling option was selected.)

Formatting restrictions make the table unreadable in the PDF output.
Replacing the Bill of Materials Sublist with the CSV File

You can replace the contents of a sublist with the contents from the CSV file. This example describes how to replace the Bill of Materials (BOM) with the contents of the CSV file, which has multiple rows (rather than columns) for each line in the BOM.

**Note:** You can only replace values in a sublist. You cannot delete sublist items.

To replace the values in a sublist:

1. Prepare two CSV files:
   a. File #1 has the internal IDs of the assembly items whose BOMs you want to overwrite. This file has one column, and one row for each internal ID.
   b. File #2 contains the BOM members. The file has one row for each member of the BOM, for each assembly item. There are multiple rows for the same assembly item. The first column must be the internal ID of the assembly item, and it must match the internal ID in column one of file #1. The second column contains the internal ID of the BOM member, and the third column contains the quantity.
2. Begin the CSV import, selecting an import type of Items and a record type of Assembly/BOM Item.
3. Click Multiple Files to Upload.
4. For Primary File – Items, select the first file you prepared.
5. For Linked File (Optional) – Item Members, select the second file you prepared.
6. In the Data Handling field, click Update.
7. On the Advanced Options menu, check the Overwrite Sublists box.
8. Map the internal ID of the assembly item (column 1) in file #1 to Internal ID on the right-hand side of the Mapping page in the first section that has the Item header.
9. At the bottom of the mapping list, expand Item Members 1.
10. Map Item Members 1:Item to BOM component, which is column two in your second file, and map Item Members 2:Quantity to Qty, which is column three in your second file.
11. Click Save & Run.

The existing Bill of Materials is replaced with the new Bill of Materials that you provided in your second CSV file.

Payment Instruments Import Type

A payment instrument is a set of fields that can be used to charge a shopper without any action on the shopper's side.

**Note:** The Payment Instruments import type is not available unless the Payment Instruments feature is enabled in your account. To enable the Payment Instruments feature, the Credit Cards Payments feature must already enabled.

To enable the Payment Instruments feature, go to Setup > Company > Setup Tasks > Enable Features, and on the Transactions subtab, check the Payment Instruments box. Then, click Save.

The Payment Instruments feature makes using various payments methods more straightforward and, in the case of payment cards, more secure. The Payment Instruments feature uses tokenization to
substitute sensitive data with tokens. Using tokens removes the need of Payment Card Industry (PCI) compliance considerations. Typically, tokens are created automatically by gateway integrations.

You can use CSV imports to import the following kinds of payment instruments:

- **Payment Card** - contains payment card details.
- **Payment Card Token** - represents a payment card without the need to save the payment card number (PAN).
- **General Token** - represents all types of credentials that are retained from processing alternative payment methods apart from payment cards.

For the CSV import to be successful, the payment method specified in the CSV file must already exist in NetSuite.

### Payment Card Example

<table>
<thead>
<tr>
<th>Entity</th>
<th>Card Number</th>
<th>Card Brand</th>
<th>Expiration Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget Works</td>
<td>4111111111111111</td>
<td>VISA</td>
<td>12/2022</td>
</tr>
</tbody>
</table>

### Payment Card Token Example

<table>
<thead>
<tr>
<th>Entity</th>
<th>Payment Method</th>
<th>Token</th>
<th>Token Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>American Computers</td>
<td>CSV_IMPORT_PAYMENT_CARD_TOKEN</td>
<td>swrwsfsfhsjkh54sf4577s</td>
<td>CyberSource</td>
</tr>
</tbody>
</table>

### General Token Example

<table>
<thead>
<tr>
<th>Entity</th>
<th>Payment Method</th>
<th>Token</th>
<th>Token Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget Works</td>
<td>CSV_IMPORT GENERAL_TOKEN</td>
<td>ccydewa678d554dyy4142</td>
<td>CyberSource</td>
</tr>
</tbody>
</table>

### Relationships Import Type

For information about relationships imports, see the following:

- **Billing Account Import**
- **Contacts Only Import**
- **Customer-Subsidiary Relationship Import**
- **Customers Only Import**
- **Projects (Jobs) Import**
- **Leads Only Import**
- **Partners Import**
- **Prospects Only Import**
- **Vendor-Subsidiary Relationship Import**
- **Vendors Import**
- **Importing Entities and Contacts Together**
Billing Account Import

You can import billing account CSV data for a customer. For more information about billing accounts, see the help topic Creating Billing Accounts.

You must set up a billing schedule before you can import billing account data. To set up a billing schedule, go to Lists > Accounting > Billing Schedules > New, type a schedule name, provide the initial amount, recurrence frequency, and recurrence count, and click Save. For more details, see the help topic Billing Schedules.

Billing Account Fields

To prepare billing account CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **External ID** – Used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports. This field is recommended but not required.
- **Customer** – Customer that will use this billing account.
- **Name** – Account name.
- **Billing Schedule** – Billing schedule name.
- **Start Date** – Date when the billing account will start to be used.

To learn about other supported fields, see billing account.

CSV File Example

The following table provides an example structure for a file to import billing account data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Name</th>
<th>Billing Schedule</th>
<th>Start Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACCT003</td>
<td>Travis Gilbert</td>
<td>Travis Gilbert - Billing</td>
<td>Monthly Billing</td>
<td>11/12/2015</td>
</tr>
<tr>
<td>BACCT004</td>
<td>Eckler Leasing</td>
<td>Eckler Leasing - Billing</td>
<td>Monthly Billing</td>
<td>11/13/2015</td>
</tr>
</tbody>
</table>

For more information about using the Import Assistant and importing CSV records, see Importing CSV Files with the Import Assistant and Guidelines for CSV Import Files.

Contacts Only Import

The Contacts Only import is used to attach individual names to existing entries in the customer, vendor, partner, or other name list. Contacts also can be imported without reference to an entity. These names can later be linked to one or more businesses in these lists.

For details about fields that can be mapped in the contact record, see the SOAP Schema Browser’s contact reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.
Review the following guidelines for Contacts imports:

- **Supported Contact Sublist Imports**
- **Importing Contacts for Existing Entity Data**
- **Importing Contacts and New Entities Data**
- **Setting the Global Subscription Status Field for Contacts**
- **Contacts Subsidiary Field Required for NetSuite OneWorld**

**Note:** If you want to update the Company field for a contact record, you need to use a key of internal ID or external ID, rather than name. To set up this key, click the edit icon for the Company field on the Import Assistant Field Mapping page, and select from the Choose Reference Type list. Otherwise the import job creates a new contact record with the same name and the Company field populated, instead of updating the existing contact record.

### Supported Contact Sublist Imports

The Contacts import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Keyed Sublists for CSV Import</a>.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
</tbody>
</table>

For imports that update existing Contact records, handling of sublist data updates depends upon the setting for the [Overwrite Sublists](#) advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see [Sublist Data Import](#).

### Importing Contacts for Existing Entity Data

If you want to import contacts for entities (Customers, Leads, Prospects, or Vendors) that already exist in NetSuite, include entity names in the Company column of Contacts CSV file data.

### Importing Contacts and New Entities Data

You can import Contacts with their related Customers, Leads, or Prospects in a single Import Assistant job. For more information, see [Importing Entities and Contacts Together](#).

The Import Assistant also supports a two-step import of Contacts and entities.

- NetSuite recommends that you import Contacts data first, use External ID as a reference type, and do not import values for the Contacts’ Company field.
- After the Contacts data exists in your account, then import the entities data.
  - NetSuite recommends that you again use External ID as a reference type.
  - Make sure the entities CSV file includes contact names in the Primary Contact column. When the entities data is imported with the Primary Contact field completed, the system links the Contact record with the entity record.
Note that you cannot set a role relationship in a two-step import; contacts can be set as primary or with no role.

Setting the Global Subscription Status Field for Contacts

The Global Subscription Status field on contact records determines whether or not a contact can receive email sent through campaigns and email merge operations.

- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a contact, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.

**Note:** Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.

- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-Out. When this option is enabled, the field defaults to Soft Opt-In.
- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

Contacts Subsidiary Field Required for NetSuite OneWorld

If your account is using NetSuite OneWorld, the Subsidiary field is a required field for Contacts Only imports. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. CSV file values for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

Contacts Only CSV File Example

The following example uses three files to import contacts only information: main contact file, address sublist, and contact subscriptions sublist.

<table>
<thead>
<tr>
<th>Contact</th>
<th>External ID</th>
<th>First Name</th>
<th>Last Name</th>
<th>Subsidiary</th>
<th>Job Title</th>
<th>Main Phone</th>
<th>Email</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSE_CON_14</td>
<td>Sandra</td>
<td>Johnson</td>
<td>ACME Corp : U.K. Subsidiary</td>
<td>Regional Manager</td>
<td>1 958 555 0100</td>
<td><a href="mailto:sandraj@acme.com">sandraj@acme.com</a></td>
<td>Tradeshow</td>
<td></td>
</tr>
<tr>
<td>SSE_CON_18</td>
<td>Andrew</td>
<td>Wilson</td>
<td>ACME Corp : German sub</td>
<td>CEO</td>
<td>1 958 555 0199</td>
<td><a href="mailto:ajw@aaalawn.com">ajw@aaalawn.com</a></td>
<td>Website</td>
<td></td>
</tr>
<tr>
<td>SSE_CON_20</td>
<td>Angela</td>
<td>Wolfe</td>
<td>ACME Corp : Canada subsidiary</td>
<td>Regional Sales Manager</td>
<td>1 958 555 0121</td>
<td><a href="mailto:awolfe@breathe.com">awolfe@breathe.com</a></td>
<td>Phone</td>
<td></td>
</tr>
</tbody>
</table>
We are importing contacts to associate with entities later, so there is no Company column in the file. If you want to associate the contact with an existing entity by the import, add a Company column to the file. The Subsidiary column is required for OneWorld accounts. Use the format parent : child.

Categories must exist in NetSuite or an error will occur.

### Contact Address

<table>
<thead>
<tr>
<th>Customer Address: External ID</th>
<th>Contact Address: ID</th>
<th>Contact Address: Country</th>
<th>Contact Address: Address</th>
<th>Contact Address: City</th>
<th>Contact Address: State</th>
<th>Contact Address: Zip</th>
<th>Contact Address: Default Billing</th>
<th>Contact Address: Default Shipping</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSE_CON_14</td>
<td>83923</td>
<td>United States</td>
<td>123 Elm Street</td>
<td>Chicago</td>
<td>Illinois</td>
<td>60604</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SSE_CON_18</td>
<td>38733</td>
<td>Czech Republic</td>
<td>Třída 123/45</td>
<td>Prague</td>
<td></td>
<td>602 00</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>SSE_CON_20</td>
<td>36366</td>
<td>Australia</td>
<td>Level 2, 15 King Street</td>
<td>Sydney</td>
<td>NSW</td>
<td>3048</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Contact Subscriptions

<table>
<thead>
<tr>
<th>Contact Subscriptions: External ID</th>
<th>Contact Subscriptions: Subscription</th>
<th>Contact Subscriptions: Subscribed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSE_CON_14</td>
<td>Newsletters</td>
<td>Yes</td>
</tr>
<tr>
<td>SSE_CON_14</td>
<td>Marketing</td>
<td>Yes</td>
</tr>
<tr>
<td>SSE_CON_18</td>
<td>Surveys</td>
<td>Yes</td>
</tr>
<tr>
<td>SSE_CON_20</td>
<td>Newsletters</td>
<td>No</td>
</tr>
<tr>
<td>SSE_CON_20</td>
<td>Marketing</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type, you choose the import character encoding. For information, see Select a Record Type for Import and Choose Import Character Encoding.

### Customer-Subsidiary Relationship Import

If you use NetSuite OneWorld and the Multi-Subsidiary Customer feature is enabled, the customer-subsidiary relationship import adds or updates multi-subsidiary customer records with subsidiary information. These multi-subsidiary customer records appear on the Customers list.

The customer-subsidiary relationship record is not visible in the user interface. The fields available for mapping appear in the header of the customer record, and on the Subsidiaries subtab.

Following are the fields that are available for CSV mapping:

- Customer (required)
- External ID
- Subsidiary (required)

Following is a sample of an added multi-subsidiary customer record.
Customers Only Import

The Customers Only import adds or updates data in the Customer record. Note that Leads Only imports and Prospects Only imports also affect Customer record data. The Stage field on a Customer record defines whether the entity is a Lead, Customer, or Prospect. To be defined as a Customer, rather than a Lead or a Prospect, an entity must have one or more associated sales transactions or closed opportunities.

For details about fields that can be mapped in the customer record, see the SOAP Schema Browser’s customer reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

Review the following guidelines for Customers imports:

- Supported Customer Sublist Imports
- Default Values for Customers’ Primary Sales Rep
- Including Primary Contact in Customers Import
- Customers as Individuals or Companies
- Setting Sales Teams for Child Customers
- Importing NetSuite Access Details for Customer Contacts
- Setting Multiple Transaction Currencies for Customers
- Setting the Global Subscription Status Field for Customers
- Customers Subsidiary Field Required for NetSuite OneWorld

Supported Customer Sublist Imports

The Customers import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Keyed Sublists for CSV Import.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from</td>
</tr>
<tr>
<td></td>
<td>other sublist fields is copied into it. If you map the Override</td>
</tr>
<tr>
<td></td>
<td>field and set it to Yes (meaning true), you can import data for the</td>
</tr>
<tr>
<td></td>
<td>Address field.</td>
</tr>
<tr>
<td>Contact Access</td>
<td>Available for updates of existing customers only, to add or update</td>
</tr>
<tr>
<td></td>
<td>NetSuite access information for existing customer contacts. See</td>
</tr>
<tr>
<td></td>
<td>Importing NetSuite Access Details for Customer Contacts.</td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Contact key field.</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Addition of new records is supported. Update of existing lines is</td>
</tr>
<tr>
<td></td>
<td>not supported.</td>
</tr>
<tr>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Currencies</td>
<td>When Multiple Currencies feature enabled.</td>
</tr>
<tr>
<td></td>
<td>See the help topics Currency Management and Setting Multiple Transaction Currencies for Customers.</td>
</tr>
<tr>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td></td>
<td>See Setting Sales Teams for Child Customers.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Available when the SuiteTax feature is enabled at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, on the Tax subtab.</td>
</tr>
<tr>
<td></td>
<td>Whenever you change the Tax Registration Number value on a sublist line, it triggers the regeneration of the value of a hidden ID field, and the values of ID fields are regenerated on all sublist lines. The ID field is hidden in the UI, but it is visible through SOAP web services. The ID field is searchable, so you can access the updated values through SOAP web services. For information about working with the tax registrations sublist through SOAP web services, see the help topic Working with Customer Sublists. For information about working with tax registration in the UI, see the help topic Assigning Tax Registrations to an Entity in SuiteTax.</td>
</tr>
</tbody>
</table>

Every sublist on each record can optionally have a separate file. For imports that update existing Customer records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Default Values for Customers' Primary Sales Rep**

For Customer records added through CSV import, values for Primary Sales Rep do not default to be the user performing the import. This behavior differs from the NetSuite user interface, where the user entering data on the Customer form is the default for Primary Sales Rep. If a CSV file does not include values for Primary Sales Rep, you can specify a default value on the Import Assistant's Field Mapping page. For information, see Assign Default Values during Field Mapping.

**Including Primary Contact in Customers Import**

If you plan to import a Customers CSV file that includes data for Primary Contact, the Contacts data must first exist in NetSuite.

- If this data is not yet in NetSuite, you need to complete a CSV import of Contacts data before you import the Customers CSV file. Leave the Company field blank in the Contacts CSV file that you import.
- After the Contacts data exists in your account, you can import the Customers data. Make sure the CSV file includes contact names in the Primary Contact column. When the entities data is imported with the Primary Contact field completed, the system links the Contact record with the entity record.
Note: It is possible to import Customers and Contacts in a single import job. See Importing Entities and Contacts Together.

Customers as Individuals or Companies

NetSuite lets you define each customer as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant's Field Mapping page includes an Individual field for Customers. This field is required.

- The Individual field is a Boolean indicating whether the customer is a company or a person. It corresponds to the Type option buttons on the Customer form.
- Unlike most radio button fields, an import of this field's data accepts all forms of True or False. For example, the following values are acceptable as a “True” value: True, true, TRUE, T, yes, Yes, YES.
  - A True value indicates a customer is an individual; a False value indicates a customer is a company.
  - The Company Name field is required for records with a False value, but not for records with a True value.
- You can set a default value for the Individual field by clicking its edit icon on the Field Mapping page. In the Default Value popup: choose Yes to default customer type to individual, choose No to default customer type to company.

Note: Your account's setting for the Default Customer Type field, at Setup > Company > General Preferences, may affect the value of the Individual field for Customers imports.

Setting Sales Teams for Child Customers

Note that if a customer is set up as a child of another customer, by default the child customer inherits the sales team of the parent customer. If you want to set up a different sales team for a child customer, enable the Overwrite Sublists option and include sales team values in the CSV file.

Importing NetSuite Access Details for Customer Contacts

For Customers Only imports that update existing records, the Field Mapping page includes a Contact Access sublist. You can map this sublist's fields to provide Customer Center access to contacts.

Sublist fields include:
- Access - Boolean indicating whether to grant NetSuite access to the contact
- Contact - Contact name used the key for the sublist
- Email - Email address used as the NetSuite username for the contact
- Notify - Boolean indicating whether to send notification email to contact
- Password - NetSuite password for the contact
- Role - NetSuite role assigned to the contact (Customer Center)

You can import this data during updates of preexisting customer records that have preexisting contact records already attached. You cannot add new customer records, add new contact records, or attach new contacts to customers at the same time that you import contact access data. You must complete these other tasks first, either in the user interface or through an import, before you can import contact access data. Here is the workflow: 1) Add customers. 2) Add contacts. 3) Attach contacts to customers. 4) Update customers to give access to attached contacts.
Setting Multiple Transaction Currencies for Customers

The Multiple Currencies feature enables you to enter sales transactions in multiple currencies for individual customers. For details about using this feature, see the help topic Currency Management.

When this feature is enabled, you can define a primary currency for customers by including the Currency body field in your CSV file and mapping it in the Import Assistant, exactly as you would without the feature enabled. However, you can also define additional currencies that can be used in this customer’s transactions, called transaction currencies, by mapping a Currencies sublist Currency field to an additional Currency field in your CSV file, for each additional currency to be supported.

To import transaction currencies for a customer:

1. In your Customers CSV file, add a column for each additional currency that you want to support, with a different name for each column, for example: TransCurrency1, TransCurrency2, TransCurrency3.
2. Start a Customers import.
3. On the Field Mapping page, after you have mapped other customer fields as necessary, map the Customer Currencies 1 sublist’s Currency field to an additional currency column in your CSV file.
4. Click the + sign next to the Customer Currencies folder to create another Customer Currencies sublist, and map that Currency field to another currency column in your CSV file.
5. Repeat step 4 until all currency columns in your CSV file are mapped.
6. Complete the import as you normally would.

**Note:** The currencies defined for the Customer Currencies sublist can be imported as values for the Currency field in Cash Sale, Estimate, Invoice, and Sales Order imports.

Setting the Global Subscription Status Field for Customers

The Global Subscription Status field on customer records determines whether or not a customer can receive email sent through campaigns and email merge operations.
- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a customer, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status, you can only send opt-in email.

  **Note:** Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.

- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.
- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

### Customers Subsidiary Field Required for NetSuite OneWorld

If your account is using NetSuite OneWorld, the Subsidiary field is a required field for Customers Only imports. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. CSV file values for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Projects (Jobs) Import

You use the project record to manage company initiatives.

To use the project record, you must have the Projects feature enabled at Setup > Company > Enable Features, on the Company subtab. If you plan to do advanced project tracking, you must also enable Project Management. If you do not see the Project Management check box, your company must first purchase the Project Management add-on from NetSuite.

To access the project record in the UI, choose Lists > Relationships > Projects (or Jobs). For help working with projects manually, see .

The import of project tasks from a CSV export of Microsoft Project plan data is supported through a specialized Project Tasks Import Assistant, available at Activities > Scheduling > Project Tasks > Import.

  **Note:** As of Version 2008, Release 2, the Jobs feature and the Advanced Job Tracking feature have been renamed to Projects and Project Management, and Job records may be labeled Project records, depending upon your account’s settings at Setup > Company > Rename Records/Transactions.

### Project Body Fields

This section describes some of the important body fields on the project record.
Subsidiary

If your account is using NetSuite OneWorld, the Subsidiary field is required for project imports. CSV file values for subsidiaries should be hierarchical names, in the following format — grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

Customer

Imported projects can be standalone or associated with an entity such as customer. You may want to use project imports to associate externally maintained project information with NetSuite customer records on an ongoing basis. However, note that you cannot use the Import Assistant to update the Customer field on a project record. This restriction is consistent with user interface business rules. If the customer for a project changes, you need to create a new project record rather than update an existing one.

Project Sublist Fields

The following sublist data is supported for import:

- Address — Available when Project Management is disabled.
- Resource — Available when Project Management is enabled.

See the following sections for more detail.

Working with Addresses

By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.

This sublist is selectively updatable based on Internal ID or Label key field. See also Keyed Sublists for CSV Import.

Working with Resources

When using the Import Assistant, the behavior of the Resources sublist differs slightly from the behavior in the UI. Specifically, in the UI, each line must have a unique value in the Name field. Further, in the UI, you can select more than one role for each resource.

With the Import Assistant, if you want to add a resource that has two different roles, you set up your CSV file as if you are adding two sublist records for that resource — one for each role. The Name values are not required to be unique, as shown in the table below. This example shows how to add two unique resources to the sublist. But because one resource has two roles, the file is set up as if adding three sublist records.
<table>
<thead>
<tr>
<th>External Id</th>
<th>Company Name</th>
<th>Job 1: Name</th>
<th>Job 1: Role</th>
<th>Job 2: Name</th>
<th>Job 2: Role</th>
<th>Job 3: Name</th>
<th>Job 3: Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>101A</td>
<td>Launch</td>
<td>John Smith</td>
<td>Installer</td>
<td>John Smith</td>
<td>Designer</td>
<td>Jane Johnson</td>
<td>Staff</td>
</tr>
</tbody>
</table>

Note that after you complete the add operation, the Resources sublist in the UI looks the same as it would if you had manually added one line for the resource, with multiple roles specified on that line, as shown in the illustration above.

**For More Information**

For details about additional body and sublist fields that can be mapped in the project record, refer to the SOAP Schema Browser’s job reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic [SOAP Schema Browser](#).

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see [Select a Record Type for Import](#) and [Choose Import Character Encoding](#).

**Leads Only Import**

The Leads Only import adds or updates data in the Customer record. Note that Customers Only imports and Prospects Only imports also affect Customer record data. The Stage field on a Customer record defines whether the entity is a Lead, Customer, or Prospect.

To be defined as a Lead, rather than a Customer or a Prospect, an entity must have no associated estimates, opportunities, or transactions. If an estimate or opportunity is created for a lead, the lead becomes a prospect. If a sales transaction is created for a lead, the lead becomes a customer.

For details about fields that can be mapped in the customer record, see the SOAP Schema Browser’s customer reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic [SOAP Schema Browser](#).

Review the following guidelines for Leads imports:

- Supported Lead Sublist Imports
- Default Values for Leads’ Primary Sales Rep
- Including Primary Contact in Leads Import
- Leads as Individuals or Companies
- Sales Rules and Lead Imports
- Setting the Global Subscription Status Field for Leads
- Leads Subsidiary Field Required for NetSuite OneWorld

**Supported Lead Sublist Imports**

The Leads import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
</tbody>
</table>
Relationships Import Type

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Cards</td>
<td>Addition of new records is supported; update of existing lines is not supported.</td>
</tr>
<tr>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
</tbody>
</table>

For more information, see Keyed Sublists for CSV Import.

By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.

Every sublist on each record can optionally have a separate file. For imports that update existing Lead records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

Default Values for Leads' Primary Sales Rep

For Lead records added through CSV import, values for Primary Sales Rep do not default to be the user performing the import. This behavior differs from the NetSuite user interface, where the user entering data on the form is the default for Primary Sales Rep. If a CSV file does not include values for Primary Sales Rep, you can specify a default value on the Import Assistant's Field Mapping page. For information, see Assign Default Values during Field Mapping.

Including Primary Contact in Leads Import

If you plan to import a Leads CSV file that includes data for Primary Contact, the Contacts data must first exist in NetSuite.

- If this data is not yet in NetSuite, you need to complete a CSV import of Contacts data before you import the Leads CSV file. Leave the Company field blank in the Contacts CSV file that you import.
- After the Contacts data exists in your account, you can import the Leads data. Make sure the CSV file includes contact names in the Primary Contact column. When the entities data is imported with the Primary Contact field completed, the system links the Contact record with the entity record.

Note: It is now possible to import Leads and Contacts in a single Import Assistant job. See Importing Entities and Contacts Together.

Leads as Individuals or Companies

NetSuite lets you define each lead as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant's Field Mapping page includes an Individual field for Leads. This field is required.

- The Individual field is a Boolean indicating whether the lead is a company or a person. It corresponds to the Type option buttons on the Lead form.
Unlike most radio button fields, an import of this field's data accepts all forms of True or False. For example, the following values are acceptable as a "True" value: True, true, TRUE, T, yes, Yes, YES.
- A True value indicates a lead is an individual; a False value indicates a lead is a company.
- The Company Name field is required for records with a False value, but not for records with a True value.

Note: Your account’s setting for the Default Customer Type field, at Setup > Company > General Preferences, may affect the value of the Individual field for Leads imports.

Sales Rules and Lead Imports

If you want automatic sales territory assignment rules to apply to imported lead records, be aware of the following:
- In Lead imports, sales rules are not applied to records that have values set for Sales Rep (when Team Selling is not enabled), or for Sales Role (when Team Selling is enabled). These values can be set either in CSV files or as defaults on the Field Mapping page. For records that do not have values set for Sales Rep or Sales Role, sales rules are applied when other field values trigger them, exactly as in the user interface.
- If territory assignments are not made during import, you can do a mass update after import, at Lists > Mass Update > Mass Updates. Under Sales Force Automation, select one of the following updates: Change Sales Rep Assignment, Change Territory Assignment, or Reassign Customers by Sales Territory Rules. Note that billing address data is required for these mass updates to work properly.

Setting the Global Subscription Status Field for Leads

The Global Subscription Status field on lead records determines whether or not a lead can receive email sent through campaigns and email merge operations.
- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a lead, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.

Note: Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.
- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.
- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

Leads Subsidiary Field Required for NetSuite OneWorld

If your account is using NetSuite OneWorld, the Subsidiary field is a required field for Leads Only imports. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. CSV file values
for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type, you choose the import character encoding. For information, see Select a Record Type for Import and Choose Import Character Encoding.

Partners Import

The Partners import adds partners to the Partner list.

**Note:** Partners imports are not available unless partner records are enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the CRM tab, check Partner Relationship Management.

For details about fields that can be mapped in the partner record, see the SOAP Schema Browser’s partner reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Partners imports:

- **Supported Partner Sublist Imports**
- **Importing Partners Primary and Alternate Contact Data**
- **Setting the Global Subscription Status Field for Partners**
- **Partners as Individuals or Companies**
- **Partners Subsidiary Field Required for NetSuite OneWorld**

### Supported Partner Sublist Imports

The Partners import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field. For more information, see Keyed Sublists for CSV Import.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Contact Access</td>
<td>Available for updates of existing partners only, to add or update NetSuite access information for existing partner contacts. See Importing NetSuite Access Details for Partner Contacts. selectively updatable based on Contact key field</td>
</tr>
<tr>
<td>Promotion Codes</td>
<td></td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Available when the SuiteTax feature is enabled at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, on the Tax subtab. Whenever you change the Tax Registration Number value on a sublist line, it triggers the regeneration of the value of a hidden ID field, and the values of ID fields are regenerated on all sublist lines. The ID field is hidden in the UI, but it is visible through SOAP web services. The</td>
</tr>
<tr>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>ID field is searchable, so you can access the updated values through SOAP web services. For information about working with the tax registrations sublist through SOAP web services, see the help topic Partner. For information about working with tax registration in the UI, see the help topic Assigning Tax Registrations to an Entity in SuiteTax.</td>
<td></td>
</tr>
</tbody>
</table>

For imports that update existing Partner records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Importing Partners Primary and Alternate Contact Data**

If you plan to import a Partners CSV file that includes data for Primary Contact or Alternate Contact, the Contacts data must first exist in NetSuite.

- If this data is not yet in NetSuite, you need to complete a CSV import of Contacts data before you import the Partners CSV file. Leave the Company field blank in the Contacts CSV file that you import.
- After the Contacts data exists in your account, you can import the Partners data. Make sure the CSV file includes contact names in the Primary Contact column. When the partners data is imported with the Primary Contact field completed, the system links the Contact record with the partner record.

**Importing NetSuite Access Details for Partner Contacts**

For Partners imports that update existing records, the Field Mapping page includes a Contact Access sublist. You can map this sublist's fields to provide Partner Center access to contacts.

Sublist fields include:

- **Access** - Boolean indicating whether to grant NetSuite access to the contact
- **Contact** - Contact name used as the key for the sublist
- **Email** - Email address used as the NetSuite username for the contact
- **Notify** - Boolean indicating whether to send notification email to contact
- **Password** - NetSuite password for the contact
- **Role** - NetSuite role assigned to the contact (Partner Center or Advanced Partner Center)

You can import this data during updates of preexisting partner records that have preexisting contact records already attached. You cannot add new partner records, add new contact records, or attach new contacts to partners at the same time that you import contact access data. You must complete these other tasks first, either in the user interface or through an import, before you can import contact access data. Here is the workflow: 1) Add partners. 2) Add contacts. 3) Attach contacts to partners. 4) Update partners to give access to attached contacts.

**Setting the Global Subscription Status Field for Partners**

The Global Subscription Status field on partner records determines whether or not a partner can receive email sent through campaigns and email merge operations.

- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a partner, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.
Note: Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.

- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.
- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

Partners as Individuals or Companies

NetSuite lets you define each partner as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant's Field Mapping page includes an Individual field for Partners. This field is required.

- The Individual field is a Boolean indicating whether the partner is a company or a person. It corresponds to the Type option buttons on the Partner form.
- Unlike most radio button fields, an import of this field's data accepts all forms of True or False. For example, the following values are acceptable as a "True" value: True, true, TRUE, T, yes, Yes, YES.
  - A True value indicates a partner is an individual; a False value indicates a partner is a company.
  - The Company Name field is required for records with a False value, but not for records with a True value.
- You can set a default value for the Individual field by clicking its edit icon on the Field Mapping page. In the Default Value popup: choose Yes to default partner type to individual, choose No to default partner type to company.

Note: Your account's setting for the Default Partner Type field, at Setup > Company > General Preferences, may affect the value of the Individual field for Partners imports.

Partners Subsidiary Field Required for NetSuite OneWorld

If your account is using NetSuite OneWorld, the Subsidiary field is a required field for Partners imports. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. CSV file values for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Prospects Only Import

The Prospects Only import adds or updates data in the Customer record. Note that Customers Only imports and Leads Only imports also affect Customer record data. The Stage field on a Customer record defines whether the entity is a Lead, Customer, or Prospect.
Prospects have no associated sales orders, invoices, cash sales, or other sales transactions, but do have associated opportunities and/or estimates. If a sales transaction is created for a prospect, or an opportunity is closed for a prospect, the prospect becomes a customer.

For details about fields that can be mapped in the customer record, see the SOAP Schema Browser’s [customer](#) reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic [SOAP Schema Browser](#).

Review the following guidelines for Prospects imports:

- Supported Prospect Sublist Imports
- Default Values for Prospects' Primary Sales Rep
- Including Primary Contact in Prospects Import
- Prospects as Individuals or Companies
- Setting the Global Subscription Status Field for Prospects
- Prospects Subsidiary Field Required for NetSuite OneWorld

### Supported Prospect Sublist Imports

The Prospects import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Keyed Sublists for CSV Import</a>.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from other sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Addition of new records is supported; update of existing lines is not supported.</td>
</tr>
<tr>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Partners</td>
<td>Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
</tbody>
</table>

Every sublist on each record can optionally have a separate file. For imports that update existing Prospect records, handling of sublist data updates depends upon the setting for the [Overwrite Sublists](#) advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see [Sublist Data Import](#).

### Default Values for Prospects' Primary Sales Rep

For Prospect records added through CSV import, values for Primary Sales Rep do not default to be the user performing the import. This behavior differs from the NetSuite user interface, where the user entering data on the form is the default for Primary Sales Rep. If a CSV file does not include values for...
Relationships Import Type

Primary Sales Rep, you can specify a default value on the Import Assistant’s Field Mapping page. For information, see Assign Default Values during Field Mapping.

Including Primary Contact in Prospects Import

If you plan to import a Prospects CSV file that includes data for Primary Contact, the Contacts data must first exist in NetSuite.

- If this data is not yet in NetSuite, you need to complete a CSV import of Contacts data before you import the Prospects CSV file. Leave the Company field blank in the Contacts CSV file that you import.
- After the Contacts data exists in your account, you can import the Prospects data. Make sure the CSV file includes contact names in the Primary Contact column. When the entities data is imported with the Primary Contact field completed, the system links the Contact record with the entity record.

**Note:** It is now possible to import Prospects and Contacts in a single Import Assistant job. See Importing Entities and Contacts Together.

Prospects as Individuals or Companies

NetSuite lets you define each prospect as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant’s Field Mapping page includes an Individual field for Prospects. This field is required.

- The Individual field is a Boolean indicating whether the prospect is a company or a person. It corresponds to the Type option buttons on the Prospect form.
- Unlike most radio button fields, an import of this field’s data accepts all forms of True or False. For example, the following values are acceptable as a “True” value: True, true, TRUE, T, yes, Yes, YES.
  - A True value indicates a prospect is an individual; a False value indicates a prospect is a company.
  - The Company Name field is required for records with a False value, but not for records with a True value.

**Note:** Your account’s setting for the Default Customer Type field, at Setup > Company > General Preferences, may affect the value of the Individual field for Prospects imports.

Setting the Global Subscription Status Field for Prospects

The Global Subscription Status field on prospect records determines whether or not a prospect can receive email sent through campaigns and email merge operations.

- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a prospect, set this field’s value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.

**Note:** Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient’s jurisdiction.

- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is
disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.

- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

**Prospects Subsidiary Field Required for NetSuite OneWorld**

If your account is using NetSuite OneWorld, the Subsidiary field is a required field for Prospects Only imports. You must map the NetSuite Subsidiary field to a field in your CSV file, or the import will fail. CSV file values for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Vendor-Subsidiary Relationship Import**

If you use NetSuite OneWorld, the vendor-subsidiary relationship import adds or updates multi-subsidiary vendor records with subsidiary, credit limit, and tax code information. These multi-subsidiary vendor records appear on the Vendors list.

The vendor-subsidiary relationship record is not visible in the user interface. The fields available for mapping appear in the header of the vendor record, and on the Subsidiaries subtab.

All of the fields are optional in the CSV file.

Following are the fields that are available for CSV mapping:

- Credit Limit
- External ID
- Internal ID
- Subsidiary
- Tax Code
- Vendor

Following is a sample of an added multi-subsidiary vendor record.

<table>
<thead>
<tr>
<th>Credit Limit (currency)</th>
<th>External ID (vendor name)</th>
<th>Subsidiary (primary and secondary subsidiaries)</th>
<th>Vendor (company name)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD</td>
<td>More Toys</td>
<td>More Toys Parent</td>
<td>More Toys</td>
</tr>
<tr>
<td></td>
<td></td>
<td>More Toys Australia</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you want to use Internal ID, follow the sample above and replace the External ID column with Internal ID.

For details about fields that can be mapped in the vendor-subsidiary relationship record, see the SOAP Schema Browser’s vendor-subsidiary relationship page. You can use the field definitions here as a basis.
for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

For information about multi-subsidiary vendors, see the help topic Assigning Subsidiaries to a Vendor.

Vendors Import

The vendors import adds vendors to the Vendors list.

For details about fields that can be mapped in the vendor record, see the SOAP Schema Browser's vendor reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Important: You must create payment terms prior to referencing them during the Import Assistant's Vendor import. In the previously supported CSV import process for vendors, new Payment Terms referenced during a Vendor import would cause a new payment term to be created in the account.

Review the following guidelines for Vendors imports:

- Supported Vendor Sublist Imports
- Setting the Global Subscription Status Field for Vendors
- Vendors as Individuals or Companies
- Vendors Primary Subsidiary Field Required for NetSuite OneWorld

Supported Vendor Sublist Imports

The Vendors import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Keyed Sublists for CSV Import.</td>
</tr>
<tr>
<td></td>
<td>By default, the sublist Address field is read-only, and data from</td>
</tr>
<tr>
<td></td>
<td>other sublist fields is copied into it. If you map the Override</td>
</tr>
<tr>
<td></td>
<td>field and set it to Yes (meaning true), you can import data for the</td>
</tr>
<tr>
<td></td>
<td>Address field.</td>
</tr>
<tr>
<td>Roles</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Available when the SuiteTax feature is enabled at Setup &gt; Company &gt;</td>
</tr>
<tr>
<td></td>
<td>Setup Tasks &gt; Enable Features, on the Tax subtab.</td>
</tr>
<tr>
<td></td>
<td>Whenever you change the Tax Registration Number value on a sublist</td>
</tr>
<tr>
<td></td>
<td>line, it triggers the regeneration of the value of a hidden ID field,</td>
</tr>
<tr>
<td></td>
<td>and the values of ID fields are regenerated on all sublist lines.</td>
</tr>
<tr>
<td></td>
<td>The ID field is hidden in the UI, but it is visible through SOAP</td>
</tr>
<tr>
<td></td>
<td>web services. The ID field is searchable, so you can access the</td>
</tr>
<tr>
<td></td>
<td>updated values through SOAP web services. For information about</td>
</tr>
<tr>
<td></td>
<td>working with the tax registrations sublist through SOAP web services,</td>
</tr>
<tr>
<td></td>
<td>see the help topic Vendor.</td>
</tr>
<tr>
<td></td>
<td>For information about working with tax registration in the UI, see</td>
</tr>
<tr>
<td></td>
<td>the help topic Assigning Tax Registrations to an Entity in SuiteTax.</td>
</tr>
</tbody>
</table>

CSV Imports
For imports that update existing Vendor records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

Setting the Global Subscription Status Field for Vendors

The Global Subscription Status field on vendor records determines whether or not a vendor can receive email sent through campaigns and email merge operations.

- Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
- If you want to send campaign email to a vendor, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.

**Note:** Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.

- If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.
- After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.

Vendors as Individuals or Companies

NetSuite lets you define each vendor as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant's Field Mapping page includes an Individual field for Vendors. This field is required.

- The Individual field is a Boolean indicating whether the vendor is a company or a person. It corresponds to the Type option buttons on the Vendor form.
- Unlike most radio button fields, an import of this field's data accepts all forms of True or False. For example, the following values are acceptable as a “True” value: True, true, TRUE, T, yes, Yes, YES.
  - A True value indicates a vendor is an individual; a False value indicates a prospect is a company.
  - The Company Name field is required for records with a False value, but not for records with a True value.

**Note:** Your account setting for the Default Vendor Type field, at Setup > Company > General Preferences, may affect the value of the Individual field for Vendors imports.

Vendors Primary Subsidiary Field Required for NetSuite OneWorld

If your account is using NetSuite OneWorld, the Primary Subsidiary field is required for Vendors imports. You must map the NetSuite Primary Subsidiary field to a field in your CSV file, or the import will fail. CSV
file values for subsidiaries should be hierarchical names, in the format grandparent: parent: child, for example, Consolidated Parent Company: UK Subsidiary: Euro Subsidiary.

**Note:** You cannot import a vendor with multiple subsidiaries using CSV Import.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Importing Entities and Contacts Together

It is now possible to import data for Contacts and some entities together, meaning you can import the following types of records with a single Import Assistant job:

- Customers and Contacts
- Leads and Contacts
- Prospects and Contacts

Review the following guidelines for importing entities and contacts together:

- **Requirements for Importing Entities and Contacts in a Single Job**
- **Benefits of Importing Related Records Together**
- **Importing Address Sublist Data for Contacts**
- **Setting the Global Subscription Status Field for Entities and Contacts**
- **Subsidiary Field Not Required for Entities and Contacts in OneWorld**
- **Steps for Importing Entities and Contacts Together**
- **Import Job Processing for Entities and Contacts Imports**

### Requirements for Importing Entities and Contacts in a Single Job

- You can use one CSV file that contains both entity and contact data, or you can use two separate files, one containing entity data and one containing contact data.
  - If you use one file, contact field values are stored by column, and you are limited to importing five contacts per entity in each import.
  - If you use two files, contact field values are stored by row, and this limitation on imported contacts per entity does not apply.
- If you use two files, you need to complete the File Mapping page of the Import Assistant to define a column in the contact data file that maps to the primary key column in the entity data file, such as Customer ID. (So if the Contacts CSV file does not include this column, you should add it before the import.)
- You must ensure that the **Ignore Read Only Fields** advanced option is enabled.
- Whether you use one or two files, you can map required fields for both entities and Contacts in one step on the Import Assistant's Field Mapping page.
  - You have the option of mapping the Attached Role field for Contacts. This field describes how the Contact is attached to the entity. Standard role values include Alternate Contact, Primary Contact, Consultant, and Decision Maker.

---

**CSV Imports**
Benefits of Importing Related Records Together

This approach of combining related records has the following advantages:

■ The process is quicker and easier, as you can import both record types during the same import, rather than requiring two distinct imports.
■ You are no longer forced to rely on name matching to link contacts and entities together, which can be prone to inaccuracy.

Importing Address Sublist Data for Contacts

When you import entities and contacts together, the Address sublist for contacts is not available for mapping. However, the address sublist values imported for each entity (customer, lead, or prospect) record are copied to all of the entity's contacts. If a contact already has one or more addresses, the newly imported address data is added; it does not overwrite existing address data.

When you map the fields in the entity's Address sublist, their values are imported to the Address subrecords on entity records and copied to the Address subrecords on all related contact records.

By default, the entity Address field is read-only, and data from other address sublist fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.

Setting the Global Subscription Status Field for Entities and Contacts

The Global Subscription Status field on lead, prospect, customer, and contact records determines whether or not these entities can receive email sent through campaigns and email merge operations.

■ Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.
■ If you want to send campaign email, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status; you can only send opt-in email.

Note: Certain jurisdictions, such as the European Union (EU), have regulations regarding whether or not you can contact entities if you do not have their explicit permission to do so. You should check that your global subscription status adheres to the regulations in the recipient's jurisdiction.

■ If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.
■ After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

For more information on global subscription statuses, see the help topic Subscription Management.
Subsidiary Field Not Required for Entities and Contacts in OneWorld

The Subsidiary field is not required for importing entities and contacts together in an account that is not a OneWorld account.

Steps for Importing Entities and Contacts Together

1. Before you start the Import Assistant, review one of the following topics to get some background information about entity imports: Customers Only Import, Leads Only Import, or Prospects Only Import.
2. Ensure that each CSV file includes required columns.
   If you are using two files for the import, the file containing Contacts data should include a column with values that map to the entities' primary key field values. You will need to map the two files' key columns on the Import Assistant's File Mapping page.
3. Start the Import Assistant by going to Setup > Import/Export > Import CSV Records.
4. On the Scan & Upload CSV File page:
   a. Choose the import's record type:
      ■ Customers and Contacts Together
      ■ Leads and Contacts Together
      ■ Prospects and Contacts Together
   b. If desired, change the default character encoding. For information, see Choose Import Character Encoding.
   c. Choose the number of files to upload:
      ■ One file to upload
      ■ Multiple files to upload
   d. Click the Select buttons and browse to the CSV files for entities and contacts data.
      If you also are importing sublist data, you can select files for sublist data as well. For information, see Sublist Data Import.
   e. After you have selected one or more files to upload, click Next.
5. On the Import Options page:
   a. Select a Data Handling option.
   b. If desired, expand the Advanced Options and make changes. For information, see Set Advanced CSV Import Options. Note that the Ignore Read-Only Fields advanced option must be enabled.
   c. Click Next.
6. (If you are uploading multiple files only) On the File Mapping page:
   a. Select a key column for the CSV file containing entity data. (The Import Assistant refers to this file as the Primary File.)
   b. Select the Contacts column containing values to be mapped to entity key values.
   c. Click Next.
7. On the Field Mapping page, review the Import Assistant's auto mappings shown in the center pane.
   a. Note that Contact fields may be mapped multiple times so that multiple linked contacts can be imported for each entity.
b. Make sure that required fields (fields marked Req. in the center pane) are mapped. You can set default values by clicking the edit icon.

c. Click Next.

d. If necessary, correct any mapping errors.

8. On the Save Mapping and Start Import page, provide a mapping name and, optionally, a description, then click Save and Run.

## Import Job Processing for Entities and Contacts Imports

The following table illustrates the actions taken during job processing for imports of Customers, Leads, or Prospects together with Contacts. This processing varies based on the following:

- Data handling option (Add, Update, Add or Update)
- Reference type (Name, Internal ID, External ID)
- Whether auto-generated numbering is enabled

<table>
<thead>
<tr>
<th>Matching Conditions</th>
<th>Add</th>
<th>Update</th>
<th>Add or Update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name Matching</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Matching Entity, No Matching Contact</td>
<td>Add Both</td>
<td>Fail Both</td>
<td>Add Both</td>
</tr>
<tr>
<td>No Matching Entity, 1 Matching Contact</td>
<td>Fail Both</td>
<td>Fail Both</td>
<td>Add Entity, Update Contact</td>
</tr>
<tr>
<td>No Matching Entity, 2 Matching Contacts</td>
<td>Fail Both</td>
<td>Fail Both</td>
<td>Fail Both</td>
</tr>
<tr>
<td><strong>1 Matching Entity, No Matching Contact</strong></td>
<td>Add Both if Auto-Generated Numbering Else Fail Both</td>
<td>Fail Both</td>
<td>Update Entity, Add Contact</td>
</tr>
<tr>
<td><strong>1 Matching Entity, 1 Matching Contact</strong></td>
<td>Fail Both</td>
<td>Update Both</td>
<td>Update Both</td>
</tr>
<tr>
<td><strong>1 Matching Entity, 2 Matching Contacts</strong></td>
<td>Fail Both</td>
<td>Fail Both</td>
<td>Fail Both</td>
</tr>
<tr>
<td><strong>2 Matching Entities, No Matching Contact</strong></td>
<td>Add Both if Auto-Generated Numbering Else Fail Both</td>
<td>Fail Both</td>
<td>Fail Both</td>
</tr>
<tr>
<td><strong>2 Matching Entities, 1 Matching Contact</strong></td>
<td>Fail Both</td>
<td>Fail Both</td>
<td>Fail Both</td>
</tr>
<tr>
<td><strong>2 Matching Entities, 2 Matching Contacts</strong></td>
<td>Fail Both</td>
<td>Fail Both</td>
<td>Fail Both</td>
</tr>
<tr>
<td><strong>Internal ID or External ID Matching</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Matching Entity, No Matching Contact</td>
<td>Add Both</td>
<td>Fail Both</td>
<td>Add Both</td>
</tr>
</tbody>
</table>
Understanding Leads, Prospects, and Customers

When you import Lead, Prospect, or Customer data into NetSuite, you import into the Customer record. The Stage field on the Customer record defines the stage of “Customer” that is currently in the system - a Customer can be a Lead, Prospect or Customer. Leads automatically can become Prospects, and Prospects can become Customers.

Following are specific definitions of the three record types:

- **Lead**: lets you track all the information you need to convert a lead into a customer. Leads have no estimates, opportunities or transactions associated with them. If an estimate or opportunity is created for a lead, the lead becomes a prospect. If you create a sales transaction for a lead, the lead becomes a customer.

- **Prospect**: lets you track all the information you need to convert a prospect into a customer. Prospects have no sales orders, invoices, cash sales or other sales transactions associated with them. They can have opportunities and estimates associated with them, however. If a sales transaction is created for a prospect, or an opportunity is closed for a prospect, the prospect becomes a customer.

- **Customer**: lets you track all the information on your current customers.

For details about fields that can be mapped in the customer record, see the SOAP Schema Browser's customer reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

Rules Setup Import Type

For information about Rules Setup imports, see the following:

- **Foreign Currency Variance Posting Rule Import**

Foreign Currency Variance Posting Rule Import

Each foreign currency variance posting rule specifies the account into which NetSuite posts gains or losses resulting from foreign currency variances. This account is the destination account. The rules consist of a set of source or revaluation transaction criteria that determine the posting account. You must create the posting accounts you want to set as destination accounts before you import rules. A destination accounts must be an account of the type Other Income or Other Expense.
If your NetSuite account has no variance posting rules, NetSuite posts the gains and losses from fluctuations in foreign exchange rates to default system-generated accounts. The default system-generated accounts are also used if no rules match the transaction. For information about the default accounts, see the help topic Foreign Currency Revaluation.

Each variance posting rule must have a unique set of criteria. NetSuite compares each transaction to the foreign currency variance posting rules in the order of rule priority. When a rule matches, that rule is used and evaluation ends. Key fields, custom segments, and custom fields that apply to Purchase, Sale, Journal, Customer Payment, Vendor Payment, or Deposit are available as criteria. Custom fields are limited to the following types:

- Check Box
- Currency
- Date
- Decimal Number
- Email Address
- Free-Form Text
- Integer Number

For more information about foreign currency variance posting rules and instructions to create the rules in the UI, see the help topics Foreign Currency Variance Mapping and its subtopics.

Use the Import Assistant to import foreign currency variance posting rules. The Import Type is Rules Setup, and the Record Type is Foreign Currency Variance Posting Rule. For help with the Import Assistant, see Importing CSV Files with the Import Assistant. For general information, see Tips for Successful CSV Imports.

Features and Permissions Required for Import

The Foreign Currency Variance Posting Rule record type is available for import only when the Foreign Currency Variance Mapping feature is enabled.

In addition to the Import CSV File permission, the Foreign Currency Variance Mapping setup permission is required at the Full level to import rules.

Field Reference for Foreign Currency Variance Posting Rule Import

Change the Reference Type as needed. See Select Reference Types.

Rule Header Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>Required: The rule name must be unique. Include enough information to identify the rule in a list if you change the priority of your rules. The rule name can include symbols in addition to letters and numbers.</td>
</tr>
<tr>
<td>Destination Account</td>
<td>Required: Use the internal ID or the exact account name, including the account number if the accounting preference box Use Account Numbers is checked. Include the reference type in your field mapping. The account must be of the account type Other Income or Other Expense and must exist prior to import. Foreign currency variances post to this destination account when the source or revaluation transaction matches the rule. Multiple rules can have the same destination account.</td>
</tr>
</tbody>
</table>
### Rules Setup Import Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Include a short description of the rule if desired.</td>
</tr>
<tr>
<td>Inactive</td>
<td>This field is a check box in the UI. For acceptable inputs, see Boolean Values in CSV Files. Inactive rules appear on the Foreign Currency Variance Posting Rules page, but they are ignored during revaluation processing.</td>
</tr>
</tbody>
</table>

### Rule Criteria Fields

Each variance posting rule must have a unique set of criteria. These fields are in the Criteria subtab in the UI. In the Import Assistant, they are a sublist.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria Field</td>
<td>You can import the standard criteria fields for foreign currency variance posting rules, plus custom fields and segments. You cannot set a default value in the Import Assistant. Be sure to create any custom fields and segments prior to import. For a description of the standard criteria fields in the UI, see the help topic Defining Foreign Currency Variance Posting Rules.</td>
</tr>
<tr>
<td>Criteria ID</td>
<td>Use this field to update existing rules. To determine the criteria ID, look at the rule in the UI and assign numbers to the criteria fields beginning with 1. You cannot set a default value in the Import Assistant.</td>
</tr>
<tr>
<td>Criteria Values</td>
<td>The criteria values depend on the criteria field. The Gain/Loss criteria field is Boolean. Use T or TRUE to indicate gain. Use F or FALSE to indicate loss. For fields that do not support external IDs (Account Type, Country, Posting Period, Variance Type, and custom segment), the default reference type is Name. (For more information about countries, see Country Names for CSV Import.) Be sure to select the reference type during field mapping. Do not mix name and internal ID reference types in the same CSV file. You cannot set a default value in the Import Assistant.</td>
</tr>
<tr>
<td>Operator</td>
<td>The following table lists the supported operators for the field types and number of inputs shown. You cannot set a default value in the Import Assistant. Number is used for Currency, Integer Number, and Decimal Number field types. Boolean includes Check Box. Text includes Email Address. Operators are not case sensitive.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operator</th>
<th>Field Type</th>
<th>Input Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFTER</td>
<td>Date</td>
<td>1</td>
</tr>
<tr>
<td>ANYOF</td>
<td>List/Record</td>
<td>1...N</td>
</tr>
<tr>
<td>BEFORE</td>
<td>Date</td>
<td>1</td>
</tr>
<tr>
<td>BETWEEN</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>EMPTY</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>EQUALTO</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>GREATERTHAN</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>GREATERTHANOREQUALTO</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>IS</td>
<td>Boolean and Text</td>
<td>1</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Values</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>ISEMPY</td>
<td>Date and Text</td>
<td>0</td>
</tr>
<tr>
<td>ISNOT</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>ISNOTEMPTY</td>
<td>Number, Date, and Text</td>
<td>0</td>
</tr>
<tr>
<td>LESSTHAN</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>LESSTHANOREQUALTO</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>NONEOF</td>
<td>List/Record</td>
<td>1…N</td>
</tr>
<tr>
<td>ON</td>
<td>Date</td>
<td>1</td>
</tr>
<tr>
<td>ONORAFTER</td>
<td>Date</td>
<td>1</td>
</tr>
<tr>
<td>ONORBEFORE</td>
<td>Date</td>
<td>1</td>
</tr>
<tr>
<td>WITHIN</td>
<td>Date</td>
<td>2</td>
</tr>
</tbody>
</table>

### Foreign Currency Variance Posting Rule Import Example

The following table shows the structure of a file to import Foreign Currency Variance Posting Rules with the rule header fields and the rule criteria fields in the same file.

<table>
<thead>
<tr>
<th>Rule Name</th>
<th>Destination Account</th>
<th>Description</th>
<th>Inactive</th>
<th>Criteria Field</th>
<th>Operator</th>
<th>Criteria Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany Realized Losses</td>
<td>612 Realized Losses</td>
<td>German subsidiary realized losses</td>
<td>N</td>
<td>variancetype</td>
<td>anyof</td>
<td>Realized</td>
</tr>
<tr>
<td>Realized Losses</td>
<td>612 Realized Losses</td>
<td>German subsidiary realized losses</td>
<td>N</td>
<td>isgain</td>
<td>is</td>
<td>F</td>
</tr>
<tr>
<td>Germany Realized Losses</td>
<td>612 Realized Losses</td>
<td>German subsidiary realized losses</td>
<td>N</td>
<td>subsidiary</td>
<td>anyof</td>
<td>Germany</td>
</tr>
<tr>
<td>Germany Realized Gain</td>
<td>611 Realized Gains</td>
<td>German subsidiary realized gains</td>
<td>N</td>
<td>variancetype</td>
<td>anyof</td>
<td>Realized</td>
</tr>
<tr>
<td>Realized Gain</td>
<td>611 Realized Gains</td>
<td>German subsidiary realized gains</td>
<td>N</td>
<td>isgain</td>
<td>is</td>
<td>T</td>
</tr>
<tr>
<td>Germany Realized Gain</td>
<td>611 Realized Gains</td>
<td>German subsidiary realized gains</td>
<td>N</td>
<td>subsidiary</td>
<td>anyof</td>
<td>Germany</td>
</tr>
<tr>
<td>Other Realized Gains/Losses</td>
<td>613 Other</td>
<td>All other subsidiaries’ realized gains and losses</td>
<td>N</td>
<td>variancetype</td>
<td>anyof</td>
<td>Realized</td>
</tr>
</tbody>
</table>

### Subscription Billing Import Type

Some of the records related to subscription billing can be imported as CSV data.
To import subscription billing records, verify the following settings:

- Check the **Consolidate Projects on Sales Transactions** box on the Items/Transactions subtab at **Setup > Accounting > Accounting Preferences**
- Enable the following features on the Transaction subtab at Setup > Company > Enable Features:
  - Advanced Billing
  - Charge-Based Billing
  - Billing Accounts
  - Billing Operations
  - SuiteBilling

For more information about setting up SuiteBilling and billing records, see the help topics **SuiteBilling** and **Viewing Records Related to the Billing Account**.

To import subscription billing data, perform the CSV imports in the following order:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Import Type</th>
<th>Requirements</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Subscription Plan</td>
<td>Items</td>
<td></td>
<td>Subscription Plan Import</td>
</tr>
<tr>
<td>2 Price Plan</td>
<td>Accounting</td>
<td>Price plans are only used one time, and the CSV import can only be used to modify existing price plans.</td>
<td>Price Plan Import</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Price plan information is not available from the UI, so ensure that you record all information from this import for later use.</td>
<td></td>
</tr>
<tr>
<td>3 Price Book</td>
<td>Accounting</td>
<td>A saved associated subscription plan and a price plan are mandatory for the price book import. Refer to the price plan using the external ID.</td>
<td>Price Book Import</td>
</tr>
<tr>
<td>4 Subscription</td>
<td>Transactions</td>
<td>Subscriptions reference existing subscription plans. The following fields are required:</td>
<td>Subscription Import</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Customer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Billing account</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Subscription plan</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Price book in the same currency that is used in the billing account.</td>
<td></td>
</tr>
<tr>
<td>5 Subscription Line</td>
<td>Transactions</td>
<td>This import can only be used to update existing lines in a subscription, usually to change the status from Draft to Pending Activation. New lines cannot be added using CSV import because all subscription lines are created with the subscription record and they reflect lines of the subscription plan.</td>
<td>Subscription Line Import</td>
</tr>
<tr>
<td>6 Subscription Change Order</td>
<td>Transactions</td>
<td>Use this import as needed. The information imported varies, depending on the action specified, that is, activation, termination, reactivation, suspension, modify pricing, and renewal. A subscription with at least one activated subscription line is required. To add a subscription change order, the subscription, billing account, and customer are</td>
<td>Subscription Change Order Import</td>
</tr>
<tr>
<td>Record Type</td>
<td>Import Type</td>
<td>Requirements</td>
<td>More Information</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Usage</td>
<td>Transactions</td>
<td>Use this import as needed. To import subscription usage data, a subscription must exist for the customer. For more information, see the help topic Creating Subscription Plans. View the video: Setting Up a Subscription Plan and Price Plan.</td>
<td>Usage Import</td>
</tr>
</tbody>
</table>

The Billing Account record type is also used for subscription billing. For more information, see Billing Account Import.

**Price Book Import**

You can import price book CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topics SuiteBilling and Creating Price Books. View the video: Setting Up a Subscription Plan and Price Plan.

A saved associated subscription plan and a price plan are mandatory for the price book import. Refer to the price plan using the external ID.

**Price Book Body and Sublist Fields**

To prepare price book CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **Currency** – Currency used for the price book values.
- **Name** – Name of the price book.
- **Subscription Plan** – Name of the subscription plan.

To learn about other supported fields, see the help topic Creating Price Books.

Price book records include the Price Book Lines sublist. Required values include:

- **Subscription Plan Line** – This is the key field, identifying the subscription plan line that the price book is associated with.
- **Price Plan** – External ID of the price plan.

**Note:** Field mapping for the price plan is set to Name by default. Ensure that you change it to External ID by clicking the edit icon.

- **Charge Frequency** – Frequency with which to charge the line item.

**Price Book CSV File Examples**

The following table shows how you might structure a file for importing price book data, when using a single CSV file.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>USD</td>
<td>Price Book 1</td>
<td>Monthly</td>
<td>1</td>
<td>1</td>
<td>Standard01</td>
<td>Annually</td>
</tr>
</tbody>
</table>
The following example imports the price book lines sublist data in a separate CSV file.

Primary file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Currency</th>
<th>Name</th>
<th>Subscription Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>USD</td>
<td>Price Book 1</td>
<td>Monthly</td>
</tr>
<tr>
<td>RPL002</td>
<td>USD</td>
<td>Price Book 1</td>
<td>Annual</td>
</tr>
<tr>
<td>RPL002</td>
<td>EUR</td>
<td>Price Book 2</td>
<td>Maintenance</td>
</tr>
<tr>
<td>RPL003</td>
<td>CAD</td>
<td>Price Book 3</td>
<td>Quarterly</td>
</tr>
</tbody>
</table>

Price Book Lines sublist file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription Plan Line</th>
<th>Repeat Every</th>
<th>Price Plan</th>
<th>Charge Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>7</td>
<td>1</td>
<td>Standard01</td>
<td>Annually</td>
</tr>
<tr>
<td>RPL002</td>
<td>8</td>
<td>1</td>
<td>Discount02</td>
<td>Quarterly</td>
</tr>
<tr>
<td>RPL002</td>
<td>3</td>
<td>0</td>
<td>Standard02</td>
<td>Monthly</td>
</tr>
<tr>
<td>RPL003</td>
<td>9</td>
<td>1</td>
<td>Discount03</td>
<td>One Time</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Accounting import type and the Price Book record type. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Price Plan Import

You can import price plan CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topic SuiteBilling.

Some price plan fields might be read-only, or not visible, depending on the price plan type (one time, usage, recurring). A price plan can be associated with a price book only when all of the conditions are met.

Price plans can be used only one time. You can only use the Price Plan CSV Import to modify the price plan itself. Although the price plan is included in other imports (for example, subscription or subscription change order), the price plan cannot be modified from other CSV imports.

Price Plan Body and Sublist Fields

To prepare price plan CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.
- **External ID** – Used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports. This field is required.
- **Currency** – Currency used for the price book values. The price plan will use the same currency.
- **Type** – Price plan type, for example, Tiered.

To learn about other supported fields, see the help topic Creating Subscription Plans.

Price plan records may include the Pricing sublist. Required values include:

- **Above Quantity** – This is the key field, and is used to identify volume pricing tiers. When adding a price plan, the first line of your CSV file must have Above Quantity = 0.
- **Pricing Options** – Pricing options for the plan, for example, Rate pricing or Fixed Amount pricing.
- **Value** – Enter the pricing value for the option chosen.

### Price Plan CSV File Examples

The following table shows how you might structure a single CSV file for adding price plan data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Currency</th>
<th>Type</th>
<th>Price Plan Pricing: Above Quantity</th>
<th>Price Plan Pricing: Pricing Option</th>
<th>Price Plan Pricing: Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>USD</td>
<td>Tiered</td>
<td>0</td>
<td>Fixed Amount</td>
<td>2</td>
</tr>
<tr>
<td>RPL002</td>
<td>USD</td>
<td>Tiered</td>
<td>50</td>
<td>Rate</td>
<td>8</td>
</tr>
<tr>
<td>RPL002</td>
<td>EUR</td>
<td>Volume</td>
<td>1</td>
<td>Fixed Amount</td>
<td>100</td>
</tr>
<tr>
<td>RPL003</td>
<td>CAD</td>
<td>Volume</td>
<td>99</td>
<td>Variable</td>
<td>4</td>
</tr>
</tbody>
</table>

The following example imports the pricing sublist data in a separate CSV file.

**Primary file:**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Currency</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>USD</td>
<td>Tiered</td>
</tr>
<tr>
<td>RPL002</td>
<td>USD</td>
<td>Tiered</td>
</tr>
<tr>
<td>RPL002</td>
<td>EUR</td>
<td>Volume</td>
</tr>
<tr>
<td>RPL003</td>
<td>CAD</td>
<td>Volume</td>
</tr>
</tbody>
</table>

**Pricing sublist file:**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Above Quantity</th>
<th>Pricing Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPL001</td>
<td>99</td>
<td>Fixed Amount</td>
<td>2</td>
</tr>
<tr>
<td>RPL002</td>
<td>50</td>
<td>Rate</td>
<td>8</td>
</tr>
<tr>
<td>RPL002</td>
<td>1</td>
<td>Fixed Amount</td>
<td>100</td>
</tr>
<tr>
<td>RPL003</td>
<td>99</td>
<td>Variable</td>
<td>4</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Accounting import type and the Price Plan record type. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.
Subscription Import

You can import subscription CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topic SuiteBilling.

Subscriptions reference existing subscription plans. The following are required:

- Billing account
- Subscription plan
- Price book in the same currency that is used in the billing account.

For more information about subscriptions, see the help topic Subscription Management.

Subscription Body and Sublist Fields

To prepare subscription CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **Subscription Plan** – Name of the subscription plan.
- **Price Book** – Name of the price book. The price book must use the same currency that is used in the billing account.
- **Customer** – Customer using the subscription.
- **Billing Account** – Customer’s billing account for this subscription.

In a single file import, either the internal ID or external ID field is required. Each single file import with repeating rows for a sublist needs a mapped field. The mapped field identifies the record, which is required because it spans multiple rows in the import file.

Subscription records include the Price Book Lines sublist. This is a keyed sublist, and the required value is the Subscription Plan Line Number.

Subscription CSV File Example

The following tables show how you might structure files for importing subscription and price book line sublist CSV data.

Primary file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription Name</th>
<th>Custom er</th>
<th>Billing Account</th>
<th>Subscription Plan</th>
<th>Initial Term</th>
<th>Original Start</th>
<th>Original End</th>
<th>Default Renewal Term</th>
<th>Default Renewal Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBSC001</td>
<td>Enterprise Monthly Service</td>
<td>Harriott Construction</td>
<td>Harriott Construction: BA_1001</td>
<td>Enterprise Monthly Solution</td>
<td>12 Months</td>
<td>01/15/2013</td>
<td>01/31/2014</td>
<td>1 Year</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

Price Book Line sublist:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription</th>
<th>Repeat Every</th>
<th>Price Plan</th>
<th>Quantity</th>
<th>Included Quantity</th>
<th>Discount</th>
<th>Charge Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBSC001</td>
<td>1</td>
<td>1</td>
<td>Annual</td>
<td>4</td>
<td>0.5</td>
<td>0.1</td>
<td>12</td>
</tr>
</tbody>
</table>
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Transactions import type and the Subscription record type. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Subscription Change Order Import

You can import subscription change order CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topic SuiteBilling.

To import subscription change order records, a subscription with at least one activated subscription line is required. When adding a subscription change order, the subscription, billing account, and customer are required. When updating a subscription change order, you must use the internal ID or external ID of the subscription change order.

### Subscription Change Order Body and Sublist Fields

To prepare subscription change order CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **Customer** (mandatory) — Name of the customer. A subscription for the customer must exist in the account.
- **Action** (mandatory) — Change order activity. Valid actions are:
  - Activate
  - Modify Pricing
  - Reactivate
  - Renew
  - Suspend
  - Terminate
- **Subscription** (mandatory) — Subscription name.
- **Requester** (mandatory) — Name of the person requesting the subscription change order.

**Note:** The information imported varies, depending on the action specified. For activation, termination, reactivation, and suspension, the line number and include fields are imported. For modify pricing, it is possible to define a new price plan, new quantity, and new discount for each item line. For renewals, only body fields are modified.

In a single file import, either the internal ID or external ID field is required. Each single file import with repeating rows for a sublist needs a mapped field. The mapped field identifies the record, which is required because it spans multiple rows in the import file.
The Subscription Change Order import supports the import of Subscription Change Order Items sublist data. **Line Number** is the key field for the sublist, specifying the line number to which the subscription change order is applied.

**Subscription Change Order CSV File Example**

The following example shows how you might structure CSV files for importing subscription change order data.

**Primary File**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Action</th>
<th>Custom er</th>
<th>Effective Date</th>
<th>Billing Ac count</th>
<th>Reque ster</th>
<th>Renewal Start Date</th>
<th>Renewal End Date</th>
<th>Renewal Method</th>
<th>Subscri ption</th>
<th>Renewal Subsc ription Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>8392-ue87</td>
<td>Renew</td>
<td>Alan Rath</td>
<td>07/01/2016</td>
<td>Billing account 1</td>
<td>J Wolfe</td>
<td>09/01/2016</td>
<td>08/31/2017</td>
<td>Extend Existing Subscripti on</td>
<td>Subscription 1</td>
<td>Enterprise 12 Months</td>
</tr>
<tr>
<td>8323-ir98</td>
<td>Modify Pricing</td>
<td>Alan Rath</td>
<td>07/01/2016</td>
<td>Billing account 1</td>
<td>J Wolfe</td>
<td>09/01/2016</td>
<td>08/31/2017</td>
<td>Extend Existing Subscripti on</td>
<td>Subscription 1</td>
<td>Customer Service 12 Months</td>
</tr>
<tr>
<td>9487-po32</td>
<td>Activate</td>
<td>Sam Tho mson</td>
<td>04/15/2016</td>
<td>Billing account 2</td>
<td>J Wolfe</td>
<td>06/30/2016</td>
<td>05/31/2017</td>
<td>Extend Existing Subscripti on</td>
<td>Subscription 4</td>
<td>Enterprise 12 Months</td>
</tr>
</tbody>
</table>

**Subscription Change Order Items Sublist File:**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8323-ir98</td>
<td>1</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8323-ir98</td>
<td>2</td>
<td>Yes</td>
<td>5</td>
<td>3</td>
<td>Ongoing</td>
<td>Active</td>
</tr>
<tr>
<td>9487-po32</td>
<td>1</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9487-po32</td>
<td>2</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Transactions import type and the Subscription Change Order record type. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Subscription Line Import**

You can import subscription line CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topics SuiteBilling and Subscription Management.

**Note:** The subscription line CSV import can update only existing lines in a subscription, usually to change the status from Draft to Pending Activation. New lines cannot be added through CSV import because all subscription lines are created with the subscription record and they reflect lines of the subscription plan.

To be able to update the subscription line data, you will need to learn the subscription line ID for each of the lines you update.

To learn the ID of a subscription line:

1. Go to Transactions > Subscriptions > Create Subscriptions > List and click the subscription containing the line.
Subscription Billing Import Type

2. Click **View** beside the subscription line.

3. Check the page's address bar to find the subscription line's ID. The ID usually appears at the end of the address and has the following format: `id=123`. For example, if the page's URL is `www.system.netsuite.com/app/accounting/subscription/subscriptionline.nl?id=103`, the line ID is **103**.

**Subscription Line Fields**

To prepare subscription line CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import. The import requires either **Internal ID**, which is the subscription line ID, or **External ID**, which is the unique identifier for the record.

**Subscription Line CSV File Example**

The following table shows how you might structure a file for updating subscription line data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Internal ID</th>
<th>Start Date</th>
<th>End Date</th>
<th>Status</th>
<th>Prorate Start Date</th>
<th>Prorate End Date</th>
<th>Revenue Recognition Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>SubS-3484</td>
<td>103</td>
<td>7/22/2016</td>
<td>7/22/2016</td>
<td>Pending</td>
<td>No</td>
<td>No</td>
<td>OVER_TERM</td>
</tr>
<tr>
<td>SubS-3603</td>
<td>109</td>
<td>2/15/2016</td>
<td>2/14/2017</td>
<td>Pending</td>
<td>Yes</td>
<td>Yes</td>
<td>OVER_TERM</td>
</tr>
<tr>
<td>SubS-4920</td>
<td>112</td>
<td>11/23/2015</td>
<td>11/22/2016</td>
<td>Pending</td>
<td>Yes</td>
<td>Yes</td>
<td>OVER_TERM</td>
</tr>
</tbody>
</table>

The Import Assistant is available at **Setup > Import/Export > Import Tasks > Import CSV Records**. Select the Transactions import type and the Subscription Line record type. After you select the record type for import, you choose the import character encoding. For more information, see **Select a Record Type for Import** and **Choose Import Character Encoding**.

**Subscription Plan Import**

You can import subscription plan CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topics **SuiteBilling** and **Creating Subscription Plans**.

**Subscription Plan Body and Sublist Fields**

To prepare subscription plan CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

- **Subscription Plan Name** – Name of the subscription plan.
- **Initial Term** – Initial term for the subscription plan.

Subscription plan records include the Subscription Plan Members sublist. Required values include:

- **Line Number** – Subscription plan line number.
- **Item** – Items included in the subscription plan.
- **Type** – Subscription plan type.
Subscription Plan CSV File Examples

The following example shows how you might structure a single CSV file for importing subscription plan data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription Plan Name</th>
<th>Initial Term</th>
<th>Location</th>
<th>Income Account</th>
<th>Subscription Plan Members: Line Number</th>
<th>Subscription Plan Members: Item</th>
<th>Subscription Plan Members: Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBSPLN001</td>
<td>Acme Vending Service Gold</td>
<td>12 Month</td>
<td>Chicago</td>
<td>Fees</td>
<td>1</td>
<td>Registration Fee</td>
<td>One Time</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>Restocking Service</td>
<td>Recurring</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>Refrigeration Service</td>
<td>Recurring</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>Sodas</td>
<td>Usage Time</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td>Bottled Water</td>
<td>Usage</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td>Juices</td>
<td>Usage</td>
</tr>
</tbody>
</table>

The following example includes the Members sublist data imported in a separate CSV file.

Primary file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription Plan Name</th>
<th>Initial Term</th>
<th>Location</th>
<th>Income Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBSPLN001</td>
<td>Acme Vending Service Gold</td>
<td>Evergreen Term</td>
<td>Chicago</td>
<td>Fees</td>
</tr>
</tbody>
</table>

Members sublist file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Line Number</th>
<th>Item</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SBSPLN001</td>
<td>1</td>
<td>Registration Fee</td>
<td>One Time</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td>2</td>
<td>Restocking Service</td>
<td>Recurring</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td>3</td>
<td>Refrigeration Service</td>
<td>Recurring</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td>4</td>
<td>Sodas</td>
<td>Usage Time</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td>5</td>
<td>Bottled Water</td>
<td>Usage</td>
</tr>
<tr>
<td>SBSPLN001</td>
<td>6</td>
<td>Juices</td>
<td>Usage</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Items import type and the Subscription Plan record type. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Usage Import

You can import subscription usage CSV data for a customer only when SuiteBilling and the related features are enabled on your account. For more information, see the help topic SuiteBilling.

Before you can import any subscription usage data for a customer, a subscription must exist for that customer. For more information, see the help topic Subscription Management.

Usage Fields

To prepare usage CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import:
Subscription Billing Import Type

- **External ID** – Used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports. This field is recommended but not required.
- **Subscription** – Subscription the imported usage data is related to.
- **Quantity** – Item quantity used.
- **Usage Date** – Date on which usage occurred.

To learn about other supported fields, see the help topic *Subscription Management*.

Usage CSV File Example

The following table shows how you might structure a file for importing subscription usage data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subscription</th>
<th>Subscription Line</th>
<th>Subscription Plan</th>
<th>Item</th>
<th>Quantity</th>
<th>Usage Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>USG001</td>
<td>Vending Services</td>
<td>7</td>
<td>Vending Service Gold</td>
<td>One-Time Charge</td>
<td>5</td>
<td>10/23/2015</td>
</tr>
<tr>
<td></td>
<td>12 Months</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USG002</td>
<td>Enterprise 12 Month</td>
<td>8</td>
<td>Enterprise Solution</td>
<td>Service Item</td>
<td>1</td>
<td>11/10/2015</td>
</tr>
<tr>
<td></td>
<td>Solution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USG003</td>
<td>Annual Maintenance</td>
<td>6</td>
<td>Vending Service Gold</td>
<td>Fixed Usage</td>
<td>1</td>
<td>11/11/2015</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USG004</td>
<td>Vending Restocking</td>
<td>9</td>
<td>Vending Service Gold</td>
<td>Usage</td>
<td>6</td>
<td>11/12/2015</td>
</tr>
<tr>
<td></td>
<td>Services</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. Select the Transactions import type and the Usage record type. After you select the record type for import, you choose the import character encoding. For more information, see *Select a Record Type for Import* and *Choose Import Character Encoding*.

Supply Chain Import Type

For information about Supply Chain imports, see the following:

- Bill of Materials Import
- Bill of Materials Revision Import
- Bin Import
- Item Location Configuration Import
- Item Revision Import
- Manufacturing Cost Template Import
- Manufacturing Routing Import

Bill of Materials Import

A Bill of Materials (BOM) lists the quantities of raw materials, assemblies, sub-components, and parts needed to manufacture a product. A BOM can be used to communicate between manufacturing partners, multiple facilities within the organization, or with a single manufacturing plant.
The BOM import record is available when the Advanced Bill of Materials feature is enabled on the Items & Inventory subtab at Setup > Company > Setup Tasks > Enable Features.

In the user interface, you can access the bills of material record at Lists > Supply Chain > Bills of Materials. To learn more, see the help topic Advanced Bill of Materials.

The member components needed for assembly items are identified in the Bill of Materials (BOM) but required components may change over time. These changing requirements can be documented in Bill of Materials Revision record which is part of the BOM. To learn more, see the help topic Creating BOM Revisions.

### Bill of Materials Import Example

The following table provides an example structure for a file to import transfer order data:

<table>
<thead>
<tr>
<th>Available for Assembly</th>
<th>Available for All Locations</th>
<th>ExternalID</th>
<th>Inactive</th>
<th>Memo</th>
<th>Name</th>
<th>Restrict to Assemblies</th>
<th>Restrict to Locations</th>
<th>Use Component Yield</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>BAR45562</td>
<td>No</td>
<td></td>
<td>Bicycle Assembly Red</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>BAB45563</td>
<td>No</td>
<td></td>
<td>Bicycle Assembly Blue</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Bill of Materials Revision Import

A Bill of Materials (BOM) revision enables you to update a BOM’s details throughout the product lifecycle. A BOM revision also provides an accessible revisions history.

For example, Bicycle Assembly Revision V2 updates the components used in building road bicycles saving the company money because it improves production and assembly methods.

The BOM Revision import record is available when the Advanced Bill of Materials feature is enabled on the Items & Inventory subtab at Setup > Company > Setup Tasks > Enable Features.

In the user interface, you can access the bill of materials revision record at Lists > Supply Chain > Bills of Materials.

The member components needed for assembly items are identified in the Bill of Materials Revision but required components may change over time. These changing requirements can be documented in Bill of Materials Revision record. To learn more, see the help topic Creating BOM Revisions.

### Bill of Materials Revision Import Example

The following table provides an example structure for a file to import bill of materials data:

<table>
<thead>
<tr>
<th>Bill of Materials</th>
<th>Effective End Date</th>
<th>Effective Start Date</th>
<th>ExternalID</th>
<th>Inactive</th>
<th>Memo</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bicycle Assembly BOM Red</td>
<td>05/31/2019</td>
<td>05/16/2019</td>
<td>BAR45562</td>
<td>No</td>
<td></td>
<td>Bicycle Assembly Red</td>
</tr>
<tr>
<td>Bicycle Assembly BOM Blue</td>
<td>05/15/2019</td>
<td>05/01/2019</td>
<td>BAR45563</td>
<td>No</td>
<td></td>
<td>Bicycle Assembly Blue</td>
</tr>
</tbody>
</table>

### Bill of Materials Revision Import Sublist Example

The following table provides an example structure for a file to import bill of materials sublist data:
Bin Import

Bin records define bin locations within a warehouse or stock room. Bin record numbers are associated with items and included on receiving and fulfilling transactions to keep track of the on-hand quantity for each bin.

For details about bins in NetSuite, see the help topic Creating Bin Records.

Note: Bin imports are not available unless the Bin Management feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Items & Inventory subtab, check Bin Management.

Note the following:

- A Bin Number field value is required to uniquely identify each Bin record.
- If the Multi-Location Inventory (MLI) feature is enabled, the Location field is required. Note that if you use bins with MLI, you must use bins in all locations. After a bin record has been saved for the first time, the location value cannot be changed.
- After bin records have been created, you can associate them with inventory item records. To associate bins with an item record, you need to set the item's Use Bins field value to True, and add bin records to the item's Bin Numbers sublist. You can set the Preferred field value to True for one item bin record per location. You can complete these tasks on the Item page in the user interface, or through an Items import.

For details about fields that can be mapped in the bin record, see the SOAP Schema Browser’s bin. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Item Location Configuration Import

When using the Advanced Item Location Configuration feature, item location attributes can be set or updated using the CSV import process.

For example, item location attributes may need to be added when a new location is added. Or, if an item has a new vendor lead time, that update may need to be made across locations. You can make these changes by mass updates using CSV import.

To import CSV records for Item Location Configuration, use the CSV import assistant. For details about CSV Imports, read CSV Imports Overview.

**To import CSV records for Item Location Configuration:**

1. Save a CSV formatted file with the updates.
2. Go to Setup > Import/Export > Import CSV Records.
3. Select Supply Chain as the Import Type.
4. Select Item Location Configuration as the Record Type.
5. In the CSV File(s) section, select to upload One File or Multiple Files.
6. Select the .csv file you want to upload.
7. Click Next.
8. In the Import Options page, select Add and then click Next.
9. Click Submit.

You can still manually update individual items and location attributes, if needed.

**Item Revision Import**

When the Assembly Items feature is enabled, you can use this import to add and update item revision records that define which member items should be included in assembly builds during specific time frames.

The exact member components needed for assembly items are identified in the Bill of Materials (BOM), but required components may change over time. These changing requirements can be documented in item revision records, which are part of BOM member control functionality. An item revision record sets an effective date for a member item to be included in assembly builds. Each item revision record can be assigned to multiple assembly items, because one item can be a member of different assembly items. For more details, see the help topic Bill of Materials Member Control for Assembly Items.

The Item Revision import supports the following fields:

- Effective Date (required) — the date when a member item should begin to be included in assembly items to which this revision record is assigned
- ExternalId — can be used as a unique identifier for each item revision record
- Inactive — Boolean indicating whether the item revision record is inactive
- Item (required) — the member item to which this item revision record applies
- Memo — optional descriptive text
- Name (required) — name of the item revision record

This import cannot add or update values for the Obsolete Date field. When an imported revision record is saved, the system determines its obsolete date, based on its effective date and on the effective dates of other revision records for the member item, to avoid gaps or overlaps in dates covered by revisions.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Manufacturing Cost Template Import**

Import of the manufacturing cost template record is possible only if the Manufacturing Routing and Work Center feature has been enabled at Setup > Company > Enable Features, on the Items & Inventory subtab.

The Manufacturing Routing and Work Center feature lets you create routings that specify a sequence of tasks, or operations, required for the building of assembly items. Creating a cost template is one step in
this process. A cost template groups together the various costs associated with a particular activity. For example, a cost template representing the cost of metalworking might include a metalworker’s wages, the fuel costs associated with running a forge, and wear and tear on the forge. Later, when you create routing records, you use cost templates to represent the rates associated with each task, or operation, included in your routing.

Before you begin importing cost templates, it might be useful to view the form you would use to manually create these records, at Lists > Supply Chain > Manufacturing Cost Templates > New. For details on the process of manually creating a cost template, see the help topic Creating Manufacturing Cost Templates. For general details about the Manufacturing Routing and Work Center feature, see the help topic Manufacturing Routing.

For more details on importing cost templates, see the following:

- Prerequisite Records for Cost Template Import
- Cost Template Body and Sublist Fields
- Cost Template CSV File Examples
- Common Errors When Importing Cost Templates

**Prerequisite Records for Cost Template Import**

When you create a cost template record, you rely on certain prerequisite records that must already exist in NetSuite. Specifically, you need at least one record of each of the following types:

- Cost Categories
- Charge Items

Before creating these records, you should also be familiar with the concept of Cost Types, which are classifications predefined by NetSuite.

**Cost Types**

A cost type is a classification that distinguishes between general types of expenses, such as the cost of paying an employee versus the cost of operating a machine. NetSuite defines the following cost types for use with the manufacturing routing feature:

- Labor Setup
- Labor Setup Overhead
- Labor Run
- Labor Run Overhead
- Machine Setup
- Machine Setup Overhead
- Machine Run
- Machine Run Overhead

These cost types become available when you enable the Manufacturing Routing and Work Center feature (at Setup > Company > Enable Features, on the Items & Inventory subtab). After the feature is enabled, you can view the routing cost types on the page where you create cost category records.

**Cost Categories**

A cost category is a record you create in NetSuite. It is an expense classification that belongs to a particular cost type. For example, you might create cost categories labeled US Labor Run Standard and Europe Labor Run Standard, each of which belongs to the cost type Labor Run. You create cost categories at Setup > Accounting > Accounting Lists > Cost Categories.
To be valid for use on a cost template, a cost category must belong to one of the manufacturing routing cost types (as opposed to one of the other cost types that may be available).

When you select cost categories to use in your cost template, note the following restriction: In some cases, if two cost categories belong to the same cost type, only one of the categories may be allowed on the template. Whether or not this restriction applies is determined by the cost type, as described in the following table.

<table>
<thead>
<tr>
<th>Cost Type</th>
<th>Notes on Using Cost Categories of this Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor Setup</td>
<td>Only one cost category using this cost type can appear on any cost template.</td>
</tr>
<tr>
<td>Labor Run</td>
<td>Only one cost category using this cost type can appear on any cost template.</td>
</tr>
<tr>
<td>Machine Setup</td>
<td>Only one cost category using this cost type can appear on any cost template.</td>
</tr>
<tr>
<td>Machine Run</td>
<td>Only one cost category using this cost type can appear on any cost template.</td>
</tr>
<tr>
<td>Labor Setup Overhead</td>
<td>Cost categories using this cost type can occur multiple times on a cost template.</td>
</tr>
<tr>
<td>Labor Run Overhead</td>
<td>Cost categories using this cost type can occur multiple times on a cost template.</td>
</tr>
<tr>
<td>Machine Setup Overhead</td>
<td>Cost categories using this cost type can occur multiple times on a cost template.</td>
</tr>
<tr>
<td>Machine Run Overhead</td>
<td>Cost categories using this cost type can occur multiple times on a cost template.</td>
</tr>
</tbody>
</table>

For more on cost types and cost categories, see the help topic Defining Cost Categories for Routing.

**Charge Items**

Before you can begin importing cost templates, you must create charge items that reference your cost categories. A charge item is an item record that has been flagged as a Manufacturing Charge Item on the Purchasing tab of the item record. Charge items include an exact monetary rate, and they must be associated with a cost category valid for use on a cost template.

You can manually create charge item records, or you can import them. To manually create a charge item, go to Lists > Accounting > Items > New, then choose an appropriate item type, such as Other Charge for Purchase. (Note that only certain item types can be flagged for use as a Manufacturing Charge Item.) When creating your charge items, make sure you select the Manufacturing Charge Item box or, if importing, map the field to a value of Yes.

For more on manually creating item records, see the help topic Creating Item Records. For more on item record import, see Items Import.

**Cost Template Body and Sublist Fields**

When you import a cost template, you specify several body values, plus at least one record in the template’s sublist.

**Body Fields**

The following body fields are supported for import.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExternalId</td>
<td>Can be used as a unique identifier for the record.</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
<td>Required?</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Inactive</td>
<td>If set to Yes, the cost template is hidden in lists on records and forms.</td>
<td>No, but if you do not include a mapping for this field, the system uses the default value, which is No.</td>
</tr>
<tr>
<td>Memo</td>
<td>Can be used to add a description about the record.</td>
<td>No</td>
</tr>
<tr>
<td>Name</td>
<td>Used as a label for the template. This value must be unique.</td>
<td>Yes</td>
</tr>
<tr>
<td>Subsidiary (OneWorld only)</td>
<td>The subsidiary in which this template is available.</td>
<td>Yes, for OneWorld accounts</td>
</tr>
</tbody>
</table>

**Sublist Fields**

At least one row is required in this record’s sublist. In the Import Assistant, this sublist is referred to as Manufacturing Cost Template Cost Detail. (In the UI, the sublist is labeled simply Costs — to see this, choose Lists > Supply Chain > Manufacturing Cost Templates > New).

Each record in the sublist must consist of a pair of values, as follows. Note that this sublist is not keyed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Category</td>
<td>Must name a cost category record, created in NetSuite, that uses one of the manufacturing cost types. For more details on this entry, including restrictions on duplicate cost type references, see Cost Categories.</td>
<td>Yes</td>
</tr>
<tr>
<td>Item</td>
<td>Must refer to a charge item, created in NetSuite, that uses the cost category named for this particular sublist record. If you choose an Item that uses a different cost category, the import fails. For more details on charge item records, refer to Charge Items.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Cost Template CSV File Examples**

You can import cost template records using multiple files or a single file.

**Multiple Files Import**

With a multiple-file import, you use one file for the cost template body fields and another file for the Cost Detail sublist.

The file holding the body data must include, at a minimum, the name of the template. An External ID is also recommended. For example:

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Metalworking Rates</td>
</tr>
<tr>
<td>102</td>
<td>Mailroom Rates</td>
</tr>
<tr>
<td>103</td>
<td>Warehouse Rates</td>
</tr>
</tbody>
</table>

For full details on body fields supported for import, see Custom List Body Fields.
Each row in the second file must include a cost category and an item that are a matching pair. For example, suppose the charge item value is Metalworker Labor Run and the cost category value is Skilled-Labor Run. If you open the item record for Metalworker Labor Run and review the record’s Purchasing tab, you should see the actual cost category for the item. If that category is not Skilled-Labor Run, the import fails.

Further, each row in the file must include a unique identifier to pair the row with the appropriate entry from the main file.

For example, the following data would create one sublist record for each of the three cost templates identified in the sample main file above.

<table>
<thead>
<tr>
<th>ExternalID</th>
<th>Cost Category</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Skilled-Labor Run</td>
<td>Metalworker Labor Run</td>
</tr>
<tr>
<td>102</td>
<td>Labor Run</td>
<td>Mailroom Labor Run</td>
</tr>
<tr>
<td>103</td>
<td>Labor Run</td>
<td>Warehouse Labor Run</td>
</tr>
</tbody>
</table>

If you want to create more than one sublist record for any of your cost template records, add multiple rows for that item to the secondary file. Again, make sure that each row includes a unique identifier to match the sublist data to the appropriate cost template record.

<table>
<thead>
<tr>
<th>ExternalID</th>
<th>Cost Category</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Skilled-Labor Run</td>
<td>Metalworker Labor Run</td>
</tr>
<tr>
<td>101</td>
<td>Skilled-Labor Setup</td>
<td>Metalworker Labor Setup</td>
</tr>
<tr>
<td>101</td>
<td>Skilled-Labor Machine Run</td>
<td>Forge Press Machine Run</td>
</tr>
<tr>
<td>102</td>
<td>Labor Run</td>
<td>Mailroom Labor Run</td>
</tr>
<tr>
<td>102</td>
<td>Labor Setup</td>
<td>Mailroom Setup Rates</td>
</tr>
<tr>
<td>103</td>
<td>Labor Run</td>
<td>Warehouse Labor Run</td>
</tr>
<tr>
<td>103</td>
<td>Labor Setup</td>
<td>Warehouse Setup Rates</td>
</tr>
</tbody>
</table>

With a multiple-file import, the fields should be mapped as shown in the following illustration. If you name your columns as shown in the tables above, the mapping should happen automatically.

**Single File Import**

With a single-file import, all data for a single cost template record must exist on a single row. For this reason, if the sublist data for any cost template must include more than one record, you must create a discrete set of columns for mapping each cost category and item pair.
For example, the following sample would create three new cost template records. For each cost template record, the Cost Detail sublist would include two records.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Name</th>
<th>Manufacturing Cost Template Cost Detail 1: Cost Category</th>
<th>Manufacturing Cost Template Cost Detail 1: Item</th>
<th>Manufacturing Cost Template Cost Detail 2: Cost Category</th>
<th>Manufacturing Cost Template Cost Detail 2: Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>104</td>
<td>Woodworking rates</td>
<td>Skilled-Labor Run</td>
<td>Woodworker Labor Run</td>
<td>Skilled-Labor Overhead</td>
<td>Woodworker-Lab Costs</td>
</tr>
<tr>
<td>105</td>
<td>Project management rates</td>
<td>Skilled-Labor Run</td>
<td>Project-Manager Labor Run</td>
<td>Skilled-Labor Overhead</td>
<td>Conference-Room Use</td>
</tr>
<tr>
<td>106</td>
<td>Assembly line rates</td>
<td>Labor Run</td>
<td>Assembly-Worker Labor Run</td>
<td>Machine Run</td>
<td>Assembly-Line Machine Cost</td>
</tr>
</tbody>
</table>

On the mapping page, the fields should be mapped as shown in the following illustration. Note that, in the column at the right, under NetSuite Fields, two instances of the sublist fields must be used, because the CSV file includes two sets of cost-category/item pairings.

If you name your columns as shown in this example, the mapping should happen automatically. If you choose column headings that do not match what the system expects, you must map the fields manually.

In these cases, if your import requires multiple instances of the sublist fields, you must manually create the additional fields in the right-hand mapping column under “NetSuite Fields.” You can create an extra instance by clicking the plus sign next to the Cost Template Cost Detail label.

Common Errors When Importing Cost Templates

The “Results” file for a failed cost template import might include any of the following messages.

You must enter at least one line

This error indicates that you failed to include sublist data for every cost template record. Each cost template record must have at least one sublist record.

If you are doing a multiple-file import, this error might point to a problem with the key column you are using to link the files. For example, one of the files might include a typo in this column, preventing proper linking of the cost template’s body data to its sublist data.
Invalid item reference key

Indicates that the item name in one of your sublist records is incorrect. You may have typed it incorrectly, or you may have paired it with a cost category that it does not belong to. Check the item record to see what the correct category is. The category is shown on the Purchasing tab of the item record.

Manufacturing Routing Import

Import of the manufacturing routing record is possible only if the Manufacturing Routing and Work Center feature has been enabled at Setup > Company > Enable Features, on the Items & Inventory subtab.

You use the manufacturing routing record to specify a sequence of tasks, or operations, required for the building of assembly items. For example, suppose your company sells handmade cedar chests. Building a cedar chest might include steps such as sanding the boards, assembling the chest, and cleaning the work space. With the routing record, you can specify the order in which all of these tasks, or operations, must take place. You can also identify the amount of time each operation is expected to take, the employees that must complete each operation, and a cost template that ultimately determines what each operation costs. Further, you can create multiple routings for the same assembly item, then pick the appropriate routing at the time you create the work order.

Before you begin importing routing records, it might be useful to view the form you would use to manually create these records, at Lists > Supply Chain > Manufacturing Routing > New.

For details about the process of manually creating a routing record, see the help topic Creating a Manufacturing Routing. For general details about the Manufacturing Routing and Work Center feature, see the help topic Manufacturing Routing.

For details on importing routing records, see the following:

- Prerequisite Records for Routing Import
- Routing Body and Sublist Fields
- Routing CSV File Examples
- Common Errors When Importing Routing Records

Prerequisite Records for Routing Import

When you create a routing record, you rely on certain prerequisite records that must already exist in NetSuite. Specifically, you need at least one record of each of the following types:

- Assembly Item
- Manufacturing Work Center
- Default Calendar
- Manufacturing Cost Template

You cannot import routings until you have created these records.

Assembly Item

An assembly item is an item built from member components — other items that exist in your system. It is not possible to create a routing record without naming a specific assembly item to which the routing
can be applied. If necessary, you can import routing records that name one particular assembly item and update the routing records later to name different assembly items.

You can manually create assembly item records using the New Assembly/Bill of Materials form, available at Lists > Accounting > Items > New > Assembly/Bill of Materials. Alternatively, you can import these records. For details on manually creating assembly records, see Assembly Item. For details on the import process, see Items Import.

**Manufacturing Work Center**

A manufacturing work center is a static group of employees that has been flagged as a manufacturing work center on the group record. For each operation you create on any routing record, you also must identify a value for manufacturing work center. This value identifies the group responsible for completing the operation.

You can create a work center by using the Create Group form, which is available at List > Relationships > Groups > New. The group you create should be a static group made up of employees. Further, on the group record, you must select the box labeled Manufacturing Work Center. If you do not do this, the group is not recognized as a valid entry on a routing record.

For more details, see the help topic Creating Manufacturing Work Centers or Groups.

**Default Calendar**

NetSuite uses the default work calendar to schedule the operations associated with work centers. The calendar can affect the time required to complete an assembly. If appropriate, you can create a different default calendar, at Lists > Employees > Work Calendars > New. To ensure that your routings use this calendar, select the Default Calendar box on the calendar record. For more details, see the help topic Setting Up a Work Calendar.

**Manufacturing Cost Template**

A manufacturing cost template defines the rates used to calculate the cost of an operation. For each operation you create on any routing record, you also must identify an existing cost template record.

For details on manually creating cost templates, see the help topic Creating Manufacturing Cost Templates. For details on importing cost templates, see Manufacturing Cost Template Import.

**Routing Body and Sublist Fields**

When you import a routing record, you specify several body values, plus at least one entry in the record’s sublist.

**Body Fields**

The following body fields are supported for import.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>If mapped to a value of Yes, this routing is used as the default for the assembly item specified in the Item field.</td>
<td>No, but if you do not include a mapping for this field, the system uses the default value, which is No.</td>
</tr>
</tbody>
</table>
Supply Chain Import Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExternalId</td>
<td>Can be used as a unique identifier for the record.</td>
<td>No</td>
</tr>
<tr>
<td>Inactive</td>
<td>If mapped to a value of Yes, this routing is hidden in lists on records and forms.</td>
<td>No, but if you do not include a mapping for this field, the system uses the default value, which is No.</td>
</tr>
<tr>
<td>Item</td>
<td>The assembly item to which this routing can be applied.</td>
<td>Yes</td>
</tr>
<tr>
<td>Location</td>
<td>The locations with which this routing is associated. When entering multiple locations, separate each value with either the pipe symbol (</td>
<td>) or your custom multi-select value delimiter (which can be specified on either the CSV Import Preferences page or under Advanced Options on the second page of the Import Assistant).</td>
</tr>
<tr>
<td>Memo</td>
<td>Can be used to add a description about the record.</td>
<td>No</td>
</tr>
<tr>
<td>Name</td>
<td>A name for this particular routing. This value must be unique.</td>
<td>Yes</td>
</tr>
<tr>
<td>Subsidiary (OneWorld only)</td>
<td>The subsidiary with which this routing is associated.</td>
<td>Yes, for OneWorld accounts</td>
</tr>
</tbody>
</table>

**Sublist**

For each routing record, you must include at least one record in the Manufacturing Routing Routing Steps sublist. Each record in the sublist must include values for the fields listed in the following table.

Note that this sublist is keyed — the key field is Operation Sequence.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Sequence</td>
<td>A numeric value that determines the sequence of this operation relative to others. This field is the key for the sublist.</td>
<td>Yes</td>
</tr>
<tr>
<td>Operation Name</td>
<td>A name that describes the task to be completed.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manufacturing Work Center</td>
<td>The group responsible for completing the operation.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manufacturing Cost Template</td>
<td>The rates associated with this work.</td>
<td>Yes</td>
</tr>
<tr>
<td>Setup Time (Min)</td>
<td>The number of minutes of setup time required to complete the task.</td>
<td>Yes</td>
</tr>
<tr>
<td>Run Rate (Min/Unit)</td>
<td>The number of minutes per unit required to complete this task.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Routing CSV File Examples**

You can import routing records using multiple files or a single file.

**Multiple Files Import**

With a multiple-file import, you create a main file for body fields and a secondary file for the Routing Steps sublist. The following example shows how your main file might look when importing one routing record.
The second file should include details of the actual operations required by the assembly process. Each operation belongs on its own row and must include a unique identifier that links it to an entry in the main file, as follows.

<table>
<thead>
<tr>
<th>ExternalId</th>
<th>Operation Sequence</th>
<th>Operation Name</th>
<th>Manufacturing Work Center</th>
<th>Manufacturing Cost Template</th>
<th>Setup Time (Min)</th>
<th>Run Rate (Min/Unit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>10</td>
<td>Retrieve materials</td>
<td>Warehouse Employees</td>
<td>Warehouse Rates</td>
<td>5</td>
<td>20</td>
</tr>
<tr>
<td>101</td>
<td>20</td>
<td>Sand boards</td>
<td>Woodworkers</td>
<td>Woodworking Rates</td>
<td>15</td>
<td>40</td>
</tr>
<tr>
<td>101</td>
<td>30</td>
<td>Assemble chest</td>
<td>Woodworkers</td>
<td>Woodworking Rates</td>
<td>15</td>
<td>180</td>
</tr>
<tr>
<td>101</td>
<td>40</td>
<td>Clean up work space</td>
<td>Shop Workers</td>
<td>Shop-Working Rates</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>101</td>
<td>50</td>
<td>Move chest to stock room</td>
<td>Warehouse Employees</td>
<td>Warehouse Rates</td>
<td>5</td>
<td>25</td>
</tr>
</tbody>
</table>

With a multiple-file import, the fields should be mapped as shown in the following illustration. If you name your columns as shown in this example, the mapping should happen automatically.

**Single File Import**

With a single-file import, all data for a single routing record must exist on the same row. For this reason, if the sublist for any routing record must describe more than one operation, you must create a discrete group of columns for mapping each operation. Each group should include all six required sublist fields (Manufacturing Cost Template, Manufacturing Work Center, and so on).

For example, the following table shows an excerpt from a file you could use to create two new manufacturing routing records. For each routing record, two operations are defined for the Routing Steps sublist. (The entire data snippet is not shown; for the import to be successful, both rows would include
additional columns representing second instances of the Work Center, Cost Template, Setup Time, and Run Rate fields.)

Formatting restrictions make the table unreadable in the PDF output.

On the mapping page, the fields should be mapped as shown in the following illustration. Note that, in the column at the right, two instances of the sublist fields must be used. Two instances are used because the CSV file includes two sets of columns for the routing steps sublist.

If you name your columns as shown in this example, the mapping should happen automatically. If in your CSV file you choose column headings that do not match what the system expects, you must map the fields manually.

In these cases, if your import requires multiple instances of the sublist fields, you must manually create the additional fields in the right-hand mapping column under “NetSuite Fields.” You can create an extra instance by clicking the plus sign next to the Manufacturing Routing Routing Steps label.

**Common Errors When Importing Routing Records**

The “Results” file for a failed routing record import might include any of the following messages.

**You must enter at least one line**

This error indicates that you failed to include sublist data for every routing record. Each routing record must have at least one sublist record.
If you are doing a multiple-file import, this error might point to a problem with the key column you are using to link the files. For example, one of the files might include a typo in this column, preventing proper linking of the routing record body data to its sublist data.

**Invalid location reference key**

This error could indicate that any of the following occurred:

- You entered an incorrect value for the Location field. For example, you might have included a typo in the location name.
- You entered a location that is not valid for the subsidiary being referenced.
- You entered multiple valid locations but made a formatting error. For example, if you placed spaces around the Multi-Select Value Delimiter (the default is a |), the system generates this error.

**This sequence number is already in use on another step**

Indicates that you mapped a value to the Operation Sequence field that is not unique for the routing record being referenced. For example, you entered two operations with the sequence “20.”

If you are doing a multiple-file import, this error might point to a mistake with the unique identifier used to link the sublist records to the body data. For example, suppose your file defines Routings A and B, each of which includes three operations with sequence values of 10, 20, and 30. If you inadvertently associated one of the Routing B rows with the same unique identifier used for Routing A, then you would get this error.

**'Invalid manufacturingworkcenter reference key Value'**

Indicates that you mapped an invalid value to the Manufacturing Work Center field. If you are certain you entered the correct name of an employee group, check to make sure that the record for the group has the Manufacturing Work Center box selected.

**Support Import Type**

The following imports relate to support management:

- **Issues Import**
- **Solutions Import**
- **Support Cases Import**
- **Topics Import**

**Issues Import**

The Issues import adds issues to the Issue list.

For details about fields that can be mapped in the issue record, see the SOAP Schema Browser’s issue reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Solutions Import**

NetSuite knowledge bases allow you to organize and deliver information specific to your business. Knowledge bases can increase the efficiency of your support reps and increase communication within your company.

You can create a hierarchy of topics and subtopics to organize your knowledge base solutions. When you create a new topic, you can place this topic under a parent topic by selecting the parent topic in the Subtopic Of field.

Solutions may be attached to topics and subtopics. If you are attaching a solution to a subtopic, you must provide the full topic reference hierarchy, using the field delimiter you define. For more information, see Name References.

The solution data that you can import depend on the fields available on either your preferred Solution form, or the custom solution form selected on the Import Assistant Import Options page. For details about specifying a custom form, see Set Advanced CSV Import Options.

For details about fields that can be mapped in the solution record, see the SOAP Schema Browser's solution reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Be aware of the following:

- Currently, custom fields cannot be imported into solution records.
- The Solutions import supports the import of Topics and Related Solutions sublist data.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Support Cases Import**

A support case, also known as a case, is a record of a customer-reported question, issue, or suggestion, and subsequent actions taken.

The support case data that you can import depend on the fields available on either your preferred Case form, or the custom case form selected on the Import Assistant Import Options page. For details about specifying a custom form, see Set Advanced CSV Import Options.

For details about fields that can be mapped in the support case record, see the SOAP Schema Browser's support case reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Be aware of the following:

- Required case fields for import are: Company, Subject, Status, and Incident Date.
Support Import Type

- The Incident Date field includes both a date and a time. You need to exercise care when you format values for this field in your CSV files. To avoid errors, review and follow the guidelines in Setting Incident Date Field Values for Cases.
- Imports cannot send case-related email.
- Escalations and Solutions sublist data can be imported. Escalation records are selectively updatable based on Escalatee key field.
- If you are doing a cases import for the addition of new cases, select the Add data handling option, rather than Add or Update.
- If you need to use an import to update existing case records, you must map either the Internal ID or External ID field to uniquely identify records. This requirement is enforced when you select the Update data handling option and when you select the Add or Update data handling option.

Setting Incident Date Field Values for Cases

The Incident Date mapped field for CSV import represents both the date and the time when a case is reported, as shown in the fields labeled Incident Date and Incident Time on the standard Case form.

Observe the following guidelines when you enter values for Incident Date fields in CSV files used for case imports:

- Provide both a date and a time, for example: 04/12/2010 09:00 AM.
- Specify values according to the NetSuite Date Format and Time Format set at Home > Set Preferences for the user doing the import. The following are example formats:
  - Date Format is MM/DD/YYYY.
  - Time Format is hh:mm AM/PM.
  - A space should be included between the date and time, for example: 04/12/2010 10:00 AM.

  **Note:** If a date is provided without a time value, 12:00 AM will be assumed by default.

- To avoid Excel formatting errors for Incident Date values, NetSuite recommends that you right-click the column and choose Format Cells to explicitly select a format that matches the Date Format (and if applicable, Time Format) set up in NetSuite.
Support Import Type

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Topics Import

NetSuite knowledge bases allow you to organize and deliver information specific to your business. Knowledge bases can increase the efficiency of your support reps and increase communication within your company. To be able to use a NetSuite knowledge base, you should ensure that you have the appropriate features enabled.

You can create topics and subtopics to organize your knowledge base solutions. When you create a new topic, you can place this topic under a parent topic by selecting the parent topic in the Subtopic Of field. When doing this, you must provide the full topic hierarchy, using the field delimiter you define. For more information, see Name References.

Solutions may be attached to topics and subtopics. If you are attaching a solution to a subtopic, you must provide the full topic hierarchy, using the field delimiter you define.

Currently, custom fields cannot be imported into topic records.

For details about fields that can be mapped in the topic record, see the SOAP Schema Browser’s topic reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Transactions Import Type

Transactions imports support the addition and/or update of data for some transaction subtypes. Currently, the Import Assistant supports the following transaction subtype imports:

- Advanced Intercompany Journal Entry Import
- Cash Sale Import
- Check Import
- Credit Card Charge Import
- Credit Card Refund Import
- Credit Memo Import
- Custom Transactions Import
- Customer Payment Import
- Estimate Import
- Inventory Adjustment Import
- Inventory Cost Revaluation Import
- Inventory Transfer Import
Be aware of the following:

- You can import transaction data in a single CSV file, or in multiple files, for example, with transaction header data in one file and item-level data in other files. For imports of new data, you should include external ID values to uniquely identify transactions. For updates, you can use internal IDs for this purpose. The unique ID should be included in every line of the CSV files. Note that the transaction ID is not unique.

- By default the Field Mapping page for a transactions import includes the NetSuite fields from your preferred form for the selected record type. Fields can be mapped for the import job if they are displayed (not hidden) and not disabled on your preferred form. These default mappable NetSuite fields may not match the fields that you need to import; you may want to include fields available on another record type form.

  To ensure that the appropriate fields are available for mapping, you can change the selection for Custom Form, in the Advanced Options area of the Import Assistant's Import Options page. For more information, see Set Advanced CSV Import Options.

- If auto-generated numbering is enabled, transaction numbers can still be set if the Allow Override option is enabled.

- To maintain performance, 5000 lines per transaction is the maximum recommended limit for transactions submitted through CSV import. (For journal entries, this limit is 10,000 lines per transaction.)

- To avoid errors related to imported transaction address data: for state fields, use short names rather than full names, and for country fields, use full names rather than codes. A dropdown list of country names is available from the edit icon on the Field Mapping page, to be set as default country field values. See State and Province Names for CSV Import and Country Names for CSV Import.

- To import a transaction with multiple line items, use the same transaction number field for each line item.

- You should import entities and items data before you import transactions data.

  - To reference entities such as customers in transaction CSV files, use the number if auto-generated numbering is enabled; otherwise, use the customer name.
Item references in transaction CSV files must match the spelling and case of the item names in your NetSuite account.

Account references in transaction CSV files should be account names rather than numbers.

For sub-customers, sub-items, and sub-accounts, use hierarchical parent:child references. For more information, see Delimiters for Hierarchical and Multi-Select Fields.

For Cash Sale, Estimate, Invoice, Purchase Order, Sales Order, and Vendor Bill imports, Items data is required for imports of new records, but not for imports that update existing records. Items data is not required for Opportunity imports. Items data is not relevant to Customer Payment and Vendor Payment imports. See Required Items Sublist Fields for Transactions Imports.

You can import values for custom transaction item options along with Items sublist data. The Item Options feature must be set up in your account, and transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New. For details, see Importing Transaction Item Options.

If you do not map the Price Level field for any imported transaction items, the base price from the item record is used as that line item's price. To use a different price, you must map the Price Level field in your import, and either include a Price Level column with values in the CSV file, or on the Field Mapping page, click the edit icon for the mapped Price Level field and select Custom as the default. (Note that this default is not guaranteed to be a valid level for all items.)

Be aware of the following when you use the Import Assistant to update transaction records:

As of Version 2010 Release 1, the Use Conditional Defaults option is no longer available. Now, imports always populate dependent field values automatically when related field values are set, in the same manner that dependent field values are populated in the user interface. For updates, be sure to include all necessary values in CSV files, to avoid inadvertently changing existing field values to defaults.

Some transaction sublists are keyed and some are not. For non-keyed sublists, partial updates are not supported; CSV file sublist data either completely replaces existing sublist data or is appended, depending upon the setting for the Overwrite Sublists option. Also, for non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields in the same import job. For a list of keyed and non-keyed transaction sublists supported for import, see Supported Sublist Imports.

The Import Assistant lets you update items data for the following types of transactions: Cash Sale, Estimate, Invoice, Opportunity, Purchase Order, Sales Order, and Vendor Bill. You can modify data for existing line items and/or add line items to existing transactions. The Items sublist for transactions uses either Line/Order Line or Item as a key field to determine how to update or add line items. For more information, see Line Item Updates on Transactions Imports.

Complete deletion of sublist data currently is not supported. Existing sublist data can only be overwritten with new CSV file sublist data, not with an absence of CSV file sublist data.

You can use transaction import capabilities to perform mass updates of supported transaction subtype data. Create a saved search, export saved search results and modify them in an external application, then use the Import Assistant, with an Update data handling option, to reimport modified data. You need to set certain criteria for your saved search to generate an exported file with appropriate data for reimporting. For information, see Creating Transaction Saved Searches for Reimport.

Advanced Intercompany Journal Entry Import

In NetSuite OneWorld, an advanced intercompany journal entry records the impact of transactions between a "from", or originating, subsidiary and multiple "to", or receiving subsidiaries.

You can import multiple advanced intercompany journal entries from another system into NetSuite. Each import job can include data for any combination of classes, department, locations, and subsidiaries.
Important: To import a single advanced intercompany journal entry, you can use a simpler import process available at Transactions > Financial > Make Advanced Intercompany Journal Entries > Import to import a single advanced intercompany journal entry. For more information, see Single Journal Entry Import.

Import is supported for journal entries with up to 10,000 lines. However, poor performance results during import and in the user interface for journal entries with over 1000 lines, and these large journal entries may not be editable in the user interface.

Review the following guidelines for advanced intercompany journal entry imports.

Permissions for Importing Advanced Intercompany Journal Entries with the Import Assistant

To use the Import Assistant to import advanced intercompany journal entries, you need the following permissions:

- Make Journal Entry (Edit or Full)
- Posting Period on Transactions (Full)
- Import CSV File

To set journal entries to approved during import, you also need:

- Journal Approval (Edit or Full)

If you have the Make Journal Entry and Posting Period on Transactions permissions, but not the Import CSV File permission, you can use the Single Advanced Intercompany Journal Entry Import. For more information, see Single Journal Entry Import.

To enable users to use the Import Assistant to import journal entries, an account administrator should do the following:

1. Create a new custom role that includes only the Make Journal Entry (Edit or Full), Posting Period on Transactions (Full), and Import CSV File permissions.
2. Add this new role to all users who require the ability to import journals.
3. Instruct users that they should choose this role when they import journals.

For users who need to set journal entries to approved during import, a custom role can be created with the Make Journal Entry, Posting Period on Transactions, Import CSV File, and Journal Approval permissions.

Users' access to subsidiaries also impacts the journal entries that they can import. For more information, see the help topic Control Employee Access to Subsidiaries.

Advanced Intercompany Journal Entry CSV File Requirements

Review the following requirements for advanced intercompany journal entry files:

- Each imported advanced intercompany journal entry must include at least four lines, with one debit and credit each for the originating and receiving subsidiary. When you use the simple import assistant, only this requirement applies.
- Your CSV files should include both header and line-level data.
You can import data in a single CSV file, or in multiple files, for example, with header data in one file and line-level data in other files. Each transaction can be uniquely identified by its value for one of the following fields: Entry No., External ID, or (updates only) Internal ID. This value should be included in every row of the CSV files.

If you include both header-level and line-level data in one file, each row of the CSV file represents a transaction line, and header-level field values must be included in each row, even if it is repetitious.

**Advanced Intercompany Journal Entry Supported Fields**

The Import Assistant Field Mapping page displays the list of advanced intercompany journal entry fields for which you can import data. Header-level fields are listed under Advanced Intercompany Journal Entry and line-level fields are listed under the Advanced Intercompany Journal Entry Line sublist. These are the fields for which you can include data in your CSV file.

This list is adjusted according to your permissions and to the features enabled in your account. By default, all fields on your preferred entry form, including custom fields, are available. You can specify a custom journal entry form, so that form’s fields are available instead. This option is not available for Single Journal Entry Import. See Custom Form Specification for Journal Entry Imports.

For more information about journal entry import fields, see the following topics:

- Journal Entry and Intercompany Journal Entry Header Fields Table
- Journal Entry and Intercompany Journal Entry Line Fields Table

For details about fields that can be mapped, see the SOAP Schema Browser’s advanced intercompany journal entry reference pages. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Usage Notes**

**Creating Book Specific Advanced Intercompany Journal Entries**

The advanced intercompany journal entry record contains an Accounting Book and an Is Book Specific field. In accounts that have the Multi-Book Accounting feature enabled, you can use these fields to create book specific advanced intercompany journal entries. For information about Multi-Book Accounting, see the help topics Multi-Book Accounting Overview and Using Multi-Book Accounting.

**Auto-balancing Advanced Intercompany Journal Entries**

If you use the Automated Intercompany Management feature, you can use the Auto Balance functionality to automatically add elimination lines and balance the transaction during CSV import. The balancing lines are automatically populated. For more information, see the help topic Making Advanced Intercompany Journal Entries.

**Using Advanced Intercompany Journal Entry Import for Updates**

For advanced intercompany journal entries that already exist in NetSuite, you can:

- Update transaction body field values
- Add lines to existing transactions
- Update values in existing journal entry lines
If you set the data handling option to Update for an advanced intercompany journal entry import, any CSV file line field values for existing transactions are appended as additional lines per transaction.

Check the Overwrite Sublists box in the advanced options to replace, overwrite, or add journal entry lines in the advanced intercompany journal entry imports.

**Important:** The lines of the Advanced Intercompany Journal Entry Line sublist are not keyed, therefore you cannot directly update specific lines. To update journal entry lines, ensure you have exported all journal entry lines, make the necessary changes in the sublist lines, check the Overwrite Sublists box in the advanced options, and overwrite the whole sublist.

**Warning:** Single Journal Entry Import does not support updates.

### Custom Form Specification for Advanced Intercompany Journal Entry Import

By default the Field Mapping page for an advanced intercompany journal entry import displays the NetSuite fields from your preferred journal entry form as available for mapping. The default form for your role may not include all the fields you need to import. To ensure that the appropriate fields are available for mapping, you can select any journal entry form that is available to your role, in the Advanced Options area of the Import Assistant’s Import Options page. For more information, see Set Advanced CSV Import Options.

**Warning:** Single Journal Entry Import does not support custom form specification.

### Advanced Intercompany Journal Entry Import Example

The following example adds an advanced intercompany journal entry record.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subsidiary</th>
<th>Date</th>
<th>Line Subsidiary</th>
<th>Line: Account</th>
<th>Line: Debit</th>
<th>Line:Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>65432</td>
<td>Parent Company</td>
<td>6/29/2017</td>
<td>Parent Company</td>
<td>Acc: Dep-Building</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>65432</td>
<td></td>
<td></td>
<td>Parent Company</td>
<td>Acc: Dep-Furnitures</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>65432</td>
<td></td>
<td></td>
<td>Parent Company: SUB UK</td>
<td>Fees Receivable</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>65432</td>
<td></td>
<td></td>
<td>Parent Company: SUB UK</td>
<td>Fees Receivable</td>
<td>1000</td>
<td></td>
</tr>
</tbody>
</table>

### Cash Sale Import

NetSuite Cash Sale transactions are records of sales for which immediate payment is received. You can use the cash sales import to import historical sales data.

For details about fields that can be mapped in the cash sale record, see the SOAP Schema Browser’s cash sale reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.
Transactions Import Type

Review the following guidelines for Cash Sale imports:

- **Supported Cash Sale Sublist Data Imports**
- **Supported Cash Sale Subrecord Data Imports**
- **Importing Currency Values for Cash Sale Transactions**
- **Charging Customer Credit Cards for Imported Cash Sales**
- **Using Import Assistant for Cash Sales Mass Update**
- **Cash Sale Import Example**

### Supported Cash Sale Sublist Data Imports

The Cash Sale import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auth. Code</td>
<td>When Gift Certificates feature enabled.</td>
</tr>
<tr>
<td>Billable Time</td>
<td>Selectively updatable based on related transaction ID (***doc).</td>
</tr>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new cash sale records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td>Shipment</td>
<td>When Multiple Shipping Routes feature enabled.</td>
</tr>
</tbody>
</table>

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Sale, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Cash Sale records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

⚠️ **Important:** For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

### Supported Cash Sale Subrecord Data Imports

The Cash Sale import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
</tbody>
</table>
Importing Currency Values for Cash Sale Transactions

When the Multiple Currencies feature is enabled, the import of Currency field values is supported for newly created cash sale transactions. The Currency value for a cash sale must be one of the currencies defined for the transaction's customer, on the Customer Currencies sublist. See the help topics Currency Management and Setting Multiple Transaction Currencies for Customers.

If the Multiple Currencies feature is not enabled, the Currency field value for a cash sale is not editable.

Charging Customer Credit Cards for Imported Cash Sales

By default, imports of Cash Sale records do not cause charges to customer credit cards. If your NetSuite account has integrated credit card processing set up, you have the option of setting a Cash Sale import to create charges to customer credit cards.

To set up a Cash Sale import to charge customer credit cards:

1. On the Field Mapping page for a Cash Sale import, double-click the Charge Credit Card field to display it in the center pane.
2. Click the edit icon and set the default value for the field to be Yes.

If you do not map the Charge Credit Card field for a Cash Sales import, its value remains No, and no credit card charges occur.

Using Import Assistant for Cash Sales Mass Update

You can perform a mass update of existing Cash Sales data by exporting Cash Sales saved search results, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Cash Sale Import Example

The following example shows how you might structure a file for importing cash sale data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Item Description</th>
<th>Quantity</th>
<th>Amount</th>
<th>Tax Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS-1234</td>
<td>Amy Johnson</td>
<td>8/17/2017</td>
<td>Model railway set — KHT15</td>
<td>2</td>
<td>1400</td>
<td>VT-855</td>
</tr>
</tbody>
</table>

CSV Imports
Check Import

A check transaction creates and records a check used to pay an expense, records an expense paid in cash and not entered as a bill, or records a non-check debit transaction, such as a debit card transaction, ATM transaction, or EFT (electronic funds transfer) payment. A check transaction records an expense directly to your books by debiting the expense account specified in the transaction detail and crediting the bank account selected for the check.

In the user interface, you can access the check record at Transactions > Bank > Write Checks.

For information about working with this record in the user interface, see the help topic Writing Checks.

Supported Check Sublist Data Imports

The check import supports the import of the following sublist data:

- Accounting Books
- Expenses
- Items

Supported Check Subrecord Data Imports

The check import supports the import of the following subrecord data.

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items – Landed Cost</td>
<td>Available when the Landed Cost feature is enabled on the Items &amp; Inventory subtab at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features.</td>
</tr>
<tr>
<td>Items – Inventory Detail</td>
<td>Available when the Advanced Bin / Numbered Inventory Management Feature is enabled on the Items &amp; Inventory subtab at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features.</td>
</tr>
</tbody>
</table>

Check Import Example

The following table provides an example structure for a file to import check data. You can identify the account either by its name or its internal ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Date</th>
<th>Subsidiary</th>
<th>Payee</th>
<th>Amount</th>
<th>Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH–12345</td>
<td>6/3/2018</td>
<td>US – East Coast</td>
<td>Anne Jenkins</td>
<td>1500</td>
<td>Travel Expenses</td>
</tr>
<tr>
<td>CH–12345</td>
<td></td>
<td></td>
<td></td>
<td>1200</td>
<td>Automobile Expenses</td>
</tr>
<tr>
<td>CH–12345</td>
<td></td>
<td></td>
<td></td>
<td>800</td>
<td>Insurance Expenses</td>
</tr>
<tr>
<td>CH–12346</td>
<td></td>
<td></td>
<td></td>
<td>650</td>
<td>Rent Expense</td>
</tr>
</tbody>
</table>
For details about fields that can be mapped in the check record, see the SOAP Schema Browser's check reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Credit Card Charge Import

To be able to import credit card charges data, your company must have a credit card account. To learn how to create a credit card account for your company, see the help topic Creating Company Credit Card Accounts.

After you have added a credit card account, you can import credit card charges and refunds CSV data. For information on importing credit card refunds data, see Credit Card Refund Import.

Credit Card Charge Body and Sublist Fields

When you import a credit card charge, you specify several body values, plus at least one record in the template's sublist.

Body Fields

To prepare credit card charge CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>The vendor related to this credit card transaction.</td>
</tr>
<tr>
<td>Date</td>
<td>The date when the charge occurred.</td>
</tr>
</tbody>
</table>

Your file must also include one of internal ID, external ID or transaction ID to be used as a unique identifier for the record. The external ID can be any value that has not been used as the External ID in previous CSV imports.

Sublist Fields

Use the Items, Expenses, and Accounting Books sublists to add or update item and expense information on a credit card charge record.

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
<th>Required Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses</td>
<td>The Expenses sublist uses Line as a key. You must map at least one item and expense.</td>
<td>Line and Amount</td>
</tr>
<tr>
<td>Items</td>
<td>The Items sublist is keyed using either Item or Order Line. Use the items sublist to specify the item that was purchased from the vendor with this credit card charge. The Items sublist is not mapped automatically. You must map at least one item or expense.</td>
<td>Item or Order Line</td>
</tr>
</tbody>
</table>

To learn more about other supported fields, see the help topic Entering Company Credit Card Charges.
Credit Card Charge CSV File Examples

The following examples show how you might structure a file for importing credit card charge data.

**Single File Import**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
<th>Posting Date</th>
<th>Credit Card Charge Items: Item</th>
<th>Credit Card Charge Items: Tax Code</th>
<th>Credit Card Charge Expenses: Account</th>
<th>Credit Card Charge Expenses: Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Best Fixture, Inc.</td>
<td>11/11/2015</td>
<td>11/15/2015</td>
<td>Accessories: Cable - SCSI</td>
<td>CA_HST</td>
<td>Office Supplies</td>
<td>10.5</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
<td>12/15/2015</td>
<td>Accessories: Cable - USB 10 ft</td>
<td>CA_HST</td>
<td>Office Supplies</td>
<td>15</td>
</tr>
<tr>
<td>CC_CH003</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
<td>12/15/2015</td>
<td>Accessories: Cable - SCSI</td>
<td>CA_HST</td>
<td>Office Supplies</td>
<td>12.5</td>
</tr>
<tr>
<td>CC_CH004</td>
<td>Best Fixture, Inc.</td>
<td>1/11/2016</td>
<td>1/15/2016</td>
<td>Accessories: Cable - USB 10 ft</td>
<td>CA_HST</td>
<td>Office Supplies</td>
<td>15</td>
</tr>
</tbody>
</table>

The following example shows how you might map your fields to the fields in the import assistant.

**Multiple Files Import**

The following example includes the Items sublist data imported in a separate CSV file.

Primary file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Best Fixture, Inc.</td>
<td>11/11/2015</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
</tr>
</tbody>
</table>
Credit Card Refund Import

To be able to import credit card refund data, your company must have a credit card account. To learn how to create a credit card account for your company, see the help topic Creating Company Credit Card Accounts.

After you have added a credit card account, you can import credit card charges and refunds CSV data. For information on importing credit card charges data, see Credit Card Charge Import.

Credit Card Refund Body and Sublist Fields

When you import a credit card refund, you specify several body values, plus at least one record in the template’s sublist.

Body Fields

To prepare credit card refund CSV data for import, make sure that your CSV file includes the following fields. They are required for a successful CSV import.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>The vendor related to this credit card transaction.</td>
</tr>
</tbody>
</table>
Transactions Import Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The date when the refund occurred.</td>
</tr>
</tbody>
</table>

Your file must also include one of internal ID, external ID or transaction ID to be used as a unique identifier for the record. The external ID can be any value that has not been used as the External ID in previous CSV imports.

**Sublist Fields**

Use the Items, Expenses, and Accounting Books sublists to add or update item and expense information on a credit card refund record.

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
<th>Required Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses</td>
<td>The Expenses sublist uses Line as a key. You must map at least one item or expense.</td>
<td>Line and Amount</td>
</tr>
<tr>
<td>Items</td>
<td>The Items sublist is keyed using either Item or Order Line. Use the items sublist to specify the item that was returned to the vendor with this credit card refund. The Items sublist is not mapped automatically. You must map at least one item or expense. To learn more about other supported fields, see the help topic Entering Company Credit Card Charges.</td>
<td>Item or Order Line</td>
</tr>
<tr>
<td>Accounting Books</td>
<td>The Accounting Books sublist is keyed by Secondary Book. The sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
<td>Secondary Book and Exchange Rate</td>
</tr>
</tbody>
</table>

**Credit Card Refund CSV File Examples**

The following examples show how you might structure a file for importing credit card refund data.

**Single File Import**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
<th>Posting Date</th>
<th>Credit Card Refund Items: Item</th>
<th>Credit Card Refund Items: Quantity</th>
<th>Credit Card Refund Items: Tax Code</th>
<th>Credit Card Refund Items: Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Best Fixture, Inc.</td>
<td>11/11/2015</td>
<td>11/15/2015</td>
<td>Accessories : Cable - SCSI</td>
<td>4</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
<td>12/15/2015</td>
<td>Accessories : Cable - USB 10 ft</td>
<td>2</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
<td>12/15/2015</td>
<td>Accessories : Cable - SCSI</td>
<td>3</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH003</td>
<td>Best Fixture, Inc.</td>
<td>1/11/2016</td>
<td>1/15/2016</td>
<td>Accessories : Cable - USB 10 ft</td>
<td>4</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
</tbody>
</table>
Multiple Files Import

The following example includes the Items sublist data imported in a separate CSV file.

Primary file:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
<th>Posting Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Best Fixture, Inc.</td>
<td>11/11/2015</td>
<td>11/15/2015</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Best Fixture, Inc.</td>
<td>12/11/2015</td>
<td>12/15/2015</td>
</tr>
<tr>
<td>CC_CH003</td>
<td>Best Fixture, Inc.</td>
<td>1/11/2016</td>
<td>1/15/2016</td>
</tr>
</tbody>
</table>

Linked file — Items:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Credit Card Refund Items: Item</th>
<th>Credit Card Refund Items: Quantity</th>
<th>Credit Card Refund Items: Tax Code</th>
<th>Credit Card Refund Items: Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Accessories : Cable - SCSI</td>
<td>3</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Accessories : Cable - USB 10 ft</td>
<td>4</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Accessories : Cable - SCSI</td>
<td>2</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
<tr>
<td>CC_CH003</td>
<td>Accessories : Cable - USB 10 ft</td>
<td>5</td>
<td>CA_HST</td>
<td>Canada</td>
</tr>
</tbody>
</table>

Linked file — Expenses:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Credit Card Refund Expenses: Account</th>
<th>Credit Card Refund Expenses: Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC_CH001</td>
<td>Office Supplies</td>
<td>55</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Office Supplies</td>
<td>83.75</td>
</tr>
<tr>
<td>CC_CH002</td>
<td>Office Supplies</td>
<td>66.34</td>
</tr>
<tr>
<td>CC_CH003</td>
<td>Office Supplies</td>
<td>46</td>
</tr>
</tbody>
</table>

Credit Memo Import

A credit memo is a record of credit due to a customer. Credit memo amounts can be applied toward the charges for specific items and for specific transactions such as invoices. For information about using credit memos in NetSuite, see the help topic Customer Credit Memos.

**Note:** Credit memo imports are not available unless the A/R (Accounts Receivable) feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Accounting tab, check the A/R box.

Review the following guidelines for Credit Memo imports:

- Supported CSV File Formats for Credit Memo Imports
- Notes on Credit Memo Import Field Values
**Supported CSV File Formats for Credit Memo Imports**

Credit memo records include Items and Apply sublists:

- Items sublist stores data about the items returned by the customer under this credit memo.
- Apply sublist contains unpaid open invoices to which the credit memo amount can be applied partly or in whole, decreasing the amount due to be paid by the customer. The invoices are referenced by their internal or external IDs.

Credit memo imports may also support the import of data for Partners and Sales Team sublists. See [Supported Credit Memo Sublist Data Imports](#).

**Note:** To maintain performance, 5000 lines per transaction is the maximum recommended limit for transactions submitted through CSV import.

**Multi-File Format**

Generally, a multi-file format is recommended for imports of transactions that support multiple sublists. In this format, body data is in a primary CSV file, Items sublist data is in a linked file, Apply sublist data is in another linked file, and data for any other sublists is in other linked files. The following tables illustrate sample data in a multi-file credit memo import.

**CreditMemo.csv** - primary file with body data:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Location</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>ABC Trucking</td>
<td>Biloxi</td>
<td>Returned Carburetors</td>
</tr>
<tr>
<td>CM-PT3-042602</td>
<td>Happy Day Motors</td>
<td>Atlanta</td>
<td>Good Customer Credit</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Smithson Auto Body</td>
<td>Atlanta</td>
<td>Returned Alternators</td>
</tr>
</tbody>
</table>

**CreditMemoItems.csv** - linked file with Items sublist data:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item</th>
<th>Quantity</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>Carburetor MK60</td>
<td>10</td>
<td>2500.00</td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td>Carburetor MK65</td>
<td>5</td>
<td>1500.00</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Alternator BS40</td>
<td>2</td>
<td>600.00</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Alternator BS52</td>
<td>3</td>
<td>300.00</td>
</tr>
</tbody>
</table>

**CreditMemoApply.csv** - linked file with Apply sublist data:

<table>
<thead>
<tr>
<th>External ID</th>
<th>Apply</th>
<th>Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>115602</td>
<td>2500.00</td>
</tr>
</tbody>
</table>
### Single-File Format with Multiple Rows per Record

The credit memo import also supports a single-file format where you can include body data and data from multiple sublists in one primary file. This single file can contain multiple rows for each credit memo record; each row only must include the external ID value, so all data can be tied to the record. The following table illustrates a single CSV file that contains body data, Items sublist data, and Apply sublist data.

**CreditMemoSingleFile.csv:**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Item</th>
<th>Quantity</th>
<th>Apply</th>
<th>Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>ABC Trucking</td>
<td>Carburetor MK60</td>
<td>10</td>
<td>EXTINV02134</td>
<td>2500.00</td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td></td>
<td>Carburetor MK65</td>
<td>3</td>
<td>EXTINV02183</td>
<td>1500.00</td>
</tr>
<tr>
<td>CM-PT3-042602</td>
<td>Happy Day Motors</td>
<td></td>
<td></td>
<td>EXTINV02190</td>
<td>750.00</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Smithson Auto Body</td>
<td>Alternator BS40</td>
<td>2</td>
<td>EXTSO12456</td>
<td>500.00</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td></td>
<td>Alternator BS52</td>
<td>3</td>
<td>EXTINV02199</td>
<td>300.00</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td></td>
<td></td>
<td></td>
<td>EXTINV02210</td>
<td>1200.00</td>
</tr>
</tbody>
</table>

In this sample:

- External ID and Customer fields are body fields. External ID values are repeated in multiple rows to indicate links for sublist data. Other body field values do not need to be repeated in multiple rows.
- Item and Quantity are Items sublist fields. Blank values for these fields indicate there is no data.
- Apply and Payment are Apply sublist fields. Blank values for these fields indicate there is no data.

### Notes on Credit Memo Import Field Values

- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID. On the Import Assistant’s Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the Credit # field, which serves as a transaction ID for credit memo records. This mapping allows external IDs to be displayed on credit memo forms in the NetSuite user interface.
- Each imported credit memo record should include a reference to a NetSuite customer record, mapped to the credit memo’s Customer field. This reference must be a unique identifier; NetSuite recommends that you use internal ID or external ID, rather than a name reference. If you do not map a reference number field, reference number values are generated automatically.
You do not have to map the required Date field. If you do not map the Date field, it is mapped automatically with default values of the current date.

If the Multiple Currencies feature is enabled, you should map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced customers. If your customers use currencies other than the currency in which your company manages its financials, you should map the Currency field. For more information, see the help topic Currency Management.

If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account field should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.

For more details about fields that can be mapped in the credit memo record, see the SOAP Schema Browser’s credit memo reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Supported Credit Memo Sublist Data Imports**

The Credit Memo import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Selectively updatable based on Apply or Line key field.</td>
</tr>
<tr>
<td>Items</td>
<td>Selectively updatable based on Order Line or Item key field.</td>
</tr>
<tr>
<td></td>
<td>See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Partner key field.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled. Selectively updatable based on Employee key field.</td>
</tr>
</tbody>
</table>

To apply credit memos to invoices or other transactions, specify invoice numbers as Apply field values, in the Apply sublist. When you import this sublist's data, you can also set Line ID values to uniquely identify each Apply line, and Payment values to set the credit memo amounts to be applied to invoices.

For imports that update existing credit memo records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Supported Credit Memo Subrecord Data Imports**

The Credit Memo import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Items — Inventory Detail</td>
<td>when Advanced Bin / Numbered Inventory Management feature enabled</td>
</tr>
</tbody>
</table>
### Setting the Form for a Credit Memo Import

By default, the Field Mapping page for a credit memo import displays the NetSuite fields from your preferred credit memo form. You can select a different credit memo form in the Advanced Options area of the Import Assistant's Import Options page. See Custom Form, under Set Advanced CSV Import Options.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Custom Transactions Import

A custom transaction is an instance of a custom transaction type. A custom transaction type lets you adjust your general ledger in ways that differ from the standard transaction types available in NetSuite.

This import is available when both of the following are true:

- The Custom Transactions feature is enabled at Setup > Company > Enable Features, on the SuiteCloud subtab.
- At least one custom transaction type exists in your NetSuite account.

To import a custom transaction instance, set the Import Type dropdown list to Transactions. In the Record Type dropdown list, choose the name of the type you want to import.

For details about working with custom transaction types in the UI, see the help topic Custom Transactions.

For details about working with custom transaction instances by using the CSV Import Assistant, see the following topics:

- Custom Transaction Body and Sublist Fields
- How List Styles Affect Your Import
- Custom Transaction CSV File Examples

### Custom Transaction Body and Sublist Fields

When you work with custom transactions, the available fields vary depending on the transaction type, the features enabled in your account, and other factors. As a best practice, view the entry form for the transaction instance in the UI to see which fields are available. Alternatively, you can look at the Import Assistant's mapping screen, or open the transaction type for editing.

The following factors affect field availability:

- Depending on the custom transaction type's configuration, the class, department, and location fields may or may not be available. Similarly, these fields can be configured to appear on either the

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
</tbody>
</table>
transaction body or Lines sublist. For details on these configuration choices, see the help topic Custom Transaction Type Classification Fields.

- The transaction type may or may not be configured to use the Status field. You can import a value for Status only if statuses exist, and only if the Show Status Field option has been selected for the custom transaction type. When the field is available, you can set a value for status by referencing the status's text label.

- Different custom transaction types can be configured to use different custom fields. You can view the fields available to a custom transaction type by viewing the Custom Fields subtab. For more details, see the help topic Custom Fields in Custom Transaction Types.

- A custom transaction type can have any of three list styles. The list style has an impact on whether the Lines sublist is available and how you use the sublist. For more details, see How List Styles Affect Your Import.

- The Lines sublist is keyed. When updating the sublist, you can use the Line field as a key. Alternatively, if every line has a unique value in the Account field, you can use Account as the key. (Note that this behavior differs from SOAP web services, where you can use only Line as a key, even when every line has a unique Account value.)

- The Accounting Books sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updatable based on the Secondary Book key field.

- The Accounting Book Detail sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.

- The subsidiary field is available only for OneWorld accounts.

For details on opening a custom transaction type for editing, see the help topic Editing a Custom Transaction Type.

Note: For full details about fields that can be mapped in the customer payment record, see the SOAP Schema Browser's custom transaction reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

How List Styles Affect Your Import

A custom transaction type can have any of three list styles. The list style dictates which fields are available when you add or update a custom transaction. For more details, see the following sections:

- Basic
- Journal
- Header Only

Basic

When working with an instance of the basic transaction type, be aware of the following:

- Each transaction must have at least one line in the Lines sublist.
Each line must include a value for the **Account** field and a value for the **Amount** field. The Account field identifies the account that is to be debited or credited by this transaction. (Whether the account is debited or credit depends on how the transaction type is configured. For details, see the help topic *Account Field Setup for Custom Transaction Types*.) The Amount field identifies the exact value of the credit or debit.

For more information about the Basic list style, see the help topic *Basic*.

### Journal

When working with an instance of the journal style transaction type, be aware of the following:

- The transaction body does not include a Memo field. However, you can set the Memo field for any line in the Lines sublist.
- Each transaction instance must have at least two lines in the LineList. More lines are permitted, but at least one line must set a value for the **Credit** field and one must set a value for the **Debit** field. The values of all lines must balance.

For more information about the Journal list style, see the help topic *Journal*.

### Header Only

With the Header Only style, it is not possible to interact with the Lines sublist. The only lines associated with these transactions are the lines generated by a custom GL Lines plug-in implementation. For more details, see the help topic *Header Only*.

### Custom Transaction CSV File Examples

When importing a custom transaction, you can use a single CSV file or multiple files.

#### Multiple Files Import

If you are using multiple CSV files, you should include one file for the body data and an additional file for each sublist that requires data. For example, if you want to include data for the Lines sublist, you include a file for that sublist. If you want to include data for the Accounting Books sublist, include a file for that sublist.

The following table shows how you might format the file that holds the main transaction body data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Status</th>
<th>Subsidiary</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>1015A</td>
<td>A</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>1016A</td>
<td>B</td>
<td>1</td>
<td>8</td>
</tr>
</tbody>
</table>

The following table shows how you might format the secondary file. In this example, the transaction type uses the journal style, so each line must include a value for either the Credit or Debit field.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Fixed Asset Accrual Lines: Account</th>
<th>Fixed Asset Accrual Lines: Credit</th>
<th>Fixed Asset Accrual Lines: Debit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1015A</td>
<td>6</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>1015A</td>
<td>8</td>
<td></td>
<td>1000</td>
</tr>
</tbody>
</table>
**Transactions Import Type**

<table>
<thead>
<tr>
<th>External ID</th>
<th>Fixed Asset Accrual Lines: Account</th>
<th>Fixed Asset Accrual Lines: Credit</th>
<th>Fixed Asset Accrual Lines: Debit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1016A</td>
<td>6</td>
<td>1952</td>
<td></td>
</tr>
<tr>
<td>1016A</td>
<td>14</td>
<td>952</td>
<td></td>
</tr>
<tr>
<td>1016A</td>
<td>18</td>
<td>1000</td>
<td></td>
</tr>
</tbody>
</table>

**Single File Import**

With the single-file approach, all data for all records is included one file. If the transaction is to include more than one line, each line is represented by its own line in the CSV file.

The following example shows how to create two instances of a custom transaction type that uses the **basic** list style. In this case, each record has two lines in the Lines sublist.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Memo</th>
<th>Status</th>
<th>Subsidiary</th>
<th>Bad Debt Lines: Account</th>
<th>Bad Debt Lines: Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>101A</td>
<td>Approved by John</td>
<td>B</td>
<td>Parent Company</td>
<td>6</td>
<td>1000</td>
</tr>
<tr>
<td>101A</td>
<td></td>
<td></td>
<td></td>
<td>8</td>
<td>1700</td>
</tr>
<tr>
<td>102A</td>
<td>Approved by Mary</td>
<td>A</td>
<td>Parent Company</td>
<td>6</td>
<td>2500</td>
</tr>
<tr>
<td>102A</td>
<td></td>
<td></td>
<td></td>
<td>10</td>
<td>500</td>
</tr>
</tbody>
</table>

The following example shows how to create two instances of a custom transaction type that uses the **journal** list style. This file is set up in a similar fashion. However, note that the Lines sublist requires values in the Credit and Debit fields. You do not enter a value for Amount.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Status</th>
<th>Subsidiary</th>
<th>Fixed Asset Depreciation Lines: Account</th>
<th>Fixed Asset Depreciation Lines: Credit</th>
<th>Fixed Asset Depreciation Lines: Debit</th>
</tr>
</thead>
<tbody>
<tr>
<td>105A</td>
<td>Awaiting approval</td>
<td>1</td>
<td>1</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>105A</td>
<td></td>
<td></td>
<td>2</td>
<td></td>
<td>800</td>
</tr>
<tr>
<td>105A</td>
<td></td>
<td></td>
<td>3</td>
<td></td>
<td>200</td>
</tr>
</tbody>
</table>

**Customer Payment Import**

NetSuite Customer Payment transactions are records of payments. You can use the customer payment import to import historical sales data.

**Note:** To maintain performance, 5000 lines per transaction is the maximum limit for transactions submitted through CSV import. The number of lines a record can contain is specific to the record.

You can import unapplied payment amounts, or apply some or all payment amounts to invoices. If you are importing both customer payments and invoices, and you want to apply imported payments to
imported invoices, you need to import invoices first. Include unique IDs, preferably external IDs, for your invoice records. You then can reference invoices in your customer payment import file by including their unique IDs as Invoices sublist field values.

---

**Important:** A payment can be associated with an invoice through the internal ID or external ID only. The transaction ID is not unique and cannot be used.

- The customer payment import uses the following logic to apply payments to invoices, based on values for the Payment Amount field, and Invoices Payment sublist fields:
  - If the Payment Amount value is greater than the total of all Invoices Payment values, the remainder is an unapplied payment.
  - If the Payment Amount is equal to the total of all Invoices Payment values, the entire payment is applied.
  - If the Payment Amount is less than the total of all Invoices Payment values, only the Payment Amount is applied, and no error is returned.
- If you import customer payment records with a value of False for the Undep. Funds field, you must supply an account for each of these records. Otherwise an error occurs. if Undep. Funds is set to True, this value overrides Payment Method, and if Undep. Funds is set to False, Account overrides Payment Method.
- If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account and A/R Account fields should include both account number and name, for example: 11000 Accounts Receivable. If this preference is not enabled, values should be account name only, for example: Accounts Receivable.
- If your Chart of Accounts includes more than one account of the Accounts Receivable type, it is strongly recommended that you: map the A/R Account field in the Import Assistant, and include a column with A/R account values in the CSV file. The A/R account value for each customer payment record should match the account to which related invoices were posted. If you do not import an A/R account value for an imported payment record, the default A/R account is used, and an error occurs if the payment is applied to an invoice that was posted to a different account.

**Customer Payment Import Examples**

The following example shows a customer payment import where the payment amounts are not applied to invoices.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Payment Amount</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cust_Payment_3</td>
<td>John King</td>
<td>6500</td>
<td>4/3/2017</td>
</tr>
<tr>
<td>Cust_Payment_4</td>
<td>Marie LaBelle</td>
<td>15000</td>
<td>4/3/2017</td>
</tr>
<tr>
<td>Cust_Payment_5</td>
<td>Tim Johnson</td>
<td>8000</td>
<td>4/3/2017</td>
</tr>
</tbody>
</table>

The following example shows a customer payment import where the payment amounts are applied to invoices.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Invoice ID</th>
<th>Payment Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP-001</td>
<td>John Woodhouse</td>
<td>5/18/2017</td>
<td>INV-425</td>
<td>10000</td>
</tr>
<tr>
<td>CP-002</td>
<td>Tim Johnson</td>
<td>5/16/2017</td>
<td>INV-633</td>
<td>6500</td>
</tr>
</tbody>
</table>
Transactions Import Type

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Invoice ID</th>
<th>Payment Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP-003</td>
<td>Ellen Guest</td>
<td>5/4/2017</td>
<td>INV-732</td>
<td>1800</td>
</tr>
</tbody>
</table>

For details about fields that can be mapped in the customer payment record, see the SOAP Schema Browser’s customer payment reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with this tool, see the help topic SOAP Schema Browser.

Review the following guidelines for Customer Payment imports:

- Supported Customer Payment Sublist Data Imports
- Using Import Assistant for Customer Payments Mass Update

**Supported Customer Payment Sublist Data Imports**

The Customer Payment import supports the import of Invoices sublist data. Each line in this sublist represents an invoice to which the payment is applied. The sum of Payment field values for sublist records represents the total amount of the payment.

In this sublist, the required Invoice key field holds the transaction IDs for invoices to which payments are applied. An additional, optional Line key field holds the line numbers for the invoice lines to which payments are applied, if payments need to be applied to specific lines.

**Note:** If you use only the Invoice key, the following error may be returned to indicate that a unique reference was not found, “Ambiguous sublist reference; multiple matches exist for key value <>”.

An import can add new invoices or invoice lines to which a payment is applied, change the amounts applied to existing invoices or invoice lines, or remove invoices or invoice lines.

When the Overwrite Sublists advanced option is not enabled (which is the default), CSV file sublist data selectively updates existing invoices data, based on the Invoice key field. When this option is enabled, CSV file sublist data completely replaces existing invoices data. For example:

- If the existing Invoices sublist data is:
  - Invoice A: $100
  - Invoice B: $200
- And CSV file sublist data is:
  - Invoice A: $120
  - Invoice C: $180
- When Overwrite Sublists=F, post update sublist data is:
  - Invoice A: $120
  - Invoice B: $200
  - Vendor Bill C: $180
- When Overwrite Sublists=T, post update sublist data is:
  - Invoice A: $120
  - Invoice C: $180

The Customer Payment import also supports the import of Accounting Book Detail sublist data. The Accounting Book Detail sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.
Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

Using Import Assistant for Customer Payments Mass Update

You can perform a mass update of existing Customer Payments main fields by exporting Customer Payments saved search results, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Estimate Import

NetSuite Estimates transactions, also known as Quotes, include items proposed for customer purchase, along with price levels, probabilities of closing, and expiration dates. Estimates can be provided to customers for review, and also can be used for sales forecasting, management, and reporting. Estimates can be attached to Opportunity records, and later can be converted to sales orders.

Note: Estimate imports are not available unless the Estimates feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Transactions tab, check the Estimates box.

- You can import Estimate transaction data in a single CSV file, or in multiple files, for example, with transaction header data in one file and item-level data in other files. Estimate transactions can be uniquely identified by internal ID or external ID. The unique ID should be included in every line of the CSV files.
- For imports of new data, use the external ID as a unique identifier. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Estimate # field, which serves as a transaction ID for Estimate records. This mapping allows external IDs to be displayed on Estimate forms in the NetSuite user interface.
- You can link an Estimate record to an Opportunity record by including the Opportunity record's identifier as the Estimate's “Opportunity” field value. This identifier can be an internal ID, external ID, or transaction ID.
- Each imported Estimate record should include a reference to a NetSuite customer record, mapped to the Estimate's Customer field. This reference must be a unique identifier; NetSuite recommends that you use the customer record's internal ID or external ID, rather than a name reference.

For details about fields that can be mapped in the estimate record, see the estimate reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Estimate imports:

- Supported Estimate Sublist Data Imports
- Supported Estimate Subrecord Data Imports
- Importing Currency Values for Estimates
- Using Import Assistant for Estimates Mass Updates
Supported Estimate Sublist Data Imports

The Estimate import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>when Multi-Partner Management feature enabled</td>
</tr>
<tr>
<td>Sales Team</td>
<td>when Team Selling feature enabled</td>
</tr>
</tbody>
</table>

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Sale, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Estimate records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

> **Important:** For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

Supported Estimate Subrecord Data Imports

The Estimate import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items — Inventory Detail</td>
<td>when Advanced Bin / Numbered Inventory Management feature enabled</td>
</tr>
</tbody>
</table>

Importing Currency Values for Estimates

When the Multiple Currencies feature is enabled, the import of Currency field values is supported for newly created estimates. The Currency value for an estimate must be one of the currencies defined for the transaction’s customer, on the Customer Currencies sublist. See the help topics Currency Management and Setting Multiple Transaction Currencies for Customers.

If the Multiple Currencies feature is not enabled, the Currency field value for an estimate is not editable.

Using Import Assistant for Estimates Mass Updates

You can perform a mass update of existing Estimates data by exporting results for a Transaction saved search with a filter of “Type is Estimate”, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Inventory Adjustment Import**

The inventory adjustment record is used to change the quantity and value of an inventory item without entering a purchase order. Inventory adjustments are used to account for clerical errors, changes in cost, thefts or miscounts. You can create and update inventory adjustment records using the CSV Import Assistant.

The inventory adjustment record is available for import when the Inventory feature is enabled on the Items & Inventory subtab at Setup > Company > Setup Tasks > Enable Features (Administrator). When Inventory is enabled, Inventory Adjustment is available on the Record Type dropdown list of the Import Assistant when Import Type is set to Transactions.

If the Multi-Book Accounting and Multi-Location Inventory features are enabled, you can also import accounting book file and inventory detail information as part of the import.

In the user interface, you access the inventory adjustment record at Transactions > Inventory > Adjust Inventory. For more information, see Adjusting Inventory.

For details about fields that can be mapped in the inventory adjustment record, see the SOAP Schema Browser's inventory adjustment reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Inventory Adjustment Body and Sublist Fields**

To prepare inventory adjustment CSV data for import, make sure that your CSV file includes the following fields.

- **Adjustment Account** — The account for the adjustment, for example, an expense account.
- **Date** — Date of the adjustment.

Most imports also require an External ID field, which is used as a unique identifier for the record. You can specify any value that has not been used as the External ID in previous CSV imports.

**Supported Inventory Adjustment Sublist Data Imports**

The Inventory Adjustment import supports the import of Adjustments sublist data. Each line in this sublist represents an item requiring adjustment and should include the line, item, and quantity adjustment.

If the Multi-Book Accounting and Multi-Location Inventory features are enabled, the Inventory Adjustment import supports the import of Inventory Detail sublist data.

**Note:** When using issue inventory numbers in your import, you should distinguish the records you reference in your CSV file by using unique names. Names are handled case insensitively, therefore you must use names that are different not only in their capitalization.

Alternatively, you can refer to the records by their internal IDs.

**Inventory Adjustment CSV File Example**

The following examples show how you might structure a file for importing inventory adjustment data.
Single File Example

Formatting restrictions make the table unreadable in the PDF output.

Multiple Files Example

With a multiple-file import, you use one file for the inventory adjustment fields, one file for the inventory detail fields, and one file for the adjustment fields.

The file holding the body data must include the external ID, date and adjustment account.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subsidiary</th>
<th>Date</th>
<th>Adjustment Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>CouInvAd_3</td>
<td>Parent Company : SUB UK</td>
<td>3/30/2016</td>
<td>Checking(UK)</td>
</tr>
<tr>
<td>CouInvAd_4</td>
<td>Parent Company : SUB UK</td>
<td>3/30/2016</td>
<td>Checking(UK)</td>
</tr>
</tbody>
</table>

Each row in the inventory detail file includes the item key, serial or lot number, and quantity.

<table>
<thead>
<tr>
<th>Adjustment: Item Key</th>
<th>Adjustment: Inventory Detail: Serial Number</th>
<th>Adjustment: Inventory Detail: Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>ItemKey1</td>
<td>Count1_1</td>
<td>5</td>
</tr>
<tr>
<td>ItemKey1</td>
<td>Count1_2</td>
<td>2</td>
</tr>
<tr>
<td>ItemKey1</td>
<td>Count1_3</td>
<td>3</td>
</tr>
<tr>
<td>ItemKey2</td>
<td>Count2_1</td>
<td>2</td>
</tr>
<tr>
<td>ItemKey2</td>
<td>Count2_2</td>
<td>3</td>
</tr>
<tr>
<td>ItemKey4</td>
<td>Count4_1</td>
<td>9</td>
</tr>
<tr>
<td>ItemKey4</td>
<td>Count4_2</td>
<td>66</td>
</tr>
<tr>
<td>ItemKey5</td>
<td>Count5_1</td>
<td>3</td>
</tr>
<tr>
<td>ItemKey6</td>
<td>Serial_Count1_1</td>
<td>1</td>
</tr>
<tr>
<td>ItemKey6</td>
<td>Serial_Count1_2</td>
<td>1</td>
</tr>
<tr>
<td>ItemKey6</td>
<td>Serial_Count1_3</td>
<td>1</td>
</tr>
</tbody>
</table>

The third file contains the Adjustments sublist. The external ID must be included to link the sublist record to the entry in the main file. The adjust quantity by column is also required.

<table>
<thead>
<tr>
<th>Adjustment: External ID</th>
<th>Adjustment: Item Key</th>
<th>Adjustment: Line</th>
<th>Adjustment: Location</th>
<th>Adjustment: Item</th>
<th>Adjustment: Adjust Qty. By</th>
</tr>
</thead>
<tbody>
<tr>
<td>CouInvAd_1</td>
<td>ItemKey1</td>
<td>1</td>
<td>Location UK</td>
<td>LotNumberedItem(UK)</td>
<td>10</td>
</tr>
<tr>
<td>CouInvAd_1</td>
<td>ItemKey2</td>
<td>2</td>
<td>Location UK</td>
<td>LotNumberedItem(UK)</td>
<td>5</td>
</tr>
<tr>
<td>CouInvAd_1</td>
<td>ItemKey3</td>
<td>3</td>
<td>Location UK</td>
<td>Inventory Item UK</td>
<td>1</td>
</tr>
<tr>
<td>CouInvAd_2</td>
<td>ItemKey4</td>
<td>1</td>
<td>Location UK</td>
<td>LotNumberedItem(UK)</td>
<td>675</td>
</tr>
<tr>
<td>CouInvAd_2</td>
<td>ItemKey5</td>
<td>2</td>
<td>Location UK</td>
<td>LotNumberedItem(UK)</td>
<td>3</td>
</tr>
</tbody>
</table>
When naming your columns, NetSuite recommends that you use the same naming conventions used by the Import Assistant so that your columns map automatically. For columns to map automatically, each sublist column should have prefixes that begin with Adjustment:.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Inventory Cost Revaluation Import

The inventory cost revaluation record is used to recalculate the value of items configured to use standard costing. You can create and update inventory cost revaluation records using the CSV Import Assistant.

This record is available for import when the Standard Costing feature is enabled at Setup > Company > Enable Features, on the Items & Inventory subtab. When the feature is enabled, “Inventory Cost Revaluation” appears a choice in the Record Type dropdown list on page 1 of the Import Assistant, when you set Import Type to Transactions.

In the user interface, you access the inventory cost revaluation record at Transactions > Inventory > Revalue Inventory Cost. For help working with this record manually, see the help topic Manually Enter an Inventory Cost Revaluation.

For details about fields that can be mapped in the inventory cost revaluation record, see the SOAP Schema Browser’s inventory cost revaluation reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

For more details on importing inventory cost revaluation records, see the following:

- Prerequisite Records for Inventory Cost Revaluation Import
- Common Errors When Importing Inventory Cost Revaluation Records

The Inventory Cost Revaluation import supports the import of Accounting Book Detail sublist data. The Accounting Book Detail sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Prerequisite Records for Inventory Cost Revaluation Import

When you import a new inventory cost revaluation record, you rely on certain prerequisite records that must already exist in NetSuite. In other words, if you choose a data handling type of Add on page 2 of the Import Assistant, every record you import must reference one of each of the following NetSuite record types:

- **Item** — You must reference an item that has been configured to use standard costing. You identify this record using the Item body field. For details on how to create items to use standard costing, see the help topic Setting Up Item Records for Standard Costing.
Cost category — You must reference a cost category defined at Setup > Accounting Lists. You identify this record using the Cost Category field in the Cost Components sublist. For help creating cost categories, see the help topic Creating Cost Categories.

Common Errors When Importing Inventory Cost Revaluation Records

This topic describes typical problems you might experience when using the CSV Import Assistant to create or update inventory cost revaluation records.

Field Mapping Error

When you click Next on the Field Mapping page, you might encounter an error that says “You must map one of the following NetSuite fields to a column in your CSV file, to be a unique identifier: External ID, Internal ID, or a transaction number field, such as Order # or Invoice #.” This error occurs when you are trying to add records, and you have not mapped a unique identifier for the records. Specifically, you must map a value for either ExternalId or Ref. No.

Mandatory Field Missing

You may see the “Mandatory Field Missing” error after clicking Next on the mapping page. This error can occur in cases where you have chosen a data handling option of Add on page 2 of the Import Assistant, and one of the following problems occurred:

- You mapped a required field to a column in your CSV file, but one of the rows in your file is missing a value in that column.
- The Import Assistant is trying to process a row in your file that you intended to be empty. If you are using Microsoft® Excel, select the first few empty rows following the last row where you intended to include data. Right-click, and select Delete > Entire Row. Save your file, then try the import again.

An Inventory Cost Revaluation Already Exists for this Item, Location, and Date

Each inventory cost revaluation record must use a unique combination of item, location, and date. In other words, if you are trying to create an inventory cost revaluation record for Widget A in your East Coast Warehouse, you can only submit one revaluation for any specified date.

Inventory Transfer Import

The inventory transfer record is used to post details about per-location item inventory level changes when items are transferred between two locations. This basic inventory transfer decreases items in the source location and increases them in the receiving location, all in one step. You can create and update inventory transfer records using the CSV Import Assistant.

This record is available for import when the Multi-Location Inventory (MLI) feature is enabled, at Setup > Company > Enable Features, on the Items & Inventory subtab. When the feature is enabled, “Inventory Transfer” appears as a choice in the Record Type list on page 1 of the Import Assistant, when you set the import type to Transactions.

In the user interface, you access the inventory transfer record at Transactions > Inventory > Transfer Inventory. For help working with this record manually, see the help topic Transferring Inventory.
For details about fields that can be mapped in the inventory transfer record, see the SOAP Schema Browser’s inventory transfer reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Inventory Transfer import supports the import of Adjustments sublist data and when the Advanced Bin / Numbered Inventory Management feature is enabled, supports the import of Adjustments – Inventory Detail subrecord data.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Inventory Transfer CSV Import Example

The following example shows how you might structure a file for importing inventory transfer data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Date</th>
<th>Location</th>
<th>Transfer Location</th>
<th>Subsidiary</th>
<th>Item</th>
<th>Quantity to Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tran_001</td>
<td>4/19/2017</td>
<td>San Francisco</td>
<td>Los Angeles</td>
<td>US — West</td>
<td>Suitcase — Medium</td>
<td>500</td>
</tr>
<tr>
<td>Tran_002</td>
<td>4/20/2017</td>
<td>San Francisco</td>
<td>Los Angeles</td>
<td>US — West</td>
<td>Suitcase — Large</td>
<td>1000</td>
</tr>
</tbody>
</table>

### Invoice Import

NetSuite Invoice transactions are records of sales for which payment is not received at the time of delivery. Invoice records include the items sold, their prices, and payment terms.

You can use the invoice import to import historical sales data. If you also are importing customer payments, and you want to apply imported payments to imported invoices, you need to import invoices first, and include unique IDs, preferably external IDs. You then can reference invoices in your customer payment import file.

If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account field should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.

**Important:** A payment can be associated with an invoice through the internal ID or external ID only. The transaction ID is not unique and cannot be used.

For details about fields that can be mapped in the invoice record, see the SOAP Schema Browser’s invoice reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for invoice imports:

- Supported Invoice Sublist Data Imports
- Supported Invoice Subrecord Data Imports
**Supported Invoice Sublist Data Imports**

The Invoice import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Book</td>
<td>Available when Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on Accounting Book key field.</td>
</tr>
<tr>
<td>Auth. Code</td>
<td>When Gift Certificates feature enabled.</td>
</tr>
<tr>
<td>Billable Time</td>
<td>Selectively updatable based on related transaction ID (<strong>doc</strong>).</td>
</tr>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td>Shipment</td>
<td>When Multiple Shipping Routes feature enabled.</td>
</tr>
</tbody>
</table>

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Sale, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Invoice records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

---

**Important:** For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

---

**Supported Invoice Subrecord Data Imports**

The Invoice import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Items — Inventory</td>
<td>When Advanced Bin/Numbered Inventory Management feature enabled.</td>
</tr>
</tbody>
</table>

---

**CSV Imports**
### Importing Currency Values for Invoices

When the Multiple Currencies feature is enabled, the import of Currency field values is supported for newly created invoices. The Currency value for an invoice must be one of the currencies defined for the transaction’s customer, on the Customer Currencies sublist. See the help topics Currency Management and Setting Multiple Transaction Currencies for Customers.

If the Multiple Currencies feature is not enabled, the Currency field value for an invoice is not editable.

### Using Import Assistant for Invoices Mass Update

You can perform a mass update of existing Invoices data by exporting Invoices saved search results, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Invoice Import Example

The following example shows how you might structure a file for importing cash sale data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Posting Period</th>
<th>Location</th>
<th>Currency</th>
<th>Exchange Rate</th>
<th>Item</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inv-00001</td>
<td>Tim Mason</td>
<td>5/10/2018</td>
<td>May 2018</td>
<td>Atlantic City</td>
<td>US USD</td>
<td>1.00</td>
<td>Travel Kit — Medium</td>
<td>15</td>
</tr>
<tr>
<td>Inv-00002</td>
<td>Anne Woods</td>
<td>5/11/2018</td>
<td>May 2018</td>
<td>San Mateo</td>
<td>US USD</td>
<td>1.00</td>
<td>Travel Kit — Small</td>
<td>10</td>
</tr>
</tbody>
</table>

### Item Demand Plan Import

An item demand plan transaction stores the quantity expected to be needed, during specified time periods, for an item. You can import item demand plan data from another system into NetSuite. You need to get the required data into a CSV file, then you can use the Import Assistant to create new demand plans and edit existing demand plans.

The item demand plan data that you can import generally matches the fields available at Transactions > Demand Planning > Item Demand Plans > New. If you are not familiar with this page, NetSuite recommends that you review it to get an understanding of the fields that you should include in your Item Demand Plan CSV files. Each plan includes two types of fields:

- Body fields used to uniquely identify the record, such as Item, Plan Start Date, Plan End Date, Location (when Multi-Location Inventory is enabled), and Subsidiary (for NetSuite OneWorld). A View body field indicates the time period used in the demand plan: monthly, weekly, or daily. For more information, see Demand Plan Body Data.

- Sublist data that varies according to the demand plan type, as represented by the monthly, weekly, and daily views. The Import Assistant maps one sublist instance per row. For a monthly plan, each row/sublist instance represents a month and can store one monthly quantity. For a weekly plan, each row/sublist instance represents a week and can store one weekly quantity. For a daily plan, each row/sublist instance represents a day and can store one daily quantity.
sublist instance represents a week and can store up to seven daily quantities. For more information, see Demand Plan Sublist Data.

You are encouraged to set up your CSV files in accordance with the recommended format for each demand plan type. When a CSV file follows the recommended format, the Import Assistant automatically maps CSV file fields to NetSuite fields, simplifying the import process. For body fields other than the View field, the recommended format is to include a column with a header matching the NetSuite field name. For sublist fields, the recommended format varies per plan type. For more information, see: Monthly Item Demand Plan Import, Weekly Item Demand Plan Import, and Daily Item Demand Plan Import.

NetSuite recommends that each CSV file used for an import include data for only one type of time period: either monthly, weekly, or daily. Also, it is strongly encouraged that your CSV file use the recommended format for each type, because these recommended formats support automatic mapping of data in the Import Assistant. For more information, see Supported Fields for Item Demand Plan Imports.

Prerequisites for Importing Item Demand Plans

- Item demand plans are available for inventory items when the Demand Planning feature is enabled in your account.
- Item demand plans are available for assembly/BOM items when both the Demand Planning and Work Orders feature are enabled.
- Demand plans can only be created for items that have a value of Time Phased for the Replenishment Method field.

If the above requirements are met, you can also import data for item record fields related to demand planning. See Importing Demand Planning Data for Items.

Item Demand Plan Import Errors

An import that attempts to add an item demand plan returns an “Invalid item reference Key” error when any of the following occur:

- The item does not exist in NetSuite.
- The demand plan already exists. (Only one demand plan can be created per item and location combination.)
- The Replenishment Method field for the item is not set to Time Phased.

Note: For information about using demand planning and creating item demand plans in the NetSuite user interface, see the help topic Demand Planning.

Demand Plan Body Data

Most body fields are used to uniquely identify the demand plan, such as Item, Plan Start Date, Plan End Date, Location (when Multi-Location Inventory is enabled), and Subsidiary (for NetSuite OneWorld). Data for each of these body fields should be stored in its own column in the CSV file.

Generally, demand plans are unique per item. In NetSuite OneWorld accounts, demand plans are unique per item/subsidiary combination. When Multi-Location Inventory is enabled, demand plans are unique per item/location combination or per item/subsidiary/location combination.

A View body field indicates the time period used in the demand plan: monthly, weekly, or daily. In the recommended format, this field does not need its own CSV file column; its value is inferred from the heading of quantity columns. See Monthly Item Demand Plan Import, Weekly Item Demand Plan Import, and Daily Item Demand Plan Import.
The demand plan body fields that can be imported remain consistent for all types of plans. If you use column headings that match NetSuite field names, these fields are automatically mapped in the Import Assistant.

See Supported Fields for Item Demand Plan Imports for more details on specific fields.

Demand Plan Sublist Data

Demand plan sublist fields vary according to the plan type: monthly, weekly, or daily. A demand plan usually includes multiple start dates and end dates. Each start date-end date pairing represents a time period within the demand plan. Quantity sublist field values store the projected quantity needed for each time period.

- For monthly demand plans, each start date-end date pairing represents a month, for which one quantity can be stored.
- For weekly demand plans, each start date-end date pairing represents a week, for which one quantity can be stored.
- For daily demand plans, each start date-end date pairing represents a week, for which up to seven quantities can be stored. Each quantity is tied to a day of the week.

The Import Assistant Field Mapping page displays Item Demand Plan sublist fields in the Item Demand Plan Demand Planning folder:
To import sublist data for multiple days, weeks, or months, add all your sublist data into one demand plan sublist file. Then map your daily, weekly, or monthly data to separate instances of the Item Demand Plan DemandPlanning sublist, as shown in the previous screenshot. Do not use separate files for the data for each day, week, or month.

Each sublist instance represents a time period within the demand plan, like each row on the Item Demand Plan page in the user interface. For monthly and weekly plans, each sublist instance includes two fields: Start Date and Quantity. For daily plans, each sublist instance also includes the Day of the Week field. Note that the End Date sublist field is not required for CSV imports.

There is a separate instance of this sublist, represented by a numbered subfolder, for each quantity column included in the CSV file. If your file includes a quantity for each month in a year, there are 12 instances of the sublist. If your file includes a quantity for each week in a year, there are 52 instances of the sublist. It is best to use the recommended file format and rely on automatic mapping of the data, so you do not have to manually map fields for a large number of sublist instances. For details about recommended formats, see Monthly Item Demand Plan Import, Weekly Item Demand Plan Import, and Daily Item Demand Plan Import.

See Supported Fields for Item Demand Plan Imports for more details on specific fields.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Monthly Item Demand Plan Import**

The following screenshot shows a monthly item demand plan in the NetSuite user interface, with sublist fields outlined in red. Each month included in the plan is represented by a row in this screenshot.

The recommended format in your CSV file for this sublist data is to include one column for each month, with a heading of Monthly Quantity: <date of first day of month> and the quantity value. For example, columns like the following should be included for a 3 month item demand plan:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>200</td>
<td>200</td>
</tr>
</tbody>
</table>

Each quantity column corresponds to one month, meaning one sublist instance, for a monthly plan.

The following screenshot illustrates how the above columns are mapped in the Import Assistant:
The View body field is automatically mapped to a value of Monthly based on the Monthly Quantity keywords in the quantity column headings.

A Start Date field for each sublist instance is automatically mapped to the date of the first day of the month based on the date in each quantity column heading.

A Quantity field for each sublist instance is automatically mapped to a Monthly Quantity.

Sublist End Date fields do not need to be included in CSV files or Import Assistant mappings.

You can also move your sublist data to a separate import file, and upload multiple files. In this case, make sure that your primary file only includes body field data, and all the sublist data for the Demand Planning sublist is moved to the linked file.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Weekly Item Demand Plan Import**

The following screenshot shows a weekly item demand plan in the NetSuite user interface, with sublist fields outlined in red. Each week included in the plan is represented by a row in the screenshot.
The recommended format in your CSV file for this sublist data is to include one column for each week, with a heading of **Weekly Quantity:<date of first day of week>** and the quantity value. For example, columns like the following should be included for the first 3 weeks of a weekly item demand plan:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>200</td>
<td>200</td>
</tr>
</tbody>
</table>

Each quantity column corresponds to one week, meaning one sublist instance, for a weekly plan.

The following screenshot illustrates how the above columns are mapped in the Import Assistant:

- The View body field is automatically mapped to a value of Weekly based on the **Weekly Quantity** keywords in the quantity column headings.
- A Start Date field for each sublist instance is mapped to the date of the first day of the week based on the date in each quantity column heading.
  - Each sublist Start Date must correspond to the date of the first day of the week based on the company preference set at Setup > Company > General Preferences. The default is Sunday.
  - If the date in a CSV file quantity column does not correspond to the first day of the week, the Import Assistant maps the date of the first day of the week, instead of the date in the CSV file, as Start Date. For example, for a heading of **Weekly Quantity:1/9/2011** where the first day of the week is Sunday, the mapped Start Date value is 1/8/2011, because that is the date of the Sunday of that week.
  - A sublist Start Date may precede the Plan Start Date, if the Plan Start Date is not the first day of the week. For example, if the Plan Start Date is 2/1/2012, which is a Wednesday, and the preference for first day of the week is Sunday, the sublist Start Date is 1/29/2012.
  - The date in the CSV file quantity column must be entered without leading zeros. For example, for January 1, 2017 to be used as the Start Date, enter this date in the CSV file as 1/1/2017, not 01/01/2017.
- A Quantity field for each sublist instance is mapped to a Weekly Quantity.
- Sublist End Date fields do not need to be included in CSV files or Import Assistant mappings.

You can also move your sublist data to a separate import file, and upload multiple files. In this case, make sure that your primary file only includes body field data, and all the sublist data for the Demand Planning sublist is moved to the linked file.
The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Daily Item Demand Plan Import**

The following screenshot shows a daily item demand plan in the NetSuite user interface, with sublist fields outlined in red. Each week included in the plan is represented by a row in this screenshot. Each row includes seven columns, one for each day of the week.

The recommended format in your CSV file for this sublist data is to include one column for each day, with a heading of **Daily Quantity:<date>** and the quantity value. For example, columns like the following should be included for the first week of a daily item demand plan:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>200</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

Each quantity column corresponds to one day, meaning one sublist instance, for a daily plan.

The following screenshot illustrates how the above columns are automatically mapped in the Import Assistant:
The View body field is automatically mapped to a value of Daily based on the **Daily Quantity** keywords in the quantity column headings.

A Start Date field for each sublist instance is automatically mapped to the date of the first day of the week based on the date in each quantity column heading.

- Each sublist Start Date must correspond to the date of the first day of the week based on the company preference set at Setup > Company > General Preferences. The default is Sunday.

- Up to seven columns may have the same Start Date, and belong to the same sublist instance. In the example above, if a first day of week preference of Sunday is assumed, each quantity has a Start Date value of 1/1/2012.

- A sublist Start Date may precede the Plan Start Date, if the Plan Start Date is not the first day of the week. For example, if the Plan Start Date is 2/1/2012, which is a Wednesday, and the preference for first day of the week is Sunday, the sublist Start Date would be 1/29/2012.

A Day of the Week field for each sublist instance is automatically mapped to a day of the week, based on the date in each quantity column heading.

- For example, the quantity column with a date of 1/2/2012 is mapped to Monday, 1/3/2012 is mapped to Tuesday, 1/4/2012 is mapped to Wednesday, 1/5/2012 is mapped to Thursday, and 1/6/2012 is mapped to Friday.

- A Quantity field for each sublist instance is automatically mapped to a Daily Quantity.

- Sublist End Date fields do not need to be included in CSV files or Import Assistant mappings.

### Supported Fields for Item Demand Plan Imports

NetSuite recommends that each CSV file used for an import include data for only one type of time period, either monthly, weekly, or daily. Also, it is strongly encouraged that your CSV file use the recommended
format for each type, because these recommended formats support automatic mapping of data in the Import Assistant. Other formats are also supported but are more difficult to use.

The following table lists standard fields available for item demand plan imports:

<table>
<thead>
<tr>
<th>Field</th>
<th>Mapping Required?</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Body Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External ID</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Internal ID</td>
<td>No</td>
<td>Available for updates only</td>
</tr>
<tr>
<td>Item</td>
<td>Yes</td>
<td>Item must have a value of Time Phased for the Replenishment Method field to be valid for this field.</td>
</tr>
<tr>
<td>Location</td>
<td>Yes, if Multi-Location Inventory enabled</td>
<td></td>
</tr>
<tr>
<td>Memo</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>No</td>
<td>Redundant of Plan Start Date, Plan End Data fields</td>
</tr>
<tr>
<td>Plan End Date</td>
<td>Yes</td>
<td>Can set default on Import Assistant mapping page instead of setting value in CSV file</td>
</tr>
<tr>
<td>Plan Start Date</td>
<td>Yes</td>
<td>Can set default on Import Assistant mapping page instead of setting value in CSV file</td>
</tr>
<tr>
<td>Subsidiary</td>
<td>Yes, if OneWorld account</td>
<td>Available when Multiple Units of Measure is enabled</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>No</td>
<td>Default value automatically set based on “Monthly Quantity”, “Weekly Quantity”, or “Daily Quantity” keywords, when recommended format used</td>
</tr>
<tr>
<td>View</td>
<td>Yes</td>
<td>If not inferred from keywords in recommended format, valid values are as follows (case-insensitive):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Monthly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Weekly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Daily</td>
</tr>
<tr>
<td>Year</td>
<td>No</td>
<td>Redundant of Plan Start Date, Plan End Data fields</td>
</tr>
<tr>
<td><strong>Sublist Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Day of the Week</td>
<td>Yes, for Daily demand plans only</td>
<td>Day of the week Value automatically set, based on date provided in CSV file, when recommended format used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If not inferred from date provided in recommended format, can be name of day, such as Sunday (case-insensitive)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Yes</td>
<td>Represents either quantity per month, per week, or per day</td>
</tr>
<tr>
<td>Start Date</td>
<td>Yes</td>
<td>■ For monthly demand plans, first day of the month, based on date provided in CSV file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ For weekly demand plans, first day of the week based on date provided in CSV file</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ For weekly demand plans, first day of the week based on date provided in CSV file</td>
</tr>
</tbody>
</table>
Item Supply Plan Import

An item supply plan lists the purchase orders or work orders required to ensure that item quantity meets expected demand. You can import item supply plan data from another system into NetSuite. You need to get the required data into a CSV file, then you can use the Import Assistant to create new supply plans and edit existing supply plans.

Importing item supply plan data is similar to creating a manual item supply plan in the NetSuite user interface. This item supply plan type is not derived from any demand plan in the NetSuite system and can be based on data or projections from external sources.

**Important:** Only one item supply plan per item is supported.

The item supply plan data that you can import generally matches the fields available at Transactions > Demand Planning > Item Supply Plans > New. If you are not familiar with this page, NetSuite recommends that you review it to get an understanding of the fields that you should include in your Item Supply Plan CSV files.

Each item supply plan includes two types of fields:

- **Body fields** used to identify the record, such as External Id, Internal ID, Item, Location (when Multi-Location Inventory is enabled), Memo, Subsidiary (for NetSuite OneWorld), and Unit of Measure (when Multiple Units of Measure is enabled).
  
  You must provide External Id or Internal ID values to uniquely identify items, because the Item field may have non-unique values.

- **Orders sublist fields** that define data for the orders needed to replenish the supply of items. These fields include:
  
  - **Order Date** (required)
  
  - **Order Line** - optionally can be used to identify orders
  
  - **Order Type** - the type of order; always purchase order for inventory items, can be purchase order or work order for assembly/BOM items
    
    Although an Order Type value is required for each line item, it is not required to be mapped for imports, because its values may be determined by the selected item.

  - **Quantity** (required)
  
  - **Receipt Date** - (required) the date when the order is expected to be received from the vendor (for a purchase order) or the date when the assembly is expected to be completed (for a work order).
    
    This date cannot be earlier than the Order Date.

**Prerequisites for Importing Item Supply Plans**

- Item supply plans are available for inventory items when the Demand Planning feature is enabled in your account.
Item supply plans are available for assembly/BOM items when both the Demand Planning and Work Orders feature are enabled.

Item supply plans can only be created for items that have a value of Time Phased for the Replenishment Method field.

**Note:** For general information about demand planning in NetSuite, see the help topic Demand Planning. For information about creating item supply plans in the NetSuite user interface, see the help topic Manual Item Supply Plans.

The following table shows how you might structure a file for importing item supply plans.

Formatting restrictions make the table unreadable in the PDF output.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

**Journal Entry Import and Intercompany Journal Entry Import**

A journal entry records debits and credits to be posted to ledger accounts, adjusting the value of accounts. In NetSuite OneWorld, an intercompany journal entry records the impact of transactions between two subsidiaries. Intercompany journal entries identify both a “from”, or originating, subsidiary and a “to”, or receiving, subsidiary.

You can import multiple journal entries and, for NetSuite OneWorld, multiple intercompany journal entries, from another system into NetSuite. Each import job can include data for any combination of classes, department, locations, and for NetSuite OneWorld, subsidiaries. Journal entry import and intercompany journal entry import are two separate tasks in the Import Assistant. For information about importing advanced intercompany journal entries, see Advanced Intercompany Journal Entry Import.

**Note:** The Journal Entry and Intercompany Journal Entry record types have been enhanced with two fields: Accounting Book and Is Book Specific. You use these fields only in accounts that have the Multi-Book Accounting feature enabled to create book specific journal entries and book specific intercompany journal entries. If you have questions about Multi-Book Accounting, see the help topics Multi-Book Accounting Overview and Using Multi-Book Accounting.

After journal entry data is in a CSV file, users with required permissions can start a journal entry import by going to Setup > Import/Export > Import CSV Records, selecting an Import Type of Transactions and a Record Type of Journal Entry (or Intercompany Journal Entry), and completing other Import Assistant pages.

**Important:** To import a single journal entry, you can use a simpler import process available at Transactions > Financial > Make Journal Entries > Import. If you use NetSuite OneWorld, you can go to Transactions > Financial > Make Intercompany Journal Entries > Import to import a single intercompany journal entry. See Single Journal Entry Import.

Import is supported for journal entries with up to 10,000 lines. However, poor performance results during import and in the user interface for journal entries with over 1000 lines, and these large journal entries may not be editable in the user interface.

See the following for more information about using the Import Assistant to import journal entries or intercompany journal entries.

- Permissions for Importing Journal Entries with the Import Assistant
Permissions for Importing Journal Entries with the Import Assistant

To use the Import Assistant to import journal entries (or intercompany journal entries), you need the following permissions:

- Make Journal Entry (Edit or Full)
- Posting Period on Transactions (Full)
- Import CSV File

To set journal entries to approved during import, you also need:

- Journal Approval (Edit or Full)

Journal entry imports that occur during the implementation phase usually are completed by users who are account administrators and have all of the above permissions. Other users, such as accountants, who may need to complete journal entry imports at a later point, most likely do not have the Import CSV File permission.

⚠️ **Important:** Users who have the Make Journal Entry and Posting Period on Transactions permissions, but not the Import CSV File permission, can use the Single Journal Entry Import (and for NetSuite OneWorld, the Single Intercompany Journal Entry Import). See [Single Journal Entry Import](#).

To enable users to use the Import Assistant to import journal entries, an account administrator should do the following:

1. Create a new custom role that includes only the Make Journal Entry (Edit or Full), Posting Period on Transactions (Full), and Import CSV File permissions.
2. Add this new role to all users who require the ability to import journals.
3. Instruct users that they should choose this role when they import journals.

An alternative is to add the Import CSV File permission to users' existing roles, but this choice allows users to import data for records other than journal entries. The safest route is to create a specialized role used only for journal entry imports.

For users who need to set journal entries to approved during import, a custom role can be created with the Make Journal Entry, Posting Period on Transactions, Import CSV File, and Journal Approval permissions.

If you use NetSuite OneWorld, users' access to subsidiaries also impacts the journal entries that they can import. For more information, see the help topic [Control Employee Access to Subsidiaries](#).

Journal Entry CSV Files

Be aware of the following requirements for journal entry CSV files:

- Each imported journal entry must include at least 2 lines, and have balancing debits and credits.
Each imported intercompany journal entry must include at 4 lines, with one debit and credit each for the originating and receiving subsidiary.

If you use NetSuite OneWorld, data for journal entries and intercompany journal entries must be imported from separate files in separate jobs, because journal entry import and intercompany journal entry import are separate record types in the Import Assistant.

**Note:** For imports with the Single Journal Entry Import Assistant, only the three requirements listed above apply.

Your journal entry CSV files should include both header and line-level data.

You can import data in a single CSV file, or in multiple files, for example, with header data in one file and line-level data in other files. Each journal entry transaction can be uniquely identified by its value for one of the following fields: Entry No., External ID, or (updates only) Internal ID. This value should be included in every row of the CSV files.

**Note:** When creating new records, if the CSV file does not include the entry number or external ID as a unique identifier, then a single import is performed.

If you include both header-level and line-level data in one file, each row of the CSV file represents a transaction line, and header-level field values must be included in each row, even if it is repetitious.

### Example Journal Entry CSV File

The following is a sample CSV file containing data for one journal entry transaction with two lines. The first two columns contain header-level data, whereas the other columns contain line-level data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Department</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>10008</td>
<td>Marketing</td>
<td>1000 Checking</td>
<td>100</td>
<td></td>
<td>Put money into petty cash</td>
</tr>
<tr>
<td>10008</td>
<td>Marketing</td>
<td>1006 Petty Cash</td>
<td></td>
<td>100</td>
<td>Put money into petty cash</td>
</tr>
</tbody>
</table>

### Example Intercompany Journal Entry CSV File

The following is a sample CSV file containing data for one intercompany journal entry transaction with four lines. The first three columns contain header-level data, whereas the other columns contain line-level data.

**Note:** The Subsidiary column indicates the subsidiary the transaction originates from, while the To Subsidiary column indicates the receiving subsidiary.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subsidiary</th>
<th>To Subsidiary</th>
<th>Line subsidiary</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
</table>

For extensive details about the fields for which data can be included in journal entry and intercompany journal entry CSV files, see: [CSV Imports](#)
Journal Entry Import Supported Fields

The Import Assistant Field Mapping page displays the list of journal entry (or intercompany journal entry) fields for which you can import data. Header-level fields are listed under Journal Entry, line-level fields are listed under the Journal Entry Line sublist. These are the fields for which you can include data in your CSV file. The NetSuite Fields for both the Journal Entry and Intercompany Journal Entry are shown side-by-side in the following screenshot.

This dynamic list adjusts according to your permissions and to the features enabled in your account. By default, all fields on your preferred journal entry form, including custom fields, are available. You have the option of specifying a custom journal entry form, so that form’s fields are available instead (not available for Single Journal Entry Import). See Custom Form Specification for Journal Entry Imports.

For more information about journal entry import fields, see the following topics:

- Journal Entry and Intercompany Journal Entry Header Fields Table
- Journal Entry and Intercompany Journal Entry Line Fields Table

For details about fields that can be mapped, see the SOAP Schema Browser’s journal entry and intercompany journal entry reference pages. You can use the field definitions here as a basis for creating
your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Journal Entry and Intercompany Journal Entry Header Fields Table

The following table lists NetSuite standard header fields commonly available for journal entry and intercompany journal entry import mapping. The fields you can map vary according to the fields available on either your preferred journal entry form, or the custom form specified for import.

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Field Size</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Book</td>
<td></td>
<td>Only used in Multi-Book Accounting to specify the accounting book for a book specific Journal Entry or a book specific Intercompany Journal Entry. The <strong>Accounting Book</strong> field works in conjunction with the <strong>Is Book Specific</strong> field to accomplish this goal. The list below outlines various combinations that can be specified in the CSV import file for Journal Entries. The same combinations are used for Intercompany Journal Entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If <strong>Is Book Specific</strong> is set to True, a book specific journal entry is created. If an <strong>Accounting Book</strong> is not specified, the book specific journal entry is entered in the primary accounting book.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If <strong>Is Book Specific</strong> is set to False, a journal entry is created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If <strong>Is Book Specific</strong> is not set, and an <strong>Accounting Book</strong> is specified, a book specific journal entry is created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If <strong>Is Book Specific</strong> is not set, and no <strong>Accounting Book</strong> is specified, a journal entry is created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you have questions about Multi-Book Accounting, see these help topics: Multi-Book Accounting Overview and Using Multi-Book Accounting.</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td></td>
<td>The Accounting Book Detail sublist is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>Approved</td>
<td>Boolean</td>
<td>Users need the Journal Approval permission to set this value to True.</td>
</tr>
<tr>
<td>Class</td>
<td>N/A</td>
<td>Must match the name of an existing class at Setup &gt; Company &gt; Classes. If the Always Allow Per-line Classifications on Journals preference is enabled at Setup &gt; Accounting &gt; Accounting Preferences, the Class field is at line-level rather than header-level.</td>
</tr>
<tr>
<td>Currency</td>
<td>N/A</td>
<td>Available for accounts with the Multiple Currencies feature enabled. See the help topic Currency Management. Must match the name of an existing currency at Lists &gt; Accounting &gt; Currencies. In accounts that are not OneWorld, defaults to company base currency when CSV file row does not specify a value. In OneWorld accounts, defaults to root parent subsidiary base currency when CSV file row does not specify a value. Click the edit icon to set a different default value for all imported rows.</td>
</tr>
<tr>
<td>Column Header</td>
<td>Field Size</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Important:</td>
<td></td>
<td>If you set a default in a OneWorld account, you need to ensure that the selected default is valid for all imported subsidiary values. See Using Dependent Field Values as Defaults.</td>
</tr>
<tr>
<td>Date</td>
<td></td>
<td>Required for new records. For Single Journal Entry Import, default value provided if necessary.</td>
</tr>
<tr>
<td>Defer Entry</td>
<td>Boolean</td>
<td>Must match the name of an existing department at Setup &gt; Company &gt; Departments. If the Always Allow Per-line Classifications on Journals preference is enabled at Setup &gt; Accounting &gt; Accounting Preferences, the Department field is at the line-level rather than header-level.</td>
</tr>
<tr>
<td>Department</td>
<td>N/A</td>
<td>For new records, NetSuite recommends that you map the external ID field from your CSV files to this field, which serves as a transaction ID for Journal Entry records. For Single Journal Entry Import, default provided if necessary. Note that if you provide a value that is already in use, this value is blank for the newly created journal entry.</td>
</tr>
<tr>
<td>Entry No.</td>
<td>45</td>
<td>Available for accounts with the Multiple Currencies feature enabled. Defaults to 1.00 when CSV file row does not specify a value.</td>
</tr>
<tr>
<td>Exchange Rate</td>
<td></td>
<td>Unique journal entry identifier in an external system.</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Available for updates. You can create a transaction saved search to obtain Internal ID values.</td>
<td></td>
</tr>
<tr>
<td>Is Book Specific</td>
<td>Boolean</td>
<td>Only used in Multi-Book Accounting. The main function of the book specific journal entry or the book specific Intercompany journal entry is to make accounting adjustments for a specific accounting book. The Is Book Specific field works in conjunction with the Accounting Book field to accomplish this goal. For simplicity, the list below outlines various combinations that can be specified in the CSV import file for Journal Entries. The same combinations are used for Intercompany Journal Entries.</td>
</tr>
<tr>
<td>Memo</td>
<td>999</td>
<td>Only used in Multi-Book Accounting. The main function of the book specific journal entry or the book specific Intercompany journal entry is to make accounting adjustments for a specific accounting book. The Is Book Specific field works in conjunction with the Accounting Book field to accomplish this goal. For simplicity, the list below outlines various combinations that can be specified in the CSV import file for Journal Entries. The same combinations are used for Intercompany Journal Entries.</td>
</tr>
<tr>
<td>Posting Period</td>
<td>N/A</td>
<td>An error is returned if a closed period is specified.</td>
</tr>
<tr>
<td>Reversal Date</td>
<td></td>
<td>An error is returned if a closed period is specified.</td>
</tr>
</tbody>
</table>
Journal Entry and Intercompany Journal Entry Line Fields Table

The following table lists NetSuite standard line-level fields commonly available for journal entry and intercompany journal entry import mapping.

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Field Size</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>N/A</td>
<td>This field is required and should match the name of an existing account at Lists &gt; Accounting &gt; Accounts. If the Use Account Numbers preference has been enabled at Setup &gt; Accounting &gt; Accounting Preferences, NetSuite recommends that values include both account number and name, such as <strong>11000 Accounts Payable</strong>. Number-only values, such as <strong>11000</strong>, also are supported. Name-only values, such as <strong>Accounts Payable</strong>, are not supported when this preference is enabled. If this preference is not enabled, name-only values should be used. Ensure that you exactly match the capitalization, spelling, and spacing of the names as defined in NetSuite with no leading or trailing spaces.</td>
</tr>
<tr>
<td>Debit</td>
<td>13</td>
<td>Defines the amount to be debited. Must be a number with a maximum of 10 digits before the decimal and 2 digits after the decimal.</td>
</tr>
<tr>
<td>Credit</td>
<td>13</td>
<td>Defines the amount to be credited. Must be a number with a maximum of 10 digits before the decimal and 2 digits after the decimal.</td>
</tr>
<tr>
<td>End Date</td>
<td></td>
<td>Available if the Revenue Recognition feature is enabled.</td>
</tr>
<tr>
<td>Gross Amt</td>
<td></td>
<td>Available if the Advanced Taxes feature is enabled. This feature is required for OneWorld accounts.</td>
</tr>
<tr>
<td>Location</td>
<td>N/A</td>
<td>Required if the Multi-Location Inventory feature is enabled. Must match the name of an existing location at Setup &gt; Company &gt; Locations.</td>
</tr>
<tr>
<td>Memo</td>
<td>4000</td>
<td>Provides a detailed description displayed in the transaction detail list and other reports.</td>
</tr>
<tr>
<td>Name</td>
<td>N/A</td>
<td>The name of the associated entity, such as customer, vendor or employee. Should match the name of an existing entity.</td>
</tr>
</tbody>
</table>

**Important:** Each imported journal entry must include at least two lines, and have balancing debits and credits. Each imported intercompany journal entry must include at least four lines, one debit and one credit each for the originating and receiving subsidiary.
Transactions Import Type

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Field Size</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Residual</td>
<td>Available if the Revenue Recognition feature is enabled.</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>Available if the Revenue Recognition feature is enabled.</td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>Available if the Revenue Recognition feature is enabled.</td>
<td></td>
</tr>
<tr>
<td>Subsidiary</td>
<td>N/A</td>
<td>Required for intercompany journal entries. Must match value for either Subsidiary or To Subsidiary. If your CSV file includes a Subsidiary column, it is automatically mapped to the header level Subsidiary field. NetSuite recommends that the column to be mapped to the line-level Subsidiary field have a different name, such as Line Subsidiary.</td>
</tr>
<tr>
<td>Tax Account</td>
<td>Available if the Advanced Taxes feature is enabled. This feature is required for OneWorld accounts.</td>
<td></td>
</tr>
<tr>
<td>Tax Code</td>
<td>Available if the Advanced Taxes feature is enabled. This feature is required for OneWorld accounts. Tax codes should be set up in NetSuite before the import.</td>
<td></td>
</tr>
<tr>
<td>VAT Amt</td>
<td>Available if the Advanced Taxes feature is enabled. This feature is required for OneWorld accounts.</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** If you set a default value in a OneWorld account, you need to ensure that the selected default is valid for all imported subsidiary values. See Using Dependent Field Values as Defaults.

Using Journal Entry Import for Updates

The Single Journal Entry Import Assistant (see Single Journal Entry Import) does not support updates.

For existing journal entries and existing intercompany journal entries, you need to use the CSV Import Assistant at Setup > Import/Export > IMPORT TASKS > Import CSV Records, which can:

- Update transaction body field values
- Add lines to existing transactions
- Update values in existing journal entry lines

In the first step of the CSV Import Assistant select the import type (Transactions) and record type (Journal Entry or Intercompany Journal Entry) as well as the CSV file or files you want to upload. In the next steps you will select the data handling options and the field mapping.

If you set the data handling option to Update, any CSV file line field values for existing transactions are appended as additional lines per transaction.
The lines of the Journal Entry Line sublist are not keyed, so you cannot directly update specific lines. To update specific journal entry lines, export them all, make the necessary changes in the sublist lines, check the Overwrite Sublists box in the advanced options and overwrite the whole sublist.

For more information on updating records with a CSV import see Choose Data Handling for Import.

For CSV file samples see Journal Entry CSV Files.

**Warning:** If you update any type of journal entry that has been applied as a payment to an invoice or vendor bill, the relationship between the journal entry and payment is removed and the payment is no longer applied.

### Custom Form Specification for Journal Entry Imports

By default the Field Mapping page for a journal entry import displays the NetSuite fields from your preferred journal entry form as available for mapping. The default form for your role may not include all the fields you need to import. To ensure that the appropriate fields are available for mapping, you can select any journal entry form that is available to your role, in the Advanced Options area of the Import Assistant's Import Options page. For more information, see Set Advanced CSV Import Options.

**Note:** Single Journal Entry Import does not support custom form specification.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

### Opportunity Import

NetSuite Opportunity transactions document negotiations with potential customers (Prospects). Opportunities are created upon customer contact, and are used for record keeping, sales forecasting, sales management, and sales reporting purposes. Each Opportunity record includes items in which the customer is interested, and can have attached estimates or sales orders, and attached activities such as tasks, events, and phone calls.

- You can import Opportunity transaction data in a single CSV file, or in multiple files, for example, with transaction header data in one file and item-level data in other files. Opportunity transactions can be uniquely identified by internal ID or external ID. The unique ID should be included in every line of the CSV files.

- For imports of new data, a key of external ID is recommended. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Opportunity # field, which serves as a transaction ID for Opportunity records. This mapping allows external IDs to be displayed on Opportunity forms in the NetSuite user interface.

- Each imported Opportunity record should include a reference to a NetSuite Customer record, mapped to the Opportunity's Company field. This reference must be a unique identifier; NetSuite recommends that you use the customer record's internal ID or external ID, rather than a name reference.

- The Status field is required for imported Opportunity records. Status field values for customers can be entered at Setup > Sales > Customer Statuses. The Import Assistant Field Mapping page lets you set a default value for Status.

- Other required fields are Probability, Date Created, and Expected Close. The user interface automatically calculates Probability based on Status; the Import Assistant does the same. Formatting
for Date Created and Expected should match the Date Format set at Setup > Company > General Preferences.

**Note:** If you are importing historical data for opportunities that have been previously closed, be sure to set Status field values to “Closed Lost” or “Closed Won”. The Close Date field value for all records imported with closed statuses are set to the date that the import job adds or updates the records. You cannot modify Close Date field values to be any other date.

For details about fields that can be mapped in the opportunity record, see the SOAP Schema Browser's opportunity reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Opportunity imports:

- **Supported Opportunity Sublist Data Imports**
- **Using Import Assistant for Opportunities Mass Update**
- **Advanced Forecasting and Opportunities' Projected Total Values**

### Supported Opportunity Sublist Data Imports

The Opportunity import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>(Related Opportunities)</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner field.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
</tbody>
</table>

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Opportunity, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Opportunity records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Important:** For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

### Using Import Assistant for Opportunities Mass Update

You can perform a mass update of existing Opportunity data by exporting Opportunity saved search results, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.
Advanced Forecasting and Opportunities' Projected Total Values

You need to be aware of potential issues for imports of Opportunity records' Projected Total field values. When Opportunity transactions are added or updated in the user interface, this field's values are calculated based on Items sublist data and attached Estimates' data, but can be overridden by user entries.

For imports of Opportunity transactions, Projected Total field values are calculated in a variety of manners, depending on whether the imported Opportunities include Items sublist data, on whether your account has the Advanced Forecasting feature enabled and you have enabled the Multiple Sales Projected Amount Preference, and on whether the import is adding or updating NetSuite records.

Review the following scenarios and ensure that Projected Total field values are populated appropriately in your CSV files for Opportunity imports:

When Advanced Forecasting Feature is Disabled:

- For Adds:
  - If CSV files do not include Items sublist data, Projected Total field values are required to avoid errors.
  - If CSV files include Items sublist data but no Projected Total field values, these imported records' Projected Total field values are calculated to be the sum of items.
  - If CSV files include both Items sublist data and Projected Total field values, the Projected Total field values are used to set values for imported records.

- For Updates:
  - If CSV files do not include Items sublist data or Projected Total field values, existing NetSuite Projected Total field values are not changed by the import.
  - If CSV files include Items sublist data but no Projected Total field values, existing NetSuite Projected Total field values are updated to be the sum of all items, both preexisting and imported.
  - If CSV files include Projected Total field values, these values replace imported records' preexisting Projected Total field values.

When Advanced Forecasting Feature and Multiple Sales Projected Amount Preference are Enabled:

With Advanced Forecasting and Multiple Sales Projected Amount enabled, two additional fields are available relating to the Opportunity Projected Total field: a Range Low and Range High.

- CSV files' Range Low field values must be lower than or equal to Projected Total field values. Range Low values represent Worst Case projected totals.
- CSV files' Range High field values must be greater than or equal to Projected Total field values. Range High values represent Upside projected totals.

- For Adds:
  - If CSV files do not include Items sublist data, Projected Total field values are required to avoid errors.
  - If CSV files do not include Items sublist data, do include Projected Total field values, and one or both of Range Low and Range High fields are missing, then field values for Range Low and Range High are set to Projected Total field value.
If CSV files include Items sublist data but are missing Projected Total, Range Low, or Range High field values, any missing values are calculated to be the sum of items.

Any values in CSV files for Projected Total, Range Low, and Range High are used to set imported records' field values, whether or not Items sublist data is included.

For Updates:
- If any of the values for an import file record's Projected Total, Range Low, or Range High field is the same as the existing record's field value, then all three fields' values are calculated based on the sum of items.
- If an import file record's Projected Total, Range Low, and Range High fields all have different values than the existing record's fields, then none of the field values are calculated based on the sum of items, and the Projected Total field value is set to the value submitted in the import file.
- If an import file record does not have a value for Projected Total, Range Low, or Range High, then all three fields' values are calculated based on sum of items, unless there is no change to Items sublist data.

The Advanced Forecasting feature is enabled at Setup > Company > Enable Features, on the CRM subtab's Sales section. For information about this feature, see the help topic Advanced Forecasting.

The Multiple Sales Projected Amount Preference is enabled at Setup > Sales > Sales Preferences, on the Forecasts Subtab. For information about this preference, see the help topic Forecasting Preferences.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Paycheck Import

The paycheck record is available when the Payroll feature is enabled on the Employees subtab at Setup > Company > Setup Tasks > Enable Features.

In the user interface, you can access the paycheck record at Transactions > Employees > Create Payroll.

For information about working with this record in the user interface, see the help topics Calculating a Payroll Batch and Editing an Individual Paycheck from a Payroll Batch.

Review the following guidelines for paycheck imports:
- The paycheck record is automatically created through the payroll batch record when you add employees to the payroll batch. You cannot create paycheck records through CSV import, you can only update paychecks that already exist in a payroll batch. For this reason, only the update option is available on the Import Options page of the Import Assistant.
- The employee whose paycheck data you want to update must be included in the payroll batch, and the payroll item you want to add to a paycheck must be available for that employee.
- You cannot commit a payroll batch through CSV import. After importing paycheck data, you must calculate and commit the payroll batch in the user interface.
- You cannot update paycheck data in a payroll batch that had already been committed.
- The CSV import file must be linked to an existing paycheck through either internal ID or external ID. The unique ID should be included in every line of the CSV file.

Supported Paycheck Sublist Data Import

The Paycheck import supports the import of the following sublist data. Each sublist is keyed by the Line field.
**Transactions Import Type**

### Note:
The line field in a paycheck sublist does not refer to the line number of a particular line in that sublist. This line number refers to the line number that is saved in a table that contains every line from every paycheck sublist. You can retrieve this line number by using SOAP web services.

- Contributions
- Deductions
- Earnings
- Expenses
- Taxes
- Time

## Paycheck Import Example

The following example shows an import where the paycheck data on a payroll batch is updated with new data.

<table>
<thead>
<tr>
<th>Paycheck Internal ID</th>
<th>Earnings</th>
<th>Line</th>
<th>Amount</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Quarterly Bonus</td>
<td>8</td>
<td>8500</td>
<td>Sales</td>
</tr>
<tr>
<td>2</td>
<td>Monthly Incentive</td>
<td>22</td>
<td>5500</td>
<td>Support</td>
</tr>
<tr>
<td>3</td>
<td>Monthly Incentive</td>
<td>10</td>
<td>5000</td>
<td>Support</td>
</tr>
<tr>
<td>4</td>
<td>Quarterly Bonus</td>
<td>4</td>
<td>2000</td>
<td>Sales</td>
</tr>
</tbody>
</table>

For details about fields that can be mapped in the paycheck record, see the SOAP Schema Browser's paycheck reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

### Period End Journal Entry Import

A Period End Journal is a transaction record that posts subsidiary consolidation and year end closing to the general ledger. Period end journals are generated automatically when you complete the Create Period End Journals task on the Period Close Checklist. For help working with this record in the user interface, see Period End Journal Entries.

You can use the Import Assistant to update the already generated Period End Journals, but not to add new records. To find the Import Assistant go to Setup > Import/Export > Import Tasks > Import CSV Records.

### Permissions and Features required for Importing Period End Journal with the Import Assistant

#### Features

To use the Import Assistant to import Period End Journals you need to have a NetSuite OneWorld account. Also, you need to enable the Accounting Periods and the Period End Journal Entries features in Setup > Company > Setup Tasks > Enable Features, Accounting subtab.
Permissions

To update period end journals, you must have the permission Period End Journals, Edit level or higher. You must also have access to both the Subsidiary to which the period end journal posts and the Source Subsidiary for the period end journal entry. To review the access level of a specific role, go to Setup > Users/Roles > User Management > Manage Roles and click on the role you want to review. In the Subsidiary Restrictions field group, you can see which subsidiaries this role can access. On the Permissions subtab, under Transactions you can see the level of the Period End Journals permission. For information about assigning permissions to roles, see the help topic Customizing or Creating NetSuite Roles.

Note: The Source Subsidiary is the child subsidiary when posting consolidation, income statement closing and balance sheet closing journals for the child subsidiary in the parent subsidiary. The child subsidiary does not need to have the Period End Journal Entries feature enabled. The Subsidiary is the same as the Source Subsidiary only when posting non-consolidated income statement closing and balance sheet closing journals for each subsidiary's year end.

Important: Editing period end journals in the UI or with a CSV import is permitted when the period is open or when the Allow Non-G/L Changes box is checked on the period record. When Allow Non-G/L Changes is checked, users with the Setup permission Allow Non-G/L Changes can make edits that do not affect the general ledger.

Period End Journal Import Supported Fields

From standard fields on period end journals, you can update only the Memo fields on each journal line and in the header. From custom fields or segments, you can update only those that do not affect the general ledger. You can't update any other fields and especially those affecting the general ledger. For more information on the header and journal line fields, see the help topics Period End Journal Header Fields and Period End Journal Line Fields.

Purchase Order Import

NetSuite Purchase Order transactions authorize vendors to provide goods or services to your company, and express a commitment to receive and pay for them. These transactions have no accounting impact until orders are received.

Note: Purchase Order imports are not available unless the Purchase Orders feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Transactions tab, check the Purchase Orders box.

- Purchase order imports can include line-level items and expenses data. For imports with items data, but no expenses data, you can choose either the one file to upload or the multiple files to upload option. For imports with expenses data, you must choose the multiple files to upload option. For more information, see Using Multiple Files for Purchase Order Sublist Data.
- By default, the NetSuite fields available for purchase order import mapping are those available on your preferred purchase order form. Fields can be mapped for the import job if they are displayed (not hidden) and not disabled on your preferred form. To make different fields available, you can specify
the standard drop ship or another purchase order form on the Import Options page. For information, see Custom Form Specification for Purchase Order Imports.

- You cannot import drop ship purchase orders and other purchase orders at the same time; you must use separate import jobs. To import drop ship purchase orders, you must specify the standard drop ship purchase order form, or a custom drop ship form, as the Custom Form advanced option on the Import Options page, so that the Ship To field is available for mapping.

- You must map either external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID.

- On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Order # field, which serves as a transaction ID for Purchase Order records. This mapping allows external IDs to be displayed on Purchase Order forms in the NetSuite user interface.

- Each imported Purchase Order record should include a reference to a NetSuite Vendor record, mapped to the Purchase Order's Vendor field. This reference must be a unique identifier; NetSuite recommends that you use the vendor record's internal ID or external ID, rather than a name reference.

- By default, Billing Address and Shipping Address fields for Purchase Order records are copied from linked Vendor records, but these fields are available for mapping in the Import Assistant so their values can be set by CSV files' field values instead.

- If the Multiple Currencies feature is enabled, you must map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced vendors. See the help topic Currency Management.

For details about fields that can be mapped in the purchase order record, see the SOAP Schema Browser’s purchase order reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Purchase Orders imports:

- Custom Form Specification for Purchase Order Imports
- Supported Purchase Order Sublist Data Imports
- Using Multiple Files for Purchase Order Sublist Data
- Supported Purchase Order Subrecord Data Imports
- Importing Purchase Orders with Billed-Back Items and Expenses
- Importing Purchase Orders with Serial or Lot-Numbered items
- Importing Purchase Orders when Advanced Taxes is Enabled
- Working with Closed Purchase Orders
- Sample Purchase Order Single CSV File Format
- Sample Purchase Order Multiple CSV File Format
- Using Import Assistant for Purchase Orders Mass Update

Custom Form Specification for Purchase Order Imports

By default the Field Mapping page for a purchase order import displays the NetSuite fields from your preferred purchase order form as available for mapping. The default form for your role may not include all the fields you need to import. To ensure that the appropriate fields are available for mapping, you can select any purchase order form that is available to your role, in the Advanced Options area of the Import Assistant's Import Options page. For more information, see Set Advanced CSV Import Options.
Warning: If you specify a drop ship purchase order form, all records in the imported file should be drop ship purchase orders. You cannot import both drop ship purchase orders and other purchase orders at the same time.

Supported Purchase Order Sublist Data Imports

The Purchase Order import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Expenses</td>
<td>When the Allow Expenses on Purchase Orders preference is enabled. Expenses data must be in a separate CSV file.</td>
</tr>
</tbody>
</table>

If you use classes, departments, or locations, you can set these values either for an entire purchase order, or per individual item/expense lines.

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Purchase, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Purchase Order records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

Important: For non-keyed sublists, it is recommended that you do not update main transaction fields and sublist fields during the same import job.

Using Multiple Files for Purchase Order Sublist Data

For purchase order imports that include items data but no expenses data, you can choose the one file to upload option, and include all data in a single CSV file, or you can choose the multiple files to upload option, and include mainline data in one file and items data in another file.

For imports that include expenses data, you must use the multiple files to upload option, with one file for mainline data, and one for expenses data. If you are also importing items data, it should be in a third file.

If you choose the multiple files option, be sure to include the external ID or key field values in the sublist files as well as in the main file.

For a multiple files upload example, see Sample Purchase Order Multiple CSV File Format.

Supported Purchase Order Subrecord Data Imports

The Purchase Order import supports the import of the following subrecord data:
<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Items — Inventory Detail</td>
<td>When Advanced Bin/Numbered Inventory Management feature enabled.</td>
</tr>
<tr>
<td>Shipping Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
</tbody>
</table>

**Importing Purchase Orders with Billed-Back Items and Expenses**

If you are importing purchase orders with items or expenses that need to be billed back to customers, you can set the value of the Billable field to "TRUE" and include a value for the Customer field, for each of these item or expense lines.

**Importing Purchase Orders with Serial or Lot-Numbered items**

If you are importing purchase orders with serial or lot-numbered items, you need to define serial or lot numbers in the Serial/Lot Numbers field for each item.

- You must enter a number for each serialized item; for example, if the Quantity field has a value of 2, you must enter two numbers.
- You can separate multiple numbers with spaces, commas, or Returns.

**Importing Purchase Orders when Advanced Taxes is Enabled**

If the Advanced Taxes feature is enabled, you can include values for the Tax Code and Tax Amount fields for purchase order item and expense lines as needed in CSV files. Tax codes should be set up in NetSuite before the import. Note that other tax-related values for line items and expenses are calculated by the system.

The Advanced Taxes feature is required for NetSuite OneWorld accounts. For information about working with taxes in OneWorld, see the help topic Nexuses and Taxes in OneWorld. For general information about setting up tax codes, see the help topic Managing Tax Codes.

**Working with Closed Purchase Orders**

You can import a purchase order as closed, by setting its Items sublist records' Closed field values to "TRUE".

If these values are not set in the CSV file itself, you can set a default value by adding the Items sublist's Closed field to the field mapping, clicking the edit icon and selecting the Yes option button. For more information, see Assign Default Values during Field Mapping.

You can use an import to update closed purchase orders by setting the Closed field value for one or more items in an order to "FALSE".
Sample Purchase Order Single CSV File Format

The following table illustrates example column headers and data snippets in a single file upload of purchase orders. This file includes data for purchase order header fields and item lines. Note that in this case, the same purchase order number can be repeated in multiple rows.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>PO Number</th>
<th>Date</th>
<th>Item</th>
</tr>
</thead>
</table>

Sample Purchase Order Multiple CSV File Format

The following tables illustrate example column headers and data snippets in a multiple file upload of purchase orders, including items and expenses data. Note that External ID is the key column that would be specified on the Import Assistant File Mapping page.

**Primary File:**

Each row of the primary file must include a unique identifier, in this case the external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>PO #</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT2003</td>
<td>American Computers</td>
<td>2003</td>
<td>7/28/09</td>
</tr>
<tr>
<td>EXT2004</td>
<td>American Computers</td>
<td>2004</td>
<td>8/3/09</td>
</tr>
</tbody>
</table>

**Linked File - Items:**

The items file can include multiple rows with the same purchase order external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item</th>
<th>Quantity</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT2003</td>
<td>Computer Systems : Desktop : HP Compaq d230</td>
<td>1</td>
<td>800</td>
</tr>
<tr>
<td>EXT2003</td>
<td>Computer Systems : Laptop : Compaq Evo n800c</td>
<td>1</td>
<td>1200</td>
</tr>
</tbody>
</table>

**Linked File - Expenses:**

The expenses file can include multiple rows with the same purchase order external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Account</th>
<th>Amount</th>
<th>Memo</th>
<th>Customer</th>
<th>Billable</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT2003</td>
<td>6150 Office Expense</td>
<td>350</td>
<td>laptop repair</td>
<td>107 Fabre Art Gallery</td>
<td>Yes</td>
</tr>
<tr>
<td>EXT2003</td>
<td>6150 Office Expense</td>
<td>20</td>
<td>laptop part</td>
<td>107 Fabre Art Gallery</td>
<td>Yes</td>
</tr>
<tr>
<td>EXT2004</td>
<td>6150 Office Expense</td>
<td>60</td>
<td>misc.</td>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

Using Import Assistant for Purchase Orders Mass Update

You can perform a mass update of existing Purchase Order data by creating a Transaction saved search with a filter of Type is Purchase Order, changing data externally, then using the Import Assistant to import
modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Return Authorization Import

Return authorization records track information about items returned by customers. These records store data such as quantity and value of returned items, and return status. The return authorization record is updated at each point in the return process, including when the return is initiated, when the returned item is received, and when the refund is issued. The return process can vary based on return management preferences, enabled features, and other account-specific factors. For more information about return authorizations, see the help topic Customer Return Management.

Note: Return Authorization imports are not available unless the Return Authorizations feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Transactions tab, check the Return Authorizations box.

This import supports the import of standalone return authorizations, but not linked return authorizations (those created from cash sales or invoices and linked to these original sales transactions).

Review the following guidelines for Return Authorization imports:

- Setting the Form for a Return Authorization Import
- Notes on Return Authorization Import Field Values
- Supported Return Authorization Sublist Data Imports
- Supported Return Authorization Subrecord Data Imports

Setting the Form for a Return Authorization Import

By default, the Field Mapping page for a return authorization import displays the NetSuite fields from your preferred return authorization form. You can select a different return authorization form in the Advanced Options area of the Import Assistant's Import Options page. See Custom Form, under Set Advanced CSV Import Options.

Two different categories of return authorization forms are usually available:

- “Credit” return authorization forms that authorize the issuing of a credit memo for the returned items. The credit memo can either be applied to an account balance or refunded.
- “Cash” return authorization forms that authorize a direct refund for the returned items. This type of authorization cannot later be processed as a credit memo.

Notes on Return Authorization Import Field Values

- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the Rtn. Auth. # field, which serves as a transaction ID for return authorization records. This mapping allows external IDs to be displayed on return authorization forms in the NetSuite user interface.
- Each imported return authorization record should include a reference to a NetSuite customer record, mapped to the return authorization's Customer field. This reference must be a unique identifier;
NetSuite recommends that you use internal ID or external ID, rather than a name reference. If you do not map a reference number field, reference number values are generated automatically.

- Although the Status field is required, you do not have to map it to a column in your CSV file. If you do not map the Status field, it is automatically mapped with default values of the default return authorization status, as set at Setup > Accounting > Preferences > Accounting Preferences, on the Order Management tab, under Returns. The default is Pending Approval if your company uses the approval process for return authorizations, and Pending Fulfillment if your company does not use this process.
- You also do not have to map the required Date field. If you do not map the Date field, it is automatically mapped with default values of the current date.
- If the Multiple Currencies feature is enabled, you should map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced customers. If your customers use currencies other than the currency in which your company manages its financials, you should map the Currency field. For more information, see the help topic Currency Management.

For more details about fields that can be mapped in the return authorization record, see the SOAP Schema Browser’s return authorization reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

**Supported Return Authorization Sublist Data Imports**

The Return Authorization import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Selectively updatable based on Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Partner key field.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Employee key field.</td>
</tr>
</tbody>
</table>

For imports that update existing Return Authorization records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Supported Return Authorization Subrecord Data Imports**

The Return Authorization import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Items — Inventory Detail</td>
<td>When Advanced Bin/Numbered Inventory Management feature enabled.</td>
</tr>
</tbody>
</table>
Transactions Import Type

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
</tbody>
</table>

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Sales Order Import

NetSuite Sales Order transactions record a commitment to sell items or services to a customer, including the items to be sold and their prices. Sales orders can be converted from existing estimate transactions, or created as new transactions. Sales orders can be attached to opportunity transactions.

For more details about Sales Orders in NetSuite, see the help topic Sales Orders.

Note: Sales Order imports are not available unless the Sales Orders feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Transactions tab, check the Sales Orders box.

- You can import Sales Order transaction data in a single CSV file, or in multiple files, for example, with transaction header data in one file and item-level data in other files.
- By default, the NetSuite fields available for sales orders import mapping are those available on the standard sales order form. Fields can be mapped for the import job if they are displayed (not hidden) and not disabled on your preferred form. To make different fields available, you can specify a custom sales order form on the Import Options page. For information, see Custom Form Specification for Sales Order Imports.
- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files.
- For imports of new data, use external ID. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Order # field, which serves as a transaction ID for Sales Order records. This mapping allows external IDs to be displayed on Sales Order forms in the NetSuite user interface.
- You can link a Sales Order record to an Opportunity record by including the Opportunity record's unique identifier as the Sales Order's “Opportunity” field value. This identifier can be an internal ID, external ID, or transaction ID.
- Each imported Sales Order record should include a reference to a NetSuite Customer record, mapped to the Sales Order's Customer field. This reference must be a unique identifier; NetSuite recommends that you use the customer record's internal ID or external ID, rather than a name reference.
- By default, Billing Address and Shipping Address fields for Sales Order records are copied from linked Customer records, but these fields are available for mapping in the Import Assistant so their values can be set by CSV files' field values instead.
- The Billing Schedule field available for Sales Orders imports can be set to reference existing NetSuite billing schedules only.

For details about fields that can be mapped in the sales order record, see the SOAP Schema Browser's sales order reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for sales order imports:
Custom Form Specification for Sales Order Imports

By default the Field Mapping page for a sales order import displays the NetSuite fields from your preferred sales order form as available for mapping. The default form for your role may not include all the fields you need to import. To ensure that the appropriate fields are available for mapping, you can select any sales order form that is available to your role, in the Advanced Options section of the Import Assistant's Import Options page. For more information, see Set Advanced CSV Import Options.

Supported Sales Order Sublist Data Imports

The Sales Orders import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Book</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
</tr>
<tr>
<td>Detail</td>
<td></td>
</tr>
<tr>
<td>Auth. Code</td>
<td>When the Gift Certificates feature is enabled.</td>
</tr>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports.</td>
</tr>
<tr>
<td>Partners</td>
<td>When the Multi-Partner Management feature is enabled.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When the Team Selling feature is enabled.</td>
</tr>
<tr>
<td>Shipment</td>
<td>When the Multiple Shipping Routes feature is enabled.</td>
</tr>
</tbody>
</table>

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Sale, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Sales Order records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.
**Important:** For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

**Supported Sales Order Subrecord Data Imports**

The Sales Order import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
<tr>
<td>Items — Inventory Detail</td>
<td>When the Advanced Bin/Numbered Inventory Management feature is enabled.</td>
</tr>
<tr>
<td>Shipping Address</td>
<td>By default, the subrecord Address field is read-only, and data from other subrecord fields is copied into it. If you map the Override field and set it to Yes (meaning true), you can import data for the Address field.</td>
</tr>
</tbody>
</table>

**Setting Imported Sales Orders' Status**

The Status field value for each Sales Order transaction indicates where the order is in terms of the approval, fulfillment, and or billing processes. Possible Status values vary according to the following:

- Whether your company uses the approval process for sales orders:
  - If the approval process is not used, initial Status for sales orders is Pending Fulfillment.
  - If the approval process is used, initial Status for sales orders is Pending Approval, and a Status of Canceled occurs when an order is not approved.

- Whether the Advanced Shipping feature is enabled to provide separate processes for fulfilling and billing sales orders:
  - If Advanced Shipping is off, additional Status values are Partially Fulfilled and Fulfilled, and Fulfilled means the sales order process is complete.
  - If Advanced Shipping is on, additional Status values are Partially Fulfilled, Pending Billing, and Billed, and Billed means the sales order process is complete.

For more explanation of sales order status values, see the help topic [Viewing the Status of Sales Orders](#).

You can set a default value of Pending Approval or Pending Fulfillment for Status by clicking the edit icon on the Field Mapping page. See [Assign Default Values during Field Mapping](#). To set Status to any other values, you have to specify them in the CSV file.

**Note:** In the UI, you can set the default value of Pending Approval or Pending Fulfillment at Setup > Accounting > Preferences > Accounting Preferences (Administrator), on the Order Management subtab.

**Setting Sales Orders to Closed**

You cannot use an import to directly set the Status field of sales orders to Closed. Instead, to set a sales order to Closed status, you need to set the Closed field for each line item to TRUE.

This Closed field is available in the Items sublist on the Import Assistant Field Mapping page. You need to include it in your sales order import mapping. You can either include this field in the CSV file with a value
of TRUE, or set a default value for this field on the Field Mapping page. To set this default, after adding the field to the mapping, click its edit icon and select the Yes option button. For more information, see Assign Default Values during Field Mapping.

You should only map the Closed field for sales order line items in imports that are updates. This field is not writable for newly created sales orders. If you attempt to set Closed field values in records being added, the import ignores these values or returns an error. Closed field values are only written successfully for imports that are updates.

**Importing Currency Values for Sales Orders**

When the Multiple Currencies feature is enabled, the import of Currency field values is supported for newly created sales orders. The Currency value for a sales order must be one of the currencies defined for the transaction’s customer, on the Customer Currencies sublist. See the help topics Currency Management and Setting Multiple Transaction Currencies for Customers.

If the Multiple Currencies feature is not enabled, the Currency field value for a sales order is not editable.

**Charging Custom Credit Cards for Imported Sales Orders**

By default, imports of Sales Orders records do not cause charges to customer credit cards. If your NetSuite account has integrated credit card processing set up, you have the option of setting a Sales Orders import to create charges to customer credit cards.

**To set up a Sales Orders import to charge customer credit cards:**

1. On the Field Mapping page for a Sales Orders import, double-click the Get Authorization field to display it in the center pane.
2. Click the edit icon and set the default value for the field to Yes.

   If you do not map the Get Authorization field for a Cash Sales import, its value remains No, and no credit card charges occur.

**Using Import Assistant for Sales Orders Mass Update**

You can perform a mass update of existing Sales Order data by creating a Transaction saved search with a filter of type Sales Order. You change data externally, then use the Import Assistant to import modified data. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type, you choose the import character encoding. For more information, see Select a Record Type for Import, Choose Import Character Encoding.

**Sales Order Import Multi-File Example**

The sales order template that you choose in the Custom Form field on the Advanced menu determines which fields are available on the Mapping page.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Status</th>
<th>Sales Order: Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SORD-003-10009</td>
<td>Acme Landscaping</td>
<td>02/22/2015</td>
<td>Pending Approval</td>
<td>San Mateo</td>
</tr>
</tbody>
</table>

CSV Imports
Transactions Import Type

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Status</th>
<th>Sales Order: Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SORD-003-20384</td>
<td>Jerry's Catering</td>
<td>03/21/2015</td>
<td>Pending Fulfillment</td>
<td>Chicago</td>
</tr>
<tr>
<td>SORD-003-20384</td>
<td>Jerry's Catering</td>
<td>03/21/2015</td>
<td>Pending Fulfillment</td>
<td>Chicago</td>
</tr>
</tbody>
</table>

Mandatory fields:
- External ID
- Customer — The customer must exist in the account. Use the internal ID.
- Date
- Status

The location must exist in the account.

**Sales Order Items**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SORD-003-20384</td>
<td>Printer</td>
<td>33</td>
<td>Base Price</td>
<td>3300</td>
</tr>
<tr>
<td>SORD-003-20384</td>
<td>Scanner</td>
<td>85</td>
<td>Base Price</td>
<td>6375</td>
</tr>
<tr>
<td>SORD-003-10009</td>
<td>Keyboard</td>
<td>42</td>
<td>Base Price</td>
<td>2730</td>
</tr>
</tbody>
</table>

Mandatory field: line ID or item. Item must exist in the account.

**Sales Order — Shipping Address**

<table>
<thead>
<tr>
<th>Sales Order - Shipping Address: External ID</th>
<th>Sales Order - Shipping Address: Country</th>
<th>Sales Order - Shipping Address: Address 1</th>
<th>Sales Order - Shipping Address: Address 2</th>
<th>Sales Order - Shipping Address: Address 3</th>
<th>Sales Order - Shipping Address: State</th>
<th>Sales Order - Shipping Address: Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td>SORD-003-20384</td>
<td>US</td>
<td>Sandra Windham</td>
<td>123 Elm Street</td>
<td>San Francisco</td>
<td>CA</td>
<td>98765</td>
</tr>
<tr>
<td>SORD-003-20384</td>
<td>Canada</td>
<td>Jerry Diner</td>
<td>456 Oak Drive</td>
<td>#829</td>
<td>ON</td>
<td>N3V 2I3</td>
</tr>
<tr>
<td>SORD-003-10009</td>
<td>Czech Republic</td>
<td>Martin Dravi</td>
<td>932 Barva</td>
<td>Brno</td>
<td></td>
<td>6574</td>
</tr>
</tbody>
</table>

Mandatory field: Country.

**Statistical Journal Entry Import**

The statistical journal entry record lets you increase or reduce the balance of a statistical account.

This import is available when the Statistical Accounts feature is enabled at Setup > Company > Enable Features, on the Accounting subtab. Also, to successfully import statistical journal entry records, you must have already created at least one statistical account.

In the user interface, you access this record at Transactions > Financial > Make Statistical Journal Entries. For help working with this record in the user interface, see the help topic Making Statistical Journal Entries.

For more details on importing statistical journal entry records, see the following:
- Statistical Journal Entry Body and Sublist Fields
- Statistical Journal Entry CSV File Examples

**CSV Imports**
Statistical Journal Entry Body and Sublist Fields

When you create a statistical journal entry, you must define certain body fields, and you must create at least one sublist line.

The required body fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit of Measure Type</td>
<td>This field must reference an existing field listed at Lists &gt; Accounting &gt; Units of Measure. Later, when you populate the sublist, the account associated with each line must be of this unit type. This field cannot be updated after the statistical journal entry record has been created.</td>
</tr>
<tr>
<td>Subsidiary</td>
<td>This field must reference an existing subsidiary listed at Company &gt; Setup &gt; Subsidiaries. Later, when you populate the sublist, each account you choose must be a valid account for this subsidiary. This field cannot be updated after the statistical journal entry record has been created. However, you can update this field through the user interface. To update the field, delete the lines from the sublist, select a new subsidiary, add new lines, and then save the modified record.</td>
</tr>
</tbody>
</table>

**Note:** As of 2015.2, you can also map a Memo field for the body of statistical journal entry. This field is in addition to the Memo field available in the Lines sublist.

Every statistical journal entry record must have at least one sublist line. Each line must include values for the fields described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>This field must reference an existing statistical account listed at Lists &gt; Accounting &gt; Accounts. The account you choose must be valid for the Subsidiary body field value, and it must use the same unit of measure specified in the Unit of Measure Type body field.</td>
</tr>
<tr>
<td>Amount</td>
<td>This field takes a double value that represents the adjustment you want to make to the account. Entering a positive amount increases the value of the account. Entering a negative amount decreases the value.</td>
</tr>
</tbody>
</table>

For more details about fields that can be mapped, refer to the SOAP Schema Browser’s statistical journal entry reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Statistical Journal Entry CSV File Examples

The following table shows how you might structure a file for importing statistical journal entries.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subsidiary</th>
<th>Unit of Measure Type</th>
<th>Statistical Journal Entry Line: Account</th>
<th>Statistical Journal Entry Line: Amount</th>
<th>Statistical Journal Entry Line: Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Parent Company</td>
<td>Floor Space</td>
<td>1002 Conference Room Square Footage</td>
<td>500</td>
<td>New board room</td>
</tr>
</tbody>
</table>
Transfer Order Import

The transfer order transaction is used to move inventory between locations. The transfer order record is available when the Multi-Location Inventory (MLI) feature is enabled on the Items & Inventory subtab at Setup > Company > Setup Tasks > Enable Features.

In the user interface, you can access the transfer order record at Transactions > Inventory > Enter Transfer Orders. For information about working with this record in the user interface, see the help topics Transferring Inventory and Inventory Transfer Orders.

Usage Notes

Review the following guidelines for transfer order imports.

The following accounting preferences, available at Setup > Accounting > Preferences > Accounting Preferences, on the Order Management subtab, apply to transfer orders:

- Default Transfer Order Status indicates whether transfer orders require approval by default. Pending Approval means that by default the status of someone with permission must approve the order before it is processed. Pending Fulfillment means that by default transfer orders are sent directly to the fulfillment queue without requiring further approval. If you select this status, you must provide a value for From Location in your CSV file.

- Use Item Cost as Transfer Cost affects how the Transfer Price from each transfer order is used on the related item receipt transaction. When this option is enabled, the transfer price is used as a declared shipping value for reference only, such as for insurance or international shipping, and the item cost from the item record is used on the item receipt. Also, when this option is enabled and different items are fulfilled in different item fulfillments, you must receive the items separately. In this case, a separate item receipt is created for each item fulfillment. When this option is disabled, the transfer price on the transfer order is used as the item cost on the item receipt. In this case, both the item fulfillment and the item receipt resulting from the transfer order have G/L impact. Also, when this option is disabled and different items are fulfilled in different item fulfillments, you can receive all items in the same item receipt.

Supported Transfer Order Sublist Data Imports

The transfer order import supports the import of the following sublist data.

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Books</td>
<td>Accounting Books is a multicolumn sublist. For more information, see Importing Sublist Data in a Single File.</td>
</tr>
<tr>
<td>Items</td>
<td></td>
</tr>
</tbody>
</table>
Supported Transfer Order Subrecord Data Imports

The transfer order import supports the import of the following subrecord data.

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items – Inventory Detail</td>
<td>Available when the Advanced Bin / Numbered Inventory Management Feature is enabled on the Items &amp; Inventory subtab at Setup &gt; Company &gt; Setup Tasks &gt; Enable Features.</td>
</tr>
<tr>
<td>Shipping Address</td>
<td></td>
</tr>
</tbody>
</table>

Transfer Order Import Example

The following table provides an example structure for a file to import transfer order data.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Date</th>
<th>Subsidiary</th>
<th>To Location</th>
<th>Status</th>
<th>Incoterm</th>
<th>Item</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>TO9876</td>
<td>5/31/2018</td>
<td>Parent Company</td>
<td>US – East Coast</td>
<td>Pending Approval</td>
<td>DAP</td>
<td>Travel Kit – Small Travel Kit – Medical Kit</td>
<td>1000</td>
</tr>
<tr>
<td>TO9876</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Light Weight Sleeping Bag</td>
<td>550</td>
</tr>
<tr>
<td>TO9877</td>
<td>5/31/2018</td>
<td>Parent Company</td>
<td>US – West Coast</td>
<td>Pending Fulfillment</td>
<td>DAP</td>
<td>Travel Kit – Large Travel Kit – Medium</td>
<td>150</td>
</tr>
</tbody>
</table>

For details about fields that can be mapped in the transfer order record, see the SOAP Schema Browser's transfer order reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Vendor Bill Import

Vendor Bill transactions allow you to track paid and unpaid vendor bills, as well as pricing for particular products you buy. You enter bills when they arrive, and then pay them when they are due. NetSuite can remind you when those bill payments are due.

**Note:** To maintain performance, 5000 lines per transaction is the maximum recommended limit for transactions submitted through CSV import.

For more details about vendor bills in NetSuite, see the help topic Vendor Bills.

- Vendor bill imports can include line-level items and expenses data. For imports with items data, but no expenses data, you can choose either the one file to upload or the multiple files to upload option. For imports with expenses data, you must choose the multiple files to upload option. For more information, see Using Multiple Files for Vendor Bill Sublist Data.
- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID. On the Import
Assistant’s Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Reference No. field, which serves as a transaction ID for Vendor Bill records. This mapping allows external IDs to be displayed on Vendor Bill forms in the NetSuite user interface.

- Each imported Vendor Bill record should include a reference to a NetSuite Vendor record, mapped to the Vendor Bill’s Vendor field. This reference must be a unique identifier; NetSuite recommends that you use internal ID or external ID, rather than a name reference. If you do not map a reference number field, reference number values are generated automatically.

- If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account field should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.

- If the Multiple Currencies feature is enabled, you must map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced vendors. See the help topic Currency Management.

- If the vendor bills you are importing contain values for the Amount, Tax Amount, and Gross Amount fields, Gross Amount must be equal to the sum of the Amount and Tax Amount values.

- If you are using a customized vendor bill form, please note that the Gross Amount field should never precede the Amount field on such a form. Otherwise it may affect the import of vendor bills CSV files.

- Note that vendor bills are typically used to bring in open payables, not to link to open purchase orders.

For details about fields that can be mapped in the vendor bill record, see the SOAP Schema Browser’s vendor bill reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Vendor Bill imports:

- Supported Vendor Bill Sublist Data Imports
- Using Multiple Files for Vendor Bill Sublist Data
- Supported Vendor Bill Subrecord Data Imports
- Linking Purchase Orders to Vendor Bills
- Importing Vendor Bills with Billed-Back Items and Expenses
- Importing Vendor Bills when Advanced Taxes is Enabled
- Importing Vendor Bills when Amortization is Enabled
- Sample Vendor Bill Single CSV File Format
- Sample Vendor Bill Multiple CSV File Format
- Using Import Assistant for Vendor Bills Mass Update

**Supported Vendor Bill Sublist Data Imports**

The Vendor Bill import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
</tbody>
</table>

CSV Imports
Transactions Import Type

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses</td>
<td>Expenses data must be in a separate CSV file. Selectively updatable based on Line/Order Line key field.</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updatable based on Accounting Book key field.</td>
</tr>
</tbody>
</table>

If you use classes, departments, locations, or custom segments, you can set these values either for an entire vendor bill, or per individual item/expense lines.

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Purchase, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Vendor Bill records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

⚠️ Important: For non-keyed sublists, NetSuite recommends that you do not update main transaction fields and sublist fields during the same import job.

Using Multiple Files for Vendor Bill Sublist Data

For vendor bill imports that include items data but no expenses data, you can choose the one file to upload option, and include all data in a single CSV file, or you can choose the multiple files to upload option, and include mainline data in one file and items data in another file.

For imports that include expenses data, you must use the multiple files to upload option, with one file for mainline data, and one for expenses data. If you are also importing items data, it should be in a third file.

For the multiple files option, be sure to include the external ID or key field values in the sublist files as well as in the main file.

Vendor bill CSV file formats are similar to those for purchase order CSV files. For examples, see: Sample Purchase Order Single CSV File Format, Sample Purchase Order Multiple CSV File Format.

Supported Vendor Bill Subrecord Data Imports

The Vendor Bill import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items — Inventory Detail</td>
<td>When Advanced Bin/Numbered Inventory Management feature enabled.</td>
</tr>
<tr>
<td>Items — Landed Cost</td>
<td>When Landed Cost feature enabled.</td>
</tr>
</tbody>
</table>

Linking Purchase Orders to Vendor Bills

The 2017.1 endpoint supports linking purchase orders to vendor bills in CSV import. This way you can populate a vendor bill with the items and expenses from one or more purchase orders.
Use the Purchase Order field on the field mapping page of the import assistant to map a purchase order to your vendor bill record. You can refer to purchase orders by name, external ID, or internal ID, and you can specify multiple purchase orders for the same vendor bill.

The Purchase Order field is a multi-select field. To specify multiple values, use multi-select value delimiters. For information about configuring delimiters, see Custom Multi-Select ValueDelimiter.

**Important:** If you map values to the Purchase Order field, you cannot map values for the Expenses and Items sublists. If you try to map values both to the Purchase Order field and the Expenses or Items sublists, the following error message is displayed: "Please specify either purchase order list or item/expense list in the request but not both."

**Note:** Partial billing of purchase orders is not supported.

### Importing Vendor Bills with Billed-Back Items and Expenses

If you are importing vendor bills with items or expenses that need to be billed back to customers, you can set the value of the Billable field to “TRUE” and include a value for the Customer field, for each of these item or expense lines.

### Importing Vendor Bills when Advanced Taxes is Enabled

If the Advanced Taxes feature is enabled, you are able to include tax codes and tax amounts in imported vendor bill items and expenses data. Tax codes should be set up in NetSuite before the import. Then you can include values for the Tax Code and Tax Amount fields for purchase order item and expense lines as needed. Note that other tax-related values for line items are calculated by the system.

The Advanced Taxes feature is required for NetSuite OneWorld accounts. For information about working with taxes in OneWorld, see the help topic Nexuses and Taxes in OneWorld. For general information about setting up tax codes, see the help topic Managing Tax Codes.

### Importing Vendor Bills when Amortization is Enabled

If the Amortization feature is enabled, you are able to include amortization schedule, amortization start date, and amortization end date values in imported vendor bill items and expenses data. These values define how costs are allocated across a range of time and recognized in increments. Amortization schedules should be set up in NetSuite before the import. For information about setting up amortization in NetSuite, see the help topic Amortization Feature Overview.

### Sample Vendor Bill Single CSV File Format

The following table illustrates example column headers and data snippets in a single file upload of vendor bills. This file includes data for vendor bill header fields and item lines. Note that in this case, the same vendor bill number can be repeated in multiple rows.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
<th>Item</th>
<th>Quantity</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB1003</td>
<td>American Computers</td>
<td>4/21/2015</td>
<td>Printer Accessories: Printer Cables</td>
<td>10</td>
<td>West Coast</td>
</tr>
<tr>
<td>VB1003</td>
<td></td>
<td></td>
<td>Printer Accessories: Printer Ink Starter Pack</td>
<td>15</td>
<td>West Coast</td>
</tr>
</tbody>
</table>
Sample Vendor Bill Multiple CSV File Format

The following tables illustrate example column headers and data snippets in a multiple file upload of vendor bills, including items and expenses data. Note that External ID is the key column that would be specified on the Import Assistant File Mapping page.

Primary File:
Each row of the primary file must include a unique identifier, in this case the external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB1003</td>
<td>American Computers</td>
<td>4/21/2015</td>
</tr>
<tr>
<td>VB1004</td>
<td>Widget Works</td>
<td>4/20/2015</td>
</tr>
</tbody>
</table>

Linked File - Items:
The items file can include multiple rows with the same vendor bill external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Item</th>
<th>Quantity</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB1003</td>
<td>Printer Accessories: Printer Cables</td>
<td>10</td>
<td>West Coast</td>
</tr>
<tr>
<td>VB1003</td>
<td>Printer Accessories: Printer Ink Starter Pack</td>
<td>15</td>
<td>West Coast</td>
</tr>
<tr>
<td>VB1004</td>
<td>Office Supplies: 12-Pack Ball Point Pens</td>
<td>25</td>
<td>West Coast</td>
</tr>
</tbody>
</table>

Linked File - Expenses:
The expenses file can include multiple rows with the same vendor bill external ID.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Account</th>
<th>Amount</th>
<th>Memo</th>
<th>Customer</th>
<th>Billable</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB1003</td>
<td>6220 Repairs &amp; Maintenance</td>
<td>35</td>
<td>installation</td>
<td>107 Fabre Art Gallery</td>
<td>Yes</td>
</tr>
<tr>
<td>VB1004</td>
<td>6150 Office Expense</td>
<td>5</td>
<td>misc.</td>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

Using Import Assistant for Vendor Bills Mass Update

You can perform a mass update of existing Vendor Bill data by creating a Transaction saved search with a filter of Type is Vendor Bill, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you Select a Record Type for Import, Choose Import Character Encoding.

Vendor Credit Import

Vendor Credit transactions create credits from vendors that can be applied to payables. For example, a vendor credit transaction may occur when items are returned to a vendor or when a discount is negotiated with a vendor.
For details about vendor credits in NetSuite, see the help topic Vendor Credits.

- Vendor credit imports can include line-level items, expenses, and apply data. For imports with items data, but no expenses or apply data, you can choose either the one file to upload or the multiple files to upload option. For imports with expenses or apply data, you must choose the multiple files to upload option. For more information, see Using Multiple Files for Vendor Credit Sublist Data.

- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Reference No. field, which serves as a transaction ID for Vendor Credit records. This mapping allows external IDs to be displayed on Vendor Credit forms in the NetSuite user interface.

- Each imported Vendor Credit record should include a reference to a NetSuite Vendor record, mapped to the Vendor Credit's Vendor field. This reference must be a unique identifier; NetSuite recommends that you use internal ID or external ID, rather than a name reference. If you do not map a reference number field, reference number values are generated automatically.

- If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account field should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.

- If the Multiple Currencies feature is enabled, you must map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced vendors. See the help topic Currency Management.

For details about fields that can be mapped in the vendor credit record, see the SOAP Schema Browser's vendor credit reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for vendor credit imports:

- Supported Vendor Credit Sublist Data Imports
- Using Multiple Files for Vendor Credit Sublist Data
- Supported Vendor Credit Subrecord Data Imports
- Importing Vendor Credits with Billed-Back Items and Expenses
- Importing Vendor Credits when Amortization is Enabled
- Using Import Assistant for Vendor Credits Mass Update

### Supported Vendor Credit Sublist Data Imports

The Vendor Credit import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports.</td>
</tr>
<tr>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expenses data must be in a separate CSV file. Selectively updatable based on Line/Order Line key field.</td>
</tr>
<tr>
<td>Apply</td>
<td>Apply data must be in a separate CSV file. Selectively updatable based on Apply or Line key field.</td>
</tr>
<tr>
<td>Accounting Book Details</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on Accounting Book key field.</td>
</tr>
</tbody>
</table>

If you use classifications, you can set class, department, and/or location values per individual item/expense lines.

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Purchase, All Items. For details, see Importing Transaction Item Options.

For imports that update existing Vendor Credit records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Using Multiple Files for Vendor Credit Sublist Data**

For vendor bill imports that include items data but no expenses and/or apply data, you can choose the one file to upload option, and include all data in a single CSV file, or you can choose the multiple files to upload option, and include mainline data in one file and items data in another file.

For imports that include expenses and/or apply data, you **must** use the multiple files to upload option, with one file for mainline data, one for expenses data, and one for apply data, as needed. If you are also importing items data, it should be in its own separate file as well.

For the multiple files option, be sure to include the external ID or key field values in the sublist files as well as in the main file.

**Supported Vendor Credit Subrecord Data Imports**

The Vendor Credit import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items — Inventory Detail</td>
<td>when Advanced Bin/Numbered Inventory Management feature enabled</td>
</tr>
</tbody>
</table>

**Importing Vendor Credits with Billed-Back Items and Expenses**

If you are importing vendor credits with items or expenses that need to be billed back to customers, you can set the value of the Billable field to "TRUE" and include a value for the Customer field, for each of these item or expense lines.
Importing Vendor Credits when Amortization is Enabled

If the Amortization feature is enabled, you are able to include amortization schedule, amortization start date, and amortization end date values in imported vendor credit items and expenses data. These values define how costs are allocated across a range of time and recognized in increments. Amortization schedules should be set up in NetSuite before the import. For information about setting up amortization in NetSuite, see the help topic Amortization Feature Overview.

Using Import Assistant for Vendor Credits Mass Update

You can perform a mass update of existing Vendor Credit data by creating a Transaction saved search with a filter of Type is Vendor Credit, changing data externally, then using the Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Vendor Payment Import

NetSuite Vendor Payment transactions record payment of vendor bills when they are due. These transactions post expenses to the general ledger, and affect both accounts payable and the bank account used for the payment.

**Note:** To maintain performance, 5000 lines per transaction is the maximum recommended limit for transactions submitted through CSV import.

For more details about vendor payments in NetSuite, see the help topic Vendor Payments.

Usage Notes

Consider the following usage notes when importing vendor payment data.

- You can import Vendor Payment transaction data in a single CSV file, or in multiple files.
- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID.
- Each imported Vendor Payment record should include a reference to a NetSuite Vendor record, mapped to the Vendor Payment's Payee field. This reference should match exactly the Vendor ID field value in the Vendor Record.
- You must map a CSV file field to the NetSuite Account field to represent the accounts from which payments are made. You have the option of mapping to the A/P Account field to represent the accounts payable accounts impacted by payments. If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account and A/P Account fields should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.
- All vendor payments must be applied to vendor bills in full. You cannot import unapplied amounts. You cannot import a total amount value for a payment; this amount is calculated by adding all of the values for the Payment field in the Bills sublist data.
If you are importing both vendor payments and vendor bills, and you want to apply imported payments to imported bills, you need to import bills first.

- If the Multiple Currencies feature is enabled, you must map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced vendors. See the help topic Currency Management.
- To import data for the In-Transit, Available Balance, Approval Status, and Next Approver fields, you must enable the following features and set the following preferences:
  - Enable the In-Transit Payments feature at Setup > Company > Setup Tasks > Enable Features, on the Accounting subtab.
  - Check Vendor Bills and Vendor Payments at Setup > Accounting > Preferences > Accounting Preferences, on the Approval Routing Subtab.
  - Select a Vendor In-Transit Payment Account at Setup > Accounting > Preferences > Accounting Preferences, on the General subtab, under Accounts Payable. Also check the Use In-Transit Vendor Payments by Default box.

For details about fields that can be mapped in the vendor payment record, see the SOAP Schema Browser’s vendor payment reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for vendor payment imports:

- Supported Vendor Payment Sublist Data Imports
- Using Import Assistant for Vendor Payments Mass Update

Supported Vendor Payment Sublist Data Imports

The Vendor Payment import supports the import of Bills sublist data. Each line in this sublist represents a vendor bill to which the payment is applied. The sum of Payment field values for sublist records represents the total amount of the payment.

In this sublist, the required Bill key field holds the transaction IDs for vendor bills to which payments are applied. An additional, optional Line key field holds the line numbers for the vendor bill lines to which payments are applied.

Note: If you use only the Bill key, the following error may be returned to indicate that a unique reference was not found, “Ambiguous sublist reference; multiple matches exist for key value <>”.

An import can add new vendor bills or vendor bill lines to which a payment is applied, change the amounts applied to existing vendor bills or vendor bill lines, or remove vendor bills or vendor bill lines.

When the Overwrite Sublists advanced option is not enabled (which is the default), CSV file sublist data selectively updates existing vendor bills data. When this option is enabled, CSV file sublist data completely replaces existing vendor bills data. For example:

- If the existing Vendor Payment Bills sublist data is:
  - Vendor Bill A: $100
  - Vendor Bill B: $200
- And CSV file sublist data is:
  - Vendor Bill A: $120
  - Vendor Bill C: $180
- When Overwrite Sublists=F, post update sublist data is:
Vendor Bill A: $120
Vendor Bill B: $200
Vendor Bill C: $180

- When Overwrite Sublists=T, post update sublist data is:
  Vendor Bill A: $120
  Vendor Bill C: $180

The Vendor Payment Import also supports the import of Accounting Book Detail sublist data. Accounting Book Detail sublist data is available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. This sublist is selectively updateable based on the Accounting Book key field.

Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

Using Import Assistant for Vendor Payments Mass Update

You can perform a mass update of existing Vendor Payment main fields by creating a Transaction saved search with a filter of Type is Vendor Payment, changing data externally, then using the Import Assistant to import modified data. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Vendor Return Authorization Import

A vendor return authorization is a non-posting transaction that tracks a return to a vendor, including the items to be returned, their quantities, the approval status, the shipment status, and the amount refunded or credited from the vendor. The vendor return process includes four steps: creating a vendor return authorization record, approving or canceling the authorization, shipping items authorized to be returned, and crediting an authorized vendor return.

**Note:** To maintain performance, 5000 lines per transaction is the maximum recommended limit for transactions submitted through CSV import.

For details about vendor return authorizations in NetSuite, see the help topic Vendor Returns.

**Note:** Vendor Return Authorization imports are not available unless the Vendor Return Authorizations feature is enabled in your account. To enable this feature, go to Setup > Company > Enable Features and on the Transactions tab, check the Vendor Return Authorizations box.

- Vendor return authorization imports can include line-level items and expenses data. For imports with items data, but no expenses data, you can choose either the one file to upload or the multiple files to upload option. For imports with expenses data, you must choose the multiple files to upload option. For more information, see Using Multiple Files for Vendor Return Authorization Sublist Data.
- You must map external ID or internal ID to serve as a unique ID per record. The unique ID should be included in every line of the CSV files. For imports of new data, use external ID. On the Import Assistant's Field Mapping page, NetSuite recommends that you map the external ID field from your CSV files to the NetSuite Reference No. field, which serves as a transaction ID for Vendor Return Authorization records. This mapping allows external IDs to be displayed on Vendor Return Authorization forms in the NetSuite user interface.
Each imported Vendor Return Authorization record should include a reference to a NetSuite Vendor record, mapped to the Vendor Return Authorization’s Vendor field. This reference must be a unique identifier; NetSuite recommends that you use internal ID or external ID, rather than a name reference. If you do not map a reference number field, reference number values are generated automatically.

If the Use Account Numbers preference has been enabled at Setup > Accounting > Accounting Preferences, imported values for the Account field should include both account number and name, for example: 11000 Accounts Payable. If this preference is not enabled, values should be account name only, for example: Accounts Payable.

If the Multiple Currencies feature is enabled, you must map the Exchange Rate field. If your CSV file does not include values for this field, you can set it to a default value. Currency values are taken from referenced vendors. See the help topic Currency Management.

For details about fields that can be mapped in the Vendor Return Authorization record, see the SOAP Schema Browser’s vendor return authorization reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

Review the following guidelines for Vendor Return Authorization imports:

- Supported Vendor Return Authorization Sublist Data Imports
- Using Multiple Files for Vendor Return Authorization Sublist Data
- Supported Vendor Return Authorization Subrecord Data Imports
- Importing Vendor Return Authorizations with Billed-Back Items and Expenses
- Importing Vendor Return Authorizations when Amortization is Enabled
- Using Import Assistant for Vendor Return Authorizations Mass Update

### Supported Vendor Return Authorization Sublist Data Imports

The Vendor Bill import supports the import of the following sublist data:

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>You must import at least one line item for all new records, and you must map required fields for this sublist on the Field Mapping page. See Required Items Sublist Fields for Transactions Imports. Selectively updatable based on Line/Order Line or Item key field. See Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expenses data must be in a separate CSV file. Selectively updatable based on Line/Order Line key field.</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on Accounting Book key field.</td>
</tr>
</tbody>
</table>

If you use classes, departments, or locations, you can set these values either for an entire vendor return authorization, or per individual item-expense lines.

If the Item Options feature is enabled in your account, you can import values for custom transaction item options along with Items sublist data. Transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New, with one of the following Applies To settings: Purchase, All Items. For details, see Importing Transaction Item Options.
For imports that update existing Vendor Return Authorization records, handling of sublist data updates depends upon the setting for the Overwrite Sublists advanced option, and on whether the sublist is keyed. Complete deletion of sublist data currently is not supported. For more information, see Sublist Data Import.

**Using Multiple Files for Vendor Return Authorization Sublist Data**

For vendor return authorization imports that include items data but no expenses data, you can choose the one file to upload option, and include all data in a single CSV file, or you can choose the multiple files to upload option, and include mainline data in one file and items data in another file.

For imports that include expenses data, you must use the multiple files to upload option, with one file for mainline data, and one for expenses data. If you are also importing items data, it should be in a third file.

For the multiple files option, be sure to include the external ID or key field values in the sublist files as well as in the main file.

**Supported Vendor Return Authorization Subrecord Data Imports**

The Vendor Return Authorization import supports the import of the following subrecord data:

<table>
<thead>
<tr>
<th>Subrecord</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items — Inventory Detail</td>
<td>When Advanced Bin/Numbered Inventory Management feature enabled</td>
</tr>
</tbody>
</table>

**Importing Vendor Return Authorizations with Billed-Back Items and Expenses**

If you are importing vendor return authorizations with items or expenses that need to be billed back to customers, you can set the value of the Billable field to “TRUE” and include a value for the Customer field, for each of these item or expense lines.

**Importing Vendor Return Authorizations when Amortization is Enabled**

If the Amortization feature is enabled, you are able to include amortization schedule, amortization start date, and amortization end date values in imported vendor return authorization items and expenses data. These values define how costs are allocated across a range of time and recognized in increments. Amortization schedules should be set up in NetSuite before the import. For information about setting up amortization in NetSuite, see the help topic Amortization Feature Overview.

**Using Import Assistant for Vendor Return Authorizations Mass Update**

You can perform a mass update of existing Vendor Return Authorization data by creating a Transaction saved search with a filter of Type is Vendor Return Authorization, changing data externally, then using the...
Import Assistant to import modified data, using the Update data handling option. For more information, see Creating Transaction Saved Searches for Reimport.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Importing Transaction Item Options

When the Item Options feature is enabled, transaction item options can be created and imported in your account. Transaction item options are custom fields that may be included in transaction line items to represent item-specific choices. When you import transaction records, you can import transaction item options along with Items sublist data.

To be available for import, transaction item options must first be set up at Customization > Lists, Records, & Fields > Transaction Item Options > New. The setup of a transaction item option includes selecting the types of transactions to which the item option can be applied. See the help topic Custom Transaction Item Options.

The Import Assistant Field Mapping page includes item options as a flat list under the Items sublist folder. Only the item options that have been set up to apply to the type of transaction being imported are included. Each item option is prefixed with the word "Options" and is marked as a custom field.

To import values for a transaction item option, you must map it to a column in the CSV file.
You can click the edit icon to select a default or null value for an item option.

Creating Transaction Saved Searches for Reimport

This process allows you to mass update transaction record types by exporting data into an external application for updates and then reimporting them into NetSuite with the Import Assistant.

The most straightforward method to make NetSuite data available to other applications is to create a saved search and export the saved search results as a CSV or XLS file.

For general information about NetSuite saved searches, see the help topic Saved Searches.

Because transaction ID values are not unique, NetSuite recommends that you use internal ID or external ID as the unique identifier when reimporting transactions data. Be sure to include one or both of these fields as results columns for your saved search.

To create a transaction saved search for reimport:

1. Go to Transactions > Management > Saved Searches > New.
2. Select the Transaction search type.
3. On the Saved Search definition page, enter basic search information, such as title.
4. On the Criteria subtab, enter filters for your search data:
   - Specify a filter for the type of transaction. Select Type in the filter list, and set it to be the transaction you want.
   - For transactions that include line items, eliminate data that is not attached to item costs, including main line, taxes, and shipping costs, because this data can result in “Item Not Found” errors when you reimport. Specify filters like the following:
     - Select Main Line in the filter list, and set it to False. For more information about main line data, see the help topic Main Line in Transaction Search Criteria.
Select Item in the filter list, and set it to “Type is any of Assembly/Bill of Materials, Description, Discount, Download Item, Gift Certificate, Inventory Item, Item Group, Kit/Package, Markup, Non-inventory Item, Other Charge, Payment, Service, Subtotal.”

Your list may vary, depending on your available item types.

- For more information about defining search filters, see the help topic Advanced Search Criteria Filters.

5. On the Results subtab, enter the results fields that you want to include.
   - Make sure you include the field you want to use as a unique identifier, either internal ID or external ID, in the results.
   - Include all fields that you want to modify in the external application. For example, if you want to modify the quantities of line items, include the quantity field.
   - You can include joined item fields if you want to modify them. Scroll down in the Field list to Item Fields..., and select a field from the Item Field list.
   - For more information about defining search results fields, see the help topic Search Results Display Options.

6. Define any additional search options that you require.
   - For information about available options, see the help topic Defining a Saved Search.

7. Click Save & Run to run your saved search.
   - If the search results do not meet your needs, click the Edit this Search button to modify the definition.
   - If the search results are satisfactory, click Export - CSV or Export - Microsoft Excel.
     You can then edit the data in the external application.

After editing the data in the external application, you can reimport the file using the CSV Import Assistant.

### Website Import Type

For information about website imports, see the following:

- Commerce Category Import
- CMS Page Import
- Site Category Import

### Commerce Category Import

The commerce category import lets you add or update commerce categories, subcategories, and category item assignments. Commerce categories are used to create a hierarchical structure of items in your web store. The fields supported for commerce category CSV import reflect those on the Commerce Category Record at Lists > Web Site > Commerce Categories. After the import, the categories and items are displayed on your site and are available for management through Site Management Tools and also through the Commerce Category record in NetSuite.

You can use the fields referenced here to create CSV files for import. You can manually create the CSV files or export them from another system, including SiteBuilder Categories.

The import includes categories and related sublists. These include:

- Commerce Category
- Commerce Category Subcategory Sublist
- Commerce Category Items Sublist
See the help topic Commerce Categories for more information on categories, subcategories, and item assignments.

## External ID Best Practice

Each CSV file includes an External ID column. Use the external ID in your CSV files to link the rows in one file to the relevant row in another file. You should also use the external ID for columns that reference a subcategory. Even though you can use the category names in these columns, category names are not necessarily unique and it is best practice to use the External ID instead.

**Note:** Any category created with Site Management Tools or through the NetSuite UI are not assigned an external ID in the CSV file. After the export, you must manually enter an external ID for each record.

## Commerce Category

The following table identifies the fields for Commerce Category record. Fields flagged with an * are required. Use the external ID to link the records in the primary CSV file to records in the subcategory and item sublist files.

<table>
<thead>
<tr>
<th><strong>Addition to Head</strong></th>
<th>JavaScript, HTML, or other code to include in the <code>&lt;head&gt;</code> area of the commerce category page when it is rendered on the site.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Catalog</strong></td>
<td>Catalog to which the category is assigned. Specify the catalog name.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Description of the category.</td>
</tr>
<tr>
<td><strong>Display in Website</strong></td>
<td>T if the category should display in the website or F if it should not display.</td>
</tr>
<tr>
<td><strong>External ID</strong></td>
<td>The external ID is a required value. This serves as a unique ID key for the record. This can be user defined for a manually generated CSV import file. It can also be the unique key for the record when the data originated as an export from another system. This ID is used to establish the relationship between the CSV import files for subcategories and items.</td>
</tr>
<tr>
<td><strong>Heading</strong></td>
<td>The heading to display on the commerce category page.</td>
</tr>
<tr>
<td><strong>Inactive</strong></td>
<td>T if the category is Inactive or F if the category is active.</td>
</tr>
<tr>
<td><strong>Meta Description</strong></td>
<td>The description to populate the meta description HTML element for the page.</td>
</tr>
<tr>
<td><strong>Meta Keywords</strong></td>
<td>The keywords to populate the meta keywords HTML element for the page.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Name of the category.</td>
</tr>
<tr>
<td><strong>Page Banner</strong></td>
<td>Image file in the file cabinet to use as the banner image for the category page. Specify the file name.</td>
</tr>
<tr>
<td><strong>Page Title</strong></td>
<td>The title of the page. This populates the HTML <code>&lt;title&gt;</code> element.</td>
</tr>
<tr>
<td><strong>Primary Parent</strong></td>
<td>The primary parent for this category. If the category has no parent, omit this value. If you specify a primary parent, that parent category must already exist or precede the record in the CSV file.</td>
</tr>
<tr>
<td><strong>Sequence Number</strong></td>
<td>Sequence number for the category. This is used for ordering the sequence of categories in SMT.</td>
</tr>
<tr>
<td><strong>Sitemap Priority</strong></td>
<td>Value between 0.0 and 1.0 used for ranking the importance of pages on the site. If you leave this empty the priority is set to 0.5. The value you enter here populates the <code>&lt;priority&gt;</code> element in an XML sitemap.</td>
</tr>
</tbody>
</table>
Website Import Type

<table>
<thead>
<tr>
<th>Thumbnail Image</th>
<th>The image file in the file cabinet to use as the thumbnail image for this category. Specify the file name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Fragment*</td>
<td>The URL fragment to use for accessing the category page.</td>
</tr>
</tbody>
</table>

Subcategory assignments with no category attribute overrides can be created with the primary commerce category CSV file by specifying a value in the primary parent field. The following table is a sample of a CSV file that creates a root level category and multiple levels of subcategories.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Name</th>
<th>Catalog</th>
<th>URL Fragment</th>
<th>Primary Parent</th>
<th>...</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Men’s</td>
<td>default</td>
<td>mens</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Men’s Shirts</td>
<td>default</td>
<td>mensshirts</td>
<td>Men’s</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Men’s Short Sleeve Shirts</td>
<td>default</td>
<td>mensshirts-ss</td>
<td>Men’s Shirts</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Men’s Long Sleeve Shirts</td>
<td>default</td>
<td>mensshirts-ls</td>
<td>Men’s Shirts</td>
<td></td>
</tr>
</tbody>
</table>

This import results in a root level category of Men’s with a subcategory of Men’s Shirts. The Men’s Shirts subcategory has two subcategories, Men’s Short Sleeve Shirts and Men’s Long Sleeve Shirts.

To create subcategories with override attributes, use the subcategory CSV import file.

**Commerce Category Subcategory Sublist**

The commerce subcategory CSV import lets you add or update subcategories and override values for those categories. The following table identifies the fields for creating override values for subcategories. Use the External ID field in this file to link to the primary commerce category CSV file.

<table>
<thead>
<tr>
<th>Addition to &lt;Head&gt; Override</th>
<th>JavaScript, HTML, or other code to include in the &lt;head&gt; area of the subcategory page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description Override</td>
<td>Description of the category.</td>
</tr>
<tr>
<td>Display in Web Site Override</td>
<td>T if the category should display in the website or F if it should not display.</td>
</tr>
<tr>
<td>External ID</td>
<td>Key column to link to records in Primary CSV file.</td>
</tr>
<tr>
<td>Heading Override</td>
<td>The heading to display on the commerce category page.</td>
</tr>
<tr>
<td>Meta Description Override</td>
<td>The description to populate the meta description HTML element for the page.</td>
</tr>
<tr>
<td>Meta Keywords Override</td>
<td>The keywords to populate the meta keywords HTML element for the page.</td>
</tr>
<tr>
<td>Name Override</td>
<td>Name of the category.</td>
</tr>
<tr>
<td>Page Banner Override</td>
<td>Image file in the file cabinet to use as the banner image for the category page. Specify the file name.</td>
</tr>
<tr>
<td>Sitemap Priority Override</td>
<td>Value between 0.0 and 1.0 used for ranking the importance of pages on the site. If you leave this empty the priority is set to 0.5. The value you enter here populates the &lt;priority/&gt;&lt;/priority&gt; element in an XML sitemap.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Name of the category.</td>
</tr>
<tr>
<td>Thumbnail Image Override</td>
<td>The image file in the file cabinet to use as the thumbnail image for this category. Specify the file name.</td>
</tr>
</tbody>
</table>
Website Import Type

<table>
<thead>
<tr>
<th>Title Override</th>
<th>The title of the page. This populates the HTML <code>&lt;title&gt;</code> element.</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL Fragment Override</td>
<td>The URL fragment to use for accessing the category page.</td>
</tr>
</tbody>
</table>

The following table is a sample CSV file that sets override values for subcategories. The examples used here continue the sample primary category CSV file example.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Subcategory</th>
<th>Name Override</th>
<th>Title Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Men's Shirts</td>
<td>Shirts</td>
<td>Shirts</td>
</tr>
<tr>
<td>12</td>
<td>Men's Short Sleeve Shirts</td>
<td>Short Sleeve</td>
<td>Short Sleeve</td>
</tr>
<tr>
<td>13</td>
<td>Men's Long Sleeve Shirts</td>
<td>Long Sleeve</td>
<td>Long Sleeve</td>
</tr>
</tbody>
</table>

**Commerce Category Items Sublist**

The following table identifies the fields for assigning items to Commerce Categories. Use the External ID field in this file to link to the primary category and subcategory files.

<table>
<thead>
<tr>
<th>External ID</th>
<th>External ID of the category to which this item should be assigned.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The item name.</td>
</tr>
<tr>
<td>Primary Category</td>
<td>T if the category is the primary category for the item or F if it is not the primary category.</td>
</tr>
</tbody>
</table>

**CMS Page Import**

The CMS Page Import lets you add or update website pages by importing them from a CSV file. This is useful when you have a large number of pages to create or edit. The import is also an important tool when you want to export pages from one account and import them into another account, for example, from your sandbox account to your production account.

Unlike pages that you create or edit with Site Management Tools, pages you create or update by CSV Import are automatically placed in a published state and are visible based on the visibility start and end dates for the page record.

For information about working with this record in the UI, see the help topic CMS Page Record.

**Tip:** If you are importing pages and do not want them to be immediately visible to site visitors, be sure to give the pages future start date.

**CMS Page Record Fields**

The following table lists the fields that are available for import or update for CMS Pages. Required fields are marked with an asterisk.

<table>
<thead>
<tr>
<th>Addition To</th>
<th>The value specified here populates the addition to head field on the CMS Page record. This is used to add code such as Java Script, HTML, or CSS to the head area of the page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS Page Type*</td>
<td>This value specifies the CMS Page Type and links to the Name field on the CMS Page Type record.</td>
</tr>
<tr>
<td>Custom Record Data</td>
<td>If you added custom fields to pages of this type, this field lets you specify the instances of the custom record data assigned to the page type record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Custom Record External ID</strong></td>
<td>This is a user-defined mapping field that can be used for linking to page types when the import data originated as an export from a different account.</td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td>This value identifies the date and time that the record should expire. If you omit this date from the import file or leave the value blank, no end date is assigned, meaning the page never expires.</td>
</tr>
<tr>
<td></td>
<td>When including a date and time in the field, use the format specified by the preferences in your NetSuite account.</td>
</tr>
<tr>
<td><strong>External ID</strong></td>
<td>The External ID might originate with data that is exported from a third party system or it can be user-defined and added to the CSV file. The external ID must be unique for each record and can be used as a primary key for updating records with CSV Import.</td>
</tr>
<tr>
<td><strong>Internal ID</strong></td>
<td>The Internal ID is a primary key assigned to a CMS Page record when it is created in the system. When performing an import that creates new CMS Page records, the Internal ID is not included in the import and is automatically assigned when the records are created.</td>
</tr>
<tr>
<td></td>
<td>For existing CMS Page records, you can use the Internal ID as the primary key when performing a CSV Import to update existing pages. You can create a saved search to generate a listing of pages and their internal IDs.</td>
</tr>
<tr>
<td><strong>Meta Description</strong></td>
<td>The value entered in this field populates the <strong>Meta Description</strong> field on the CMS Page record and is set as the value of the content attribute for the meta description HTML element for the page.</td>
</tr>
<tr>
<td><strong>Meta Keywords</strong></td>
<td>The value entered in this field populates the <strong>Meta Keywords</strong> field on the CMS page record and is set as the value of the content attribute for the meta keywords HTML element for the page.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This value specifies the page name.</td>
</tr>
<tr>
<td><strong>Page Heading</strong></td>
<td>This value populates the <strong>Page Heading</strong> field on the CMS Page record. If the page template file supports it, the heading is displayed to site visitors.</td>
</tr>
<tr>
<td><strong>Page Title</strong></td>
<td>This identifies the page title and populates the HTML &lt;title&gt; element on the page. This is usually the title of the page that is shown in the tab or browser title bar.</td>
</tr>
<tr>
<td><strong>Site</strong></td>
<td>This value identifies the website. You can use the numeric site id or the site name during the import. Be sure to edit the field mapping to specify if the value in your CSV file is the internal ID or the site name. You cannot use both name and site ID in a single import file.</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>This value identifies the date and time the page should begin displaying on the site. If you omit the start date from the file or leave the value blank, no start date is assigned, and the page displays immediately.</td>
</tr>
<tr>
<td></td>
<td>When including a date and time in the field, use the format specified by the preferences in your NetSuite account.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>Specifies the template for the page. If the page uses the default template, leave the field empty or enter <strong>default</strong> to use the default template. If the page uses a custom template, enter the template name.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Specifies the type of page. Valid entries are:</td>
</tr>
<tr>
<td></td>
<td>- Landing Page</td>
</tr>
<tr>
<td></td>
<td>- Enhanced Page</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td>This field specifies the page URL.</td>
</tr>
<tr>
<td><strong>CMS Page Tags</strong></td>
<td>The tags field lets you specify tags for the CMS Page Record. See Import Tags for CMS Page.</td>
</tr>
</tbody>
</table>
Import Tags for CMS Page

When you include tags in the CSV import for CMS Pages, the CSV file must have a separate tag column for each tag. For example, if each record in the CSV file contains only one tag for each page, then you need only one tag column, but if one or more pages has multiple tags, then the file must include multiple tag columns. In the following sample CSV file, you see four separate tag columns. Some records have multiple tags, with four tags being the most, and other records have only one tag.

<table>
<thead>
<tr>
<th>Name</th>
<th>Tag1</th>
<th>Tag2</th>
<th>Tag3</th>
<th>Tag4</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Us</td>
<td>About Us</td>
<td>Company Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Back To School</td>
<td>Sale</td>
<td>School Supplies</td>
<td>Back to School</td>
<td>Fall</td>
</tr>
<tr>
<td>Locations</td>
<td>Store Locations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Return Policy</td>
<td>Return Policy</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

By default, the NetSuite Fields mapping for CMS Page Tags includes only one column. You can add more tag columns to the import by clicking the Add New tag button. The following example illustrates four tag columns to accommodate four tag columns in the CSV file:

You can then map each tag column in the CSV file to a tag CMS Page Tag column in the import.

Site Category Import

The site category import lets you add or update website categories in NetSuite. These categories are used to organize information and items for sale on your website. Each category must be associated with a presentation tab to be displayed in a website. Presentation tabs are the building blocks, or pages, in a website.

Supported fields for this import mostly match the fields on the Site Category page available at Lists > Web Site > Categories > New, including the following:

- Category - name of the site category (required)
- Site - the site where the category should be used (required when the Multiple Sites feature is enabled)
- Subcategory of - the tab or category where this category is grouped
- Display in Web Site - Boolean indicating whether the category should be displayed

For details about fields that can be mapped in the site category record, see the SOAP Schema Browser’s site category reference page. You can use the field definitions here as a basis for creating your own CSV import template file. For information about working with the SOAP Schema Browser, see the help topic SOAP Schema Browser.

The Import Assistant is available at Setup > Import/Export > Import Tasks > Import CSV Records. After you select the record type for import, you choose the import character encoding. For more information, see Select a Record Type for Import and Choose Import Character Encoding.

Review the following guidelines for site category imports:

- Supported Site Category Sublist Data Import
- Importing Updates to Site Category Records

**Supported Site Category Sublist Data Import**

The site category import supports the import of information and items to be included in each category, as Presentation Items sublist data. The records in this sublist can be file cabinet items, information items, actual items to be sold on the website, or subcategories.

To import values for multiple presentation items per category, format your CSV file with repeating columns for the Presentation Items sublist fields (such as Item1, Type1, Item2, Type2, Item3, Type3), and map multiple instances of this sublist on the Import Assistant Field Mapping page. (Click the + sign next to the sublist to add mappable instances.)

**Importing Updates to Site Category Records**

If you need to import updates to existing site category records, NetSuite recommends that you use an identifier of internal ID or external ID to prevent duplication of records.
If you select the **Update** data handling option, you can use Category as an identifier to match records and perform updates.

If you select the **Add or Update** data handling options, no Category lookups are performed, so in the absence of internal ID or external ID, multiple records with the same category name may be added.

**Note:** The site category import does not support the definition of an audience for categories to be published internally to an intranet or to specific set of individuals. If necessary, you can define an audience for a category on its record within NetSuite after the import.

### Simple Imports

Specialized two-step Import Assistants are available for the following imports:

- Single Journal Entry Import
- Budget Import
- Single Inventory Worksheet Import
- Project Tasks Import
- Web Site Redirects Import

**Note:** These simple imports do not support the SuiteScript API that is available to automate CSV imports through scripting, because they do not support saved import maps.

**Note:** For information about importing banking transactions, see the help topic [Importing Online Bank Statements](#).

### Single Journal Entry Import

You can use the Single Journal Entry Import Assistant to import a single journal entry's data from an external system into NetSuite. If you use NetSuite OneWorld, you can use a similar assistant to import data from a single intercompany journal entry.

You need the Make Journal Entry and Posting Period on Transactions permissions to import a single journal entry. You do not need the Import CSV File permission.

**Important:** The Single Journal Entry Import Assistant preserves the journal entry import process available prior to Version 2010 Release 1, with a modified user interface. More complex journal entry import functions are also available. See [Journal Entry Import and Intercompany Journal Entry Import](#) and [Advanced Intercompany Journal Entry Import](#).

The Single Journal Entry Import Assistant is available at Transactions > Financial > Make Journal Entries > Import. For intercompany journal entries, a similar assistant is available at Transactions > Financial > Make Intercompany Journal Entries > Import. For advanced intercompany journal entries, a similar assistant is available at Transactions > Financial > Make Advanced Intercompany Journal Entries > Import.

If you are using statistical accounts, the Single Journal Entry Import Assistant is available at Transactions > Financial > Make Statistical Journal Entries > Import. For information about statistical accounting, see the help topic [Statistical Accounting Overview](#).

The Assistant includes the following steps:
The first page of the Single Journal Entry Import Assistant provides a link to a CSV journal entry template file that is identical to the template for the previously available journal import process.

- Click this link to download the template file and populate it with your data.
  
  Note that you can add columns to your CSV file for journal entry fields that are not included in the template, if you want to import data for these fields.

  For more information, see Supported Values for Journal Entry Import CSV Files.

- After you have a CSV file with data in it, click the Select button in the Import Assistant and select your file, then click Next.

The Assistant automatically maps fields in your CSV file to NetSuite journal entry fields and lets you view these mappings.

- You can simply click Run to accept the default mappings and immediately start the import.
- Or, you can make changes: You can drag and drop fields to change or add mappings. Also, you can click the edit icon for a field to open a popup where you can set a default value.

  Note that if you do not map or set defaults for the Date and Entry No. fields, the import process provides defaults.

After you click Run and the import process completes, the newly created journal record displays. The Entry No. field shows the journal entry number for the transaction.

If errors prevent the process from completing, a status page displays instead. Note that, unlike other imports, email notification is not sent for single journal entry import.

**Supported Values for Journal Entry Import CSV Files**

For ease of use and compatibility with the previous journal import, the following values are supported in your CSV files:

- For **Account** — If the Use Account Numbers preference is enabled, NetSuite recommends that Account field values include both numbers and names, such as **11000 Accounts Payable**. Number-only values, such as **11000**, also are supported. Name-only values, such as **Accounts Payable**, are not supported when this preference is enabled. If this preference is not enabled, name-only values should be used.
- For **(Entity) Name** — If auto-generated numbering is enabled, you should make sure that Name field values include both entity ID and name, such as **A2255 ABC Company**. ID-only values, such as **A2255**, also are supported.
- For **Account, Class, Department, Location, and Subsidiary** — Most CSV imports require the use of the full hierarchical name, but journal entry import supports the use of the simplified name. For example, for location name, both **California : Los Angeles** and **Los Angeles** are supported.

For more information about supported CSV file fields, see Journal Entry and Intercompany Journal Entry Header Fields Table and Journal Entry and Intercompany Journal Entry Line Fields Table.

**Important:** Import is supported for journal entries with up to 10,000 lines. However, poor performance results during import and in the user interface for journal entries with over 1000 lines, and these large journal entries may not be editable in the user interface.

For more information about journal entries, see the following.

- For step-by-step instructions for importing a single journal entry, see the help topic Importing a Journal Entry.
- For more information about working with journal entries, see the help topic Journal Entries.
To import multiple journal entries, see Journal Entry Import and Intercompany Journal Entry Import.

Budget Import

The Budget Import lets you import your external budget data as NetSuite budget records. The interface and process for budget imports vary from those for other record type imports.

- A simplified version of the Import Assistant is used for budget imports, with two pages to complete instead of five. This Assistant is available from Transactions > Financial > Set Up Budgets > Import instead of the Setup menu.
- NetSuite provides a CSV budget template file that you download and populate with your data before the import. For details, see Budget Template File and Budget Template File Tips.
- After you populate a file with your budget data and save it, you select this file in the Assistant. The Assistant automatically maps fields in your budget file to NetSuite budget fields and lets you view these mappings, and change them if necessary. Then click Run to import budget data directly into the database.

You can export your NetSuite budget data into an external application, make changes, and then reimport the changed data. To export NetSuite budget data, create a budget search at Transactions > Financial > Set Up Budgets > Search, then click Export for the search.

You need the Set Up Budgets permissions to import budget data. You do not need the Import CSV File permission. For questions about permissions, contact your administrator.

For more instructions for completing a budget import, see the help topic Importing a Budget.

Note: Account field values in budget import CSV files can be names, internal IDs or external IDs, but cannot include account numbers, even if the Use Account Numbers preference is enabled. When using names, values for subaccounts should be hierarchical, with the format parent account name: child account name.

Budget Template File

The budget template file is available for download at Transactions > Financial > Set Up Budgets > Import, when you click the BUDGETS template link in the Import Assistant.

The budget template file includes every field as columns, so that every row of data can store values for fields.

Budget Template File Tips

Review the following tips for populating a budget CSV file from the template:

- The year entered on the budget must match the name of the year at Setup > Accounting > Manage Accounting Periods.
- Note that the CSV file field mapped to the required Account field should contain account names, internal IDs or external IDs, but not account numbers.

When using names, be sure to only use the name that appears in the Name field on the Account record. If you are entering a line item for a subaccount, the Account field must include the parent account name and subaccount name separated by a colon, for example, Checking : Purchases. Use this format for the Account field even if the Use Account Numbers preference is enabled.
If you use the Multiple Budgets feature, Category is a required field. You can create new categories at Setup > Accounting > Accounting Lists > New, by clicking the Budget Category link and entering a budget category name.

**Important:** If the Budget Category field is not mapped during the import, its value defaults to the first budget category on the list. This list is ordered alphabetically.

In OneWorld accounts, each budget category is classified as global or local to support subsidiary-level budgeting in local currencies. You do not have to modify your budget template file to include this global/local classification, because it is associated automatically with the imported budget category.

### Single Inventory Worksheet Import

In the NetSuite user interface, you can use the Inventory Worksheet form to make adjustments to the levels of inventory items in stock. On this form, you need to manually enter general information as well as changes to the quantity and/or value of each inventory item to be adjusted.

The Single Inventory Worksheet Import provides an alternative that you can use to create a new inventory worksheet in NetSuite. With this import, you can submit inventory adjustment data in a CSV file that can be built from a system-provided template. For inventory worksheets with many lines, this import can be significantly faster than data entry in the Inventory Worksheet form.

This type of import can be used for adjustments that are required after physical inventory counts. Another use case for this import is to reset stock quantity and value at the end of the NetSuite implementation phase.

### Inventory Worksheet Import Limitations

Review the following limitations to decide whether this import would be useful for you:

- Each import can create one new inventory worksheet. You cannot use the inventory worksheet import to update an existing NetSuite inventory worksheet or to create multiple inventory worksheets at one time.
- Each inventory worksheet import can import data for one combination of class, department, location, and, if applicable, subsidiary values. You must do multiple import jobs to import data for multiple classes, departments, locations, or subsidiaries.
- The inventory worksheet import currently does not support the import of bin information.
- Like the inventory worksheet form in the user interface, this import is best suited if you are using average costing. The import, like the UI form, ignores LIFO and FIFO, so does not preserve that history.
- The inventory worksheet import shares other limitations of the inventory worksheet form, including:
  - New quantity values are exclusive of previous stock totals.
  - Adjustments to lot numbered items, serial numbered items, and inactive items are not supported.
  - A change to the quantity of an assembly item changes the quantity of the assembly only; it does not change the quantity of individual member items.

For more details about the Inventory Worksheet form, see the help topic [Adjust Inventory Worksheet](https://www.oracle.com/netsuite/help/topic/AdjustInventoryWorksheet).

- Import is supported for inventory worksheets with up to 1,000 lines. However, poor performance results during import and in the user interface for inventory worksheets with over 1,000 lines, and these large inventory worksheets may not be editable in the user interface. Note that 1,000 lines are not always processed by the import. If the timeout limit is reached during the import process, some records are not processed. In this case, try the import with fewer than 1,000 lines.
You cannot save field mappings for an inventory worksheet import.

Permission for Inventory Worksheet Import

You need the Adjust Inventory Worksheet and Import CSV File permissions to import an inventory worksheet.

By default, only account administrators have the Adjust Inventory Worksheet permission. This permission is not assigned to any standard roles. This permission can be added to a custom role that can be assigned to users who perform this type of import.

How to Do an Inventory Worksheet Import

- For details about the interface for importing an inventory worksheet, see Using the Inventory Worksheet Import Assistant.
- For tips to help you set up your CSV file for an inventory worksheet import, see Requirements for Inventory Worksheet CSV File Data.
- For information about making inventory adjustments, see the help topic Adjusting Inventory.
- For information about the adjust inventory worksheet, see the help topic Adjust Inventory Worksheet.

Using the Inventory Worksheet Import Assistant

The Single Inventory Worksheet Import Assistant is available at Transactions > Inventory > Adjust Inventory Worksheet > Import, to users who have the required permission. See Permission for Inventory Worksheet Import.

This Import Assistant includes the following steps:

1. Upload the CSV file that contains your inventory worksheet data.
   - The first page of the Assistant provides a link to a CSV template file. Click this link to download the template file and populate it with your data.
   - Before you populate your CSV file data, review Requirements for Inventory Worksheet CSV File Data.
   - After you have a CSV file with data in it, click the Select button in the Import Assistant, browse to your file, and click Next.

2. Review mappings of CSV fields to NetSuite fields and start the import.
The Assistant automatically maps fields in your CSV file to NetSuite standard inventory worksheet fields. Header-level fields are listed under Inventory Worksheet; line-level fields are listed under the Inventory Worksheet Adjustments sublist.

- You can click Run to accept the default mappings and immediately start the import.
- You can make changes as necessary by dragging and dropping fields to add or subtract them from the import.
- You can click the edit icon for a field to open a popup where you can set a default value. This option is useful for header-level fields, that need to be the same value for each imported line. For example, in the following screenshot, the CSV file does not include a Subsidiary field value, so a default value is set in the popup:

When you click Run, the import job is processed.

- If the import was successful, or if there are errors, the Job Status page appears.
- Note that, unlike most other imports, email notification is not sent for single inventory worksheet imports.

For more information about adjusting inventory, see the help topics Adjusting Inventory and Adjust Inventory Worksheet.
Requirements for Inventory Worksheet CSV File Data

Your inventory worksheet CSV file should include both header and line-level data. Each row of the CSV file represents a transaction line, with repeated header field values, and a different item, new quantity, and new value for each line.

For more information, see:
- Inventory Worksheet Field Details
- Using IDs Instead of Names for Items
- Example Inventory Worksheet CSV File

Inventory Worksheet Field Details

The following tables provide details about the fields supported in a CSV file used for an inventory worksheet import.

```
<table>
<thead>
<tr>
<th>Header Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment Account</td>
<td>Usually an expense account for inventory adjustments. This field is required and should match the name of an existing account at Lists &gt; Accounting &gt; Accounts. If the Use Account Numbers preference has been enabled at Setup &gt; Accounting &gt; Accounting Preferences, NetSuite recommends that values include both account number and name, such as 11000 Accounts Payable. Number-only values, such as 11000, also are supported. Name-only values, such as Accounts Payable, are not supported when this preference is enabled. If this preference is not enabled, name-only values should be used. Note that account names may be non-hierarchical, even for sub-accounts.</td>
</tr>
</tbody>
</table>

| Class | Must match the name of an existing class at Setup > Company > Classes. Most CSV imports require the use of the full hierarchical name, but inventory worksheet import supports the use of the simplified name. For example, both Headquarters : Executive and Executive are supported. |

| Date | Required. Default value provided if CSV file does not include this field. |

| Department | Must match the name of an existing department at Setup > Company > Departments. Most CSV imports require the use of the full hierarchical name, but inventory worksheet import supports the use of the simplified name. For example, both Marketing : Marcom and Marcom are supported. |

| Location | Required if the Multi-Location Inventory feature is enabled. Must match the name of an existing location at Setup > Company > Locations. Most CSV imports require the use of the full hierarchical name, but inventory worksheet import supports the use of the simplified name. For example, for location name, both California : Los Angeles and Los Angeles are supported. |

| Memo | Provides a detailed description displayed in the transaction detail list and other reports. |
```
### Simple Imports

<table>
<thead>
<tr>
<th>Header Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Posting Period</td>
<td>An error is returned if a closed period is specified.</td>
</tr>
<tr>
<td>Reference #</td>
<td>Used to track adjustments. This number appears on register and account detail reports. Maximum length = 45. Default value provided if CSV file does not include this field. Note that if you provide a value that is already in use, an error occurs.</td>
</tr>
<tr>
<td>Subsidiary</td>
<td>Required for OneWorld accounts. Must match the name of an existing subsidiary at Setup &gt; Company &gt; Subsidiaries. Most CSV imports require the use of the full hierarchical name, but journal entry import supports the use of the simplified name. For example, both EMEA : Germany and Germany are supported.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transaction Order</th>
<th>Required. Must use one of the following values:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- First transaction in day - posts the worksheet at the beginning of the day and does not include additional inventory transactions entered during that day for this worksheet.</td>
</tr>
<tr>
<td></td>
<td>- Last transaction in day - posts the worksheet at the end of the day and includes all inventory transactions entered during that day for this worksheet.</td>
</tr>
</tbody>
</table>

Each line in the CSV file should include a different value for each line-level field.

<table>
<thead>
<tr>
<th>Line-Level Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Required. Item to be adjusted. Must match an existing item at Lists &gt; Accounting &gt; Items. You cannot reference the same item in multiple lines.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default item names should be used as values for this field, but you can also choose to use internal ID or external ID values. See Select Reference Types.</td>
</tr>
<tr>
<td>New Qty</td>
<td>Required. The new total quantity on hand for the item.</td>
</tr>
<tr>
<td>New Value</td>
<td>Required. The new value for the new quantity of item in stock.</td>
</tr>
</tbody>
</table>

### Using IDs Instead of Names for Items

By default, the Import Assistant expects the values in the Item column of your CSV file to match the names of existing items in the system. You have the option of setting up the import to expect either internal ID or external ID values instead.

- The internal ID is a NetSuite system-assigned ID number. To display internal ID values on NetSuite forms, go to Home > Set Preferences. Click the General subtab, and in the Defaults section, check Show internal IDs. When this preference is enabled, a list displays the IDs as one of the columns.
- The external ID is an ID number used by an external system. A record has an external ID only if the user created one when bringing the record into NetSuite.
To set the Item field to use ID instead of name values, click its edit icon on the Field Mapping page, and in the popup, select either Internal ID or External ID.

Example Inventory Worksheet CSV File

The following table illustrates a sample CSV file containing data for an inventory worksheet. Columns A-J contain header-level data, whereas columns K-M contain line-level data. Notice that the header-level fields include values only in the first row.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Posting Period</td>
<td>Reference #</td>
<td>Adjustment Account</td>
<td>Subsidiary</td>
<td>Department</td>
<td>Class</td>
<td>Location</td>
<td>Memo</td>
<td>Transaction Order</td>
<td>Item</td>
<td>New Qty</td>
<td>New Value</td>
</tr>
<tr>
<td>7/22/2011</td>
<td>10100 Uncat Exp</td>
<td>USA</td>
<td>East Coast</td>
<td>July Cycle</td>
<td>Last Transaction in Day</td>
<td>Kid Sport Lunch Box</td>
<td>120</td>
<td>1200.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Medium Cooler</td>
<td></td>
<td>255</td>
<td>5100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Small Icerpack</td>
<td></td>
<td>125</td>
<td>500.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Large Icerpack</td>
<td></td>
<td>180</td>
<td>1080.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Multicolor Snack Bag</td>
<td></td>
<td>60</td>
<td>480.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Kid Flower Lunch Box</td>
<td></td>
<td>85</td>
<td>850.00</td>
</tr>
</tbody>
</table>

For more information about adjusting inventory, see the help topics Adjusting Inventory and Adjust Inventory Worksheet.

Project Tasks Import

The Project Tasks Import lets you import project tasks from a Microsoft Project plan. You can build project plans in Microsoft Project, then bring the data into NetSuite after the plan has been well developed, or develop project plan templates in Microsoft Project for use in NetSuite.

**Note:** The project tasks import supports addition of new data into NetSuite; updates currently are not supported.

The process for project tasks imports differs from other types:
A simplified version of the Import Assistant is used for project task imports, with two pages to complete instead of five. This Assistant is available from Activities > Scheduling > Project Tasks > Import instead of the Setup menu.

NetSuite provides a blank project file with a predefined export map that you can download and use to export MPP file data into a properly formatted CSV file. You can then use the Import Assistant to import this CSV file data.

Be aware of the following requirements for the project tasks import:

- Your account must have Project Management enabled.
- To do an import, users must have the following NetSuite permissions:
  - Import CSV File
  - Projects (at least View level)
  - Project Tasks (at least Create level)
- The following tasks should be completed before a project tasks import:
  - Create a project in NetSuite to which the project tasks can be added. Be sure to enter a value for start date, as all scheduling for project tasks is generated from this date. Also, all assignees listed in Microsoft Project should be listed in the Project's Resources subtab.
  - Edit the NetSuite Employee records of project task assignees, enabling the Job Resource check box on the Human Resources subtab, so that the import can include assignments.

For instructions for importing Microsoft Project tasks into NetSuite, see the help topic Importing Project Tasks from Microsoft Project. To create project records by importing jobs, see Projects (Jobs) Import.

Note: CRM tasks are imported with the Import Assistant, available to users with the Import CSV File permission, at Setup > Import/Export > Import CSV Records. See Tasks Import.

Note: Every project task record is designated as either a project task or a milestone task. If you import a project task record and do not include any estimated work, the record is saved as a milestone task. If you do include estimated work, the record is saved as a project task. For more details on the difference between project tasks and milestone tasks, see the help topic Project Tasks.

Web Site Redirects Import

The Web Site Redirects import lets you add and update URL redirects in bulk. You can create URL redirects in NetSuite to make Web pages available under multiple URLs. This functionality is useful if you have moved a site to a new domain, or if you want to redirect a typically misspelled domain to the correct location.

The Web site redirects import assistant is at Setup > Web Site > Redirects > Import, when the Web Site and Host HTML Files features are enabled. You need the Set Up Web Site permission. A link to a CSV template file is available in this import assistant.

For instructions for completing this import, see the help topic Importing Web Site Redirects.

For more information about search engine optimization (SEO) and redirects, see the help topic SEO and Redirects.

Tips for Successful CSV Imports

To set up your CSV files correctly before importing:
Tips for Successful CSV Imports

- Review guidelines for the specific record type of data you want to import, in the Supported Record Types for CSV Import section.
- Review information about the sublist data that can be imported for the record type you want to import, meaning the related data, for example pricing data for item records. For a complete list of sublists supported for import, and identification of which sublists are keyed for selective updates, see Sublist Data Import.
- Review information about the subrecord data that can be imported for the record type you want to import, meaning a specialized set of important related data, for example item inventory details for sales order records. For information and a complete list of subrecords supported for import, see Importing Subrecord Data and Supported Subrecord Imports.
- Determine whether auto-generated numbering is enabled for the record type of imported data, and review the related effects, in Effects of Auto-Generated Numbers during Imports.
- Review general requirements and limitations for imported CSV files, in General CSV File Conventions and related topics.
- If your CSV file contains numbers, see Tips for Using Numbers in CSV Files.
- For imports that include values for check boxes and radio button fields, see Boolean Values in CSV Files.
- Ensure that your CSV file does not contain extra, unneeded characters. See Avoiding Errors for Commas and Other Delimiter Symbols within CSV File Fields.
- If you are importing records that contain hierarchical relationships, review the delimiters that you have used in Delimiters for Hierarchical and Multi-Select Fields.
- Ensure that name references duplicate how the name is displayed in the NetSuite user interface. For information, see Name References.
- State and province names should use the short name values set up for your site. For information, see State and Province Names for CSV Import.
- Replace any country codes with names, in Country Names for CSV Import.

Sublist Data Import

Some types of NetSuite records may include sets of related data called sublists. For example, each sales order record includes a set of items. The items data is considered a sublist of sales order. You can use the Import Assistant to import sublist data for some record types. Sublist data can be included in the same file as other record type data, or you can upload a separate file for each sublist’s data.

**Note:** Some related data may be structured as a subrecord rather than a sublist of a record type. See Importing Subrecord Data.

Supported sublist imports vary according to the features that are enabled in your account. For a list of sublists supported for import, see Supported Sublist Imports.

Some sublists include one or more key fields that can uniquely identify each sublist record. For keyed sublists, imported CSV file sublist data can selectively update or completely overwrite existing sublist data, depending upon the setting of the Overwrite Sublists option. For non-keyed sublists, CSV file sublist data can either be appended to or completely overwrite existing sublist data. For details about keyed sublists, see Keyed Sublists for CSV Import. Complete deletion of sublist data currently is not supported.

Be aware that if you do not map any fields for a sublist, no sublist data is imported, even if you set a default value for one or more sublist fields on the Field Mapping page. For information about mapping sublist fields, see Required Fields for Sublist Import Mapping.

For some transaction types, you can update items data during the CSV import. For more information, see Line Item Updates on Transactions Imports.
**Supported Sublist Imports**

The following table shows the sublists for which you may be able to add or update data through CSV imports. These sublists depend upon the features enabled in your account. You can see the sublists available in your account for a particular record type on the Import Assistant's Field Mapping page.

For more details about sublist key fields, see [Keyed Sublists for CSV Import](#).

> **Note:** Some related data may be structured as a subrecord rather than as a sublist of a record type. If you do not see a sublist in the table below, see [Supported Subrecord Imports](#) to check if the data is set up as a subrecord instead.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting: Chart of Accounts</td>
<td>Translations</td>
<td>When Multi-Language feature enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td>Accounting: Expense Categories</td>
<td>Rates</td>
<td>Sublist available to OneWorld accounts only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Subsidiary field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Subscription Plan Line field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Above Quantity field.</td>
</tr>
<tr>
<td>Activities: Events</td>
<td>Attendees</td>
<td>Selectively updatable based on the Attendee field.</td>
</tr>
<tr>
<td></td>
<td>Resources</td>
<td>Selectively updatable based on the Resource field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see <a href="#">Event CSV File Examples</a>.</td>
</tr>
<tr>
<td></td>
<td>Time Track</td>
<td></td>
</tr>
<tr>
<td>Activities: Phone Calls</td>
<td>Contacts</td>
<td>Selectively updatable based on the Participant or Contact key field.</td>
</tr>
<tr>
<td></td>
<td>Time Tracking</td>
<td>When Time Tracking feature enabled.</td>
</tr>
<tr>
<td>Activities: Tasks</td>
<td>Contacts</td>
<td>Selectively updatable based on the Company/Project or Contact key field.</td>
</tr>
<tr>
<td></td>
<td>Time Tracking</td>
<td>When Time Tracking feature enabled.</td>
</tr>
<tr>
<td>Classification: Class</td>
<td>Class Translations</td>
<td>When Multi-Language feature enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Classification:</strong> Department</td>
<td>Department Translations</td>
<td>When Multi-Language feature enabled. Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td><strong>Classification:</strong> Location</td>
<td>Location Translations</td>
<td>When Multi-Language feature enabled. Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td><strong>Classification:</strong> Merchandise Hierarchy Node</td>
<td>Hierarchy Versions</td>
<td>The <strong>Included in Version</strong> box on the Hierarchy Versions subtab indicates if the hierarchy node is assigned to a hierarchy version. You can assign a node to multiple versions.</td>
</tr>
<tr>
<td><strong>Custom Records:</strong> Translations</td>
<td>Translations</td>
<td>When Multi-Language feature is enabled.</td>
</tr>
<tr>
<td><strong>Customization:</strong> Custom Lists</td>
<td>Custom List Values</td>
<td>Selectively updatable based on the ID field. For more information, see Custom List CSV File Examples.</td>
</tr>
<tr>
<td></td>
<td>Custom List Translations</td>
<td>When Multi-Language feature enabled. Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td><strong>Employees:</strong> Employees</td>
<td>Payroll Accrued Times</td>
<td>Selectively updatable based on the Payroll Item key field. When Payroll feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Address</td>
<td>Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>Payroll Contributions</td>
<td>Selectively updatable based on the Payroll Item key field. When Payroll feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Payroll Deductions</td>
<td>Selectively updatable based on the Payroll Item key field. When Payroll feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Direct Deposit</td>
<td>Selectively updatable based on the Internal ID key field. When Direct Deposit feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Payroll Earnings</td>
<td>Selectively updatable based on the Payroll Item key field. When Payroll feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Emergency Contacts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Roles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subscriptions</td>
<td>Selectively updatable based on the Subscriptions key field.</td>
</tr>
<tr>
<td><strong>Employees:</strong> Expense Reports</td>
<td>Expenses</td>
<td>Available when Expense Reports feature is enabled. Selectively updatable based on the Line Id or Ref No. field.</td>
</tr>
</tbody>
</table>
### Tips for Successful CSV Imports

#### Record Type  | Sublist              | Notes                                                                                                                                 |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Accounting Book Detail</td>
<td>Available when the Multi-Book Accounting feature is enabled, and when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td></td>
<td>Bin Numbers</td>
<td>When Bin Management or Advanced Bin/Numbered Inventory Management feature enabled. Selectively updatable based on the Bin Number key field. For Assembly/BOM Item and Inventory Item imports.</td>
</tr>
<tr>
<td></td>
<td>Locations</td>
<td>When Multi-Location Inventory feature enabled. Selectively updatable based on Internal ID, External ID, or Location. For Assembly/BOM Item and Inventory Item imports. For more information, see Updating Locations on Items.</td>
</tr>
<tr>
<td></td>
<td>Members</td>
<td>For Assembly/BOM Item, Item Group, and Kit/Package Item imports.</td>
</tr>
<tr>
<td></td>
<td>Merchandise Hierarchy</td>
<td>For Inventory Items, Lot Numbered Inventory Items, and Serialized Inventory Items. Available when the Merchandise Hierarchy feature is enabled.</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>When Multiple Prices, Quantity Pricing, and/or Multiple Currencies feature enabled. Selectively updatable based on Currency, Quantity, and/or Level fields, depending on enabled features. (See Keys for Item Pricing Sublist.)</td>
</tr>
<tr>
<td></td>
<td>Related Items</td>
<td>When Web Site feature enabled. Not available for Non-Inventory Item for Purchase, Service Item for Purchase, or any Other Charge Item imports. For more information, see Importing Related Items Groups.</td>
</tr>
<tr>
<td></td>
<td>Site Category</td>
<td>When Web Site feature enabled. Not available for Non-Inventory Item for Purchase, Service Item for Purchase, or any Other Charge Item imports. For more information, see Site Category Import.</td>
</tr>
<tr>
<td></td>
<td>Task Templates</td>
<td>When Project Management feature enabled. For Service Item for Sale imports.</td>
</tr>
<tr>
<td></td>
<td>Translations</td>
<td>When Multi-Language feature enabled.</td>
</tr>
</tbody>
</table>

**Note:** If you are importing bin records, you should complete this import before you import items with associated bin numbers. See Bin Import.
<table>
<thead>
<tr>
<th>Record Type</th>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendors</td>
<td></td>
<td>Selectively updatable based on the Language key field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Multiple Vendors feature enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Vendor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For Inventory Item, Non-Inventory Item for Resale or Purchase, Service Item for Resale or Purchase, and Other Charge Item for Resale or Purchase imports, and Assembly/BOM Item when Allow Purchase of Assembly Items preference is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see <a href="#">Updating Vendors on Items</a>.</td>
</tr>
<tr>
<td>Items:</td>
<td>Subscription</td>
<td>Members</td>
</tr>
<tr>
<td></td>
<td>Subscription</td>
<td>When SuiteBilling feature enabled.</td>
</tr>
<tr>
<td>Relationships: Contacts</td>
<td>Address</td>
<td>Selectively updatable based on Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td>Relationships: Customers</td>
<td>Address</td>
<td>Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td></td>
<td>Contact Access</td>
<td>Available for updates of existing customers only, to add or update NetSuite access information for existing customer contacts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on the Contact key field.</td>
</tr>
<tr>
<td></td>
<td>Credit Cards</td>
<td>Addition of new records is supported; update of existing lines is not supported.</td>
</tr>
<tr>
<td></td>
<td>Currencies</td>
<td>When Multiple Currencies feature enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more information, see <a href="#">Setting Multiple Transaction Currencies for Customers</a>.</td>
</tr>
<tr>
<td></td>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Subscriptions</td>
<td>Selectively updatable based on Subscription key field.</td>
</tr>
<tr>
<td></td>
<td>Tax Registrations</td>
<td>Available when the SuiteTax feature is enabled.</td>
</tr>
</tbody>
</table>
### Record Type: Relationships: Jobs

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>When Project Management feature disabled. Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td>Resource</td>
<td>When Project Management feature enabled.</td>
</tr>
</tbody>
</table>

### Record Type: Relationships: Leads

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Addition of new records is supported. Update of existing lines is not supported.</td>
</tr>
<tr>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
</tbody>
</table>

### Record Type: Relationships: Partners

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td>Contact Access</td>
<td>Available for updates of existing partners only, to add or update NetSuite access information for existing partner contacts. Selectively updatable based on the Contact key field.</td>
</tr>
<tr>
<td>Promotion Codes</td>
<td></td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Selectively updatable based on the Subscription key field.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Available when the SuiteTax feature is enabled.</td>
</tr>
</tbody>
</table>

### Record Type: Relationships: Prospects

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Selectively updatable based on the Internal ID or Label key field.</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Addition of new records is supported. Update of existing lines is not supported.</td>
</tr>
<tr>
<td>Downloads</td>
<td>When Sell Downloadable Files feature enabled.</td>
</tr>
<tr>
<td>Group Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Item Pricing</td>
<td>When Multiple Prices feature enabled.</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Sublist</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Relationships: Vendors</td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Roles</td>
</tr>
<tr>
<td></td>
<td>Subscriptions</td>
</tr>
<tr>
<td></td>
<td>Tax Registrations</td>
</tr>
<tr>
<td>Rules Setup: Foreign Currency Variance Posting Rule</td>
<td>Criteria</td>
</tr>
<tr>
<td>Supply Chain: Bill of Materials Revision</td>
<td>Bill of Materials Revision Components</td>
</tr>
<tr>
<td>Supply Chain: Manufacturing Cost Template</td>
<td>Cost Detail</td>
</tr>
<tr>
<td>Supply Chain: Manufacturing Routing</td>
<td>Routing Steps</td>
</tr>
<tr>
<td></td>
<td>Component per Operation</td>
</tr>
<tr>
<td>Support: Solutions</td>
<td>Solutions</td>
</tr>
<tr>
<td></td>
<td>Topics</td>
</tr>
<tr>
<td>Support: Support Cases</td>
<td>Escalate to</td>
</tr>
<tr>
<td>Transactions: Advanced Intercompany Journal Entry</td>
<td>Advanced Intercompany Journal Entry Line</td>
</tr>
<tr>
<td></td>
<td>Billable Time</td>
</tr>
</tbody>
</table>
### Tips for Successful CSV Imports

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>At least one line item is required for new records. (See Required Items Sublist Fields for Transactions Imports.)</td>
</tr>
<tr>
<td>Partners</td>
<td>When Team Selling feature enabled.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Internal ID, External ID, or Partner.</td>
<td></td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
<td></td>
</tr>
<tr>
<td>Shipment</td>
<td>When Multiple Shipping Routes feature enabled.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Check</strong></td>
<td>Accounting Books</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Multi-Book Accounting feature is enabled, and when more than one active accounting book exists.</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Selectively updatable based on Line.</td>
<td></td>
</tr>
<tr>
<td>Items</td>
<td>Selectively updatable based on Item.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Credit Card Charge</strong></td>
<td>Accounting Books</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Multi-Book Accounting feature is enabled, and when more than one active accounting book exists.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Line or Order Line.</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Selectively updatable based on Line.</td>
<td></td>
</tr>
<tr>
<td>Items</td>
<td>Selectively updatable based on Item.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Credit Card Refund</strong></td>
<td>Accounting Books</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Multi-Book Accounting feature is enabled, and when more than one active accounting book exists.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on Line or Order Line.</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Selectively updatable based on Line.</td>
<td></td>
</tr>
<tr>
<td>Items</td>
<td>Selectively updatable based on Item.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Credit Memo</strong></td>
<td>Apply</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, see Credit Memo Import.</td>
<td></td>
</tr>
<tr>
<td>Items</td>
<td>For more information, see Credit Memo Import.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Custom Transaction</strong></td>
<td>Accounting Books</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Custom Transactions feature is enabled and at least one custom transaction type is created.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Selectively updatable based on the Line and Account fields.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note that the Account field can be used as the key only when every line in the sublist has a unique value in the Account field. This behavior differs from SOAP web services, where you can use only Line as a key, even when every line has a unique Account value.</td>
<td></td>
</tr>
<tr>
<td>Record Type</td>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
<td>Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>Transactions: Customer Payment</td>
<td>Invoices</td>
<td>Selectively updatable based on the Invoice key field (and optionally Line key field).</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
<td>Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>Transactions: Estimate</td>
<td>Items</td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports). At least one line item is required for new records. (See Required Items Sublist Fields for Transactions Imports.)</td>
</tr>
<tr>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updateable based on Internal ID, External ID, or Partner.</td>
<td></td>
</tr>
<tr>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
<td></td>
</tr>
<tr>
<td>Shipment</td>
<td>When Multiple Shipping Routes feature enabled.</td>
<td></td>
</tr>
<tr>
<td>Transactions: Intercompany Journal Entry</td>
<td>Intercompany Journal Entry Line</td>
<td>Each imported intercompany journal entry must include at least 4 lines, with one debit and one credit each for originating and receiving subsidiary. Line debits and credits must balance. For more information, see Journal Entry Import and Intercompany Journal Entry Import.</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
<td>Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>Transactions: Inventory Cost Revaluation</td>
<td>Cost Components</td>
<td>Available when Standard Costing feature is enabled. Selectively updatable based on the Component and Cost Category fields.</td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists.</td>
<td></td>
</tr>
</tbody>
</table>
### Tips for Successful CSV Imports

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Sublist</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transactions: Inventory Transfer</strong></td>
<td>Adjustments — Inventory Detail</td>
<td>Available with the Advanced Bin/Numbered inventory Management feature is enabled</td>
</tr>
<tr>
<td><strong>Transactions: Invoice</strong></td>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td></td>
<td>Auth. Code</td>
<td>When Gift Certificates feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Billable Time</td>
<td>Selectively updatable based on related transaction ID (<strong>doc</strong>).</td>
</tr>
<tr>
<td></td>
<td>Items</td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports). At least one line item is required for new records, (see Required Items Sublist Fields for Transactions Imports)</td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td></td>
<td>Shipment</td>
<td>When Multiple Shipping Routes feature enabled.</td>
</tr>
<tr>
<td><strong>Transactions: Item Demand Plan</strong></td>
<td>Demand Planning</td>
<td>Fields vary according to type of demand plan: monthly, weekly, or daily. See Demand Plan Sublist Data.</td>
</tr>
<tr>
<td><strong>Transactions: Item Supply Plan</strong></td>
<td>Orders</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Journal Entry</strong></td>
<td>Journal Entry Line</td>
<td>Each imported journal entry must include at least 2 lines, with balancing debits and credits. For more information, see Journal Entry Import and Intercompany Journal Entry Import.</td>
</tr>
<tr>
<td></td>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Sublist</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transactions: Opportunity</td>
<td>Items</td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports).</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
<td>When Team Selling feature enabled.</td>
</tr>
<tr>
<td>Transactions: Paycheck</td>
<td>Contributions, Deductions, Earnings, Expenses, Taxes, Time</td>
<td></td>
</tr>
<tr>
<td>Transactions: Period End Journal Entry</td>
<td>Period End Journal Entry Line</td>
<td></td>
</tr>
<tr>
<td>Transactions: Purchase Order</td>
<td>Items</td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports).</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>When Allow Expenses on Purchase Orders preference enabled. Expenses data must be in a separate CSV file. For more information, see Purchase Order Import.</td>
</tr>
<tr>
<td>Transactions: Return Authorization</td>
<td>Items</td>
<td>Selectively updatable based on Order Line or Item key field. For more information, see Return Authorization Import.</td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Partner key field.</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
<td>When Team Selling feature enabled. Selectively updatable based on Employee key field.</td>
</tr>
<tr>
<td>Transactions: Sales Order</td>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td>CSV Imports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Items</strong></td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports). At least one line item is required for new records. (See Required Items Sublist Fields for Transactions Imports.)</td>
<td></td>
</tr>
<tr>
<td><strong>Partners</strong></td>
<td>When Multi-Partner Management feature enabled. Selectively updatable based on Internal ID, External ID, or Partner.</td>
<td></td>
</tr>
<tr>
<td><strong>Sales Team</strong></td>
<td>When Team Selling feature enabled.</td>
<td></td>
</tr>
<tr>
<td><strong>Shipment</strong></td>
<td>When Multiple Shipping Routes feature enabled.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Statistical Journal Entry</strong></td>
<td><strong>Line</strong></td>
<td>At least one line is required for new records (see Statistical Journal Entry Body and Sublist Fields).</td>
</tr>
<tr>
<td><strong>Transactions: Subscription</strong></td>
<td><strong>Price Book Lines</strong></td>
<td>When SuiteBilling feature enabled.</td>
</tr>
<tr>
<td><strong>Transactions: Subscription Change Order</strong></td>
<td><strong>Subscription Change Order Items</strong></td>
<td>When SuiteBilling feature enabled. Selectively updatable based on the Line Number field.</td>
</tr>
<tr>
<td><strong>Transactions: Transfer Order</strong></td>
<td><strong>Accounting Books</strong></td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports).</td>
</tr>
<tr>
<td><strong>Transactions: Vendor Bill</strong></td>
<td><strong>Accounting Book Detail</strong></td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
</tr>
<tr>
<td><strong>Items</strong></td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports). At least one item line is required for new records (see Required Items Sublist Fields for Transactions Imports). For more information, see Vendor Bill Import.</td>
<td></td>
</tr>
<tr>
<td><strong>Expenses</strong></td>
<td>Expenses data must be in a separate file. For more information, see Vendor Bill Import.</td>
<td></td>
</tr>
<tr>
<td><strong>Transactions: Vendor Credit</strong></td>
<td><strong>Items</strong></td>
<td>Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports).</td>
</tr>
<tr>
<td>Expense Type</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>At least one item line is required for new records (see Required Items Sublist Fields for Transactions Imports). Expenses data must be in a separate file. Selectively updatable based on the Line/Order Line key field.</td>
<td></td>
</tr>
<tr>
<td>Apply</td>
<td>Apply data must be in a separate file. Selectively updatable based on the Apply or Line key field.</td>
<td></td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
<td></td>
</tr>
<tr>
<td>Transactions: Vendor Payment</td>
<td>Bills Selectively updatable based on the Bill key field (and optionally Line key field).</td>
<td></td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
<td></td>
</tr>
<tr>
<td>Transactions: Vendor Return Authorization</td>
<td>Items Selectively updatable based on the Line/Order Line or Item key field (See Line Item Updates on Transactions Imports). At least one item line is required for new records (see Required Items Sublist Fields for Transactions Imports).</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Expenses data must be in a separate file. Selectively updatable based on the Line/Order Line key field.</td>
<td></td>
</tr>
<tr>
<td>Accounting Book Detail</td>
<td>Available only when the Multi-Book Accounting feature is enabled, and only when more than one active accounting book exists. Selectively updateable based on the Accounting Book key field.</td>
<td></td>
</tr>
</tbody>
</table>

**Website: Site Category**

**Presentation Items**

---

**Importing Sublist Data in a Single File**

When you import body and sublist data in a single file, the sublist data in the import file can be represented and handled in distinct ways based on the record type. NetSuite distinguishes between two types of sublists, and this determines how you can format your file when you import sublist data.

The first sublist type is the multiline sublist. With this type of sublist, the import file can contain one or more line of sublist data for a record in consecutive rows of the import file.
The other sublist type is the multicolumn sublist. With this sublist, the import file can also contain one or more line of sublist data for a record, but the sublist data is represented in columns rather than rows.

The sublists that support multicolumn import are marked with a plus sign in the import assistant. By adding a copy of these sublist fields to the import assistant, you can import and map the same type of data multiple times.

For example, your data can be translated to more than one language. By adding a copy of the Translation sublist fields, you can import and map multiple translations in one import file.

An import file may contain sublist data structured in either or both ways. It can contain:

- One or more lines of data for a single multiline sublist.
- One or more lines of data for more than one multiline sublist.
- One or more lines of data for multiple copies of the same multicolumn sublist.
- One or more lines of data for multiple copies of more than one multicolumn sublist.
- One or more lines of data for both multicolumn and multiline sublists.

**Important:** It depends on the record type whether sublist data can be mapped in multiline or in multicolumn sublists. This is an internal attribute and you cannot override this behavior. For information about the sublists that support multiline import, see Multiline Sublists for CSV Import.

Each sublist structure is best suited for a particular purpose, depending on whether your sublist data has a variable number of lines, or a limited and fixed number of lines.
For example, if you import customer payments, each record may contain sublist data for a variable number of invoices. In this case, the first and second methods are the best.

As opposed to this, if you import translations of your data, you usually want to provide the translations in a fixed and limited number of languages. In this case, use the third or fourth method.

**Import Format and Mapping Considerations**

In a single-file import format, where you import both body and sublist data in one file, and the sublist data consists of multiple lines for each sublist item, you must provide a mapping to identify the record the sublist belongs to. This is necessary because the record ranges over more than one line of the import file.

Even though the external ID is not a required field on the Field Mapping page of the import assistant for transaction imports, you must include it to uniquely identify the record when you use the single-file import format and you are importing new data. The unique ID must be included in every line of the CSV file. If you attempt to import a file without specifying a unique identifier, you will receive the following error:

"You must map one of the following NetSuite fields to a column in your CSV file, to be a unique identifier: External ID, Internal ID, or a transaction number field, such as Order # or Invoice #"

If you import new data, the transaction ID is not yet available, and the Internal ID is created during import. The only unique identifier in this case is the External ID, and you must include it in each row of the file. When you update existing data, you can use internal IDs for the same purpose.

When you import new data, each record must be created with all the required data during an import, and the import file must contain values for the required body and sublist fields. When you update existing records, you can update the values of body fields and sublists separately.

**Handling Gaps in Sublist Data**

If you import file contains multiple lines of data for sublists, some lines of the sublist data may be empty. If you have empty lines in your sublist data, you must structure your import file in a way that the sublist data is at the beginning of your sublist data lines for each record. Additionally, the sublist data for each record must be consecutive.

In the following example, the data for one or more sublists is missing from the first line of sublist data. This leads to problems during the import.

In the following example, the sublist data contains empty lines in the last position in the record, and the import works.
Handle Multiple Values for Body Fields

If your file contains multiple lines of data for sublists, the body field values are only considered for the first line.

In the following example, the Date body field has three different values for the record CP-001, and two values for the record CP-002. In this case, only the first date value is imported, and the other two values will be skipped. The example in the Import File with Sublist Data for a Multiline Sublist section shows how to structure this import file correctly.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Invoice ID</th>
<th>Payment Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP-001</td>
<td>John Woodhouse</td>
<td>4/25/2017</td>
<td>INV-004</td>
<td>10000</td>
</tr>
<tr>
<td>CP-001</td>
<td></td>
<td>5/3/2017</td>
<td>INV-115</td>
<td>5800</td>
</tr>
<tr>
<td>CP-001</td>
<td></td>
<td>4/28/2017</td>
<td>INV-229</td>
<td>6200</td>
</tr>
<tr>
<td>CP-002</td>
<td>Tim Johnson</td>
<td>4/29/2017</td>
<td>INV-532</td>
<td>5600</td>
</tr>
<tr>
<td>CP-002</td>
<td></td>
<td>5/2/2017</td>
<td>INV-938</td>
<td>9800</td>
</tr>
</tbody>
</table>

Performance Considerations During Record Updates

To update sublist data in existing records, instead of using a single import file that includes body field and sublist data, consider using a separate import file for the sublist data, in which you provide a reference to the record you want to update. This approach leads to improved performance.

⚠️ Important: If you move a set of sublist data to a separate import file, you must do this with all other sublist data. In the following example, if you move Item and Quantity into a separate Item import file, you must also move Apply and Payment into a separate Apply import file.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Item</th>
<th>Quantity</th>
<th>Apply</th>
<th>Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3–042601</td>
<td>ABC Trucking</td>
<td>Carburetor MK60</td>
<td>10</td>
<td>EXTINV02134</td>
<td>2500</td>
</tr>
<tr>
<td>CM-PT3–042601</td>
<td></td>
<td>Carburetor MK65</td>
<td>3</td>
<td>EXTINV02183</td>
<td>1500</td>
</tr>
<tr>
<td>CM-PT3–042601</td>
<td></td>
<td></td>
<td></td>
<td>EXTINV02190</td>
<td>750</td>
</tr>
<tr>
<td>CM-PT3–042602</td>
<td>Happy Day Motors</td>
<td></td>
<td></td>
<td>EXTSO12456</td>
<td>500</td>
</tr>
<tr>
<td>CM-PT3–042603</td>
<td>Smithson Auto Body</td>
<td>Alternator BS40</td>
<td>2</td>
<td>EXTINV02210</td>
<td>1200</td>
</tr>
<tr>
<td>CM-PT3–042603</td>
<td></td>
<td>Alternator BS55</td>
<td>3</td>
<td>EXTINV02199</td>
<td>300</td>
</tr>
</tbody>
</table>

When you move sublist data to separate import files, make sure that the primary import file only contains data for body fields. If the import has more than one import file specified, multiline sublists are not supported. In this case, you must add all sublist data into separate import files, refer to the record ID in each additional file, and run the import.

Import File Examples

The following examples illustrate how sublist lines are handled when the import file contains sublist data for different numbers and types of sublists.

- Import File with Sublist Data for a Multiline Sublist
Import File with Sublist Data for a Multiline Sublist

The following example shows a customer payment import file that contains data for body fields and for the Invoices sublist. The external ID, the customer name, and the date are body fields. The invoice ID and the payment amount are sublist fields.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Date</th>
<th>Invoice ID</th>
<th>Payment Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP-001</td>
<td>John Woodhouse</td>
<td>4/25/2017</td>
<td>INV-004</td>
<td>10000</td>
</tr>
<tr>
<td>CP-001</td>
<td></td>
<td></td>
<td>INV-115</td>
<td>5800</td>
</tr>
<tr>
<td>CP-001</td>
<td></td>
<td></td>
<td>INV-229</td>
<td>6200</td>
</tr>
<tr>
<td>CP-002</td>
<td>Tim Johnson</td>
<td>4/29/2017</td>
<td>INV-532</td>
<td>5600</td>
</tr>
<tr>
<td>CP-002</td>
<td></td>
<td></td>
<td>INV-938</td>
<td>9800</td>
</tr>
</tbody>
</table>

Import File with Sublist Data for More Than One Multiline Sublists

The following example shows a credit memo import file that contains data for body fields and for two different sublists, the Item sublist and the Apply sublist. The external ID and the customer name are body fields. Item and quantity are fields on the Item sublist. Apply and payment are fields on the Apply sublist.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Item</th>
<th>Quantity</th>
<th>Apply</th>
<th>Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>ABC Trucking</td>
<td>Carburetor MK60</td>
<td>10</td>
<td>EXTINV02134</td>
<td>2500</td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td></td>
<td>Carburetor MK65</td>
<td>3</td>
<td>EXTINV02183</td>
<td>1500</td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td></td>
<td></td>
<td></td>
<td>EXTINV02190</td>
<td>750</td>
</tr>
<tr>
<td>CM-PT3-042602</td>
<td>Happy Day Motors</td>
<td></td>
<td></td>
<td>EXTSO12456</td>
<td>500</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Smithson Auto Body</td>
<td>Alternator BS40</td>
<td>2</td>
<td>EXTINV02210</td>
<td>1200</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td></td>
<td>Alternator BS52</td>
<td>3</td>
<td>EXTINV02199</td>
<td>300</td>
</tr>
</tbody>
</table>

Import File with Sublist Data for a Multicolumn Sublist

The following example shows a custom list import that contains data for body fields and for the fields of the Translation sublist in two languages. The custom list name and ID are body fields. Language and translation are fields on the Custom List Translation sublist.

<table>
<thead>
<tr>
<th>Custom List Name</th>
<th>Custom List ID</th>
<th>Language 1</th>
<th>Translation 1</th>
<th>Language 2</th>
<th>Translation 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td>_electronics</td>
<td>German</td>
<td>Elektronik</td>
<td>French</td>
<td>electronique</td>
</tr>
<tr>
<td>Computers</td>
<td>_computers</td>
<td>German</td>
<td>Computer</td>
<td>French</td>
<td>ordinateur</td>
</tr>
<tr>
<td>Musical instruments</td>
<td>_musical_instruments</td>
<td>German</td>
<td>Musikinstrumente</td>
<td>French</td>
<td>instruments de musique</td>
</tr>
</tbody>
</table>
Import File with Sublist Data for More Than One Multicolumn Sublists

The following example shows a customer import that contains data for body fields and for the fields of two different multicolumn sublists, the Customer Credit Cards and the Customer Currencies sublists. The customer and company name are body fields. The credit card number and expiration date are fields on the Customer Credit Cards sublist. Currency is a field on the Customer Currencies sublist.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Company Name</th>
<th>CC Number 1</th>
<th>Expiration Date 1</th>
<th>CC Number 2</th>
<th>Expiration Date 2</th>
<th>Currency 1</th>
<th>Currency 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hannah King</td>
<td>King Enterprises</td>
<td>1111 2222 3333 4444</td>
<td>Jun-17</td>
<td>2222 3333 4444 5555</td>
<td>Sep-19</td>
<td>USD</td>
<td>AUD</td>
</tr>
<tr>
<td>Holly Fleming</td>
<td>Flemingway Inc.</td>
<td>3333 4444 5555 6666</td>
<td>Nov-23</td>
<td>5555 6666 7777 8888</td>
<td>Nov-20</td>
<td>CZK</td>
<td>EUR</td>
</tr>
</tbody>
</table>

Import File with Sublist Data for Both Multiline and Multicolumn Sublists

The following example shows a credit memo import that contains data for body fields and for the fields of both multiline and multicolumn sublists. The external ID and customer name are body fields. Apply and payment are fields on the Apply sublist. Accounting book and exchange rate are fields on the Credit Memo Accounting Books sublist.

<table>
<thead>
<tr>
<th>External ID</th>
<th>Customer</th>
<th>Item</th>
<th>Quantity</th>
<th>Apply</th>
<th>Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM-PT3-042601</td>
<td>ABC Trucking</td>
<td>Carburetor MK60</td>
<td>10</td>
<td>EXTINV02134</td>
<td>2500</td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td>EXTNV02183</td>
<td></td>
<td>1500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM-PT3-042601</td>
<td>EXTNV02190</td>
<td></td>
<td>750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CM-PT3-042602</td>
<td>Happy Day Motors</td>
<td>EXTSO12456</td>
<td>500</td>
<td>Accounting UK</td>
<td>0.85</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>Smithson Auto Body</td>
<td>EXTNV02210</td>
<td>1200</td>
<td>Accounting AU</td>
<td>1.8</td>
</tr>
<tr>
<td>CM-PT3-042603</td>
<td>EXTNV02199</td>
<td></td>
<td>300</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Limits of Using Multi-threaded CSV Import

If your import file contains multiple lines of data for sublist lines, you must consider whether you can use multi-threading to import the data. Multi-threading can lead to errors if the import file is structured incorrectly.

In the following example, each section marked with red is processed as one record.

In this case, multi-threading works, but only if your import file is structured in a way that the lines that refer to the same record are consecutive.

In the following example, multi-threading can lead to an error because the lines referring to the same record are not consecutive. The first two lines of this example are processed as one record, and if multi-threading is used, it is possible that the process works on the last line at the same time, which modifies the same record.
**Note:** When using an import file that contains multicolumn sublists, each line of the CSV file is submitted separately.

### Multiline Sublists for CSV Import

The following table lists in alphabetical order the sublists that support multiline import, and the record types for which each sublist is available.

For information about formatting the import file, see [Importing Sublist Data in a Single File](#).

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Record Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add More Payees Machine</td>
<td>Payroll Batch Add Employees</td>
</tr>
<tr>
<td>Apply</td>
<td>Credit Memo, Customer Payment, Vendor Payment</td>
</tr>
<tr>
<td>Custom Value</td>
<td>Custom List</td>
</tr>
<tr>
<td>Exclude Location Regions</td>
<td>Location</td>
</tr>
<tr>
<td>Expense</td>
<td>Credit Card Charge, Credit Card Refund, Purchase Order, Vendor Bill, Vendor Credit, Vendor Return Authorization</td>
</tr>
<tr>
<td>Include Location Regions</td>
<td>Location</td>
</tr>
<tr>
<td>Inventory</td>
<td>Inventory Adjustment, Inventory Transfer</td>
</tr>
<tr>
<td>Invt</td>
<td>Inventory Worksheet</td>
</tr>
<tr>
<td>Item</td>
<td>Cash Sale, Check, Credit Card Charge, Credit Card Refund, Credit Memo, Estimate, Invoice, Opportunity, Purchase Order, Return Authorization, Sales Order, Transfer Order, Vendor Bill, Vendor Credit, Vendor Return Authorization</td>
</tr>
<tr>
<td>Member</td>
<td>Item Group, Subscription Plan</td>
</tr>
<tr>
<td>Order</td>
<td>Item Supply Plan</td>
</tr>
</tbody>
</table>
### Keyed Sublists for CSV Import

The methodology for Import Assistant updates of existing sublist data varies according to: whether the sublist is keyed, and the setting for the Overwrite Sublists option.

The key fields for each sublist are denoted with a key icon on the Import Assistant Field Mapping page.

The following table lists in alphabetical order by sublist the sublists that are keyed for CSV import, record types for which each sublist is available, key fields that can be used, and other details to help you set up your CSV files. To see a table of sublists grouped by associated record type, see Supported Sublist Imports.

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Record Types</th>
<th>Key Fields</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Comm</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contribution</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deduction</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Earnings</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taxes</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Paycheck</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Interval</td>
<td>Price Book, Subscription</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Tiers</td>
<td>Price Plan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subline</td>
<td>Subscription Change Order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tax Details</td>
<td>Cash Sale, Credit Card Charge, Credit Card Refund,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Credit Memo, Estimate, Invoice, Opportunity, Purchase</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Order, Return Authorization, Sales Order, Vendor Bill,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vendor Credit, Vendor Return Authorization</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Accounting Book**

Transactions

**Accounting Books**

Transactions

**Accrued Time**

Employees

**Address**

Contacts, Customers, Employees, Jobs, Leads

If a CSV file row includes values for both key fields, ID takes precedence.
### Tips for Successful CSV Imports

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Record Types</th>
<th>Key Fields</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partners, Prospects, Vendors</td>
<td>Important: The Internal ID field should not be used as a key. It is not possible to update an existing address identified by the Internal ID.</td>
<td>If a CSV file includes more than one address with the same Label value, an error occurs. Address fields for entities are available as search filters and results. To maintain this data in NetSuite, you can create a saved search to export existing values for these fields before setting up an import.</td>
<td></td>
</tr>
<tr>
<td>Apply</td>
<td>Vendor Credit</td>
<td>Apply or Line</td>
<td></td>
</tr>
<tr>
<td>Attendees</td>
<td>Event</td>
<td>Attendee</td>
<td></td>
</tr>
<tr>
<td>Billable Time</td>
<td>Cash Sale, Invoice</td>
<td>related transaction ID (<strong>doc</strong>)</td>
<td></td>
</tr>
<tr>
<td>Bills</td>
<td>Vendor Payment</td>
<td>Bill (and optionally Line)</td>
<td></td>
</tr>
<tr>
<td>Bin Numbers</td>
<td>Items</td>
<td>Bin Number</td>
<td></td>
</tr>
<tr>
<td>Company Contributions</td>
<td>Employees</td>
<td>Payroll Item</td>
<td></td>
</tr>
<tr>
<td>Contact Access</td>
<td>Customers, Partners</td>
<td>Contact</td>
<td>Used to import NetSuite access details, such as password, login, and role, for existing customer or partner contacts.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Phone Calls, Tasks</td>
<td>Customer (Company/Project, Participant) or Contact</td>
<td></td>
</tr>
<tr>
<td>Cost Components</td>
<td>Inventory Cost Revaluation</td>
<td>Component or Cost Category</td>
<td></td>
</tr>
<tr>
<td>Currencies</td>
<td>Customers</td>
<td>Currency</td>
<td>Only one field per sublist.</td>
</tr>
<tr>
<td>Custom List Values</td>
<td>Custom List</td>
<td>ID</td>
<td>The value for the ID field is automatically generated by the system and is read-only.</td>
</tr>
<tr>
<td>Deductions</td>
<td>Employees</td>
<td>Payroll Item</td>
<td></td>
</tr>
<tr>
<td>Sublist</td>
<td>Record Types</td>
<td>Key Fields</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------</td>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Direct Deposit</td>
<td>Employees</td>
<td>Internal ID</td>
<td></td>
</tr>
<tr>
<td>Earnings</td>
<td>Employees</td>
<td>Payroll Item</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Report</td>
<td>Line Id or Ref No.</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Vendor Bill, Vendor Credit, Vendor Return Authorization</td>
<td>Line or Order Line</td>
<td>If a CSV file row includes values for both key fields, Line/Order Line takes precedence. For more information, see Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Expenses</td>
<td>Transactions</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Invoices</td>
<td>Customer Payment</td>
<td>Invoice (and optionally Line)</td>
<td></td>
</tr>
<tr>
<td>Items</td>
<td>Cash Sale, Check, Estimate, Invoice, Opportunity, Purchase Order, Return Authorization, Sales Order, Transfer Order, Vendor Bill, Vendor Credit, Vendor Return Authorization</td>
<td>Line/Order Line or Item</td>
<td>If a CSV file row includes values for both key fields, Line/Order Line takes precedence. For more information, see Line Item Updates on Transactions Imports.</td>
</tr>
<tr>
<td>Lines</td>
<td>Custom Transaction</td>
<td>Line or Account</td>
<td>Account can be used only if each line has a unique value in the Account field. (Note that this behavior differs from SOAP web services, where you can use only Line as a key, even when every line has a unique account value.)</td>
</tr>
<tr>
<td>Locations</td>
<td>Item</td>
<td>Internal ID, External ID, or Location</td>
<td>You can update reorder point, quantity on hand, and preferred stock level per location.</td>
</tr>
<tr>
<td>Merchandise Hierarchy</td>
<td>Item</td>
<td>Hierarchy Version</td>
<td>Sublist available on Inventory Items, Lot Numbered Inventory Items, and Serialized Inventory Items. Available when the Merchandise Hierarchy feature is enabled.</td>
</tr>
<tr>
<td>Rates</td>
<td>Expense Categories</td>
<td>Subsidiary</td>
<td>Sublist available to OneWorld accounts only.</td>
</tr>
</tbody>
</table>
### Sublist Record Types Key Fields Notes

<table>
<thead>
<tr>
<th>Sublist</th>
<th>Record Types</th>
<th>Key Fields</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing Steps</td>
<td>Manufacturing Routing</td>
<td>Operation Sequence</td>
<td></td>
</tr>
<tr>
<td>Partners</td>
<td>Customer, Lead, Prospect, Cash Sale, Estimate, Invoice, Opportunity, Return Authorization, Sales Order</td>
<td>Internal ID, External ID, or Partner</td>
<td>You can update role and contribution per partner.</td>
</tr>
<tr>
<td>Price Book Lines</td>
<td>Price Book, Subscription</td>
<td>Subscription Plan Line</td>
<td></td>
</tr>
<tr>
<td>Pricing</td>
<td>Item, Price Plan</td>
<td>Currency, Quantity, Level, or Above Quantity</td>
<td>Fields used for the combination key depend upon enabled features.</td>
</tr>
<tr>
<td>Resources</td>
<td>Event</td>
<td>Resource</td>
<td></td>
</tr>
<tr>
<td>Sales Team</td>
<td>Customer, Lead, Prospect, Cash Sale, Estimate, Invoice, Opportunity, Return Authorization, Sales Order</td>
<td>Internal ID, External ID, or Employee</td>
<td>You can update role or contribution per sales team member.</td>
</tr>
<tr>
<td>Subscription Change Order Items</td>
<td>Subscription Change Order</td>
<td>Line Number</td>
<td></td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Contact, Customer, Employee, Partner, Vendor</td>
<td>Subscription</td>
<td>You can manage subscriptions for entities who have opted to receive marketing communications.</td>
</tr>
<tr>
<td>Tax Registrations</td>
<td>Customer, Partner, Vendor</td>
<td>ID</td>
<td>Available when the SuiteTax feature is enabled.</td>
</tr>
<tr>
<td>Translations</td>
<td>Chart of Accounts, Class, Custom Lists, Department, Item, Location</td>
<td>Language</td>
<td>You can update and maintain translations of certain values.</td>
</tr>
<tr>
<td>Vendors</td>
<td>Item</td>
<td>Vendor</td>
<td>You can update information such as vendor code and purchase price per vendor.</td>
</tr>
</tbody>
</table>

### Required Fields for Sublist Import Mapping

Generally, fields marked (Req) on the Import Assistant Field Mapping page must be mapped for an import to proceed. These fields automatically display in the center pane of the Field Mapping page to make it clear that they must be mapped.
However, you do not always need to map sublist fields that are marked (Req), as these fields are only required if you are importing sublist records. For example, the Vendor field in the Item Vendors sublist is only required if you map one or more fields from this sublist.

The Import Assistant determines whether you are importing sublist records, and whether to treat mapping of the sublist's required fields as mandatory for import, based on your selection of One File to Upload or Multiple Files to Upload on the Scan & Upload CSV File page:

- If you choose a single file upload, the Import Assistant does not assume that you are importing any sublist data, so sublist required fields do not display in the center pane of the Field Mapping page and are not required for import.
- If you choose a multiple file upload, meaning one primary file for the record type and one or more linked files for sublists, the Import Assistant assumes you are importing data for each sublist that has a linked file, and sublist required fields display in the center pane of the Field Mapping page.

Processing for Import Assistant updates handles the addition and removal of dependent fields, in the same manner as the user interface. If an import adds a field that depends on other required fields, these other required fields are added. If an import removes a required field, all of its dependent fields are removed as well.

If a sublist field has the same name as a required body field, the required sublist field is automatically mapped. For an import where you are adding records, you can remove the required sublist field from the mapping if needed.

**Note:** The Import Assistant handles Items sublist required fields for some transactions imports differently, because items are required to add new records of these types, but not for updates to existing records. See Required Items Sublist Fields for Transactions Imports.

For a single file upload, if you attempt to map a sublist field on the Field Mapping page, the system displays a pop-up dialog. This dialog states that if you map the field, you must map all required fields for the sublist. After you click OK, the sublist’s required fields display in the center pane so you can map them.

**Required Items Sublist Fields for Transactions Imports**

The Import Assistant provides special handling of Items sublist required fields for the following transactions imports: Cash Sale, Estimate, Invoice, Purchase Order, Sales Order, Vendor Bill, Vendor
Tips for Successful CSV Imports

Credit, and Vendor Return Authorization imports. This handling is necessary because new records for these transactions cannot be saved without any items. The import of Items sublist data is always required when new records are imported for these transaction types, but is not required when updated records are imported for these transaction types. (For Opportunity imports, Items sublist data is never required.)

The Import Assistant determines whether you are importing Items sublist records for transactions, and whether to treat mapping of the Items sublist’s required fields as mandatory for import, based on your selection of Add, Update, or Add or Update data handling on the Import Options page.

- If you select Add, Items required fields display in the center pane of the Field Mapping page and you are required to map these fields.
- If you select Update, or Add or Update, Items required fields do not display in the center pane of the Field Mapping page and you are not required to map these fields.

If you then attempt to map an Items sublist field on the Field Mapping page, you receive a warning that you must map Items required fields. When you click OK, the Items sublist’s required fields display in the center pane so you can map them.

You can create a saved CSV import without the items sublist to add transactions without items. However, each time you run the import, the sublist Item field appears in the mapping. If you are not importing items, remove the sublist Item field from the mapping.

Line Item Updates on Transactions Imports

The Import Assistant lets you update items data for the following types of transactions: Cash Sale, Estimate, Invoice, Opportunity, Purchase Order, Sales Order, Vendor Bill, Vendor Credit, and Vendor Return Authorization. You can modify data for existing line items and/or add line items to existing transactions.

The Items sublist for transactions uses either Line/Order Line or Item as a key field to determine how to update or add line items.

- If a CSV file row includes values for both Line/Order Line and Item fields, Line/Order Line takes precedence over Item.
- CSV file rows with key field values that match existing line item key field values are used to update existing line items. CSV file rows with non-matching key field values are added as new line items.
- An error is returned if the import cannot determine which lines to update. This error occurs if there are two existing lines with duplicate Item values and if there are two lines in the CSV file that match a single existing line.
- NetSuite recommends that you use Line/Order Line as a key field. Because transactions may include multiple lines with the same Item value, using Item as the key may cause errors resulting from duplicate Item values.
- If you import line items to update a transaction and these new line items have the same Line/Order Line values as existing transaction line items, the import results in the new line items overwriting the existing line items. To instead add the line items, map a column with null values to the Line/Order Line field for the import.
- You can remove a line item from an existing transaction by exporting your data, removing the unnecessary line in your CSV file, and then importing the file again. In this case, set the Overwrite Sublists option to True.
- For updates of existing transaction line items (based on matching key field values), by default only mapped field values overwrite existing line item field values; fields that are not mapped for import do not change. If you want all CSV file values to overwrite existing values, set the Overwrite Sublists option to True. Generally you do not want to overwrite sublists, as there are many values set at the time of transactions that you would not want changed after the fact, such as Rate.
Important: Even if you do not have values for Line/Order Line, you should include it as a column in your CSV file and map it on the Field Mapping page. If Line/Order Line is mapped, even if its values are blank in the CSV file, errors do not result from duplicate Item values.

Review the following examples to get an understanding of how to format a CSV file to update transaction item lines.

Example CSV Data - Unsuccessful Transaction Line Item Update

- Existing Sales Order Transaction Lines
  - Item Y, Quantity 1
  - Item Y, Quantity 2
- CSV File for Import
  - Item Y, Quantity 5
  - Item Y, Quantity 5
  - Item Y, Quantity 15

This data results in an error because the import is trying to use the Item value as the key, and it is not clear which transaction lines should be updated.

Example CSV Data - Successful Transaction Line Item Addition

- Existing Sales Order Transaction Lines
  - Item Y, Quantity 1
  - Item Y, Quantity 2
- CSV File for Import
  - Item Y, Quantity 5, Order Line (no value)
  - Item Y, Quantity 5, Order Line (no value)
  - Item Y, Quantity 15, Order Line (no value)
- Updated Sales Order Transaction Lines
  - Item Y, Quantity 1
  - Item Y, Quantity 2
  - Item Y, Quantity 5
  - Item Y, Quantity 5
  - Item Y, Quantity 15

The inclusion of the Order Line column in the CSV file prevents the error. Because the Order Line column does not have any values, CSV file lines are not matched with any existing line items, and are simply added.

The following example illustrates how you might structure your CSV import file. Because the order line ID is not specified, this example adds another line item to the specified sales order.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Date</th>
<th>Order Number</th>
<th>Item</th>
<th>Quantity</th>
<th>Order Line ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Julie Homer</td>
<td>13/7/2017</td>
<td>7</td>
<td>Service Kit — Medium</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

Example CSV Data - Successful Transaction Line Item Update

- Existing Sales Order Transaction Lines
Tips for Successful CSV Imports

The first two CSV file lines are matched to existing line items so the quantity amounts are added. The third CSV file line is not matched, so it is added as a new line item.

The following example illustrates how you might structure your CSV import file. Because the order line ID is specified, this example updates the matching line item in the specified sales order.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Date</th>
<th>Order Number</th>
<th>Item</th>
<th>Quantity</th>
<th>Order Line ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Julie Homer</td>
<td>13/7/2017</td>
<td>7</td>
<td>Service Kit — Medium</td>
<td>8</td>
<td>4</td>
</tr>
</tbody>
</table>

Note: You can create a saved transaction search to retrieve order line values for item lines, before setting up an import to update this data.

Importing Subrecord Data

Some types of NetSuite records may include sets of related data called subrecords. For example, each sales order record may include a set of item inventory detail subrecords. Subrecords are similar to record types, but subrecords must be created, edited, removed, or viewed from within the context of a standard (parent) record type. You can use the Import Assistant to import subrecord data for some record types.

Subrecord data can be included in the same file as other record type data in a single-file import, or you can upload a separate file for each subrecord's data in a multi-file import. In either case, file formatting can be complex. Multi-file imports match foreign keys in subrecord data files to primary keys in the primary record file data to determine relationships, whereas single-file imports that include subrecord data may have recursively repeating rows to represent relationships. It may be easier to set up multi-file imports, but there are no performance gains with this format. Be aware that if you put data for one subrecord in a separate file for an import, you must put data for all other subrecords in their own separate files as well. CSV processing of subrecord data is divided strictly between a single file or multi-file approach, so you cannot mix the two approaches. If you put some subrecord data in the primary record data file and some in a separate file, the import will not process successfully.

Supported subrecord imports vary according to the features that are enabled in your account. For a list of subrecords supported for import, see Supported Subrecord Imports.

Note: Some related data may be structured as a sublist rather than as a subrecord of a record type. See Sublist Data Import.

Supported Subrecord Imports

The following table shows the subrecords for which you may be able to add or update data through CSV imports. These subrecords depend upon the features enabled in your account. You can see the
subrecords available in your account for a particular record type on the Import Assistant's Field Mapping page.

**Note:** Some related data may be structured as a sublist rather than as a subrecord of a record type. If you do not see a subrecord in the table below, see Supported Sublist Imports to check if the data is set up as a sublist instead.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Subrecord</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification: Location</td>
<td>Return Address</td>
</tr>
<tr>
<td>Transactions: Cash Sale</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Check</td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Items — Landed Cost</td>
</tr>
<tr>
<td>Transactions: Credit Memo</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Estimate</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Inventory Transfer</td>
<td>Adjustments — Inventory Detail</td>
</tr>
<tr>
<td>Transactions: Invoice</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Purchase Order</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Return Authorization</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Record Type</td>
<td>Subrecord</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Transactions: Sales Order</td>
<td>Billing Address</td>
</tr>
<tr>
<td></td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Transfer Order</td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Shipping Address</td>
</tr>
<tr>
<td>Transactions: Vendor Bill</td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td></td>
<td>Items — Landed Cost</td>
</tr>
<tr>
<td>Transactions: Vendor Credit</td>
<td>Items — Inventory Detail</td>
</tr>
<tr>
<td>Transactions: Vendor Return Authorization</td>
<td>Items — Inventory Detail</td>
</tr>
</tbody>
</table>

**Effects of Auto-Generated Numbers during Imports**

NetSuite lets you enable auto-generated numbering for many record types, including many types of transactions, so that records are numbered automatically in the order they are created. Auto-generated numbering is set up and recorded at Setup > Company > Auto-Generated Numbers.

- After auto-generated numbering is set up for a record type, NetSuite generates IDs for all records of that type. These IDs are stored in the name field of each record.
- If you need to import legacy IDs for a record type that has auto-generated numbering enabled, be sure to check the Allow Override box. Otherwise, your import job may return errors.

If auto-generated numbering is enabled for a record type, NetSuite recommends that you use the external ID as the key for matching imported records to existing NetSuite records during updates, and as the reference type for mapping CSV file values to that record's dropdown lists and multi-select fields. The external ID is a unique value referenced from an external database. Using the external ID avoids...
mismatches and errors that can occur if you attempt to use the NetSuite system-generated internal ID or name as a key or reference type.

Review the following for more details about auto-generated numbers and imports:

- Auto-Generated Numbers and Imports that Add Data
- Auto-Generated Numbers and Imports that Update Data
- Enabling Auto-Generated Numbering After Importing Records
- Auto-Generated Numbers and Customers Only, Leads Only, and Prospects Only Imports
- Auto-Generated Numbers and Chart of Accounts Imports

**Note:** For more information about setting up auto-generated numbering, see the help topic Set Auto-Generated Numbers.

### Auto-Generated Numbers and Imports that Add Data

If auto-generated numbering is enabled for a record type, you may not be able to import values for ID field data, even if you map the field in the Import Assistant, depending on the record type's Allow Override setting on the Set Up Auto-Generated Numbers page.

- If you have enabled auto-generated numbering for a record type and disabled Allow Override, any ID field values in the CSV file are ignored, and auto-generated numbers are saved with imported records.
- If you have enabled auto-generated numbering for a record type and enabled Allow Override, ID field values can be imported.

For example, if you import a customer with a Customer ID of jack1 listed in the CSV file:

- If Allow Override is disabled, the new customer record has a Customer ID of CUST0001.
- If Allow Override is enabled, the new customer record has a Customer ID of jack1.

### Auto-Generated Numbers and Imports that Update Data

For import jobs that update records that have auto-numbering enabled, you may receive an error like the following if your import file includes any ID field values other than the auto-generated ones, "You do not have permissions to set a value for element entityid...". To avoid this error, make sure that the Ignore Read-Only Fields advanced option is enabled, on the Import Options page. See Ignore Read Only Fields. If you need this option to be disabled for some reason, you alternately can remove the ID field values from your file, or simply do not map the ID field.

An enabled auto-generated numbering preference changes the record names that NetSuite users see in dropdown lists, so this preference changes requirements for name references in imported CSV files. When you do an import of a record, all CSV file references to that record must match the exact name of the record that the user sees in the user interface dropdown list for that field. When auto-generated numbering is turned on, the name in the dropdown list is typically <auto-generated_#+ Name>, for example, "154 Bob Jones" or "4058 Budget".

The Import Assistant uses reference types to map individual CSV records to existing NetSuite records for updating. Internal IDs, external IDs, or names can be used as reference types. A reference type of External ID is recommended for the import of records with auto-generated numbers. For information about setting up reference types, see Select Reference Types.

### Enabling Auto-Generated Numbering After Importing Records

If you import new records with ID values included in the CSV files, and then you enable auto-generated numbering for their record type with the Update option checked, auto-generated numbers may be
concatenated with imported ID values for imported records. (The Update option for auto-generated numbering indicates that existing records should be given auto-generated numbers.)

For example, for customer records, the imported ID value may be moved to the Company Name field when an auto-generated number is added, but if the Company Name field already is populated, the imported ID value appears after the auto-generated number.

So if you have imported a record for a customer with a Customer ID of ABC0001 and a Company Name of Star Records, then after the import, you enable auto-generated numbering for customers and check the Update box, this record has a Customer ID of CUST1 ABC0001 and a Company name of Star Records.

Auto-Generated Numbers and Customers Only, Leads Only, and Prospects Only Imports

In cases where Entities (Leads, Prospects, and Customers) are being imported in a separate import job from Contacts, auto-generated numbering behaves as follows:

- If auto-generated numbering is ON:
  - If you map the Lead, Prospect, or Customer ID, the value in the source column must match the generated ID.
  - If you map the company name, the value in the source column must match the descriptive name.
- When auto-generated numbering is OFF:
  - If you map the Lead, Prospect, or Customer ID, the value in the source column must match the descriptive name.
  - If you map the company name, it will not match any records.

Auto-Generated Numbers and Chart of Accounts Imports

For details about how auto-generated numbering works in the Chart of Accounts record type, see Referencing Child Accounts by Name and Number.

Important: When entering numbers into a CSV file, many spreadsheet programs do not allow leading zeros. For example, if you use Auto-Generated Numbers, you cannot enter 01543 to reference a record. You can eliminate this problem by formatting the cells in your spreadsheet as Text cells instead of numbers. For information on formatting the cells, please refer to the help system for your spreadsheet software.

General CSV File Conventions

To be successfully imported, CSV files must contain values separated by commas or other supported column separators, such as the semicolon, pipe, space, and tab.

CSV files typically include a top row with column names as headers, and multiple rows of data below.

Review the following tips as you are setting up CSV files for the Import Assistant:

- The Import Assistant has a limit of 25,000 records or 50 MB per import job. For a multiple file upload, all files combined must be under these limits.
  - It is strongly recommended that you break large import jobs into smaller chunks to improve performance.
- The Import Assistant attempts to map each CSV file's column headers to field names for the selected NetSuite record type, so that data can be imported into the appropriate NetSuite fields. The Assistant includes a Field Mapping page where you can review and edit its mappings, and define mappings for columns that the Assistant was unable to map.
If a file contains fields of data without column headers, the Import Assistant does not import the trailing fields’ data.

- Blank lines at the end of an imported CSV file are not included in the import.
- You can specify name references in a CSV file, but reference types such as External ID or Internal ID are preferable. Data values for fields used as reference types must be written exactly as they appear in dropdown lists in the NetSuite record form. For more information, see Select Reference Types, Name References, and Effects of Auto-Generated Numbers during Imports.
- If your account is using NetSuite OneWorld, the Subsidiary field is a required field for the following record types: Chart of Accounts, Contacts, Customers, Employees, Jobs, Leads, Partners, Prospects, and Vendors. For imports of these record types, you must include in your CSV file a field that can be mapped to the NetSuite Subsidiary field. If the import attempts to add or update records in a OneWorld account without identifying the subsidiary, the import will fail. CSV file values for subsidiaries should be hierarchical names, in the format grandparent : parent : child, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.
- If your system’s regional settings designate commas as decimal separators, CSV files that you generate with Microsoft Excel use semi-colons as CSV value separators. To learn more about the number formats supported for CSV imports, see Tips for Using Numbers in CSV Files.
- Go to Home > Set Preferences. On the General tab, scroll down to Formatting. Make sure that the CSV Column Delimiter option is set to the column separator used in the CSV files you are planning to import.
- If you are importing CSV data in a language different from your NetSuite language preferences, the data import might be slow. To improve the import speed, change your NetSuite language settings at Home > Set Preferences before importing CSV data, so that your language settings match the language of the CSV file you are importing.

Tips for Using Numbers in CSV Files

Be careful when entering numbers into a CSV file. Many spreadsheet programs do not permit or do not show leading zeros by default, which can be a problem if your data needs those leading zeros. You can work around this problem by formatting the cells in the spreadsheet program as text rather than numbers.

If you plan to import a CSV file created in Excel, be aware that Excel uses scientific notation to save long numbers to CSV files. Long numbers will be imported into NetSuite in rounded form, resulting in incorrect values. You can work around this issue by formatting long numbers such as UPC codes as “Text” in Excel before doing a CSV import.

Commas Used as Decimal Marks

If you use commas as decimal marks in your CSV files, you should specify this choice in the Advanced Import Options of the Import Assistant. If appropriate, you can make it the default format for all CSV imports. To learn how to do that, see the help topics General Personal Preferences and Setting CSV Import Preferences. If you want to set this format as the default for a subsidiary, see the help topic Editing Subsidiary Records.

If the decimal mark is the same character that is used as the CSV column separator, you should put quotation marks around any floating point numbers in the CSV file you import. To learn more, see Avoiding Errors for Commas and Other Delimiter Symbols within CSV File Fields.

Boolean Values in CSV Files

NetSuite recommends that you use only “TRUE” or “FALSE” as values for radio button fields to ensure that import of these fields is successful.
Tips for Successful CSV Imports

- Currently, radio button fields do not accept any other Boolean values.
- The Individual field for entities is an exception that accepts all forms of True or False. For information, see Customers as Individuals or Companies.
- Check boxes accept the following forms for true values: TRUE, YES, T, Y.
- Check boxes accept the following forms for false values: FALSE, NO, F, N

When working with check boxes and radio buttons, note the following:
- True and false values are case insensitive.
- The Import Assistant does not honor localization. This means that true and false values are not accepted in languages other than English.
- The Import Assistant does not accept any other true or false value than the eight values listed.

Avoiding Errors for Commas and Other Delimiter Symbols within CSV File Fields

The Import Assistant ignores extra trailing commas and other column separators repeated at the end of fields or rows.

If any of the fields in the CSV file you import contains characters that are also used as column separators in the file (comma, semicolon, pipe, space, or tab), errors might occur during the import. To avoid errors when importing these files, enclose the content of such fields in quotation marks ("for example").

If the CSV file you import uses commas as both value separators and decimal marks, make sure that all floating point numbers are enclosed in quotation marks (for example, "1,42").

Delimiters for Hierarchical and Multi-Select Fields

When importing records that contain hierarchical relationships, use a colon ":" as the field delimiter. If relationships are multi-tiered, place a colon between each record and subrecord. Place a space between each value and each delimiter.

If there is a hierarchy in a user interface dropdown list, then the CSV file requires the colon delimiter, even if a colon does not display in the UI dropdown list.
- For multi-select field values, the default delimiter is a pipe "|". You can specify a different single character to be used instead of the pipe, for an import job. Set this value on the Import Assistant’s Import Options page, in the Advanced Options section. For information, see Set Advanced CSV Import Options.
- If you are an administrator, you can specify a different character be used for all import jobs in the account, on the CSV Import Preferences page. For information, see Setting CSV Import Preferences.
- The user-level character set as an advanced option for an import job overrides the account-level character, for that import job.
- In your CSV files’ multi-select fields, leave a space between each value and each delimiter.

Example Hierarchical Delimiters

In this example, Solution 1 is associated with Topic B, which is a Subtopic of A. Solution 2 is associated with Topic Z, a Subtopic of Y, which is a Subtopic of X. The colon ":" is the field delimiter. You signify the hierarchy between items using the colon in the topic column.
Name References

Name references need to duplicate exactly the name displayed in the NetSuite user interface. Name references can be prone to error:

- Name references may need to specify a parent-child relationship between two objects using hierarchical delimiters, as described in Delimiters for Hierarchical and Multi-Select Fields.
- For names that contain spaces, HTML rendering can sometimes distort the number of spaces included, causing mismatches between CSV file values and existing records, that result in import errors. To verify the number of spaces in names, you can create a saved search with a list of names and export it.
- Your preference for auto-generated numbering can affect the way that names display. For information, see Effects of Auto-Generated Numbers during Imports.

If you are unsure or unable to verify the name reference for a record, NetSuite recommends that you use the External ID field instead. For updates, you can use the Internal ID.

State and Province Names for CSV Import

State and province names in CSV files need to match Short Name values listed at Setup > Company > States/Provinces/Counties.

NetSuite provides initial system lists of names for several countries. You can add custom states and provinces at Setup > Company > States/Provinces/Counties > New.

If an imported CSV file includes state or province names that do not match current system or custom names, the import job returns an error like "Invalid state state_name for country country_name". If you receive this error, review state and province names in your file, and either make corrections to the file or make additions to system States/Provinces/Counties.
Important: If a CSV file includes the full names for states or provinces rather than short names, the import job may complete, but state or province values may not be saved correctly. To avoid errors, use short names. For example, importing full names for the Shipping Address Country field in transactions can prevent later calculation of shipping costs.

Country Names for CSV Import

You must specify countries by name in CSV files. The Import Assistant cannot import country codes, which are used as countries' NetSuite internal IDs. Before an import, you should replace any country codes with names.

Warning: If an imported CSV file includes country codes (internal IDs), they will be returned as invalid with the following error message: "Invalid country reference key US". On the Field Mapping page of the Import Assistant, you can click the edit icon for a country field, to select a default country value from a dropdown list. Selecting from this list can prevent errors.

In addition to country codes and names, NetSuite’s SOAP web services schema includes country enumerations for use in SOAP web services operations. See the help topic Country Enumerations.

The following table lists the country names in English that map to NetSuite country codes. NetSuite translates country names for each locale, so if you are running NetSuite in a language other than English, you should use the country names that appear in your NetSuite user interface rather than the names in this table.

<table>
<thead>
<tr>
<th>Internal ID</th>
<th>Country Name in English</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD</td>
<td>Andorra</td>
</tr>
<tr>
<td>AE</td>
<td>United Arab Emirates</td>
</tr>
<tr>
<td>AF</td>
<td>Afghanistan</td>
</tr>
<tr>
<td>AG</td>
<td>Antigua and Barbuda</td>
</tr>
<tr>
<td>AI</td>
<td>Anguilla</td>
</tr>
<tr>
<td>AL</td>
<td>Albania</td>
</tr>
<tr>
<td>AM</td>
<td>Armenia</td>
</tr>
<tr>
<td>AO</td>
<td>Angola</td>
</tr>
<tr>
<td>AQ</td>
<td>Antarctica</td>
</tr>
<tr>
<td>AR</td>
<td>Argentina</td>
</tr>
<tr>
<td>AS</td>
<td>American Samoa</td>
</tr>
<tr>
<td>AT</td>
<td>Austria</td>
</tr>
<tr>
<td>AU</td>
<td>Australia</td>
</tr>
<tr>
<td>AW</td>
<td>Aruba</td>
</tr>
<tr>
<td>AX</td>
<td>Aland Islands</td>
</tr>
<tr>
<td>AZ</td>
<td>Azerbaijan</td>
</tr>
<tr>
<td>BA</td>
<td>Bosnia and Herzegovina</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>BB</td>
<td>Barbados</td>
</tr>
<tr>
<td>BD</td>
<td>Bangladesh</td>
</tr>
<tr>
<td>BE</td>
<td>Belgium</td>
</tr>
<tr>
<td>BF</td>
<td>Burkina Faso</td>
</tr>
<tr>
<td>BG</td>
<td>Bulgaria</td>
</tr>
<tr>
<td>BH</td>
<td>Bahrain</td>
</tr>
<tr>
<td>BI</td>
<td>Burundi</td>
</tr>
<tr>
<td>BJ</td>
<td>Benin</td>
</tr>
<tr>
<td>BL</td>
<td>Saint Barthélemy</td>
</tr>
<tr>
<td>BM</td>
<td>Bermuda</td>
</tr>
<tr>
<td>BN</td>
<td>Brunei Darussalam</td>
</tr>
<tr>
<td>BO</td>
<td>Bolivia</td>
</tr>
<tr>
<td>BQ</td>
<td>Bonaire, Saint Eustatius, and Saba</td>
</tr>
<tr>
<td>BR</td>
<td>Brazil</td>
</tr>
<tr>
<td>BS</td>
<td>Bahamas</td>
</tr>
<tr>
<td>BT</td>
<td>Bhutan</td>
</tr>
<tr>
<td>BV</td>
<td>Bouvet Island</td>
</tr>
<tr>
<td>BW</td>
<td>Botswana</td>
</tr>
<tr>
<td>BY</td>
<td>Belarus</td>
</tr>
<tr>
<td>BZ</td>
<td>Belize</td>
</tr>
<tr>
<td>CA</td>
<td>Canada</td>
</tr>
<tr>
<td>CC</td>
<td>Cocos (Keeling) Islands</td>
</tr>
<tr>
<td>CD</td>
<td>Congo, Democratic People's Republic</td>
</tr>
<tr>
<td>CF</td>
<td>Central African Republic</td>
</tr>
<tr>
<td>CG</td>
<td>Congo, Republic of</td>
</tr>
<tr>
<td>CH</td>
<td>Switzerland</td>
</tr>
<tr>
<td>CI</td>
<td>Cote d'Ivoire</td>
</tr>
<tr>
<td>CK</td>
<td>Cook Islands</td>
</tr>
<tr>
<td>CL</td>
<td>Chile</td>
</tr>
<tr>
<td>CM</td>
<td>Cameroon</td>
</tr>
<tr>
<td>CN</td>
<td>China</td>
</tr>
<tr>
<td>CO</td>
<td>Colombia</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>CR</td>
<td>Costa Rica</td>
</tr>
<tr>
<td>CU</td>
<td>Cuba</td>
</tr>
<tr>
<td>CV</td>
<td>Cape Verde</td>
</tr>
<tr>
<td>CW</td>
<td>Curacao</td>
</tr>
<tr>
<td>CX</td>
<td>Christmas Island</td>
</tr>
<tr>
<td>CY</td>
<td>Cyprus</td>
</tr>
<tr>
<td>CZ</td>
<td>Czech Republic</td>
</tr>
<tr>
<td>DE</td>
<td>Germany</td>
</tr>
<tr>
<td>DJ</td>
<td>Djibouti</td>
</tr>
<tr>
<td>DK</td>
<td>Denmark</td>
</tr>
<tr>
<td>DM</td>
<td>Dominica</td>
</tr>
<tr>
<td>DO</td>
<td>Dominican Republic</td>
</tr>
<tr>
<td>DZ</td>
<td>Algeria</td>
</tr>
<tr>
<td>EA</td>
<td>Ceuta and Melilla</td>
</tr>
<tr>
<td>EC</td>
<td>Ecuador</td>
</tr>
<tr>
<td>EE</td>
<td>Estonia</td>
</tr>
<tr>
<td>EG</td>
<td>Egypt</td>
</tr>
<tr>
<td>EH</td>
<td>Western Sahara</td>
</tr>
<tr>
<td>ER</td>
<td>Eritrea</td>
</tr>
<tr>
<td>ES</td>
<td>Spain</td>
</tr>
<tr>
<td>ET</td>
<td>Ethiopia</td>
</tr>
<tr>
<td>FI</td>
<td>Finland</td>
</tr>
<tr>
<td>FJ</td>
<td>Fiji</td>
</tr>
<tr>
<td>FK</td>
<td>Falkland Islands</td>
</tr>
<tr>
<td>FM</td>
<td>Micronesia, Federal State of</td>
</tr>
<tr>
<td>FO</td>
<td>Faroe Islands</td>
</tr>
<tr>
<td>FR</td>
<td>France</td>
</tr>
<tr>
<td>GA</td>
<td>Gabon</td>
</tr>
<tr>
<td>GB</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>GD</td>
<td>Grenada</td>
</tr>
<tr>
<td>GE</td>
<td>Georgia</td>
</tr>
<tr>
<td>GF</td>
<td>French Guiana</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>GG</td>
<td>Guernsey</td>
</tr>
<tr>
<td>GH</td>
<td>Ghana</td>
</tr>
<tr>
<td>GI</td>
<td>Gibraltar</td>
</tr>
<tr>
<td>GL</td>
<td>Greenland</td>
</tr>
<tr>
<td>GM</td>
<td>Gambia</td>
</tr>
<tr>
<td>GN</td>
<td>Guinea</td>
</tr>
<tr>
<td>GP</td>
<td>Guadeloupe</td>
</tr>
<tr>
<td>GQ</td>
<td>Equatorial Guinea</td>
</tr>
<tr>
<td>GR</td>
<td>Greece</td>
</tr>
<tr>
<td>GS</td>
<td>South Georgia</td>
</tr>
<tr>
<td>GT</td>
<td>Guatemala</td>
</tr>
<tr>
<td>GU</td>
<td>Guam</td>
</tr>
<tr>
<td>GW</td>
<td>Guinea-Bissau</td>
</tr>
<tr>
<td>GY</td>
<td>Guyana</td>
</tr>
<tr>
<td>HK</td>
<td>Hong Kong</td>
</tr>
<tr>
<td>HM</td>
<td>Heard and McDonald Islands</td>
</tr>
<tr>
<td>HN</td>
<td>Honduras</td>
</tr>
<tr>
<td>HR</td>
<td>Croatia/Hrvatska</td>
</tr>
<tr>
<td>HT</td>
<td>Haiti</td>
</tr>
<tr>
<td>HU</td>
<td>Hungary</td>
</tr>
<tr>
<td>IC</td>
<td>Canary Islands</td>
</tr>
<tr>
<td>ID</td>
<td>Indonesia</td>
</tr>
<tr>
<td>IE</td>
<td>Ireland</td>
</tr>
<tr>
<td>IL</td>
<td>Israel</td>
</tr>
<tr>
<td>IM</td>
<td>Isle of Man</td>
</tr>
<tr>
<td>IN</td>
<td>India</td>
</tr>
<tr>
<td>IO</td>
<td>British Indian Ocean Territory</td>
</tr>
<tr>
<td>IQ</td>
<td>Iraq</td>
</tr>
<tr>
<td>IR</td>
<td>Iran (Islamic Republic of)</td>
</tr>
<tr>
<td>IS</td>
<td>Iceland</td>
</tr>
<tr>
<td>IT</td>
<td>Italy</td>
</tr>
<tr>
<td>JE</td>
<td>Jersey</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>JM</td>
<td>Jamaica</td>
</tr>
<tr>
<td>JO</td>
<td>Jordan</td>
</tr>
<tr>
<td>JP</td>
<td>Japan</td>
</tr>
<tr>
<td>KE</td>
<td>Kenya</td>
</tr>
<tr>
<td>KG</td>
<td>Kyrgyzstan</td>
</tr>
<tr>
<td>KH</td>
<td>Cambodia</td>
</tr>
<tr>
<td>KI</td>
<td>Kiribati</td>
</tr>
<tr>
<td>KM</td>
<td>Comoros</td>
</tr>
<tr>
<td>KN</td>
<td>Saint Kitts and Nevis</td>
</tr>
<tr>
<td>KP</td>
<td>Korea, Democratic People's Republic</td>
</tr>
<tr>
<td>KR</td>
<td>Korea, Republic of</td>
</tr>
<tr>
<td>KW</td>
<td>Kuwait</td>
</tr>
<tr>
<td>KY</td>
<td>Cayman Islands</td>
</tr>
<tr>
<td>KZ</td>
<td>Kazakhstan</td>
</tr>
<tr>
<td>LA</td>
<td>Lao People's Democratic Republic</td>
</tr>
<tr>
<td>LB</td>
<td>Lebanon</td>
</tr>
<tr>
<td>LC</td>
<td>Saint Lucia</td>
</tr>
<tr>
<td>LI</td>
<td>Liechtenstein</td>
</tr>
<tr>
<td>LK</td>
<td>Sri Lanka</td>
</tr>
<tr>
<td>LR</td>
<td>Liberia</td>
</tr>
<tr>
<td>LS</td>
<td>Lesotho</td>
</tr>
<tr>
<td>LT</td>
<td>Lithuania</td>
</tr>
<tr>
<td>LU</td>
<td>Luxembourg</td>
</tr>
<tr>
<td>LV</td>
<td>Latvia</td>
</tr>
<tr>
<td>LY</td>
<td>Libya</td>
</tr>
<tr>
<td>MA</td>
<td>Morocco</td>
</tr>
<tr>
<td>MC</td>
<td>Monaco</td>
</tr>
<tr>
<td>MD</td>
<td>Moldova, Republic of</td>
</tr>
<tr>
<td>ME</td>
<td>Montenegro</td>
</tr>
<tr>
<td>MF</td>
<td>Saint Martin</td>
</tr>
<tr>
<td>MG</td>
<td>Madagascar</td>
</tr>
<tr>
<td>MH</td>
<td>Marshall Islands</td>
</tr>
</tbody>
</table>

CSV Imports
<table>
<thead>
<tr>
<th>Internal ID</th>
<th>Country Name in English</th>
</tr>
</thead>
<tbody>
<tr>
<td>MK</td>
<td>Macedonia</td>
</tr>
<tr>
<td>ML</td>
<td>Mali</td>
</tr>
<tr>
<td>MM</td>
<td>Myanmar</td>
</tr>
<tr>
<td>MN</td>
<td>Mongolia</td>
</tr>
<tr>
<td>MO</td>
<td>Macau</td>
</tr>
<tr>
<td>MP</td>
<td>Northern Mariana Islands</td>
</tr>
<tr>
<td>MQ</td>
<td>Martinique</td>
</tr>
<tr>
<td>MR</td>
<td>Mauritania</td>
</tr>
<tr>
<td>MS</td>
<td>Montserrat</td>
</tr>
<tr>
<td>MT</td>
<td>Malta</td>
</tr>
<tr>
<td>MU</td>
<td>Mauritius</td>
</tr>
<tr>
<td>MV</td>
<td>Maldives</td>
</tr>
<tr>
<td>MW</td>
<td>Malawi</td>
</tr>
<tr>
<td>MX</td>
<td>Mexico</td>
</tr>
<tr>
<td>MY</td>
<td>Malaysia</td>
</tr>
<tr>
<td>MZ</td>
<td>Mozambique</td>
</tr>
<tr>
<td>NA</td>
<td>Namibia</td>
</tr>
<tr>
<td>NC</td>
<td>New Caledonia</td>
</tr>
<tr>
<td>NE</td>
<td>Niger</td>
</tr>
<tr>
<td>NF</td>
<td>Norfolk Island</td>
</tr>
<tr>
<td>NG</td>
<td>Nigeria</td>
</tr>
<tr>
<td>NI</td>
<td>Nicaragua</td>
</tr>
<tr>
<td>NL</td>
<td>Netherlands</td>
</tr>
<tr>
<td>NO</td>
<td>Norway</td>
</tr>
<tr>
<td>NP</td>
<td>Nepal</td>
</tr>
<tr>
<td>NR</td>
<td>Nauru</td>
</tr>
<tr>
<td>NU</td>
<td>Niue</td>
</tr>
<tr>
<td>NZ</td>
<td>New Zealand</td>
</tr>
<tr>
<td>OM</td>
<td>Oman</td>
</tr>
<tr>
<td>PA</td>
<td>Panama</td>
</tr>
<tr>
<td>PE</td>
<td>Peru</td>
</tr>
<tr>
<td>PF</td>
<td>French Polynesia</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>PG</td>
<td>Papua New Guinea</td>
</tr>
<tr>
<td>PH</td>
<td>Philippines</td>
</tr>
<tr>
<td>PK</td>
<td>Pakistan</td>
</tr>
<tr>
<td>PL</td>
<td>Poland</td>
</tr>
<tr>
<td>PM</td>
<td>St. Pierre and Miquelon</td>
</tr>
<tr>
<td>PN</td>
<td>Pitcairn Island</td>
</tr>
<tr>
<td>PR</td>
<td>Puerto Rico</td>
</tr>
<tr>
<td>PS</td>
<td>State of Palestine</td>
</tr>
<tr>
<td>PT</td>
<td>Portugal</td>
</tr>
<tr>
<td>PW</td>
<td>Palau</td>
</tr>
<tr>
<td>PY</td>
<td>Paraguay</td>
</tr>
<tr>
<td>QA</td>
<td>Qatar</td>
</tr>
<tr>
<td>RE</td>
<td>Reunion Island</td>
</tr>
<tr>
<td>RO</td>
<td>Romania</td>
</tr>
<tr>
<td>RS</td>
<td>Serbia</td>
</tr>
<tr>
<td>RU</td>
<td>Russian Federation</td>
</tr>
<tr>
<td>RW</td>
<td>Rwanda</td>
</tr>
<tr>
<td>SA</td>
<td>Saudi Arabia</td>
</tr>
<tr>
<td>SB</td>
<td>Solomon Islands</td>
</tr>
<tr>
<td>SC</td>
<td>Seychelles</td>
</tr>
<tr>
<td>SD</td>
<td>Sudan</td>
</tr>
<tr>
<td>SE</td>
<td>Sweden</td>
</tr>
<tr>
<td>SG</td>
<td>Singapore</td>
</tr>
<tr>
<td>SH</td>
<td>Saint Helena</td>
</tr>
<tr>
<td>SI</td>
<td>Slovenia</td>
</tr>
<tr>
<td>SJ</td>
<td>Svalbard and Jan Mayen Islands</td>
</tr>
<tr>
<td>SK</td>
<td>Slovak Republic</td>
</tr>
<tr>
<td>SL</td>
<td>Sierra Leone</td>
</tr>
<tr>
<td>SM</td>
<td>San Marino</td>
</tr>
<tr>
<td>SN</td>
<td>Senegal</td>
</tr>
<tr>
<td>SO</td>
<td>Somalia</td>
</tr>
<tr>
<td>SR</td>
<td>Suriname</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>SS</td>
<td>South Sudan</td>
</tr>
<tr>
<td>ST</td>
<td>Sao Tome and Principe</td>
</tr>
<tr>
<td>SV</td>
<td>El Salvador</td>
</tr>
<tr>
<td>SX</td>
<td>Sint Maarten</td>
</tr>
<tr>
<td>SY</td>
<td>Syrian Arab Republic</td>
</tr>
<tr>
<td>SZ</td>
<td>Swaziland</td>
</tr>
<tr>
<td>TC</td>
<td>Turks and Caicos Islands</td>
</tr>
<tr>
<td>TD</td>
<td>Chad</td>
</tr>
<tr>
<td>TF</td>
<td>French Southern Territories</td>
</tr>
<tr>
<td>TG</td>
<td>Togo</td>
</tr>
<tr>
<td>TH</td>
<td>Thailand</td>
</tr>
<tr>
<td>TJ</td>
<td>Tajikistan</td>
</tr>
<tr>
<td>TK</td>
<td>Tokelau</td>
</tr>
<tr>
<td>TL</td>
<td>East Timor</td>
</tr>
<tr>
<td>TM</td>
<td>Turkmenistan</td>
</tr>
<tr>
<td>TN</td>
<td>Tunisia</td>
</tr>
<tr>
<td>TO</td>
<td>Tonga</td>
</tr>
<tr>
<td>TR</td>
<td>Turkey</td>
</tr>
<tr>
<td>TT</td>
<td>Trinidad and Tobago</td>
</tr>
<tr>
<td>TV</td>
<td>Tuvalu</td>
</tr>
<tr>
<td>TW</td>
<td>Taiwan</td>
</tr>
<tr>
<td>TZ</td>
<td>Tanzania</td>
</tr>
<tr>
<td>UA</td>
<td>Ukraine</td>
</tr>
<tr>
<td>UG</td>
<td>Uganda</td>
</tr>
<tr>
<td>UM</td>
<td>US Minor Outlying Islands</td>
</tr>
<tr>
<td>US</td>
<td>United States</td>
</tr>
<tr>
<td>UY</td>
<td>Uruguay</td>
</tr>
<tr>
<td>UZ</td>
<td>Uzbekistan</td>
</tr>
<tr>
<td>VA</td>
<td>Holy See (City Vatican State)</td>
</tr>
<tr>
<td>VC</td>
<td>Saint Vincent and the Grenadines</td>
</tr>
<tr>
<td>VE</td>
<td>Venezuela</td>
</tr>
<tr>
<td>VG</td>
<td>Virgin Islands (British)</td>
</tr>
<tr>
<td>Internal ID</td>
<td>Country Name in English</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>VI</td>
<td>Virgin Islands (USA)</td>
</tr>
<tr>
<td>VN</td>
<td>Vietnam</td>
</tr>
<tr>
<td>VU</td>
<td>Vanuatu</td>
</tr>
<tr>
<td>WF</td>
<td>Wallis and Futuna Islands</td>
</tr>
<tr>
<td>WS</td>
<td>Samoa</td>
</tr>
<tr>
<td>XK</td>
<td>Kosovo</td>
</tr>
<tr>
<td>YE</td>
<td>Yemen</td>
</tr>
<tr>
<td>YT</td>
<td>Mayotte</td>
</tr>
<tr>
<td>ZA</td>
<td>South Africa</td>
</tr>
<tr>
<td>ZM</td>
<td>Zambia</td>
</tr>
<tr>
<td>ZW</td>
<td>Zimbabwe</td>
</tr>
</tbody>
</table>
CSV Import Error Messages

This section lists some of the common errors found during a CSV import and what you can do to correct the error. The errors are organized by import record type.

- General Import Errors
- Employee Import Errors
- Relationship Import Errors
- Items Import Errors
- Transactions Import Errors
- Website Import Errors

General Import Errors

This section describes errors that you might see on any type of import. See the following:

- There is already an item with that name or name/parent combination
- The following file(s) could not be uploaded because of one or more errors. Please correct and re-upload.
- Mandatory field missing for field "XXXX"
- You do not have permissions to set a value for element XXXX due to one of the following reasons: 1) The field is read-only; 2) An associated feature is disabled
- Invalid effective date reference key
- A Saved Search with Internal ID xxx does not exist
- Please enter a value for amount
- Different number of columns than in the header row
- AfterSubmit Script failed, record created with internalId xxx

There is already an item with that name or name/parent combination

The error occurs when the CSV file contains duplicate data for a multi-select field column.

To resolve the error, review the CSV file, look for a multi-select field column, and make sure that no data (internal ID) is entered twice.

Example

Incorrect:

(CSV File) Custom Field value = 1|2|3|4|5|5|6

Correct:

(CSV File) Custom Field value = 1|2|3|4|5|6
The following file(s) could not be uploaded because of one or more errors. Please correct and re-upload.

CSV import errors are encountered if leads, estimates and opportunity CSV files that have a character encoding option of UTF-8 are saved with ANSI encoding. The error is resolved if the special character for example 'ä', is removed from the CSV file.

Incorrect file encoding was used when the file is saved for import. When saving the file for import:

1. Open the CSV file in Notepad.
2. Select File > Save as.
3. In the Encoding dropdown list, select UTF-8.
4. Click Save.
5. Import this file using the Import Assistant.

Mandatory field missing for field "XXXX"

The file might contain extra commas. When you open a CSV file in Excel, extra commas are not visible. However, extra commas are visible when you open the file in Notepad.

Use Notepad or a similar application to open the CSV file and look for extra commas.

You do not have permissions to set a value for element XXXX due to one of the following reasons: 1) The field is read-only; 2) An associated feature is disabled

To resolve the error, in the Import Assistant, expand the Advanced Options menu and check Ignore Read-Only Fields. This option is enabled by default; however, for existing imports, Ignore Read-Only Fields is disabled.

Invalid effective date reference key

The error occurs when the date format of the Effective Date column in the CSV file is inconsistent with the date format used in the Date Format field found in Home > Set Preferences > General, in the Formatting field group.

To resolve the issue, do one of the following:

- Modify the Date Format in the CSV file to match the format in NetSuite.
- Modify the Date Format in the NetSuite preferences to match the format in the CSV file.
- Modify the Effective Date value during field mapping by clicking the edit icon and setting a default value that matches the date format of the NetSuite preferences.

Excel converts value from text to date format

The format conversion happens when:

1. A value is initially formatted as text
2. The file is saved as a CSV file.
3. Excel incorrectly converts the value to the date format.
4. The file is opened again.

If the CSV file is saved again, it retains the incorrect formatting. Then, if that file is used in a CSV import, an invalid reference error is received.

To prevent Microsoft Excel from automatically converting text values to the date format, enter an equal sign with quotation marks on the value. This notation forces the use of the text format.

For example, to enter Sept 2013, in Excel, enter " Sept 2013". Note the space after the quotation marks.

A Saved Search with Internal ID xxx does not exist

The error is triggered by a custom field on the form that pulls its value from the results of a saved search and one of the following conditions is met:

- The saved search is inactive or no longer exists
- The saved search is set to private and the user running the CSV import does not belong to the search’s audience

To resolve the error, the administrator needs to ensure that:

1. The saved search is active, and
2. The user has access to the saved search (either the saved search is public or the user belongs to the audience for the search). For more information, see Defining Audiences for Saved Searches.

Please enter a value for amount

The error occurs when:

- the import contains duplicate records, for example duplicate items when importing sales order. Remove duplicate records to resolve.
- the format of the data in the CSV file is not recognized. Set formatting on the amount column.

To format the Amount column in the CSV file:

1. Select the column.
2. Right-click and select Format Cells.
3. On the Number tab, select Number.
4. Click OK.
5. Save the file.

Also ensure that there are no zero values in the Amount column. Some imports require that the amount not be zero.

There is already a Custom Record Entry with that name

The error occurs when the external ID is specified in the CSV file. The external ID serves as a reference key and should be unique for each record type. To resolve the error, make sure that the external ID has not yet been used for another record.
Different number of columns than in the header row

This error occurs if a row in the CSV file contains more values than the specified header row. Consider the following example.

The first row leads to an error because it contains more columns than the number of headers. The second row contains data for all columns, therefore it does not lead to an error. The third row is also processed correctly because the CSV file does not need to contain data in all rows for all columns.

<table>
<thead>
<tr>
<th>Name</th>
<th>Country</th>
<th>Item</th>
<th>&lt;empty header&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>USA</td>
<td>Travel kit — medium</td>
<td>TAX-CA-125</td>
</tr>
<tr>
<td>Katherine Thomas</td>
<td>France</td>
<td>Travel kit — large</td>
<td></td>
</tr>
<tr>
<td>Jane Murray</td>
<td>USA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

AfterSubmit Script failed, record created with internalId xxx

When an afterSubmit script runs after a CSV import, and the script fails, the records are still created or updated in NetSuite. The CSV response indicates that the record has been created or updated even if an afterSubmit script that runs after the CSV import fails.

In this case, the CSV response contains a message similar to the following:

[AFTERSUBMIT Script failed, record created with InternalId 123] You must enter at least one line item for this transaction.

This message indicates that the records have been saved, and you only need to retry the user event script, but should not run the CSV import again.

Note: For information about working with afterSubmit scripts, see the help topics afterSubmit(scriptContext) and SuiteScript 2.0 User Event Script Type.

Employee Import Errors

This section describes errors that you might see on an employee import. See the following:

- Please enter value(s) for: Currency
- Invalid category reference key xx
- Expense Categories – The field name contained more than the maximum number (61) of characters allowed
- Invalid employee reference key xx

Please enter value(s) for: Currency

When adding a new Expense Report, the error occurs if Use Multicurrency is checked on the Expense Report form and no currency information was mapped or provided in the Import Assistant.

To resolve the error, choose one of the following options.

**Option 1:** Disable the Use Multicurrency Expense Reports preference.

1. Go to Home > Set Preferences.
2. On the General subtab, in the Defaults field group, clear the **Use Multicurrency Expense Reports** box.
3. Click **Save**.

**Option 2:** Edit the CSV file and add a Currency column.

**Option 3:** Enter a default value in the Expenses 1 : Currency field on the Field Mapping page of the Import Assistant.

1. On the Field Mapping page, click the edit icon beside Expenses 1 : Currency.
2. Click **Provide Default Value**.
3. Select **USD** from the dropdown list.
4. Click **Done**.

**Option 4:** Edit the CSV file and add a Use MultiCurrency column with a value of **No**.

**Option 5:** Provide a default value to the Use MultiCurrency field on the Field Mapping page of the Import Assistant.

1. On the Field Mapping page, click the pencil button beside **MultiCurrency**.
2. Click **Provide Default Value**.
3. Select **No** from the dropdown list.
4. Click **Done**.

**Invalid category reference key xx**

To resolve the error:

1. Make sure that the Expense Category is active. Go to Setup > Accounting > Expense Categories. Check the **Show Inactives** box.
2. If Expense Category Names are being used, the format of the field must be the same as the Category dropdown list displayed on the Expense Report Form. Go to Transactions > Employees > Enter Expense Reports > Expenses.
3. Expense category internal IDs can be used instead of names. On the Field Mapping page, click the edit icon beside the **Category** field, click **Choose Reference Type**, and select **Internal ID**.

**Expense Categories – The field name contained more than the maximum number (61) of characters allowed**

The Expense Account field on expense category records should contain a maximum of 61 characters, including spaces and symbols.

Edit the CSV file to ensure that the Expense Account field is not longer than 61 characters.

**Invalid employee reference key xx**

The error may occur when doing a time track record type import. To resolve the error, the Employee value in the CSV import file should contain either:

- **Employee Internal ID** - This option is highly recommended and avoids errors with incorrect employee names; or
Employee Name – This field should use the same format as the Employee field in the Time Tracking Form.

Depending on which employee value was entered in the CSV file, on the Field Mapping page, click the edit icon beside the Employee field and set Choose Reference Type to either Internal ID or Names.

Relationship Import Errors

This section describes errors associated with relationship imports, including the following record type imports:

- General Relationship Import Errors
- Customer Import Errors
- Customers and Contacts Import Errors
- Prospects and Contacts Import Errors

General Relationship Import Errors

This section describes errors that you might see on a relationship import. See the following:

- Invalid Lead Source Reference Key
- You have entered an Invalid Field Value incoming for the following field: email

Invalid Lead Source Reference Key

The error can occur when importing entity records that include assigning lead sources.

Common causes of this error include the following:

- The values in the CSV file do not match the values in the Lead Sources list, for example, typographical errors.
- The lead source value in the CSV file does not exist in the Lead Sources list.
  - If Marketing Automation is enabled, the list can be found in Lists > Marketing > Marketing Campaigns. To add a new Lead Source, create a campaign.
  - If Marketing Automation is disabled, go to Setup > Sales > CRM Lists > New. To add a new Lead Source, click Lead Source.
- The lead source value in the CSV file does not match the naming convention in the Lead Sources list. If the Lead Source name contains Campaign ID + Title, then the CSV file must have the same value.
  
  For example:
  
  1 LeadSource
  34 OnlineForm

You have entered an Invalid Field Value incoming for the following field: email

When importing entity records or performing a relationship import type, the following error appears when you click Next on the Field Mapping page:
Column: Email. Value: null. Error: You have entered an Invalid Field Value incoming for the following field: email

Check the CSV file to ensure that an email address exists in the email column for each record, and its format is correct (for example, abc123@yahoo.com).

This entity already exists.

When performing an import to update the external ID of leads, prospects, or customers, the error occurs if there is another entity that already uses that external ID.

To find the record that uses that external ID, create a saved search for an entity:

1. Go to Lists > Search > Saved Searches > New.
2. Click Entity.
3. Enter a title for the search.
4. On the Criteria > Standard subtab, add the following filter:
   - External ID is XXXXX (where XXXXX is the external ID used in the CSV file that had the error)
5. On the Results > Columns subtab, add the fields to display in the search result, for example:
   - ID
   - Name
   - Type
6. Click Save & Run.

The duplicate external ID can be edited in the CSV file to add a character.

Customer Import Errors

This section describes errors that you might see on a customer import. See the following:

- Could not find matching record. Primary name field was not mapped or is empty.
- Please set value for Type
- The field vateregnumber contained more than the maximum number (20) of characters allowed.
- The country and state/province are mismatched, the country is US and the state/province is XX. Please enter a state/province short name that matches the country.
- Invalid isperson reference key (customer name)
- Illegal ID. Please enter a name.

Could not find matching record. Primary name field was not mapped or is empty.

The error occurs if the company name or another field on the customer record is used as a reference key when updating the customer record.

There are only three reference keys that can be used when updating a customer record: internal ID, external ID, or customer ID.
Note: A 'Matched more than one record' error is encountered if:

1. The customer record being updated has a parent customer with several child customers.
2. The Data Handling specified is Add or Update.
3. Child of is mapped.
4. None of internal ID, external ID, or customer ID are mapped.

Please set value for Type

To resolve the error:

1. Go to Setup > Customization > Entry Forms.
2. Edit the preferred Customer, Lead, or Prospect form.
3. On the Customize Form page, select Fields > Main.
4. Find the Type field and clear the Mandatory box.
5. Click Save.

The field vatregnumber contained more than the maximum number (20) of characters allowed.

This error might occur on the Field Mapping page of the Import Assistant when updating the Tax Reg. Number field in customer records.

The vatregnumber field is the field ID of the Tax Reg. Number field. The maximum number of characters allowed for this field is 20 characters. Edit the CSV file and ensure that the Tax Reg. Number field is no more than 20 characters.

The country and state/province are mismatched, the country is US and the state/province is XX. Please enter a state/province short name that matches the country.

If you are adding new customer records and the Country field is not available on the Field Mapping page, the country might not be shown. You can verify by checking the Address subtab of a customer record to see if the Country field is available.

To make the country available, perform the following steps:

1. Go to Setup > Customization > Address Form.
2. Check the Show box for the Country field.
3. Click Save.

Invalid isperson reference key (customer name)

The error may occur when importing customer records. The isperson field is the field ID of the Company Type field. An individual or a company should be specified on the import.

To correct the error:

1. Run a CSV import, specifying a Relationships import type and Customers record type.
2. Set the Data Handling field to Add.
3. Map all mandatory fields.
4. Map Individual (Req) or click the edit icon and select Yes or No.
5. Complete the import.

**Illegal ID. Please enter a name.**

The error occurs when the following conditions are met:

1. On Setup > Company > General Preferences, the Default Customer Type field is set to Individual.
2. The Type field is not exposed on the form selected in Custom Form.

To correct the error:

1. Go to Customization > Forms > Entry Forms.
2. Edit the custom form that was selected in step 2 of the CSV import on the Advanced Options menu.
3. On the Fields > Main subtab, check the Show box for the Type field.
4. Click Save.

**Customers and Contacts Import Errors**

This section describes errors that you might see on a customers and contacts import. See the following:

- Illegal ID. Please enter a name.

**Illegal ID. Please enter a name.**

The error occurs when all of the following conditions exist during the import to add a new customer:

- The customer type is Individual.
- A contact record is also added.
- In the Import Assistant, the record type selected is Customers and Contacts Together.

It is not possible to add individual customers and contacts together. The Customers and Contacts Together record type should only be selected in the Import Assistant for customers that have the Company customer type.

To resolve the error and successfully add the individual customer record, in the Import Assistant, choose the following:

- Import Type = Relationships
- Record Type = Customers Only

**Prospects and Contacts Import Errors**

This section describes errors that you might see on a prospects and contacts import. See the following:

- That Record Does Not Exist
That Record Does Not Exist

The error occurs when phone numbers are not mapped correctly.

To correct the error:

1. Go to Lists > Search > Saved Searches > New.
2. Click Customer.
3. On the Criteria > Standard subtab, add the following filters in addition to any other required fields:
   ▪ Stage is Prospect
4. In the Results > Columns subtab, add the following fields:
   ▪ Name
   ▪ Phone Number
   ▪ Contact Fields: Name
   ▪ Contact Fields: Internal ID
   ▪ Other required fields
5. Click Preview.
6. Click Export - CSV.
7. Save the CSV file.
8. Open the CSV file and edit as required (for example, update the phone number field).
9. Save the CSV file.

When importing the CSV file, map the fields as follows:

<table>
<thead>
<tr>
<th>Your Fields</th>
<th>NetSuite Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal ID</td>
<td>Internal ID (Internal ID of Prospect)</td>
</tr>
<tr>
<td>Company</td>
<td>Company Name (Prospect Folder)</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone (Prospect Folder)</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact (Contact Folder)</td>
</tr>
<tr>
<td>Contact Phone Number</td>
<td>Main Phone (Contact Folder)</td>
</tr>
<tr>
<td>Internal ID of Contacts</td>
<td>Internal ID (Contact Folder)</td>
</tr>
</tbody>
</table>

Items Import Errors

This section describes errors that you might see on an items import. See the following:

- General Item Import Errors
- Assembly Item Import Errors
- Item Demand Plan Import Errors
- Inventory Detail Import Errors
- Inventory Item Import Errors
Items Import Errors

General Item Import Errors

This section describes errors that you might see on an item import. See the following:

- Please Enter Missing Price(s)
- Invalid Purchaseunit Reference Key
- Invalid Custitem Reference Key xxx
- Invalid Item Reference Key xx
- Adding New Line to Sublist Locations is not Allowed
- You cannot remove subsidiary: xxx because this record is used on a transaction for subsidiary: xxx
- Please enter value(s) for: Type
- If you are not replacing the entire matrix you may only update existing headers. X is not in the existing matrix
- Invalid assetaccount reference key xxx or Invalid cogsaccount reference key xxx
- Unexpected Error
- Invalid price level reference key XXX
- 'Invalid parent reference key' on Item Record Import
- Could not find any records by this name
- You have entered an Invalid Field Value for [CostEstimate]
- Invalid Parent Reference Key

Please Enter Missing Price(s)

The error occurs when the quantity imported is more than zero, for example, Qty 1, whereas Qty 0 does not have any quantity pricing information set in the item record.

To resolve this error, import pricing quantity information first for Qty 0. Both Qty 0 and Qty1 quantity information can be imported at the same time.

Invalid Purchaseunit Reference Key

You might receive one of the following errors: Invalid purchaseunit reference key xx for unitstype <NULL>, Invalid saleunit reference key xx for unitstype <NULL>, or Invalid stockunit reference key xx for unitstype <NULL>

The error occurs when the Purchase Units, Sales Unit, or Stock Units field is updated without mapping the Units Type field. The Units Type field is set to Null (Blank) on the item record. To resolve the error, include the Units Type field on the Field Mapping page as shown below, selecting the appropriate unit type:

Internal ID = Internal ID
Purchase Units = Purchase Units
Sales Units = Sales Units
Stock Units = Stock Units
Invalid CustItem Reference Key xxx

The xxx refers to the customized field. When this error message is encountered, NetSuite cannot find the values on the customized field included on the CSV file.

To correct the error:

1. Go to the list for the type of custom field mentioned in the error message. Go to Customization > Lists, Records, & Fields > [Field Type].
2. Open the CSV file.
3. Check the values entered in the CSV file. Make sure the values are consistent with the values in NetSuite:
   - Consistency of spaces before and after the values.
   - Ensure values are spelled correctly.
   - Check consistency of uppercase and lowercase letters.
   - Make sure values exist in NetSuite, and add to the list if necessary.
   - When importing multi-select fields, check that the multi-select value delimiter specified in the import advanced options matches the delimiter used in the CSV file.
4. If there are other custom fields on the file, verify the formatting of them.

Invalid Item Reference Key xx

The error occurs when adding related items data to an item record. The Import Assistant supports the import of related item sublist data for item records when the Web Site feature is enabled. Related Items data are mapped to the NetSuite field Presentation Items 1 : Item (Req) and you have the option to choose the following reference types:

1. Names (Item Name/Number or Web Store Display Name*).
2. Internal ID.

The error occurs when Name is chosen as the reference type for the following reasons:

1. The Item Name/Number was incorrectly used (for example, misspelled or incorrect Item Name/Number).
2. The Internal ID was used.
3. The Item Name/Number is used correctly but there is a value set on the Web Store Display Name of the related item record. Use the Web Store Display Name instead of the Item Name/Number.

Adding New Line to Sublist Locations is not Allowed

The error occurs when the Location sublist field is not mapped.

To resolve the error, when updating fields that are updateable per location, the Location sublist must also be mapped. When importing Preferred Stock Level, Quantity on Hand, and Reorder Point, map...
the Location sublist, which is a keyed sublist (key icon). The Location field can be based on internal ID, external ID, or location name.

**You cannot remove subsidiary: xxx because this record is used on a transaction for subsidiary: xxx**

The error occurs when updating or adding another subsidiary on an item record.

Enter the information in the CSV file as shown in the following example.

<table>
<thead>
<tr>
<th>Name</th>
<th>Subsidiary</th>
</tr>
</thead>
</table>

Because the Subsidiary field in the item record is a multi-select field type, values in the CSV file are entered in one row with a delimiter, for example, the pipe, (|).

On the File Mapping page, set Name to Item Name/Number and Subsidiary to Subsidiary.

**Please enter value(s) for: Type**

The error appears when no type is selected for the related items being imported. To find the Type field for related items on the Field Mapping page, open Items Presentation Items > Item Presentation Item 1.

When performing the import, use the following settings:

- Set **Data Handling** to **Update**. Only existing items can be added as a related item.
- On the Field Mapping page, ensure the following fields are mapped:
  - **Internal ID** = Internal ID Internal ID of the main item.
  - **Item Number** = Presentation Items 1: Item Number of the related item.
  - **Type** = Presentation Items 1: Item Set this field manually or through a CSV field.

**If you are not replacing the entire matrix you may only update existing headers. X is not in the existing matrix**

Verify the following settings:

- In the CSV file, include all existing prices for each quantity.
- Set **Data Handling** to **Update**.
- On the Advanced Options menu, check the **Overwrite Sublist** box.
- Map the fields. All quantity pricing must be included in the mapping.

**Invalid assetaccount reference key xxx or Invalid cogsaccount reference key xxx**

The error occurs when updating the asset or COGS account on Item record. There are three options to set a value on the Asset Account or COGS Account field.

Choose an option:

1. Use the internal ID of the account. On the Field Mapping page, click the edit icon beside the **Asset Account** field. Click **Choose Reference Type**, and then select **Internal ID**.
2. Use the account name. In the CSV file, the asset account should have the same format used in NetSuite.
   a. Go to Lists > Accounting > Items.
   b. Click Edit on any item record.
   c. In the Asset Account field on the Accounting subtab, copy the format of the field to the CSV file. The format used is as follows:
      - Account Number is not enabled: Parent Account
      - Account Number is enabled: Number Parent Account
      - Account Number is not enabled and there is a Child Account: Parent Account : Child Account
      - Account Number is enabled and there is a Child Account: Number Parent Account : Child Account

3. Set a default value for the asset or COGS account. This option is feasible if the same asset or COGS account is to be set on all of the item records. On the Field Mapping page, select Asset Account or COGS Account under NetSuite Fields. Click the edit icon, click Provide Default Value, and select the asset or COGS account.

Unexpected Error

The error occurs when the Item Name field and the Store Display Name field are mapped. Ensure that the Item Translation : Language field is also mapped.

Invalid price level reference key XXX

Use one of the following options to resolve the error.

Option 1

1. Go to Setup > Accounting > Accounting Lists.
2. Set Type to Price Level.
3. Make sure that the Price Level set in the CSV file is:
   a. Not set to Inactive
   b. Correctly spelled

Option 2

When performing the import, on the Mapping Page:

1. Select Item Pricing > Item Pricing 1.
2. Map Pricing 1 to Price Level (Req).
3. Click the edit icon and select the correct Price Level from the dropdown list.

'Invalid parent reference key' on Item Record Import

The error occurs when the parent item being referenced is of a different item type (for example, Inventory, Description, and so on) than the item being imported. The parent item must be the same type (for example, Inventory, Non-Inventory, Description, and so on) as the items being imported.

There are two ways to resolve this error:
Option One

If the parent item being referenced has been set up with the incorrect item type, delete or inactivate the parent item, and then recreate it.

1. Go to List > Accounting > Items.
2. Check the **Show Inactives** box.
3. Choose an option:
   - Inactivate the parent item by checking the **Inactive** box.
   - Delete the item by editing the item and selecting More Actions > Delete.
4. Go to Lists > Accounting > Items > New.
5. Create the correct item type.

Option Two

If the parent item being referenced has been set up correctly, select the appropriate record type in the Import Assistant.

Could not find any records by this name

The error occurs when updating child matrix items.

In the CSV file, enter a separate column for the parent matrix item and another for the child matrix item. The CSV file will look like the following:

<table>
<thead>
<tr>
<th>Item Name/Number</th>
<th>Subitem of</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child item</td>
<td>Parent item</td>
<td></td>
</tr>
</tbody>
</table>

The previous example assumes that the Department field is being updated on the Child Matrix Item record.

Also, in the Item Name/Number column, the Parent : Child format should not be used. The Child Matrix Item Name is entered without the Parent Matrix Item name. For example, use Basket rather than Containers : Basket.

You can also use the internal ID of the child matrix item.

Go to Home > Set Preferences > General. In the Defaults field group, check the **Show Internal Ids** box to show the internal id on a list.

You have entered an Invalid Field Value for [CostEstimate]

When trying to update the item defined cost, the error appears even though the field has the correct currency amount.

A sample CSV file has the following columns:

- Internal ID
- Name (Item Name)
- Cost Estimate Type = Item Defined Cost
- Item Defined Cost = $123.00

Make sure the column **does not have the $ symbol**. The field in NetSuite holds the amount without the currency symbol.
On the Mapping Page, check the format of the Item Defined Cost field, select **Currency with Symbol** and set it to **None**.

**Invalid Parent Reference Key**

The error occurs because the **Show Display Name with Item Codes** option is enabled in General Preferences.

There are two ways to resolve this error:

- Disable the **Show Display name with Item Codes** option in General Preferences.
- Update the CSV file used for the import to include the item name/number display name/code. External ID and Matrix Option fields are still required.

**Assembly Item Import Errors**

This section describes errors that you might see on an assembly item import. See the following:

- **Please select member items before submitting**
- **An Unexpected Error has Occurred**

**Please select member items before submitting**

When member items are created in a separate CSV file, there needs to be a linking column: Assembly Item: External ID, Internal ID or Name.

When performing the import, ensure that the following options are specified:

- Import Type – enter Item
- **Record Type** – enter Assembly/BOM Item
- Click **Multiple Files to Upload**
  - For Primary File - Item, select the file with the Assembly Item
  - For Linked File (Optional) - Item Members, select the file with member items
- Data Handling – click **Add**
- Map all Assembly Item fields with fields from the Item folder
- Map the Member Items name and quantity with Item (Req) and Quantity in the Item Members folder

**An Unexpected Error has Occurred**

This item type (Assembly, subtype) is missing a required unit parameter. Instead of Assembly, InvtPart might be listed.

To resolve the error:

1. Check the assembly record and its component records to determine if the following fields have values:
   - Unit Type
   - Stock Units
   - Purchase Units
■ Sales Units
- Enter values on these fields.
- If the fields have values and you are still experiencing the error, click **Edit** to edit the assembly. Without making any changes, save the assembly record and its components.

### Item Demand Plan Import Errors

This section describes errors that you might see on an item demand plan import. See the following:

- **Could not find record with internal ID = xxx**
- **Invalid start date ref key mm/dd/yyyy**

#### Could not find record with internal ID = xxx

The error occurs when importing the Item Demand Plan. To resolve the error, map the internal ID of the item demand plan record to the field: Demand: Item (Req).

The internal ID of the item demand plan record serves as the identifier to complete the import. Updating an Item Demand Plan through the user interface requires that you edit and overwrite the existing record. This concept also applies when performing a CSV import of the Item Demand Plan.

#### Invalid start date ref key mm/dd/yyyy

The error occurs when the plan start date falls on a year ahead of the current year, and both the year and plan end date fields are not included in the mapping.

You can see these dates in the UI. For example, the current year is 2013, and you want to create a new item demand plan with a start plan date of 1/1/2014, and an end plan date of 12/31/2014.

Go to Transactions > Demand Planning > Item Demand Plans > New. The default fields in the header show:

- **Year** = 2013
- **Start Date** = 1/1/2013
- **End Date** = 12/31/2013

Change the **Start Date** field to 1/1/2014. Notice the following:

- **Year** field becomes null.
- **End Date** remains at 12/31/2013. It does not automatically update to 12/31/2014
- No Monthly/Weekly Start Date and End Dates appear.

To resolve the issue:

- Map the **Year** to 2014
- Map both **Plan Start Date** and **Plan End Date** in the CSV Import.

### Inventory Detail Import Errors

This section describes errors that you might see on an inventory detail import. See the following:
Unable to Import Inventory Worksheet due to CSV Response/Error message ‘Please configure the inventory detail for “Item xxx”’

To perform the inventory worksheet import:

1. Go to Setup > Accounting > Accounting Preferences > Items/Transactions.
2. Clear the **Require Bins on All Transactions Except Item Receipts** box and save.
3. Proceed with the CSV import of the Inventory Worksheet.
4. Return to Setup > Accounting > Accounting Preferences > Items/Transactions and check the **Require Bins on All Transactions Except Item Receipts** box.
5. Click **Save**.

Inventory Item Import Errors

This section describes errors that you might see on an inventory item import. See the following:

- **Invalid Locale Reference Key XX**
- **The record you are attempting to load has a different type: inventoryitem from the type specified: serializedinventoryitem**
- **The following CSV file(s) have errors in them and can't be imported into the system: Multiple values found for a dropdown field that can only take one when importing a record with External ID that uses special character**

**Invalid Locale Reference Key XX**

The error occurs when:

1. The Multi-Language feature is enabled, and
2. You are creating an inventory item, and
3. The CSV file contains following columns:
   - Item Name
   - Purchase Tax Code
   - Sales Tax Code
   - Quantity On Hand
   - Price
   - Price Level
   - Location
   - Translation Language
   - Translation Display Name

To resolve this error, first import the item without the translation, and then update the imported items with the translation data.
**Importing the Item**

To import the item, ensure that you choose the following options:

- Set **Data Handling** to **Add**.
- On the Field Mapping page, set the following:
  - Item Name = Item Name/Number
  - Purchase Tax Code = Purchase Tax Code
  - Sales Tax Code = Sales Tax Code
  - Quantity On Hand = Locations 1: Quantity on Hand
  - Location = Locations 1: Location
  - Price = Pricing 1: Price (Req)
  - Price Level = Pricing 1: Price Level
- If Quantity Pricing is enabled, add the following field to the mapping:
  - 0 = Pricing 1: Quantity (Reg)

**Update the Imported Items**

Next, update the imported Items with the translation data using the same CSV file, but with different data handling, and different mapping.

- Set **Data Handling** to **Update**.
- On the **Field Mapping** page, set the following:
  - Item Name = Item Name/Number
  - Purchase Tax Code = Purchase Tax Code
  - Sales Tax Code = Sales Tax Code
  - Translation Language = Translation 1: Language
  - Translation Display Name = Translation 1: Display Name

**The record you are attempting to load has a different type:**

**inventoryitem from the type specified: serializedinventoryitem**

The record type selected in the Import Assistant must be the same as the item type. The error states that the inventory item is to be updated, but the record type selected was serialized inventory item. Ensure that you select the inventory item record type for the import.

**The following CSV file(s) have errors in them and can’t be imported into the system:**

**Multiple values found for a dropdown field that can only take one when importing a record with External ID that uses special character**

To remove the field mapping error, select the items import type and inventory item record type.

On the Advanced Options menu, set the **Custom Multi-Select Value Delimiter** field to any special character that is not used in the string "SNG-EDUC|SKU-1004921210/08/2010|14:06:00"
For example, do not use the pipe (|) or slash (/). Also, do not use a space as a delimiter.

Setting the Custom Multi-Select Value Delimiter field to NULL results in an error because NetSuite considers it to be the same as Space.

Kit/Package Import Errors

This section describes errors that you might see on a kit or package import. See the following:

- **Invalid item reference key xx**

Invalid item reference key xx

To resolve the error, verify the following:

- In the CSV file, enter the same format for the member item that is shown in the Item dropdown list in Lists > Accounting > Items > Kit/Package > Purchasing/Inventory.
- Internal ID can be used instead of member item name. To use the internal ID, on the Field Mapping page, click the edit icon for the Members xx : Item (Req) field and Choose Reference Type = Internal ID.
- Verify that the member item exists and is active.

Transactions Import Errors

This section includes errors that you might encounter when performing a transactions import:

- General Transaction Import Errors
- Customer Payment Errors
- Invoice Import Errors
- Journal Entry Import Errors
- Purchase Order Import Errors
- Sales Order Import Errors
- Vendor Bills Import Errors
- Vendor Payment Import Errors

General Transaction Import Errors

This section describes errors that you might see on any transaction import. See the following:

- You must map one of the following NetSuite fields to a column in your CSV file, to be a unique identifier: External ID, Internal ID, or a transaction number field, such as Order # or Invoice #
- Adding Multiple Line Items with the Same Item on a Transaction Through CSV Import Throws Ambiguity Error
- This record already exists
- Date field not in your preferred date format for field “Date” – You have entered an Invalid Field Value x/x/xxxx for the following field: trandate
- Total contribution for sales reps cannot exceed 100%
You must map one of the following NetSuite fields to a column in your CSV file, to be a unique identifier: External ID, Internal ID, or a transaction number field, such as Order # or Invoice #

The error occurs when clicking Next on the Field Mapping page.

To import new transactions, at least one of the following NetSuite fields must be mapped on the Field Mapping page to uniquely identify transactions:

- External ID (for more information, see the help topic External IDs Overview).
- Internal ID (for more information, see the help topic Setting the Internal ID Preference.)
- Order #, Invoice #, or another transaction number field

For more information, see also Select Reference Types.

Adding Multiple Line Items with the Same Item on a Transaction Through CSV Import Throws Ambiguity Error

The error occurs when you are adding line items to an existing transaction (for example, sales order). The line item information in the CSV import uses the same item record, as shown in the following example.

The sales order has the following items:

- Item X -- Quantity 1
- Item Y -- Quantity 2

You want to update the sales order to:

- Item X -- Quantity 10
- Item X -- Quantity 11
- Item X -- Quantity 12

To perform the import:

1. Create a CSV file that has the Line ID column. Set the column value as blank.
   Sample CSV file format
   Sales Order's Internal ID, Item Name, Quantity, Price, Tax Code, Line ID

   **Note:** The Line ID of new items can be assigned a new value. The system will know these new items are added in the same transaction. For example, the last line ID in the transaction is 10. To avoid the ambiguity error, assign a Line ID of higher than 10.

2. Go to Setup > Import/Export > Import CSV Records.
3. In the Import Type field, select Transactions.
4. In the Record Type field, select the transaction type, for example, Sales Order.
5. Locate and open the CSV file, and then click Next.
6. Set the Data Handling field to Update, and then click Next.
7. On the Field Mapping page, map the following fields:

<table>
<thead>
<tr>
<th>Your Fields</th>
<th>NetSuite Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>SO Internal ID</td>
<td>Internal ID</td>
</tr>
</tbody>
</table>
This record already exists

The error appears if the external ID was already used in a previous transaction. To successfully import the transaction, use a unique external ID.

Use a saved search to see if an external ID is already used in the system.

1. Go to Lists > Search > Saved Searches > Net.
2. Click Transaction.
3. On Criteria > Standard subtab, add a filter of External ID = XXX (where XXX is the external ID that had the error).
4. Click Preview.

Date field not in your preferred date format for field "Date"
– You have entered an Invalid Field Value x/x/xxxx for the following field: trandate

In the CSV file, highlight the Date column and ensure that the format is the same as the Date field in the Time Tracking Form found in Transactions > Employees > Track Time.

Total contribution for sales reps cannot exceed 100%

The error occurs when the sales team assigned to the record you are updating or creating has a contribution percentage of greater than 100.

When creating a transaction record, this error usually occurs because in the Advanced Option menu, you did not check the Overwrite Sublists box.

If Overwrite Sublists is not checked, then the system will try to use the sales team currently assigned to the entity and any sales representatives in your CSV file.

Customer Payment Errors

This section describes errors that you might see on a customer payment import. See the following:

- Could not find record with Internal ID = xxxx

Could not find record with Internal ID = xxxx

The error can occur when you link a Customer Payment to an invoice. NetSuite looks for a record with an internal ID that does not exist in the system.
Use the correct internal ID of the Customer Payment and the Invoice.

To show the internal ID in the list of transactions:

1. Go to Home > Set Preferences > General.
2. Check the Show Internal IDs box.
3. Click Save.

The system will give priority to using the internal ID to locate the transaction rather than the payment's external ID.

Invoice Import Errors

This section describes errors that you might see on an invoice import. See the following:

- You must enter at least one line item for this transaction
- Unable to find a matching line for sublist apply with key: [doc,line]
- Invalid item reference key xx

You must enter at least one line item for this transaction

When importing a new invoice, the error is received if a default value was entered in the Items: Item (Req) NetSuite field on the Field Mapping page of the Import Assistant.

If you are importing an invoice with a single item, it must be referenced in the CSV file as a separate column.

Set Data Handling to Add, and then on the Field Mapping page, map the following fields:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer (Req)</th>
</tr>
</thead>
<tbody>
<tr>
<td>External ID</td>
<td>External ID</td>
</tr>
<tr>
<td>Location</td>
<td>Location (Req)</td>
</tr>
<tr>
<td>Date</td>
<td>Date (Req)</td>
</tr>
<tr>
<td>Item</td>
<td>Items: Item (Req)</td>
</tr>
</tbody>
</table>

Unable to find a matching line for sublist apply with key: [doc,line]

The error occurs when there are multiple invoice numbers being matched to a single credit memo. If the invoice internal ID is listed multiple times, NetSuite looks for corresponding amounts for the other lines, which do not exist.

For example, there are three items on a credit memo and it is being applied to a single invoice. The CSV file contains the following information:

<table>
<thead>
<tr>
<th>Invoice Internal ID</th>
<th>Credit Memo Internal ID</th>
<th>Customer Name</th>
<th>Amount Applied</th>
</tr>
</thead>
</table>
Transactions Import Errors

<table>
<thead>
<tr>
<th>Invoice Internal ID</th>
<th>Credit Memo Internal ID</th>
<th>Customer Name</th>
<th>Amount Applied</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234</td>
<td>5678</td>
<td>John Smith</td>
<td></td>
</tr>
</tbody>
</table>

This will generate the error. To resolve the error, modify the CSV file as follows:

<table>
<thead>
<tr>
<th>Invoice Internal ID</th>
<th>Credit Memo Internal ID</th>
<th>Customer Name</th>
<th>Amount Applied</th>
</tr>
</thead>
<tbody>
<tr>
<td>1234</td>
<td>5678</td>
<td>John Smith</td>
<td>300</td>
</tr>
<tr>
<td>5678</td>
<td></td>
<td>John Smith</td>
<td></td>
</tr>
<tr>
<td>5678</td>
<td></td>
<td>John Smith</td>
<td></td>
</tr>
</tbody>
</table>

There should be one invoice internal ID for each line item. Since the invoice has one line item, the invoice is listed one time and the corresponding total amount being applied is also listed one time.

Invalid item reference key xx

The CSV file should contain the same Item Name format as shown in the Item dropdown list shown in Transactions > Sales > Create Invoices > Items > Items.

The internal ID can be used instead of the item name. On the Field Mapping page, click the edit icon beside the Item field, click Choose Reference Type, and then select Internal ID.

Determine if the item is inactive. If the item record is inactive, set its status to active:

1. Go to Lists > Accounting > Items.
2. Check the Show Inactives box.
3. Clear the Inactive box beside the item name.
4. Click Submit.

Journal Entry Import Errors

This section describes errors that you might see on a journal entry import. See the following:

- Invalid account reference key 'xxx' for subsidiary 'xxx'
- Invalid department reference key xxx
- No empty or blank headers are allowed in the CSV file
- Please enter the value(s) for Account
- Amortization end date cannot be before amortization start date
- Rounding Error xx.xx

Note: For information about other errors you might see on a journal entry import, search for the error message on SuiteAnswers.

Invalid account reference key ‘xxx’ for subsidiary ‘xxx’

To resolve the error, verify the format of the Account field, ensure that the account is active, and map the internal ID, if required.
First, verify that the format of the Account field in the CSV file uses the same format that is used in NetSuite:

2. From the Account dropdown list, select the account. Ensure that the format of the account in the CSV file matches the format of the account name displayed.

Next, determine whether the account is inactive.

1. First, ensure that internal IDs are displayed. Go to Home > Set Preferences > General.
2. In the Defaults field group, check the Show Internal IDs box and save.
3. Go to Lists > Accounting > Accounts.
4. Check the Show Inactives box.
5. Look for the Internal ID that was referenced in the error message.
6. Clear the Inactive box for the account. Also verify that the account is associated with the correct subsidiary.

If the internal ID is used, on the Field Mapping page, click the edit icon beside the Account field. Click Choose Reference Type, and then select Internal ID.

Invalid department reference key xxx

Verify the following for departments:

- Ensure that the department is spelled correctly. If a parent-child relationship exists, make sure that the names of the parent departments are included. For example, if Accounting is a child of Finance, the department must be entered as Finance : Accounting.
- Ensure that the department is active. Go to Setup > Company > Departments. Check the Show Inactives box and make sure that the department specified in the error message is not inactive.
- If internal IDs are used, on the Field Mapping page, click the edit icon beside the Department field. Then, click Choose Reference Type and select Internal Id.
- If external IDs are used, on the Field Mapping Page of the CSV import, click the edit icon beside the Department field. Then, click Choose Reference Type and select External Id.

Invalid entity reference key xx for currency xx

To correct the error, verify the following:

- Ensure that the entity record (customer, vendor, employee, other name) is active.
- Check to see how the entity record (customer, vendor, employee, other name) is listed in NetSuite, and ensure that the value in the CSV file has the same format.
- Check the entity record and makes sure that it has the same currency as the Journal Transaction Currency. You can assign the Currency as Secondary Currency in the entity record if its Primary Currency is different than the Transaction Currency.

No empty or blank headers are allowed in the CSV file

Ensure that you have included column headings in row 1 of your CSV file, similar to the following example.
Please enter the value(s) for Account

The error might appear even if the Account field has already been included in the field mapping. The error occurs when there is an extra line in the CSV file, usually a line or row for the total of both the Debit and the Credit columns.

Since one row is assigned per account line, the system treats this row as another account line and looks for the fields required in a Journal Entry import, including the Account field.

Modify the CSV file and remove the extra total row.

Amortization end date cannot be before amortization start date

The Start Date and End Date fields on a Journal Entry form are only available when the Revenue Recognition feature is enabled under Setup > Company > Enable Features > Accounting.

In the CSV file, check the dates entered in the Start Date and End Date columns. The start date must be before the end date. Modify the CSV file as needed.

Rounding Error xx.xx

To correct the error:
- Remove amounts with value = 0.00 in the Debit or Credit column.
- NetSuite formats columns to expose additional decimal places. When the file was exported from the source, NetSuite might still see additional decimal places in the Debit/Credit amount beyond the 0.00 shown in the CSV file.
- If there is already an amount on the Debit side for the line item that is greater than or less than zero, then there is no need to enter zero (0.00) in the Credit side, and vice versa.

Purchase Order Import Errors

This section describes errors that you might see on a purchase order import. See the following:
- Invalid entity reference key xxx

Invalid entity reference key xxx

To correct the error, verify the following.

1. Vendor names in the CSV file must be entered the same way they appear in the Vendor field on the Transactions > Purchases > Enter Purchase Orders page. If auto-generated numbering is enabled, the format will be Vendor ID Vendor Name.
2. The vendor record must be active. Go to List > Relationships > Vendors and check the **Show Inactive** box to see if the vendor is inactive.

3. Internal IDs of the vendors can also be used. If the CSV file contains the internal IDs, on the Field Mapping page, click the edit icon beside the **Vendor** field, click **Choose Reference Type**, and select **Internal Id**.

4. External IDs of the vendors can also be used. If the CSV file contains the external IDs, on the Field Mapping page, click the edit icon beside the **Vendor** field, click **Choose Reference Type**, and select **External Id**.

**Sales Order Import Errors**

This section describes errors that you might see on a sales order import. See the following:

- You must enter at least one line item for this transaction
- The record has been deleted since you retrieved it
- `TypeError: Cannot find function getFullYear in object NaN. (NLRecordScripting.scriptInit$sys#3881)`.
- Invalid item reference key xx
- Please choose an item to add
- Please enter value(s) for: `<Field XYZ>`

**You must enter at least one line item for this transaction**

The CSV file should include the value for the **Item** field, which should be mapped to the **Items : Item (Req)** field. There is no need to map the Line ID.

Even if you set a default value for one or more fields in a sublist, no sublist data is imported unless you map at least one field for that sublist.

**The record has been deleted since you retrieved it**

Ensure that the CSV import has been set up as follows:

1. Go to Setup > Import/Export > Import CSV Records.
2. Specify an import type of **Transaction** and a record type of **Sales Order**.
3. Specify data handling of **Update**.
4. On the Advanced Options menu, check **Overwrite Sublists**.

**Warning:** Use this option with extreme caution.

5. On Field Mapping page, ensure that Line ID is not mapped to anything.

**TypeError: Cannot find function getFullYear in object NaN. (NLRecordScripting.scriptInit$sys#3881).**

The error occurs when the date format entered in the **Date** field is incorrect. For example instead of entering a date of 3/29/2014 the date was incorrectly entered as 3/29/20014.

The `getFullYear()` function returns a four-digit year, and an error occurs if the year contains more than four digits.
Please specify either a terms parameter or a payment method parameter in the request but not both. When you import a sales order, the Terms and Payment Method fields cannot be mapped simultaneously. You can only map one of those fields on the Field Mapping page.

If you enter Terms on a sales order, an invoice is automatically generated when it is billed. If you enter a Payment Method, a cash sale is automatically generated when it is billed.

Invalid item reference key xx

Please verify your import using the following recommendations:

- The Item Name column in the CSV file should use the format that is used in NetSuite. Verify that the format in the file matches the format of the Item dropdown list in Transactions > Sales > Enter Sales Orders > Items > Items.
- Internal ID can also be used instead of Item Name. On the Field Mapping page, click the edit icon beside the Item field, click Choose Reference Type, and select Internal ID.
- Ensure that the item is active. Go to Lists > Accounting > Items. Check the Show Inactives box. If the item record is inactive, clear the Inactive box to make it active.

Please choose an item to add

The error might occur when incorrect item line IDs are entered in the CSV file. Create a saved search to extract the correct item line IDs.

To create the saved search:

2. On the Criteria > Standard subtab, add a filter Type of Sales Order.
3. On the Results > Columns subtab, add the Line ID field.
4. Modify the CSV file and enter the correct line ID of the items.

Please enter value(s) for: <Field XYZ>

In NetSuite, transactions like sales orders are stored with the forms when they are created. When performing an import to update sales orders, the validation for mandatory fields is not performed on the form selected on the Advanced Options menu of the import. Instead, mandatory fields are validated on the form where the record being updated is saved.

If a sales order was saved using a custom form, and later that form is customized to set a certain field to mandatory, you will get an error about missing field values.

The sales order cannot be updated via CSV import unless you perform one of the following:

- Set a value for the mandatory field specified in the error, or
- Clear the Validate Mandatory Custom Fields box on the Advanced Options menu.

⚠️ Important: This behavior applies only to CSV updates for transactions.

Vendor Bills Import Errors

This section describes errors that you might see on a vendor bills import. See the following:
You must enter a line item for this transaction

If you are importing vendor bills with expenses, use two files for the import.

1. One file for the bills that contains the following fields:
   - External ID (match to Vendor Bill: External ID)
   - Date
   - Memo
   - Reference No.
   - Vendor Internal ID
   - Posting Period
   - Terms
   - Due Date

2. One file for the expenses line that contains the following fields:
   - External ID (match the external ID in your file to the Line field of the Vendor Bill Expenses sublist)
   - Account
   - Total (Do not enter Amount as the column name.)
   - Memo

Multiple rows in your primary CSV file have the same value for the key column. Please edit this file to eliminate rows with duplicate key column values for field "ExternalId"

You may encounter the error if you are using multiple files to import vendor bills with expense line items, and you are using the external ID as the reference key.

Make sure that the Primary File - Vendor Bill does not contain more than one row with the same external ID.

Sample Correct CSV Import Files

*Primary File - Vendor Bill

<table>
<thead>
<tr>
<th>External ID</th>
<th>Vendor</th>
<th>Date</th>
<th>Posting Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB01</td>
<td>ABC Company</td>
<td>11/24/2012</td>
<td>Nov 2012</td>
</tr>
<tr>
<td>VB02</td>
<td>DEF Company</td>
<td>10/20/2012</td>
<td>Oct 2012</td>
</tr>
</tbody>
</table>
### Transactions Import Errors

<table>
<thead>
<tr>
<th>External ID</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>VB01</td>
<td>Selling</td>
<td>100</td>
</tr>
<tr>
<td>VB01</td>
<td>Amortization</td>
<td>200</td>
</tr>
<tr>
<td>VB01</td>
<td>Gas and Oil</td>
<td>300</td>
</tr>
<tr>
<td>VB02</td>
<td>Automobile</td>
<td>150</td>
</tr>
<tr>
<td>VB02</td>
<td>Amortization</td>
<td>250</td>
</tr>
<tr>
<td>VB02</td>
<td>Gas and Oil</td>
<td>350</td>
</tr>
</tbody>
</table>

**Your transaction does not balance. Please Adjust Expenses/Items.: userTotal:xx: totalField:xx**

When importing vendor bills, there are three Amount fields available on the Field Mapping page:

- Vendor Bill folder > Amount – The Amount field on the header of the bill record. This value is automatically computed by the system.
- Vendor Bill Expenses folder > Amount – The amount of each expense line added on the bill.
- Vendor Bill Items folder > Amount – The amount of each item added on the bill.

On the Field Mapping page, remove the mapping for the Amount field taken from the Vendor Bill folder. This value is automatically computed by the system, depending on the total of Expenses:Amount and/or Items:Amount fields.

### Invalid location reference key xx for subsidiary xx

The xx in the error message refers to the internal ID of the location and subsidiary.

In a OneWorld account, this error occurs when the subsidiary of the location selected does not match the transaction subsidiary. Choose another location for the vendor subsidiary that is valid.

To confirm, perform the following steps:

1. Go to Lists > Relationships > Vendors.
2. Open the vendor used in the CSV file.
3. On the vendor record, take note of the subsidiary assigned.
4. Go to Setup > Company > Locations.
5. Open the record of the location used in the CSV file.
6. In the location record, the subsidiary assigned does not match the vendor's subsidiary.

### You have entered an invalid field value for the following field: amount

Make sure that the Amount column does not contain a comma (,) as a separator or any currency symbols, for example, $.

---

*Linked File (Optional) - Vendor Bill Expenses*
Vendor Payment Import Errors

This section describes errors that you might see on a vendor payment import. See the following:

- Invalid account reference key Accounts Payable xx for entity xx
- Unable to find a matching line for sublist apply with key: [doc,line]
- One or more bills or invoices has had a payment made on it since you retrieved the form
- Adding new line to sublist apply is not allowed
- Unparseable Internal Id, did you mean to lookup this field by Name or External ID? for field xx

Invalid account reference key Accounts Payable xx for entity xx

The Accounts Payable account listed on the Transactions > Payables > Pay Bills page serves as the filter for bills available for payment.

If you use the internal ID to map the bill to be paid, you do not need to map the Accounts Payable account since the system will search for the bill and then in turn encounter the applicable AP account for the bill.

To resolve the error, remove the AP account from the field mapping.

Unable to find a matching line for sublist apply with key: [doc,line]

The error can occur when importing new customer or vendor payments and there are no open invoices with the internal ID or external ID specified in the CSV file.

In this situation you need to verify if:

- The payments being imported are applied to invoices that are open and not already paid with a status of Paid in Full.
- The internal ID or external ID specified in the CSV file corresponds to an existing open invoice in the system.

You can search for invoices using the external ID or internal ID. These are the only two reference fields that can be used to import vendor or customer payments, so use either the internal ID or external ID of the bill in the CSV file.

Perform one or more of the following procedures to verify the status of the invoices and resolve the error.

Use a Saved Search

To create a saved search that uses the external ID or internal ID of the invoice as a filter:

1. Go to Lists > Search > Saved Searches > New.
2. Click Transaction.
3. On the Criteria > Standard subtab, add Internal Id (Number) to use the internal ID of the invoice. You can also enter the external ID as a filter.
4. Click Save and Run. Look for the invoice and check its status.

Use the Invoice List

If you know the internal ID of the invoice that you want to verify, look for the invoice on the invoice list.
To use the invoice list:

1. Go to Home > Set Preferences > General.
2. Check Show Internal Ids and save.
3. Go to Transactions > Sales > Create Invoices > List. Look for the invoice and check its status.

**Use Accept Customer Payments**

1. Go to Transactions > Customers > Accept Customer Payments.
2. In the Customer field, enter the name of the customer.

**Use Vendor Bill Payments**

1. Go to Home > Set Preferences > General.
2. Check Show Internal Ids and save.
3. Go to Transactions > Purchases/Vendors > Enter Bills > List. Look for the bill and check its status.

**Use Pay Single Vendor**

1. Go to Transactions > Purchases/Vendors > Pay Single Vendor.
2. Enter the name of the Vendor in the Payee field.
3. Select the correct A/P account. Notice only open Bills appear on the Apply subtab.

**Use Pay Bills**

1. Go to Transactions > Purchases/Vendors > Pay Bills.
2. Select the correct A/P Account. Only open bills appear on the Apply subtab.

**One or more bills or invoices has had a payment made on it since you retrieved the form**

The error usually occurs when the vendor bill has a term and a discount amount.

To resolve, consider the following:

- Update the CSV import file. Payment amount should be equal to the actual payment amount due, that is, the net amount (Amount – Discount Amount = Payment Amount Due).
- If there should not be a discount on the vendor bills, update the bill records and clear out the Terms and Disc. Amt. fields.

**Note:** This error also applies when importing customer payments.

**Adding new line to sublist apply is not allowed**

The error occurs when trying to import vendor payments and apply existing vendor credits simultaneously. Also, the following conditions apply.
Vendor credits are already posted in NetSuite, and the CSV file contains the following fields:
- External ID
- Vendor ID
- Payment Amount
- ID of the Bill

The Payment Amount for the vendor bill is positive and for the bill credit the amount is negative.

The Vendor Bill Credit Internal ID and the Vendor Bill Internal ID are used on the ID of the Bill column.

The error will be encountered if:
- Data Handling is set to Add. Set it to Add/Update.
- The Vendor Bill is no longer Open or has already been paid with status Paid in Full.
- The Bill Credit has already been applied.
- The Vendor Bill and Bill Credit do not have the same A/P Account.

Unparseable Internal Id, did you mean to lookup this field by Name or External ID? for field xx

The xx in the error message refers to the mapped field name in the CSV file.

The value of the field mapped onto the NetSuite field Bill (Req) could not be found. Ensure that the value corresponds to the internal ID of the bill being paid. The internal ID can be taken from the URL of the bill or via a saved bill search that includes the internal ID column.

Website Import Errors

This section describes errors that you might see on a website import. See the following:
- Invalid category reference key Information for website <NULL>

Invalid category reference key Information for website <NULL>

In the UI, before you can select a site category for an item, a site must be chosen first.

Because the site is required, the site should be included in the CSV file and be mapped during the import. Or, you can assign a default site value by clicking the edit icon and choosing a site. If you assign a default value, the error is eliminated.
Additional Import and Export Options

This section describes options for data import and export that do not use the CSV Import Assistant.

- Importing a Peachtree CSV File
- Exporting Selected Lists and Reports as CSV Files (CSV Export)
- Extracting Data from NetSuite
- Replacements for smbXML
- Emailing or Faxing NetSuite Forms

For information about importing CSV data into NetSuite with the Import Assistant, see CSV Imports Overview.

Importing a Peachtree CSV File

If you use Peachtree Accounting® or Peachtree Complete Accounting®, you can import these lists into NetSuite:

- Accounts Receivable Customer list
- Accounts Payable Vendor list
- Payroll Employee list
- General Ledger Chart of Accounts list
- Inventory Item list
  If you import an item list, you must also import your chart of accounts at the same time.

First you export the lists from Peachtree, and then you import them into NetSuite.

To export lists from Peachtree:

1. In Peachtree, click File > Select Import/Export.
2. On the left side of the Select Import/Export window that appears, select the category of the list you want to export.
   For example, to export your chart of accounts, select General Ledger.
3. On the right side of the Select Import/Export window, select the list you want to export.
   For example, to export your chart of accounts, select Chart of Accounts list.
4. Click Export at the top of this window.
   Another window with list information appears.
5. Click the Options tab.
6. In the Export Options field group, check the Include Headings box.
   You do not need to make changes to the Fields tab.
   The import works in NetSuite even if Peachtree exports more columns than NetSuite requires.
7. Click OK.
8. Repeat these steps for each list you want to export.

If you are using a version besides Peachtree 7 or 8, you can open your CSV file in a spreadsheet and examine it to be certain that all the column headings match the required mapping to NetSuite fields. If not, you can change the column headings to match.
To import your CSV files into NetSuite:

See Importing CSV Files with the Import Assistant.

Exporting Selected Lists and Reports as CSV Files (CSV Export)

The Full CSV Export option in NetSuite does not currently export all data as CSV files.

This menu option exports the following data:

- Accounting Lists
- Classes
- Contacts
- Customers
- Departments
- Employees
- Expense Categories
- Items
- Memorized Transactions
- Notes
- Other Names
- Partners
- Saved Reports (that you own)
- Ship Items
- Solutions
- Tasks
- Topics
- Transaction Detail Report
- Vendors

**Note:** On record lists such as Customer and Item, the export mechanism exports the data based on the view you have selected for each list. For more information about options for exporting from record lists, see the help topic Exporting Lists.

Known Excel Limitation for Values with More Than 16 Digits

When opening a CSV file directly, Excel treats long numeric sequences as numbers and displays them using scientific notation. This treatment leads to a loss of precision when the number has more than 16 digits and to loss of information when digits at 16+ position are truncated. Even if apostrophes or double quotes are used as text qualifiers, the text within them is still recognized by Excel heuristics as a number and an additional formatting hint must be provided. This heuristics is known in Excel as the "General" format. One way to work around this limitation is to always open CSV files using the Excel's multistep Text Import Wizard. The wizard enables you to set column formatting in the last step ("Text"
format). Alternatively, you can use a different Office suite, for example LibreOffice, which always displays the import wizard when opening a CSV file.

For suggestions of other methods to export data from NetSuite, see Extracting Data from NetSuite.

To export selected data as a CSV file:

1. Go to Setup > Import/Export > Export Tasks > Full CSV Export.
2. Click Submit.
   A progress bar will appear.
   When progress is complete, the File Download window appears.

   **Note:** If the export times out, you can export smaller sets of data by opening pages for the lists or reports listed above and clicking the Export - CSV button.

3. In the File Download window, select Save this file to disk and then OK.
   The Save As window appears with File Name highlighted.
4. In the Save As window, enter a file name that means something to you, like your company name and 'listsandrecords', with the extension ZIP.
   For example, you might name your file WOLFELISTSANDRECORDS.ZIP.
5. Click Save.
6. Open the ZIP file to see the titles of the generated CSV files.
   For example, when you unzip the exported file, you can choose the file custjobs.csv.
7. Open the CSV file in a spreadsheet or text editor program.

   **Note:** The CSV Export function runs your saved searches and saves the results in a CSV file. A saved search that fails may cause the export to fail. So if you encounter errors during the export, review your saved searches to find the problem.

Permissions

Only users who have the Administrator role can use the CSV Export function.

Extracting Data from NetSuite

NetSuite provides an export function at Setup > Import/Export > Export Tasks > Full CSV Export, described in Exporting Selected Lists and Reports as CSV Files (CSV Export).

If this export functionality does not meet your needs, you can use a combination of the following options to extract detailed data from NetSuite:

- Exporting saved search results to CSV files. For information, see the help topic Exporting Search Results.
- Exporting report results as CSV files. For information, see the help topic Exporting a Report.
- Writing a SOAP web services program to query record data. For information, see the help topic SuiteTalk SOAP Web Services Platform Overview.
- Using SuiteAnalytics Connect to access NetSuite data through an ODBC, JDBC, or ADO.NET driver and an external application such as Microsoft Excel or Crystal Reports. For information, see the help topic SuiteAnalytics Connect. Note that ODBC access is an additional service with an associated fee.
You can use the detailed records that you obtain from these approaches to create spreadsheets of relevant information. All of these approaches can preserve the relational aspects of data, as long as you export the Internal ID with each data row.

**Recommendations for Financial Data Extraction**

Reports may be more useful for the extraction of transaction information than saved searches, because they provide easier matching of totals.

- A possible organizing mechanism is to aggregate purchase transactions in one spreadsheet and sales transactions in another.
- The Transaction Detail report can be customized to be filtered by transaction type and to include relevant columns such as transaction number and memo, before export.
- In some cases, it may be necessary to set date range filters to limit report run time, and run multiple versions of the same report to extract data from multiple date ranges.

**Recommendations for CRM Data Extraction**

Saved searches can be used to extract CRM data from NetSuite.

- Saved searches are organized by record type, such as contact, customer, and vendor; and NetSuite recommends that you organize extracted information by record type as well.
- Notes field data on entity records (such as customers and vendors) can be extracted through a separate type of search, either System Note or User Note. In some cases, you may need to run separate searches and combine their data into an aggregated spreadsheet. In other cases, you can access notes data through a search for Contacts, Customers, or Vendors.
  
  For information about saved searches, see the help topic **Saved Searches**.

**Replacements for smbXML**

As of Version 2013 Release 2, NetSuite no longer supports data imports using smbXML.

There are two methods that can replace smbXML import: CSV Import and NetSuite's SOAP web services. Many customers choose the CSV Import Assistant because it has an easy-to-use UI and requires no programming knowledge. You can also import data using SOAP web services; however, programming knowledge and SOAP web services development are required. This method is more beneficial if you seek an automated system-to-system integration model.

To start learning about the CSV Import Assistant, see **Additional Import and Export Options**. You can find this topic in the NetSuite Help Center at Account Administration > CSV Imports > CSV Imports Overview.

To start learning about SOAP Web Services, see the help topic **SuiteTalk SOAP Web Services Platform Overview**.

**Emailing or Faxing NetSuite Forms**

In NetSuite, you can automatically email or fax your transaction forms when you save them to your account.

Emailing your forms only requires that you enter an email address. Faxing your forms requires that you set up faxing through NetSuite. To set up fax service, an administrator must go to Setup > Company > Preferences > Printing & Fax.
Emailing or Faxing NetSuite Forms

For additional information, see the help topic Sending Email from NetSuite. Also, for details about emailing or faxing a specific type of transaction, search for transaction-specific help topics. For example, if you need details about emailing an invoice, search for Invoice in the Help Center.

**To email a transaction form:**

1. Go to the type of transaction you want to enter.
2. Check the To Be Emailed box, and enter or verify an email address to email the form.
   - You can enter multiple email addresses by separating them with a semicolon.
   - It is important to separate the addresses with a semicolon only, and to not include any spaces.
3. When you have finished entering information for this transaction, choose one of the following options to post the information to your NetSuite account:
   - Click **Save** to save the information, email the transaction form and return to the Transactions page.
   - Click **Save & New** to save the information, email the transaction form and return to a new transaction page of the same type.
   - Click **Print** to save the information, email the transaction form, and immediately print the transaction form.

**To fax a transaction form:**

1. Go to the type of transaction you want to enter.
2. Check the To Be Faxed box, and enter or verify a fax number to fax the form.
   - If you have not set up fax service, an warning message appears.
   - An administrator must set up fax service at Setup > Company > Preferences > Printing & Fax.
3. When you have finished entering information for this transaction, you can choose from three ways to post the information to your NetSuite account:
   - Click **Save** to save the information, fax the transaction form and return to the Transactions page.
   - Click **Save & New** to save the information, fax the transaction form and return to a new transaction page of the same type.
   - Click **Print** to save the information, fax the transaction form and immediately print the transaction form.

You can choose to print, email and fax the same transaction form from the transaction page. Check the To Be Printed, To Be Emailed and To Be Faxed boxes. When you click Save, NetSuite automatically queues the transaction form for printing, emailing, and faxing.
FAQ: CSV Import

See the questions and answers below for information on CSV Import.

Can I use the Import Assistant for all data imports into NetSuite?

The Import Assistant supports most commonly imported record types, and is the recommended method for transferring small to medium-sized data sets from other applications into NetSuite. For information about record types that the Import Assistant supports, see Supported Record Types for CSV Import.

NetSuite’s SOAP Web Services import tools provide another alternative for migrating data for record types not currently supported for CSV import, as well a solution for large or ongoing data migration projects. For information, see the SOAP Web Services Platform Guide.

NetSuite also supports the following specialized imports:

- Importing a Peachtree CSV File

⚠️ Important: As of 2017.1, the Quicken® QIF file import capability has been deprecated.

What is the recommended order for importing data into NetSuite?

The following order is recommended for data imports:

1. Chart of Accounts
   Note that you should enter opening balances as journal entries on “go live”, using the specialized journal entry import process. See the help topic Importing a Journal Entry.

2. Classifications
   Departments, Classes, Locations - supported by Import Assistant

3. Entities
   Employees, Vendors, Partners, Customers (including Leads, Prospects, and Customers), Contacts - supported by Import Assistant

4. Items
   Assembly/BOM Item, Lot Numbered Assembly/BOM Item, Serialized Assembly/BOM Item, Inventory Item, Lot Numbered Inventory Item, Serialized Inventory Item, Kit/Package Item, Non-Inventory Item for Sale, Non-Inventory Item for Resale, Non-Inventory Item for Purchase, Service Item for Sale, Service Item for Resale, Service Item for Purchase, Other Charge Item for Sale, Other Charge Item for Resale, Other Charge Item for Purchase - supported by Import Assistant

5. CRM Records
   Notes, Issues, Solutions, Topics - supported by Import Assistant
   Cases, Events, CRM Tasks, Messages - not yet supported, need another method

6. Transactions
   Cash Sales, Customer Payments, Estimates, Invoices, Opportunities, Purchase Orders, Sales Orders, Vendor Bills, Vendor Payments - supported by Import Assistant
   Credit Memos, Return Authorizations - not yet supported, need another method

How do I set up a CSV file for use by the Import Assistant?

The Import Assistant performs imports by record type, so you should put data for each record type in its own CSV file.
The first step is usually to export data from your current application to a CSV file. After that, you may need to add columns required by NetSuite to the file, to ensure the import is successful. You can determine the fields required for import, and set default values for these added columns, on the Import Assistant's Field Mapping page.

If you want to take full advantage of the Import Assistant's automatic mapping capabilities, you can change the column names in your CSV file to match NetSuite field names. You can see these field names on the Field Mapping page.

It is a good idea to include unique ID values from the current application in the CSV file, rename their CSV column to “External ID”, and import these values into NetSuite. These ID values uniquely identify each records, and can provide primary keys to use for record matching and linking.

What is sublist data and how do I import it?

Most records in NetSuite include sublists. Each record's sublist can include a list of references to other records. For example, a transaction record can include an items sublist, and a customer record can include an address sublist.

The Import Assistant enables you to import sublist data at the same time that you import other record type data. For more information, see Sublist Data Import.

On the first page of the Import Assistant, you can choose whether to use a single file or multiple files to import data. If you choose to use a single CSV file, this one file includes all sublist data as well as other record type data. If you choose to use multiple CSV files, the Import Assistant enables you to specify a primary file for record type data and separate files for data from different sublists. See Select a File for Import.

Sublist data fields are listed at the bottom of the Import Assistant Field Mapping page, within separate folders for each sublist. You can click Add New (to the right of the sublist folder name) to add instances of the sublist to be imported. You need to map sublist fields on this page for sublist data to be imported. See Step 4 Field Mapping.

Import Assistant updates of sublist data vary according to whether sublists are keyed or non-keyed. Keyed sublists have individual sublist lines that can be searched for and updated. For more information, see Keyed Sublists for CSV Import.

Why is my import job processing so slowly?

Your import may be slow because of the time at which it is processed or because it includes a large number of records.

You can save your import to be run at a later time. See Step 5 Save Mapping & Start Import.

It is also recommended that you break large CSV files into multiple, smaller files that you import as separate jobs, to improve performance. There is a limit of 25,000 records per imported file. If you would like to speed performance, you may wish to make CSV files smaller than this limit.

Where are email messages regarding a CSV import job sent?

Email notifications about the status of a CSV import job, including information about post-processing errors, go to the email address used to log in to the session that initiated the import job.

For example, if you log in as jsmith@companyx.com and run the CSV Import Assistant to initiate an import job, any related email notification are sent to jsmith@companyx.com.

Are there any special requirements for importing data into OneWorld accounts?

If your account is using NetSuite OneWorld, you should set up subsidiaries in NetSuite before you begin importing data. For instructions, see the help topic Subsidiary Setup.
For NetSuite OneWorld accounts, the Subsidiary field is a required field for the following record types: Chart of Accounts, Contacts, Customers, Employees, Jobs (Projects), Leads, Partners, Prospects, and Vendors. For imports of these record types, you must include in your CSV file a field that can be mapped to the NetSuite Subsidiary field, and map this field on the Import Assistant Field Mapping page. If the import attempts to add or update records in a OneWorld account without identifying the subsidiary, the import will fail.

CSV file values for subsidiaries should be hierarchical names, in the format `grandparent : parent : child`, for example, Consolidated Parent Company : UK Subsidiary : Euro Subsidiary.

How can I use the Import Assistant to update existing NetSuite records?

To update records with the Import Assistant, select either the Update or the Add or Update data handling option on the Import Options page. See Step 2 Import Options.

Your CSV file should include data for a primary key field that can be used to match CSV file records with existing NetSuite records and correctly update them.

- For best results, use the Internal ID field as the primary key, include a column of NetSuite Internal ID values in your CSV file, and map this column to the Internal ID field. You can obtain Internal ID values by creating a saved search of the record type in NetSuite that includes Internal ID as a results column and exporting saved search results to a CSV file. For instructions on how to do this for transactions, see Creating Transaction Saved Searches for Reimport.
- If internal ID values are not available, use the External ID field as the primary key, include a column of unique identifier values in your CSV file, and map this column to the External ID field. If the external application from which you want to import data includes unique identifiers, you can save these to a column in your CSV file, and name this column External ID. Note that External ID field values are never visible or editable in the NetSuite user interface. However, these values can be modified by CSV import, SuiteScript, and SOAP Web Services, and can be returned by saved searches.
- The last possibility is to use a name field as a primary key. This option is not recommended, as name formatting can be complex, and key matching for updates can be difficult and error-prone if CSV file name values are formatted incorrectly. For example, customer names are mapped to the Customer ID field and should have the format Parent : Child, such as ABC Medical : A1 Bandages. Also, for names that contain spaces, HTML rendering can sometimes distort the number of spaces included, causing mismatches between CSV file values and existing records, that result in import errors. To verify the number of spaces in names, you can create a saved search with a list of names and export it.

The above text refers to the update of body fields. Sublists have predefined key fields that you need to use as unique identifiers for updates. Note that not all sublists are selectively updateable; only a subset of the sublists supported for import are keyed. See Keyed Sublists for CSV Import.

When you use the Import Assistant to update data, you need to be aware of the effects of the Advanced Options, Overwrite Missing Fields and Overwrite Sublists. See Set Advanced CSV Import Options. You also need to be aware of how sublist data records are updated. See Keyed Sublists for CSV Import.

Why does my import keep returning invalid reference key errors?

These errors usually occur when you are using name rather than internal ID or external ID as the primary key for your imported records, or as one or more reference types, and one or more names in your CSV files do not match names in existing records.
Using names as primary keys or reference types is not recommended, as name formatting can be complex, and matching for updates can be difficult and error-prone if CSV file name values are formatted incorrectly. For example, customer names are mapped to the Customer ID field and should have the format Parent : Child, such as ABC Medical : A1 Bandages.

Also, for names that contain spaces, HTML rendering can sometimes distort the number of spaces included, causing mismatches between CSV file values and existing records, that result in import errors. To verify the number of spaces in names, you can create a saved search with a list of names and export it.

Should I import account balances as part of the Chart of Accounts import?

You should not include account balances as part of your Chart of Accounts import. This import should include account numbers, names, and descriptive information like type, description, and currency.

Because the Chart of Accounts is the basis for all company data, you should complete this import first when you are setting up your account. You should not import account balances until your account is ready to go live.

You can use NetSuite's journal entry import process to import balances as journal entries. This import uses a template rather than the Import Assistant. See the help topic Importing a Journal Entry.

How do I create template files for CSV imports?

You do not need to create template files for CSV import, as the Import Assistant is not template-based. You can use any CSV file for an import; you do not need to start with a template file provided by NetSuite.

If you want to set up your own standard CSV file columns for particular record type imports, you can obtain information about NetSuite fields to which you can map CSV file fields in the following ways:

- Walk through the Import Assistant for an import of the selected record type and review the fields listed in the NetSuite Fields pane on the Field Mapping page. You can use these field names as column names in your CSV file to facilitate automatic mapping.
- Another way to understand these fields is to review carefully the form in the NetSuite user interface for the selected record type. You can click each field label to get help that describes each field.
- For more descriptions of fields, review the SOAP Schema Browser for details about fields for each record type. For information about working with this tool, see the help topic SOAP Schema Browser.
- Be aware that, by default, mappable NetSuite fields are those available on your preferred form for the selected record type. Fields can be mapped for the import job if they are displayed (not hidden) and not disabled on your preferred form. For example, when you import customer records, the fields that you can map to be imported are those that you can edit on the NetSuite customer form.

If these fields do not include all of the data you want to import, for some record types, you can specify a custom form that includes the fields you need, as an Advanced Option in the CSV Import Assistant. This specification changes the NetSuite fields listed on the Field Mapping page. See Set Advanced CSV Import Options.

How do I complete an import if my CSV file does not include values for a required field?

NetSuite fields that are required to be mapped are marked as (Req) on the Import Assistant Field Mapping page and usually are automatically placed in the center pane of this page, to remind you to map them. If you do not map one or more required fields, you cannot move past the Field Mapping page.

If you do not have any values to import for a required field, you can do one of the following:

- Include a column with blank values in your CSV file and map this column to the required NetSuite field.
- Click the edit icon next to the required field and set the value for the required field to be NULL.
- Click the edit icon next to the required field and select a default value for the required field. (This is possible only if values are set up in NetSuite).
What is a reference type?

A reference type enables you to map a column in an imported CSV file to a NetSuite field that can have one or more list values, such as a dropdown list or a multi-select. You specify reference types on the Import Assistant Field Mapping page by clicking on the edit icon next to a mapped field that is a dropdown list or multi-select. See Select Reference Types.

Can I use the Import Assistant to import pricing data for items?

The Import Assistant supports the import of items' pricing data, including multiple price levels, quantity-based pricing, quantity pricing schedules, and multiple currencies. Import of item pricing data can occur only when one or more of the following related features are enabled: Multiple Prices, Quantity Pricing, and Multiple Currencies.

- NetSuite recommends that you import multiple files, rather than a single file for item pricing, with pricing data in a separate file from other item data. For more information, see Guidelines for CSV Import Files.
- Recommended column headers for item pricing CSV files vary, depending upon whether you plan to upload a single file or multiple files. For more information, see Guidelines for CSV Import Files.
- Pricing data can be selectively updated based on key field values. The key fields depend upon the pricing-related features that are enabled. For information, see Guidelines for CSV Import Files.

For more information, see Guidelines for CSV Import Files.

Why is the Individual field required for an import of customers, when all of my customers are companies, not individuals?

NetSuite enables you to define each customer, partner, and vendor as either an individual (a person) or a company. The NetSuite Fields pane of the Import Assistant's Field Mapping page includes an Individual field for all of these entities. This field is required.

- The Individual field is a Boolean indicating whether the entity is a company or a person.
- It corresponds to the Type option buttons on NetSuite's user interface forms for customers, partners, and vendors.
- Unlike most radio button fields, an import of this field's data accepts all forms of True or False. For example, the following values are acceptable as a “True” value: True, true, TRUE, T, yes, Yes, YES.
  - A True value indicates an individual; a False value indicates a company.
  - The Company Name field is required for records with a False value, but not for records with a True value.
- You can set a default value for the Individual field by clicking its edit icon on the Field Mapping page. In the Default Value popup: choose Yes to default customer type to individual, choose No to default customer type to company.

Note: Your account’s settings for the Default Customer Type, Default Partner Type, and Default Vendor Type fields, at Setup > Company > General Preferences, may affect the value of the Individual field for imports.

What values should I import for the Global Subscription Status field for customers?

The Global Subscription Status field on customer records determines whether or not a customer can receive email sent through campaigns and email merge operations.
FAQ: CSV Import

Four values are possible: Confirmed Opt-In, Soft Opt-In, Soft Opt-Out, and Confirmed Opt-Out, but only the soft values are available to be set by import.

If you want to send campaign email to a customer, set this field's value to Soft Opt-In, because you cannot send campaign email to users with Soft Opt-Out status, only opt-in email.

If you do not include this field in an import, its value is defaulted, based on the Unsubscribed to Marketing By Default option at Setup > Marketing > Marketing Preferences. By default, this option is disabled, and the Global Subscription Status field defaults to Soft Opt-In. When this option is enabled, the field defaults to Soft Opt-Out.

After an import, you can change the value of the Global Subscription Status between Soft Opt-In and Soft Opt-Out manually in the user interface and through mass updates. Only recipients themselves can change the value to Confirmed Opt-In or Confirmed Opt-Out.

**Note:** The Global Subscription Status field replaces the previously used Unsubscribed field and enhances on its functionality.

What is the difference between leads, prospects, and customers imports?

When you import Lead, Prospect, or Customer data into NetSuite, you import into the Customer record. The Stage field on the Customer record defines the stage of “Customer” that is currently in the system - a Customer can be a Lead, Prospect or Customer. Leads automatically can become Prospects, and Prospects can become Customers.

Specifically:

- **Lead:** enables you to track all the information you need to convert a lead into a customer. Leads have no estimates, opportunities or transactions associated with them. If an estimate or opportunity is created for a lead, the lead becomes a prospect. If you create a sales transaction for a lead, the lead becomes a customer.

- **Prospect:** enables you to track all the information you need to convert a prospect into a customer. Prospects have no sales orders, invoices, cash sales or other sales transactions associated with them. They can have opportunities and estimates associated with them, however. If a sales transaction is created for a prospect, or an opportunity is closed for a prospect, the prospect becomes a customer.

- **Customer:** enables you to track all the information on your current customers.

Should I import customers and contacts together or separately?

The Import Assistant enables you to perform separate import jobs for customers (meaning leads, prospects, or customers) and contacts, or to import both at the same time.

Setting up files for importing customers and contacts together can be complex. For instructions for importing customers and contacts together, see Importing Entities and Contacts Together. For information about how data is processed for these types of imports, see Import Job Processing for Entities and Contacts Imports.

You may find it simpler to import contacts and customers separately. For tips on how to do this, see Contacts Only Import. Especially review Importing Contacts for Existing Entity Data and Importing Contacts and New Entities Data.

Can I use the Import Assistant to import project data?

The Jobs import, a Relationships type import, enables you to import core project data and project resource data into NetSuite. See Projects (Jobs) Import.

In addition, a simplified Import Assistant is available for you to import project tasks data from Microsoft Project into NetSuite. See Project Tasks Import.
What is the difference between the following advanced options: Overwrite Sublists and Overwrite Missing Fields?

Both of these options apply to updates, and are not enabled by default, but one option applies at the sublist level and the other applies at the field level.

The Overwrite Sublists option applies to all data in sublists that have fields mapped for an import job. When this option is enabled, CSV file data for any sublists with mapped fields completely replaces any existing sublist data in NetSuite. If this option is not enabled, CSV file sublist data either selectively updates or appends to existing sublist data.

The Overwrite Missing Fields option applies to individual fields. When this option is enabled, any mapped CSV file fields with null values overwrite existing data in NetSuite fields, blanking it out.

Why didn't my CSV import job that created new records trigger my workflow based on record creation or update?

If a workflow is triggered when you create or update records in the NetSuite user interface, but is not triggered when a CSV import job creates or updates records, you probably need to enable the Run Server SuiteScript CSV and Trigger Workflows preference when performing the import. Workflows are treated as server-side SuiteScript, so they do not run if this preference is not enabled.

You enable this preference for the current import on the Advanced Options of the Import Assistant. Go to Setup > Import/Export > Import Tasks > Import CSV Records. On Step 2 of the Import Assistant, in the Advanced Options, check the Run Server SuiteScript and Trigger Workflows box. If the box is unavailable, you do not have permission to change the setting for the import, and the company setting will apply.

How can I import Price Level for transaction line items?

On the Field Mapping page of the CSV Import Assistant, expand the Items folder in the NetSuite Fields pane on the right side. Double-click the Price Level field to display it in the middle pane.

NetSuite recommends that you include a Price Level column (with values) in your CSV file that can be mapped to the NetSuite Price Level field. If you are unable to add this column, you can still map the Price Level field on the Field Mapping page, and then click the edit icon and select Custom as the default value. However, this default is not guaranteed to be a valid level for all items.

**Important:** If you do not map the Price Level field for a CSV import, the base price from each item record is used as the price for each transaction line item. This behavior is consistent with the behavior when you add transaction line items in the user interface.

How do I know what the number is for an imported journal entry?

There are two methods for journal entry: a simple method you can use to import one journal entry at a time, and a more involved method you can use to import multiple journal entries.

If you use the simple method, available at Transactions > Financial > Make Journal Entries > Import, you do not have to provide the number for the journal entry in your CSV file. If you do not include this number, a default number is applied during the import process.

If you want to know the defaulted number for an imported journal entry, you can obtain it before you start the import from the View Mapping / Start Import page. Before you click the button to Run the import, do the following:

Click the Entry No. field in the right pane so that it appears in the center pane, then click its edit icon. The default value displays in the popup.

If you are importing multiple journal entries, you need to provide numbers in your CSV file.